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WARNINGS AND PRECAUTIONS

READ ALL PRODUCT MANUALS AND CONSULT WITH BECKMAN COULTER-TRAINED PERSONNEL BEFORE ATTEMPTING
TO OPERATE INSTRUMENT. DO NOT ATTEMPT TO PERFORM ANY PROCEDURE BEFORE CAREFULLY READING ALL
INSTRUCTIONS. ALWAYS FOLLOW PRODUCT LABELING AND MANUFACTURER’S RECOMMENDATIONS. IF IN DOUBT AS
TO HOW TO PROCEED IN ANY SITUATION, CONTACT YOUR BECKMAN COULTER REPRESENTATIVE.

HAZARDS AND OPERATIONAL PRECAUTIONS AND LIMITATIONS

WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:

WARNING - Can cause injury.
CAUTION - Can cause damage to the instrument.
IMPORTANT - Can cause misleading results.

BECKMAN COULTER, INC. URGES ITS CUSTOMERS TO COMPLY WITH ALL NATIONAL HEALTH AND SAFETY
STANDARDS SUCH AS THE USE OF BARRIER PROTECTION. THIS MAY INCLUDE, BUT IT IS NOT LIMITED TO,
PROTECTIVE EYEWEAR, GLOVES, AND SUITABLE LABORATORY ATTIRE WHEN OPERATING OR MAINTAINING THIS OR
ANY OTHER AUTOMATED LABORATORY ANALYZER.

WARNING Risk of operator injury if:
« All doors, covers and panels are not closed and secured in place prior to and during instrument operation.
 The integrity of safety interlocks and sensors is compromised.
« Instrument alarms and error messages are not acknowledged and acted upon.
* You contact moving parts.
« You mishandle broken parts.
« Doors, covers and panels are not opened, closed, removed and/or replaced with care.
 Improper tools are used for troubleshooting.
To avoid injury:
» Keep doors, covers and panels closed and secured in place while the instrument is in use.
« Take full advantage of the safety features of the instrument. Do not defeat safety interlocks and sensors.
» Acknowledge and act upon instrument alarms and error messages.
¢ Keep away from moving parts.
» Report any broken parts to your Beckman Coulter Representative.
» Open/remove and close/replace doors, covers and panels with care.
 Use the proper tools when troubleshooting.

CAUTION System integrity might be compromised and operational failures might occur if:
 This equipment is used in a manner other than specified. Operate the instrument as instructed in the Product Manuals.

 You introduce software that is not authorized by Beckman Coulter into your computer. Only operate your system’s
computer with software authorized by Beckman Coulter.

 You install software that is not an original copyrighted version. Only use software that is an original copyrighted
version to prevent virus contamination.

IMPORTANT If you purchased this product from anyone other than Beckman Coulter or an authorized Beckman Coulter
distributor, and, if it is not presently under a Beckman Coulter service maintenance agreement, Beckman Goulter cannot
guarantee that the product is fitted with the most current mandatory engineering revisions or that you will receive the most
current information bulletins concerning the product. If you purchased this product from a third party and would like
further information concerning this topic, call your Beckman Coulter Representative.




REVISION STATUS -

Initial Issue, 6/01
Software version 1.03

Issue B, 10/04

Software Version 2.00

Added information about the new features provided by software version 2.00. Updated
illustrations.

Issue BA, 06/10
Software Version 2.00.

Updates were made to the company corporate address.

Note: Changes that are part of the most recent revision are indicated in text by a bar in the
margin of the amended page.

This document applies to the latest software listed and higher versions. When a subsequent software version changes the
information in this document, a new issue will be released to the Beckman Coulter website. For labeling updates, go to
www.beckmancoulter.com and download the most recent manual or system help for your instrument.
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INTRODUCTION -
PURPOSE OF THIS DOCUMENT

To provide an authorized trainer with corporately accepted training materials for instructing a
new operator in the proper use and operation of a COULTER® ACeT™ 5diff Cap Pierce (CP)
hematology analyzer.

DOCUMENTATION

Several documents are available with your new instrument.

* Instructions For Use manual, PN 624021, provides information about:
» getting started,
» running of your instrument,
» reviewing results,

» performing special procedures, such as cleaning, replacing, or adjusting an
instrument component,

» troubleshooting problems,

» determining what the instrument does,

» understanding how to safely operate the instrument,
» powering up the instrument,

» customizing the setup, and

» running controls and samples.

The information contained in the Instructions For Use manual can also be accessed
using the ACeT 5diff CP online Help system. The printed version is available by order.
Contact your Beckman Coulter Representative if you want to order a printed copy of this
manual.

* Host Transmission Specification, PN 4277065, defines the information needed to
program the transmission interface between the ACeT 5diff CP hematology analyzer and
the laboratory’s host computer. The printed version is available by order. Contact your
Beckman Coulter Representative if you want to order a printed copy of this manual.

* Operator Manuals CD-ROM, PN RAXO015, provides the operator manuals in two
formats: one for viewing and one for printing. Use this CD-ROM at any compatible
desktop PC to access the same Operator’s Guide information that is accessible through
the Help menu on the ACeT 5diff CP Workstation and the same Host Transmission
Specification information that is accessible in the printed manual.

Do not use the Operator Manuals CD-ROM at your ACeT 5diff CP Workstation. This
CD-ROM is optimized for use on a desktop home or office PC, not the ACeT 5diff CP
Workstation.
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ABOUT THIS TRAINING GUIDE

ABOUT THIS TRAINING GUIDE

Scope

This training guide is designed to support ACeT 5diff CP hematology analyzer training. This
document provides the trainer with the opportunity to customize the training experience to
best fit the individual trainee and laboratory. Since trainee experience levels and laboratory
needs differ, this training outline is designed with flexibility in mind.

Topics
The materials in this guide support the training of eight different topics:
e Topicl GETTING TO KNOW YOUR INSTRUMENT
* Topic2 STARTUP/SHUTDOWN
* Topic3 SET UP OPTIONS
* Topic4 QUALITY ASSURANCE
e Topic5 CALIBRATION
e Topic6 SAMPLE ANALYSIS
e Topic 7 DATA REVIEW
* Topic 8 BASIC TROUBLESHOOTING

Each topic consists of several related subjects that may be used, as needed, in your training.

Organization

The eight individual topics contained in the Operator’s Training Guide are part of a larger
organization that includes four basic types of information:

Introduction Explains how to use this training guide

Topics Heart of this document, each topic consists of multiple subjects and
operational summaries relating to the overall topic

Summary Pages Master copy for use by the Key Operator in their laboratory once
training is complete

Training Checklist ~ Method for documenting the specific training an operator receives

Summary Pages

Routine operational tasks detailed in the Operator’s Guide are abbreviated in this training
document. These abbreviated instructions are referred to as either summary pages or
operational summaries. Each summary page is an individual, stand-alone document that is
designed for use in your laboratory as a training aid and/or as a reference tool for a trained
operator. A master copy of each summary page is located behind the Summary Masters tab.

These summary pages contain essential operational instructions. As a result, it is important
that you become proficient in the use of this tool during your training. To eliminate the need
to flip back and forth between the topic and the summary masters, the appropriate summaries
are inserted within each topic.
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INTRODUCTION
RESPONSIBILITIES

How to Identify an Inserted Summary

When a summary is inserted in the training material, a rotated chevron (3) appears to the
left of the Summary Page title. For example, at the point of insertion, the Startup summary
would begin with

>» Startup Summary

Since this is a stand-alone summary for use after training is complete, some of the
instructions discussed in the training topic may be repeated in the summary. Two rotated
chevrons (3 ») mark the end of the inserted summary.

Daily Operations Quick Reference

Daily operational tasks detailed in the summary page format are further abbreviated in this
Quick Reference trifold (PN 4277315). An experienced operator may use these abbreviated
instructions to perform those routine operations completed on a daily basis, including:

» Startup when the power is already turned on
*  Running COULTER® ACeT™ 5diff Control Plus
* Running patient samples (with or without using the Worklist)
* Shutdown
This Quick Reference tool is not designed to teach an operator how to run the instrument. It

is designed for use by a trained, experienced operator who is already familiar with the
information on the corresponding Summary pages.

Training Checklist
This checklist provides the trainer with an official method to document the completion of
training on the ACeT 5diff CP hematology analyzer.

When the training process is complete, we recommend that both the trainer and trainee sign
the Training Checklist to show agreement that the trainee is sufficiently trained and able to
meet the objectives listed for each topic.

RESPONSIBILITIES

Beckman Coulter’s Responsibility
Beckman Coulter is responsible for instructing a Key Operator in the proper use and
operation of the ACeT 5diff CP hematology analyzer.

Our goal is to provide your laboratory with high quality training that best fits your
laboratory’s needs. This means the emphasis given to each topic may differ, with some topics
needing to be covered more thoroughly than others.

Key Operator’s Responsibility
It is the Key Operator’s responsibility to train all other operators in their laboratory. To assist
you in this process, a master copy of each operational summary is located at the end of the
Operator’s Training Guide. Once trained by an authorized Beckman Coulter trainer, the Key
Operator is authorized to copy these masters for use in training other laboratory personnel.

PN 4277205BA ix



INTRODUCTION
CONVENTIONS

CONVENTIONS

This training guide uses the following conventions:

A primary window is the window displayed after you select one of the following tabs:
Worklist, Run, Results, Quality Assurance, or Analyzer / Logs.

Instructions assume operator is using the mouse for navigation.
Tabs are the major navigation tool.

Black text on a tab indicates the name of the window currently displayed. Although text
is greyed-out on the other tabs, these tabs are still active and may be selected as desired.

If an icon is active, it appears in color; if icon is inactive, the coloring is removed

(greyed-out).

Software navigation to access a needed function or screen appears as a sequence of menu
items separated by double arrow heads. For example, the path to the command for
priming the reagents is Diagnostics » Operator > Diluter Systems » Prime Reagents.

Bold indicates a menu item such as File or a tab such as Worklist.

Italics font indicates screen text and/or messages displayed by the instrument such as
Calibration Passed.

Information that is to be typed is in Courier font such as type the password 123.

Instrument or system is sometimes used to refer to the ACeT 5diff Cap Pierce
hematology analyzer (meaning both Analyzer and Workstation).

CP refers to cap pierce.
Note (in bold font) prefaces supplemental information.

An ATTENTION contains information that is important to remember or helpful when
performing a procedure.

Main card refers to the main circuit board (card) in the instrument.
RBC bath is sometimes referred to as RBC/PIt bath.

The terms “screen” and “window’ are used interchangeably.

ACeT 5diff Rinse reagent is sometimes referred to as Rinse.

ACeT 5diff Fix reagent is sometimes referred to as Fix.

ACeT 5diff Hgb Lyse reagent is sometimes referred to as Hgb Lyse.
ACeT 5diff WBC Lyse reagent is sometimes referred to as WBC Lyse.
ACeT 5diff Diluent reagent is sometimes referred to as Diluent.

() indicates a key such as (Enter).

indicates the operator needs to press and release the Tab key.

(J + (4 indicates to press and hold the first key listed, then press the next key.

A rotated chevron (3) placed to the left of a Summary Page title identifies an operational
summary inserted within the training materials. For example,

» Changing Reagent Summary

Two rotated chevrons (3 ») designate the end of an operational summary.
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SAFETY SYMBOLS

Safety symbols alert you to potentially dangerous conditions. These symbols, together with
text, apply to specific procedures and appear as needed in the operational summary pages
throughout this training guide.

Symbol Warning Condition Action
~ | Biohazard. Consider all materials Wear standard laboratory attire and follow
& (specimens, reagents, controls, and safe laboratory procedures when handling
V3

calibrators, and so forth) and areas these any material in the laboratory.
materials come into contact with as being
potentially infectious.

contain biohazardous materials, such as probe and probe area.

Q Probe hazard. The probe is sharp and may | Avoid any unnecessary contact with the
& controls and calibrators.

GRAPHICS

All graphics, including screens and printouts, are for illustration purposes only and must not
be used for any other purposes.
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GETTING TO KNOW YOUR INSTRUMENT

OBJECTIVES

When the subject is complete, you will be able to . . .

Workstation
* Locate and name the three major components of the computer system.

* Locate and explain the function of specific keys on the keyboard.

* Log on the Workstation using the proper User name and password.

* Use the mouse to navigate through the software and select desired items or functions.
* Locate the menu bar and access the pull-down text menus using the mouse.

* Locate the tool bar and identify each icon and its purpose.

*  Quickly access a primary window by selecting its corresponding tab.

e Use the buttons, fields, boxes, scrollable lists, and scroll bars as needed.

* Explain the significance of the green, red, and yellow background colors.

* Access and use the online Help system as needed.

* Load paper in the printer and verify the printer is ready to print.

Main Unit

* Locate and name the hardware controls and indicators on an ACeT 5diff Cap Pierce (CP)
hematology analyzer.

* Given an instrument that appears to be without power,
» Tell whether it is powered down or in Standby.
» Bring the instrument back into operation.
* Reset the system.
* Locate the cap pierce module and the two tube holders.
* Explain how to select the proper tube holder and sample position.

* Demonstrate how to properly change the tube holder.

Single Point of Aspiration

* Explain why the ACeT 5diff CP hematology analyzer is referred to as a single point of
aspiration system.

* Briefly overview closed-vial operation versus open-vial operation.

* List four situations when open-vial operation may be necessary.

Reagents
* Locate the reagent compartment.

* Name the reagents used on the ACeT 5diff CP hematology analyzer.

* State if the reagent is used for CBC analysis, DIFF analysis, or both.

* State the open container stability of each reagent used on an ACeT 5diff instrument.
* Explain how to change reagents.

* Explain how to handle and replace a waste container, if applicable.
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NOTES

NOTES
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GETTING TO KNOW YOUR INSTRUMENT 1
WORKSTATION

WORKSTATION
Functions of the ACeT 5diff CP Workstation

* Controls and monitors instrument operation

* Displays, stores, outputs, and allows recall of sample results

* Stores and graphs control results for the Quality Assurance program
* Automatically calculates new calibration factors

* Allows bidirectional communication with a host computer

* Consists of three major components: the computer, the monitor, and the printer

Major Components

Computer
* Must not use this system as a personal computer

* Consists of hardware components and software
* Hardware is the term used to describe the physical components of a computer system
» Locate the following hardware components:
— Power ON/OFF button
— Power ON/OFF indicator light
— Hard drive indicator and symbol
— CD-ROM drive
— Diskette drive

* Software refers to a sequence of detailed instructions (called a program) that directs the
computer to perform certain actions

Monitor
* Computer uses the monitor to visually display information

* Locate the Power ON/OFF switch and the indicator that lights when power is on

* Locate screen adjustment controls

Printer

* Used to either print a copy of the screen displayed on the monitor or of data stored in the
computer’s database

* Locate the Power ON/OFF switch
* Explain use of the ONLINE/OFFLINE button
* Demonstrate how to load the paper

* Demonstrate how to change the ink cartridge

Bar-code Reader (Optional)
* Hand-held scanner for reading the bar-code label on a specimen tube before sampling

* Operator must press button on the bar-code reader before scanning a label

* An audible beep indicates barcode was read successfully
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GETTING TO KNOW YOUR INSTRUMENT
WORKSTATION

Keyboard

* Direct line of communication between the operator and the computer containing the
Workstation software program

Layout
* Alphanumeric keys:

» Configured in a standard typewriter keyboard layout

» Consists of all standard alphanumeric keys plus a handful of special computer keys
and symbols

e |Tab
» May be used to move from field to field on some windows
. Caps Lock
»  Works like the Shift Lock key on a typewriter
»  With Caps Lock on,
— Pressing any alphabet key on the keyboard produces an uppercase letter
— Pressing the key plus a letter produces a lowercase letter
— Only shifts the letter keys, all other keys on the keyboard remain the same
*  Numeric keypad:

» Keypad contains the numbers O through 9, plus the period, an key, and various
mathematical symbols

» Can expedite manual entry of patient ID numbers and certain quality control entries
®  |NumLock

» Controls operation of the numeric keypad

» Locate light that illuminates when Num Lock is turned on

» With Num Lock turned on, numeric keypad produces numbers

» Workstation keyboard is designed to be used with Num Lock turned on

»  With Num Lock turned off, numeric keypad on a typical keyboard doubles as a
cursor keypad

* Cursor control keys:
>
— Also called arrow keys
— Directional keys for moving the cursor

— Used to highlight menu items, scroll up and down screens, or move to a field
on a screen to enter or edit data

» [(Page Up) and [Page Down] may be used to page through stored sample and control data
> and may be used to locate the beginning or the end of stored data
* Keys not used with the Workstation: (insert), through , (PrintScreen), (Esc), and
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GETTING TO KNOW YOUR INSTRUMENT
WORKSTATION

» Mainly used to select a highlighted menu or submenu option which then activates a
change in the screen display or initiates a function

» Do not use to bring up the Primary Window as pressing this key may activate a
command

» Do notuse to save new information on any setup screen
» Keyboard has two keys; both work identically
¢ @ and

» Modifier keys that have no action by themselves but can be used in conjunction
with other keys to generate special operations

» Must simultaneously press (Ctl) + (At]) + to log onto the Workstation

Software
e Workstation software is based on Windows-NT

* Familiarity with Windows conventions and use is beneficial but not required

Initial Windows-NT Logon
*  When the software initially loads, a Windows-NT logon window appears

* Logon Information box is where you enter user name and password information

User Names and Passwords

*  When logging on the system, required to type a user name

* Type one of the following:
» BCI (for normal operation), or
» Admin (for special procedures)

* For normal operation (which is the majority of the time):
» Log on using BCI as the User name
» 123 is password for BCI User name
» Once operator enters the password for BCI, the system prompts for the Operator ID

* For special procedures and only when instructed to by a Beckman Coulter
Representative:

» Log on using the Admin User name provided to you at the time it is needed

Operator ID

* A 3-character (alphanumeric) ID of your choice which uniquely identifies you as the
current operator

* Enter your Operator ID after logging on. The system then automatically loads the
Workstation application software.

Software Passwords

* Various Workstation software areas, such as Setup and Calibration, require an
“Administrator” password before permitting access
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GETTING TO KNOW YOUR INSTRUMENT
WORKSTATION

*  When “Administrator” password is requested, type 123 to gain access to that particular
software screen

* Other Workstation software areas, such as service diagnostics, requires a “Service”

password before permitting access; “Service” password is for use only by Beckman
Coulter Representatives

Logging On the Workstation

*  When the Begin Logon box is displayed on the Workstation screen, operator must follow
the instructions on the screen and simultaneously press + +

*  When Logon Information box appears:

Logon Information

Enter a uger name and pazsword that iz valid for this
spster.

User name: II%

Password: I

Lancel | Help | §hutd0wn|

» Type BCI as the User name (User name for normal operation)

» Press

» Type 123 (Password for BCI User name)
> Press or click OK to log on

*  When the following window appears:

AC-T"5diff

» Type your 3-character Operator ID

» Press or click @

*  Wait for Analyzer / Logs window to appear
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GETTING TO KNOW YOUR INSTRUMENT

Verity background behind (lightening bolt) is green

WORKSTATION

Note: Analyzer and Workstation should begin communicating within 30 seconds. In the
upper right corner, the System State indicator on the right should also be green.

AT s Diagnostics  Setup Help ‘
glel o 8] o o] §l s T 3 e

Wiorklist | Fun | Results |Qua\nyAssurance AnalyzeriLogs |

[ Reagent Statu:

[SY— ERES [Fi< [HaB LrsE [wecLvse |[EENg
LotMumber. | | | | |
o | | | | | |
ExpiaionDate: | | | | |
Dperator EE] EE] [eci [eci [eci
FilLevet T ooz -az | T
Change All Reagents LChange prnd
tartup Systar
Backaround WBC REC HGE LT Analy:
Results IPassed IPassed IPassed IPassed

Startup Log Erorlog | Calibration Log) Maintenance Lo

| 03/09/2001 155358




GETTING TO KNOW YOUR INSTRUMENT

WORKSTATION

Primary Windows

Primary Window (Analyzer / Logs)

Ac-T Sdiff

File Cycles Diagnostics Setup  Help

Sl Bl ] tipd ACT ] Bl LB W 2

ge

Wy'orklist | Fun I Results I Cuality Assurance AHEWZEI’."LDQS'
—Reagent Statu
Reagent [RINSE [Fix |HGB L'vsE [weCLvsE [DILUENT
Lot Hurmber: [o0102C01445 |00402E00061 0202401091 00402800041 00202000214
OpenedDate:  |03/27/2001 |03/27/2001 0372742001 |03s27/2001 |03/27/2001
Expiration Date: |~ |04/05/2001 |04r20/2001 [10/05/2001 |o8/23/2001 |og/09/2001
Operator fAdmin [sdmin |Asdimin fAsdmin fsdmin
Fill Lewvel: 97 - 97y
Change All Feagents | Change Heagentl
startup System
Backaground WBL RBC HGB PLT .t’-‘«nalyzer.

Reagents | Fieagent Log | Startup Log I ErrorLog ICaIibratiDn LDgI haintenance LDgI Service Log I

| 03/28/2001 13:47:32

First window to appear after log on

May also be referred to as Reagents window

Primary naviagation window

» Provides operator with quick access to other primary windows via tabs

» Use the mouse to select the desired tab

» Each primary window can be reached within two tab selections
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GETTING TO KNOW YOUR INSTRUMENT 1
WORKSTATION

Tab Selections
* Five main tab options appear across the top of the Analyzer / Logs window

From left to right:

»  Worklist
» Run
» Results

» Quality Assurance
» Analyzer/Logs
* Analyzer/Logs is the selected main tab option after log on
* Sub-options appear across the bottom of the window when a main tab is selected

* Reagents, Reagent Log, Startup Log, Error Log, Calibration Log, Maintenance Log, and Service
Log are the sub-option tabs appearing at the bottom of the Analyzer / Logs window

* Analyzer/Logs and Reagents appear in black print to identify the current primary window
being displayed

* Any window accessed using a tab is considered a primary window

* All other tabs are functional even though they appear greyed-out

* Any other tab may be selected any time, as desired

Table of Tab Options and Sub-Options

* Following table provides an overview of the various displays that can be accessed from
the primary window

» Five main tab options are in bold
» Associated sub-options are indented under each main tab, as applicable
* Descriptions are not inclusive

* Additional information concerning these selections is detailed in other sections of this
training guide as applicable
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GETTING TO KNOW YOUR INSTRUMENT

WORKSTATION
Tab Name Purpose
Analyzer / Logs  Provides access to various logs via the tabs at the bottom of the window.
Reagents « Displays current reagent status and the background status of the last completed Startup.
* This is the default display.
Reagent Log * Tab used to access the Reagent Log display.

» Maintains most recent 50 entries displaying the most recent log entry at the top of the
log and the oldest entry at the bottom of the log.

 Rollover is first in, first out when the 51st entry is added.

« Additional information about reagents and the Reagent Log is located under the
REAGENTS heading towards the end of this topic.

Startup Log  Tab used to access the Startup Log display.

» Maintains most recent 50 entries displaying the most recent log entry at the top of the
log and the oldest entry at the bottom of the log.

* Rollover is first in, first out when the 51st entry is added.

« Additional information about Startup and the Startup Log is located in Topic 2 (Startup /
Shutdown).

Error Log « Tab used to access the Error Log display.

« Maintains most recent 100 entries displaying the most recent log entry at the top of the
log and the oldest entry at the bottom of the log.

* Rollover is first in, first out when the 101st entry is added.

« Additional information about the Error Log is located under the BASIC
TROUBLESHOOTING TECHNIQUES heading in Topic 8 (Basic Troubleshooting).

Calibration Log « Tab used to access the Calibration Log display.

» Maintains the most recent 50 entries displaying the most recent log entry at the top of
the log and the oldest entry at the bottom of the log.

 Rollover is first in, first out when the 515t entry is added.

« Additional information about calibration and the Calibration Log is located in Topic 5
(Calibration).

Maintenance Log  Tab used to access the Maintenance display.

« Maintains the most recent 100 entries displaying the most recent log entry at the top of
the log and the oldest entry at the bottom of the log.

 Rollover is first in, first out when the 101st entry is added.

« Additional information about preventive maintenance and the Maintenance Log is located
under the PREVENTIVE MAINTENANCE heading in Topic 8 (Basic Troubleshooting).

Service Log « Tab used to access the Service Log display.

» Must use the Service Password to access.

 Function is similar to that of the Maintenance Log.

 Used by your Beckman Coulter Service Representative to maintain a record of the service
performed on ACeT 5diff CP hematology analyzer in your laboratory.

» Maintains the most recent 100 entries displaying the most recent log entry at the top of
the log and the oldest entry at the bottom of the log.

 Rollover is first in, first out when the 101st entry is added.
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GETTING TO KNOW YOUR INSTRUMENT
WORKSTATION

Tab Name

Purpose

Quality Assurance

« When this tab is selected, the display provides access to various quality assurance
techniques via the tabs at the bottom of the window.

Controls

« Displays recent runs (up to five) for the selected file and designated shift unless zero

(24 hour shift) is selected. If zero is designated for the shift, the most recent runs (up to

five) for the selected file are displayed. Most recent run is displayed at the bottom.

« Shift times are configured by the individual laboratory during set up.
« Control source may be commercial or patient.
« Control types may be CBC or CBG/DIFF.
« Control levels may be Low, Normal, or High.
» Up to three thumbnail graphs are displayed at a time.

» Display is determined via selection of the mini-tab.

» Up to the last 10 data points are displayed.

» Runs are plotted right to left with the last included entry on the right.

» Data points are not displayed for any control run excluded from the control file.
« Additional control information is located in Topic 4 (Quality Assurance).

Reproducibility

 Tab used to access the Reproducibility display.

 Study may be done using the GBC or CBG/DIFF panel.

« Reproducibility studies are done to check the instrument precision.

« Precision is the ability to obtain the same results, time after time, on the same sample.
« Reproducibility, precision, and repeatability are synonymous terms.

« Additional reproducibility information is located in Topic 4 (Quality Assurance) and
Topic 8 (Basic Troubleshooting).

Calibration

« Tab used to access the Calibration display.
« Calibration is needed to establish the accuracy of the instrument.
 Accuracy is how close a test result is to the true value.

« Calibration is performed using a special reference material such as COULTER® ACeT™
5diff Cal calibrator.

« Additional calibration information is located in Topic 5 (Calibration).

|QAP

« Tab is used to access the IQAP download screen

« Refer to the Help System or Instructions For Use manual for the IQAP download
procedure

PN 4277205BA
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GETTING TO KNOW YOUR INSTRUMENT

WORKSTATION
Tab Name Purpose
XM  Tab used to access the XM display.
« XM tab is only visible if the XM option is On. Default setting is Off.
(Setup » Quality Assurance » Enter Password » General tab » XM Options)
o XM analysis is:
» An on going method of monitoring your automated hematology analyzer.
»Similar to X, analysis in that it uses a weighted moving average of patient sample
results.
» An optional form of quality control that your laboratory may or may not choose to use.
« If your laboratory decides to use the XM option, you may choose to monitor either three
parameters (MCV, MCH, and MCHC) or nine parameters (WBC, RBC, Hgh, Hct, MCV,
MCH, MCHC, RDW, and PIt).
 Laboratory must establish their own mean values.
« Additional information about the XM option is located in Topic 4 (Quality Assurance).
Results « When this tab is selected, the Result List appears.
« Result List is a sortable listing of processed samples in the current active archive.
« To view the Detailed Results, first highlight the desired patient then click @ the
Results/List icon.
« |fthe Detailed Results view is currently displayed and the operator clicks the Results/ List
icon, the Result List reappears.
 There are two tabs at the bottom of the window. Results and Search Results.
« Detailed information concerning how parameter results are generated and reviewed is
located in Topic 7 (Data Review).
Results « Select this tab for routine Result List activities.

Search Results

Select this tab to search for results based on your choice of criteria:
» Sample ID
» Patient ID
» Patient Name

Can search either current or closed archives

Run

When this tab is selected, the Run window appears.

Displays the results for the last sample analyzed (blank, calibration, reproducibility,
control, or patient sample).

Displays the next sample ID to be processed if samples are preassigned in the Worklist
or autonumbering is ON.

A Sample ID must be entered prior to processing a sample.

Detailed information concerning the processing of patient samples is located in Topic 6
(Sample Analysis).

Worklist

When this tab is selected, the Worklist appears. A worklist is a list of work to be done.
This worklist identifies the patient samples that need to be processed.

Entries may be received (via download) from a host computer or individually added by
the operator.

Detailed information concerning the Worklist and its usage is located in Topic 6 (Sample
Analysis).

12
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Other Navigation Tools
* Menu bar allows access to pull-down menus

Ac-T bdiff
File Cwclez Diagnostics Setup Help

|

Mew archive Startup

Operator | Patients @ LContents

Open archive Shutdown Service Buality Assurance Print Manual
Cl hi System

LCloze archive S_l,.ls.tem. Beset Cycle =L About
Backup databaze ElAEE

EETERL Backflush

Hestore databaze

ilete Bifibse Extended Cleaning

Logout

* Tool bar (may also be referred to as Icon bar)

Shel B M| -pd 08 §] S W 29 |

» Text buttons access secondary windows

Chanhge Heagentl
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Primary Windows versus Secondary Windows

Ac-T 5diff

v

Text button

File Cycles Diagnostics Setup Help
ENES A PRz BN la s
EEN L HEE G ER D N
Worklist | Run | Resuis | QualityAssurance | Analyzerflogs |
~Reagent Statu
Bl [RINSE [Fi< [HGB LvsE [WBCLYSE [DILUENT
Lot Number: |nmnzcm441 |I]I]4DZEDDDDE |DDZDZADDE48 |DD4D?ED]2E4 |nn302000n35
DpenedDater | |03/27/2001 [o372772001 [03r2772001 [3rz772001 [03/2772001
Eupitaion Date: | |03/30/2001 [04720/2001 [10/05/2001 [08/23720m [08/11/2001
= IAdmin |Admin IAdmm |Admin IAdmin
Fill Levet: 97% - ‘ a7 ’ 0%
Change &ll Reagents I Change Haagen.'
Startup System
Background WBC RBC HGB LT Analyzer -
Results Connection 7
Status
{ Heagents Reagentlog J_ Startup Log ErrorLog J_Calibration Loql Maintenance anl Service Log |
| [ [ | 03/27/200 161708

DILUENT
Secondary
window — Lot Number: [ou302000243
(Or bOX) Opened Date:
Expiration Date: |1 1412/200 v I

e Menu bar and tool bar (icon bar) are:

» Active while primary window displayed
— Options can be selected

— Icons that appear in color are active

Replace a Reagent

Primary windows are those accessed by clicking on a tab; any other window (usually
accessed by clicking on a text button) is a secondary window (or box)

— Primary window

©| X|

» Not active while a secondary window or box is displayed

— Options cannot be selected

— Icons that appear in color are not active

— Must click either @ (to save and exit) or x (to cancel and exit)
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SOFTWARE MENU TREE
File Cycles Diagnostics Setup Help
New archive Startup Operator Patients @ Contents
Open archive Shutdown Hardware Systems (Administrator Password) Print Manual
Close archive System Reset Cycle Reset Hardware Flagging and Messaging About
Backup database Mini Prime Motors Parameters (including RUQ)
Restore database | Backflush Valves Reports
Delete database Extended Cleaning Traverse Service Quality Assurance
Logout Position (Administrator Password)
Park Syringes General
Diluter Systems Calibration
Drain Baths Shifts
Rinse System
Cleaning Cycles (Administrator Password)
Prime Reagents General
Cycles == Date/Time
Service == Physician/Location
(Service Password) == Communication
LIS/HIS
Variable Format
= Printer
== Cycle Option
= Units
== Analyzer
= Config. Save/Restore
= |anguage

72050108
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SOFTWARE MENU TREE

Software Icons

* Icons depict executable functions

* Icon activity correlates with window function:

» Ificon active, it appears in color

» Ificon inactive, coloring is removed (greyed-out)

=l
=

il

EFEFEEF=E]

16

Print

Transmit

Delete

Find

Previous

Next

Add

Edit

Results / List

Validate

Rerun Sample

Load Sample

Startup

Shutdown

Logout or Exit

Help

Cancel

OK

Save

Restore Defaults

System State
(Double-click to quickly
access the Error Log)
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ONLINE HELP
Using the Online Help System on Your ACeT 5diff CP Hematology Analyzer

* Help system is an electronic version of the Instructions For Use manual that includes:
» Table of contents
» Index for finding information quickly
» Glossary of definitions

* Access online Help one of two ways:

» C(Click @ on the icon bar
or

» From Menu bar, select Help » Contents

Note: In the event that you cannot access the ACeT 5diff Cap Pierce Online Help System
from your instrument, contact your Beckman Coulter Representative.
* Three options available from the Help menu:
> Contents
Allows operator to search for information on specific system-related topics
> Print Manual

Allows operator to print the Instructions For Use manual in whole or in part (prints
with the same page breaks and document structure as printed document available
by order)

» About

Shows the software version currently installed on Workstation

Using Your ACeT 5diff CP Hematology Analyzer Operator Manuals CD-ROM
* An Operator Manuals CD-ROM was shipped with your instrument

¢ CD-ROM contains:

» COULTER® ACeT™ 5diff CP Hematology Analyzer Instructions For Use manual
(.PDF and .HTML files)

» COULTER® ACeT™ 5diff CP Hematology Analyzer Host Transmission
Specification, English (.PDF file)

» Adobe® Acrobat® Reader 4.0 (or higher) for reading the .PDF files

* Allows you to access the same information you can access through the Help menu on the
ACeT 5diff CP Workstation from any compatible personal or office desktop computer
that meets the requirements listed in the Minimum System Requirements for Using the
CD-ROM

ATTENTION: The Workstation PC that is part of your laboratory’s ACeT 5diff CP system is
configured to work only with the ACeT 5diff CP system and is not intended for other PC
operations, such as running other software applications, playing computer games, or
accessing the Internet. This means that you cannot read the contents of this CD-ROM on
the ACeT 5diff CP Workstation. You must use a different personal or office desktop
computer.
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Minimum System Requirements for Using the CD-ROM
* Do not use the CD-ROM on your ACeT 5diff CP Workstation
* You can use this CD-ROM on any PC that meets these minimum requirements:
»  Microsoft® Internet Explorer 4.0 (or higher) for displaying the HTML files
» An IBM® PC or compatible with a CD-ROM drive

» A Microsoft® operating system: Windows® 95, Windows 98, Windows 2000,
Windows ME, or Windows NT® 4.0 (or higher)

» 32 MBRAM
» Display settings: 800 x 600 and 256 colors

Launching the Manual from the CD-ROM
* CD-ROM contents do not automatically install on your PC

* Can view or print direct from the CD-ROM

» View option is an .HTML file that looks and responds the same as your ACeT 5diff
CP Workstation online Help system

» Print option is a .PDF file that prints the Instructions For Use manual in whole or in
part (prints with the same page breaks and document structure as the printed
document that is available by order)

* Contact your Beckman Coulter Representative if you cannot access the Instructions For
Use manual on the CD-ROM

Viewing the Instructions For Use Manual

* Viewing the Instructions For Use manual using your ACeT 5diff CP online Help system
or the View file on the CD-ROM is the same

* Both are . HTML files

*  When the Help window is accessed, operator may:
» Move or resize the window
» Open or close topic panes

* Screen that appears when an operator
» From the Menu bar, selects Help » Contents

or

» From the icon bar, clicks E@
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ONLINE HELP

Help Screen
* Screen that appears when Contents is selected from Help menu:

Hon\e | Contents | Index | lllustrations | Tables | Search | 2 | /o

Closes the topics pane when selected

Displays the menu options for the online Help
Allows an operator to navigate through the Help
Displays the contents of the selected Help topic

Displays the topics (contents, illustrations, or tables)

© ©®© 06 © &0 0O

Displays the Index letters (only when Index is selected)
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General Instructions for Using Help
* Help window is divided into three panes: Banner, Topics, and Content

Home | Contents | Index | Illustrations | Tables | Search | 7 |
Banner BECKMAN ®
COULTER... @ ®
44
N— — S, -
T 7
Topics Content

* Banner pane contains the Help menu and navigational arrows
* Topics pane displays different lists based on the Help menu options selected
* Content pane displays information on the selected topic

* Easiest way to find specific information is to use the contents or index lists
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Help Menu Options

Home * Displays title screen

Contents * Displays list of top-level subject headings
* Select a top-level heading to expand and view its sub-topic headings

* Select a sub-heading to display information about that topic in the
Content pane

Index * Displays list of index entries sorted alphabetically

* From the box that appears, select a letter or symbol to display an
alphabetically sorted list of index entries that start with that
letter / symbol

* Scroll through the topics and select the number after an index entry
to view that topic

lllustrations * Displays list of illustrations from all topics
e Scroll through the list and select the illustration you want to view
Tables * Displays list of tables from all topics
* Scroll through the list and select the table you want to view
Search * Used to locate specific words
* Click inside the Search for: text box and type one or more words
separated by spaces; do not use punctuation marks
* Select OK button to begin search through the Help topics
*  When search complete, lists all the topics that contain those specific
words
* Scroll through the list and select the topic you want to view
? * Allows operator to view Help file for using Help
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Navigational Aids
e Click '#;:' to display the previous topic in the sequence
* Click 'i;x' to display the next topic in the sequence
* Click '\-'E'..:I to display the previous link

e Click 4 4 4 4 4 4 toslide the Topics pane off the screen
» Selecting an option from the Help menu slides Topics pane back into the screen
» Icon may not be visible in some browsers

» Alternative method to reduce/enlarge the width of the Topics pane is to use slider
bar located between the panes

29 PN 4277205BA



GETTING TO KNOW YOUR INSTRUMENT 1
ONLINE HELP

» ONLINE HELP SYSTEM QUICK REFERENCE

Accessing Online Help

ATTENTION: In the event that you cannot access the ACeT 5diff Cap Pierce Online Help System,
contact your Beckman Coulter Representative.

Using the COULTER® ACeT™ 5diff CP Workstation

* Click @ to display the Help screen

Using Your COULTER ACeT 5diff CP Hematology Analyzer Operator Manuals CD-ROM
ATTENTION: Do not use this CD-ROM on your ACeT 5diff CP Workstation.

1 Turn on your personal or office desktop PC and allow it to boot up.
Refer to the PC manual for instructions, as needed.

2 Insert the CD-ROM into the CD-ROM drive.
* If Autorun is enabled on your PC, the PC automatically launches the program.
* If Autorun is disabled on your PC, do steps 3 through 4.
3  Locate the Start. HTM file (CD-ROM drive letter:\Start. HTM):
* Click the Windows Start button.
*  Click Run.
* Click Browse and locate the CD-ROM drive.
* Double-click the CD-ROM drive letter (usually D or E).

4  Double-click Start. HTM to launch the program.

9  Click For Viewing (or For Printing) as desired.

Moving or Resizing the Help Screen

1 Access online Help.

2  To move the Help window:
* Click the title bar and hold down the left mouse button.
*  Move the mouse to drag the window to a new location.

¢ Release the mouse button when the window is located as desired.

3  To resize the Help window:
* Move the cursor over the window border until the arrows appear.
* Click the left mouse button and drag the border to resize the window.

¢ Release the mouse button when the window is the desired size.

PN 4277205BA 23



GETTING TO KNOW YOUR INSTRUMENT
ONLINE HELP

24

Opening / Closing the Topics Pane

1

Access online Help.

2 Click the arrows to close the topics pane.

3  Click Contents, Index, Illustrations, Tables, or Search to re-open the topics pane.

Viewing Help Topics

1

Access online Help.

2  Navigate through Help as needed:

* Click Contents to browse through topics by heading.
e (Click Index to see a list of index entries.

* (Click Tables to see a list of tables.

*  Click lllustrations to see a list of illustrations.

* Click Search to search for words or phrases.

* Click Home to return to main Help screen.
Move through topics as needed:

e Click ™) 1o display the previous topic in the sequence.

. Click ™ 1o display the next topic in the sequence.
* Click '-'!':-I to display the previous link.
View referenced or related topics:
* Click the highlighted words in a topic body to link directly to the referenced topic.
* (lick a word in the highlighted hierarchy — at the top of the topic — to change topic
levels. The current topic’s position also appears in the hierarchy.

To view information not visible in the Help window, scroll through the window by using
the scroll bar.

Using the Contents Option

1

2
3
4
9

Access online Help.

Click Contents to browse through topics by heading.

Select a top-level heading to expand and view its sub-topic headings.

Select a sub-heading to display information about that topic in the Content pane.

Use the scroll bar to scroll through the information.
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Using the Index Option

1 Access online Help.

Click Index.

2
3  Click the letter corresponding with the list of index entries you want to see.
4  Scroll through the topics as needed.

9

Click a number after the index entry to display information about that topic.

Using the Tables Option

1 Access online Help.

2 Click Tables to display the list of tables.

3 Scroll through the tables to locate the table you want to view.
4

Click the table to display it on the screen.

Using the lllustrations Option
1 Access online Help.
Click Illustrations to display the list of illustrations.

2
3  Scroll through the illustrations to locate the table you want to view.
4

Click the illustration to display it on the screen.

Using the Search Option

1 Access online Help.

2 Click Search to display the search field.
3  Type the word you want to locate.
4

Click Search. If the word you typed appears in the document, each instance where it
appears will be shown.
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Printing Operator Manuals

To Print the Instructions For Use Manual from the Workstation

Note: Prints with the same page breaks and document structure as the printed document that
is available by order.

1

2
3
4

At the Menu bar, click Help » Contents » Print Manual.
Click Print.
Define what pages you want to print. You can print all or part of the document.

Follow the instructions on the screen.

To Print Operator Manuals from the CD-ROM

Note: Prints with the same page breaks and document structure as the printed document that
is available by order.

ATTENTION: Do not use this CD-ROM on your ACeT 5diff CP Workstation.

1 Turn on your personal or office desktop PC and allow it to boot up.
Refer to the PC manual for instructions, as needed.
2  Insert the CD-ROM into the CD-ROM drive.
* If Autorun is enabled on your PC, the PC automatically launches the program.
(The contents of this CD-ROM are not installed on your PC.)
e If Autorun is disabled on your PC, do steps 3 through 4.
3  Locate the Start. HTM file (CD-ROM drive letter:\Start. HTM):
* Click the Windows Start button.
*  Click Run.
* Click Browse and locate the CD-ROM drive.
* Double-click the CD-ROM drive letter (usually D or E).
4 Double-click Start. HTM to launch the Home page.
9  Select a language.
6  Under the name of the manual you wish to print, click For Printing.
1  Define what pages you want to print. You can print all or part of the document.
8 TFollow the instructions on the screen.
> >
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ANALYZER

Controls and Indicators

Power On/Off
rocker switch

Red LED —

Green LED

Cap-pierce door Tube holder

WARNING Risk of operator injury when covers and doors are not closed and secured in place before you
operate the instrument. Ensure all covers and doors are closed and secured before operating the instrument.

POWER On/0ff Rocker Switch
*  Main POWER On/Off switch located on the left side of the Analyzer

* Recommend the Main Power be left on at all times to increase the stability of electronic
components

Red and Green LEDs (Light Emitting Diodes)

* Used to quickly identify instrument status

e If either light is glowing, Main Power is ON; if neither light is glowing, analyzer power is
OFF

*  When green LED is glowing, instrument is ready for operation

*  When red LED is glowing, instrument is busy or in a standby state
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Tube Holders

* Two tube holders are available for accommodating various size specimen tubes,
microcollection devices, and control vials

* Identifying characteristics
» Tube holder #1 has one dot in its center; tube holder #2 has two dots

» Sample positions within the tube holder are notched to correlate with the number
assigned to that position; for example, sample position 3 has three notches next to
its tube slot

» Slot numbering sequence in tube holder #1 is counterclockwise; slot numbering
sequence in tube holder #2 is clockwise

Tube Holder #1 Slot Designations for Tube Holder #1
@ Position 1

/ ’\ @ Position 2
© Position 3

O Position 4

Note: Tube Holder #1 has one dot in
the center.

9/
/

Tube Holder #2 Slot Designations for Tube Holder #2
@ Position 1
\ @  Position 2
© Position 3
) @ Position 4

Note: Tube Holder #2 has two dots in
the center.

0/

* Tube holders are interchangeable
» To remove, rotate and pull the holder off the metal shaft

» To exchange, slide the desired holder over the metal shaft then rotate the tube
holder until it is properly seated
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Approved Collection Devices and Control Vials

* Each specimen tube, microcollection device, and control vial approved for use with these
tube holders have an assigned slot in the tube holder

Tube Holder #1 Tube Holder #2

7653099A

* Detailed list of whole-blood collection devices and control vials approved for use with
these holders is available in the Instructions For Use manual, Appendix D

» Lists whole-blood collection devices and control vials compatible with the
cap-pierce mechanism used on the ACeT 5diff CP hematology analyzer

» List is not a recommendation for using one tube in preference to another nor does it
guarantee the acceptability of the specimen tube to produce quality results

* Summarized tube list is available in the Sample Analysis section of this training guide

e For those evacuated collection tubes, microcollection devices, and calibrator vials
without pierceable stoppers or caps:

» Stopper or cap must be removed prior to sampling (open-vial sampling)

» Open-vial sampling increases the operator’s exposure to the whole-blood
specimen which is considered a biohazardous material
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Operation

Single Point Aspiration System
* Means there is only one pierce position

* Specimen tube vial must be in the pierce position for the sample to be aspirated
* If the specimen tube is in any other slot:
» Cap-pierce door may not close

» If cap-pierce door does close (which initiates the cycle), analyzer aspirates air and
results reflect analysis of reagents only (background results)

Pierce Position
* Single-point of aspiration is the 12 o’clock position

* Holder can be manually rotated (clockwise or counterclockwise as needed) to position
the desired tube slot in the pierce position

* An open or closed collection device or vial may be placed in the tube slot
* Sampling probe pierces a closed-vial specimen tube before aspirating the sample
* May run specimen tubes with or without bar-code labels

* If a bar-code label is used, barcode must be scanned before placing the specimen tube in
the tube holder

Cap Pierce Door
* Closing the door initiates a cycle

*  When the door is pushed into its closed position:

» Red and green LEDs alternately flash approximately six seconds then the red LED
glows steady the remainder of the cycle

» Four switches inside the cap-pierce mechanism sense the indentations on the side of
the tube holder to determine which tube holder is inserted and the size of the tube
slot located in the pierce (aspirate) position (Analyzer’s computer then knows the
downward movement needed to completely submerge the sampling probe’s tip in
the specimen)

» Door opens automatically when the aspiration is complete

* If the door is closed and the Analyzer is not cycling, click Iil to open the door
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Panels
* Samples are processed as either a CBC/DIFF or CBC panel

CBC/DIFF Panel
* Default panel

* Aspirates 53 pL of sample from the specimen tube (or vial) via the sampling probe
* Reports 20 parameters

» CBC parameters: WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt,

» and MPV

»  DIFF parameters: NE%, NE#, LY%, LY#, MO%, MO#, EO%, EO#, BA%, and BA#
* If RUO (Research Use Only) is enabled, six additional parameters are reported

» Qualitative parameters that must not be used for the purpose of diagnosis

» RUO parameters include Pct, PDW, IMM%, IMM#, ATL%, and ATL#

CBC Panel

* Must be selected before the specimen is processed
* Aspirates 30 pL of sample from the specimen tube (or vial) via the sampling probe
* Reports 10 CBC parameters only
» WBC, RBC, Hgb, Het, MCV, MCH, MCHC, RDW, Plt, and MPV
* If RUO (Research Use Only) is enabled, two additional parameters are reported
» Qualitative parameters that must not be used for the purpose of diagnosis
» RUO parameters include Pct and PDW

* Final results are calculated automatically
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REAGENTS

To obtain the optimum performance characteristics stated in the Instructions For Use
manual, use the following reagents on your ACeT 5diff CP hematology analyzer.

Reagent Label Color | Function CBC | DIFF

ACeT 5diff Diluent Purple « |sotonic solution that dilutes the sample v v

« Stabilizes cell membranes

¢ Conducts aperture current

¢ Provides the sheath medium for focused flow
through the flow cell

¢ Rinses analyzer components after analysis

« (ontains less than 0.1% sodium azide which
may cause an explosion if not properly

flushed down the drain with large volumes of
water

AGeT 5diff Hgb Lyse Orange  Disrupts erythrocytes (lysis) v

¢ Frees hemoglobin

» Reduces cellular debris

« Converts hemoglobin to a stable
cyanide-containing pigment

« Contains potassium cyanide, a quarternary
ammonium salt; special instructions are
provided for proper disposal

ACeT 5diff WBC Lyse | Yellow « Dilutes the sample for the total WBC count v v

« Specifically differentiates between the
basophils and other white blood cells for the
basophil percentage analysis

e Lyses red blood cells

¢ Reduces cellular debris

ACeT 5diff Fix Green ¢ Lyses red blood cells v

 Preserves the white blood cells in their native
state

« Stains the granules of eosinophils,
neutrophils, and monocytes

¢ Provides the dilution used to differentiate the
white blood cell subpopulations using the
absorbance cytochemistry technology

ACeT 5diff Rinse Blue  Cleans and rinses the diluter parts v v

¢ Prevents protein buildup

¢ Eliminates routine aperture bleaching
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Reagent Container Locations

Accessing the Reagent Compartment

7205015A

* Pushing on the reagent compartment door allows access to on-board reagent bottles
From left to right:
» ACeT 5diff Rinse reagent bottle
» ACeT 5diff Fix reagent bottle
» ACeT 5diff WBC Lyse reagent bottle
» ACeT 5diff Hgb Lyse reagent bottle
* 20 liter ACeT 5diff Diluent reagent container generally sits on floor below the instrument

* If a waste container is being used, this container tends to be placed near the diluent
container

Storage and Handling

* Always handle the reagents as instructed in the Instructions For Use manual
e All reagents should be stored and used at an ambient temperature of 18°C to 25°C

* Discard any reagent that has been or that you suspect has been frozen.

Before Using a Reagent

* Gently mix by inversion
* Allow sufficient time for any microbubbles to dissipate

Note: Microbubbles may increase the background count and affect parameter results.
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When Changing a Reagent

* Do not pool reagents; pouring reagents from one container to another may contaminate
the new reagent container which will cause unacceptable background results, especially
for platelets

* Always make sure the label on the stopper assembly tubing correlates with the reagent
name on the new container

*  When transferring the stopper assembly from the old container to the new container, do
not touch the pickup tubes or lay the assembly on an uncovered tabletop or the floor

» If the pickup tube portion of a stopper assembly is contaminated during transfer,
bacterial and/or fungal growth may occur inside the reagent container

» Contamination may cause unacceptable background results especially for platelets

» If a pickup tube touches you or anything outside the container, flood the pickup
tube with distilled water then wipe it with a lint-free tissue before inserting it in the
new reagent container

* Always correlate the position of the color-coded reagent bottle with the color-coded label
attached to the rear of the reagent compartment

IMPORTANT Risk of misleading results.
If a reagent is connected in the wrong
position, contamination of the other
reagents occurs which means all reagents
must then be replaced. When replacing
on-board reagents, always correlate the
position of the color-coded reagent bottle
with the color-coded label attached to the
rear of the reagent compartment and with
the reagent-name label on the reagent
pickup tubing.

Reagent Lot Numbers

* Reagent lot numbers contain 11 alphanumeric characters consisting of five numeric
digits, an alphabet letter, and five more numeric digits

For example, lot number for ACeT 5diff Diluent might be 00102D00002

* If an operator tries to enter an invalid lot number, a message appears
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REAGENTS

Reagent Log

* Click on Analyzer / Logs tab » Reagent Log tab to view the log

* Maintains most recent 50 entries displaying the most recent log entry at the top of the
log and the oldest entry at the bottom of the log

* Rollover is first in, first out when the 51st entry is added

* Log contains the following information fields

Note: It is necessary to scroll right to see some of these fields.

Information Fields

Field

Date/Time
Reagent

Lot Number

Opened Date

Opr

Expiration Date

Comment

36

Function

Displays when the reagent change was made
Displays operator entry which identifies the reagent that was changed

Displays operator entry that identifies the specific reagent container
connected to the Analyzer

Displays the date the reagent in that container began to be used for
sample analysis

Displays the User name logon information in the Workstation when
the reagent was changed

* Displays the new reagent container’s expiration date as manually
selected by the operator from a drop-down calendar

e If operator does not select a date, current date is displayed

Displays any comments entered by the operator changing the reagent:

e Optional entry that provides an opportunity for the operator to
type a personal observation or appraisal

e Operator may use the Add Comments button to access the Add
Comments box, as desired

* If the Prompt User For Comments check box is checked (¥), the
Add Comments box pops up automatically during the entry
process

 If the Prompt User For Comments check box is checked (v'),
the Add Comments box pops up automatically to prompt the
operator to enter a comment

Note: When Add Comments box is displayed, operator cannot
access any other window until they either:

» Enter a comment then click '1? )| to save and exit the box

or

» Click x to exit the box without entering a comment
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Before Disposing of a Reagent or Its Container
* Always dispose of reagents and containers according to your laboratory’s guidelines

* If disposing expired ACeT 5diff Hgb Lyse reagent, always follow the instructions for
eliminating cyanides before discarding the expired reagent according to your laboratory’s
guidelines

Note: See the Instructions For Use manual for specific instructions.

Before Disposing of a Waste Container

* If waste is being collected in a container, it must always be considered a biohazard and
therefore, must be treated as a biohazard

* To disinfect 20 liters of waste liquid:

» 250 mL of sodium hypochlorite solution (12% available chlorine) should either be
placed in the empty container before it is connected to the instrument or before
moving a full waste container to another location

» Sodium hypochlorite solution with 12% available chlorine may be ordered from a
chemical company or swimming pool chlorine is an acceptable substitute

» 500 mL of a good quality household bleach may also be used

Note: Since household bleach only has about 6% available chlorine, the volume
must be doubled.

* If the waste container is to be capped:

» Always follow the instructions for neutralizing the waste before capping the
container for disposal according to your laboratory’s guidelines

» Non-neutralized waste may produce gas which can build up pressure in a capped
container

» Neutralize waste after removing the waste container but before capping the
container for disposal

Note: See the replacement procedure in Chapter 11 of the Instructions For Use manual
or the Replacing a Waste Container Summary for specific instructions.
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» CHANGING REAGENT SUMMARY

Note: If all reagents are being changed, see Chapter 11 of the Instructions For Use manual.

38

1 Verify a New Reagent Container is Needed

Display the Reagents window by choosing Analyzer/Logs tab » Reagents tab.

Check reagent levels to determine which reagent triggered the REAGENT LOW LEVEL
message.

» Check all levels because more than one may be low.

» Obtain a new unopened container of each reagent that according to your
laboratory’s protocol requires the reagent to be changed.

ON &

2 Replace the Reagent Container

Open the new reagent container.

Remove the stopper assembly from the old container then transfer it directly to the new
container and tighten to ensure an adequate seal.

Note: If the lower part of the assembly touches you or anything outside the container,
flood that lower part of the assembly with distilled water then wipe it with a lint-free
tissue.

Put the cap from the new container onto the empty container.

Properly dispose of the empty bottle according to your laboratory’s protocol.

3 Record the New Reagent Information

At the Reagents window, click Change Reagent.

Choose the reagent that was changed from the drop-down menu.

Type the new lot number.

Note: Today’s date automatically appears in the Opened Date box.

Choose the Expiration Date (or open container stability) from the drop-down calendar.

» For all reagents except ACeT™ 5diff Hgb Lyse reagent, select the date printed on the
reagent container.

» For the ACeT 5diff Hgb Lyse reagent which has a 90 day open container stability,
select the date that is 90 days from today.

Click @ J| to save the information and return to the Reagents window.

4 Wait for the Reagent Lines to Prime

> >

System automatically primes the reagent and updates the level indicator.
Note: Reagent level may not be displayed at 100% due to this priming.

Once priming is complete, continue normal operation.
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» REPLACING A WASTE CONTAINER SUMMARY

Note: If the waste container is not full and the waste alarm is chirping (beeping) at regular
intervals, replace the 9 Volt alkaline battery in the waste sensor alarm.

1 Power Off the System

At the Workstation

* C(lick E )

* Select Quit Application.

*  Press (Enter) or click @ .

*  Wait while the Workstation closes its program.

*  When the Begin Logon box appears, press + (At) + simultaneously.
* Click Shut Down at the Logon Information box.

* Select Shutdown then click OK at the Shutdown Computer box.

*  When the It is now safe to turn off your computer message appears, power the Workstation
computer off.

At the Analyzer

* Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located
at the base of the left side panel.

ON &

2 Replace the Waste Container
* Clearly mark or apply a waste label to an empty 20 L container.

* Using biohazardous precautions:
» Carefully remove the cap (with waste sensor attached) from the full waste container.

» Transfer the waste assembly directly to the empty waste container and tighten.

3 Neutralize and Disinfect the Waste Before Capping the Container
* For 20 liters of waste liquid, add the following to the waste container:

» 250 mL of sodium hypochlorite solution (if 12% available chlorine) or 500 mL of
sodium hypochlorite solution (if 6% available chlorine) to disinfect waste.

» 50 mL of 200 g/L sodium hydroxide solution to prevent gas from forming if the
container is being capped.

* Dispose of the biohazardous waste according to your laboratory’s protocol.
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4 Power Up the System

At the Analyzer

* Toggle the Power ON/OFF rocker switch ON (position —). This rocker switch is located
at the base of the left side panel.

*  Verify the red LED is glowing steady.

At the Workstation
* Power ON the Workstation computer.

*  Wait while the computer performs its internal checks.

*  When the Begin Logon box appears, press + (At) + simultaneously.
* Type the User name and Password then press or click OK to log on.

* Type your 3-character (alphanumeric) Operator ID.

*  Press (Enter] or click @ .

*  Wait for the Reagents window to appear.
*  Verify the background behind the “lightening bolt” is green.

Note: Analyzer and Workstation should begin communicating within 30 seconds. In the
upper right corner, the right circle should also be green.

5 Prepare the System for Processing Samples
* If the Automatic Startup function is enabled:

» Startup routine was automatically activated when the power was toggled back ON.

»  Cycle in progress : Startup status bar provides a visual display of how close the
routine is to completion.

» When complete, resume normal operation.
e If the Automatic Startup function is not enabled:
» At the Menu bar, select Cycles » Mini Prime.

» Cycle in progress : Mini Prime status bar provides a visual display of how close the
routine is to completion.

» When complete, resume normal operation.

> >
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STARTUP / SHUTDOWN

OBJECTIVES

When the subject is complete, you will be able to . . .

Startup

* Initiate a Startup.
* Recognize an out-of-limit result on the Reagents window.
* Identify the Reagent Status, Startup, and System areas of the Reagent window.
* Cite the two ways to monitor Analyzer connection status.
* Access the Startup Log.
* Add a comment to the Startup Log.
* Explain how to handle an unacceptable background result.
Mini Prime
* Initiate a Mini Prime.
* State the difference between a Startup and a Mini Prime.

* Identify when to do a Startup versus when to do a Mini Prime.

Autoclean Function
* Explain the purpose for the Autoclean function.

* Set up the Autoclean function based on your laboratory’s desired protocol.

Shutdown

* [Initiate a Shutdown.
* State how often a Shutdown must be performed.

* State the minimum time the ACeT 5diff Rinse reagent should stay in the instrument
while in Shutdown.
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STARTUP

e Startup must be completed before running patient specimens or controls anytime
ACeT 5diff Rinse reagent has replaced diluent in the aperture baths

» Startup routine is a sequence of automated Analyzer cycles designed to exchange the
ACeT 5diff Rinse reagent left in the diluter after the Shutdown routine with ACeT 5diff
Diluent reagent

* Also primes the ACeT 5diff Hgb Lyse, ACeT 5diff WBC Lyse, and ACeT 5diff Fix reagent
lines to prepare the Analyzer for sample analysis

* Checks for sufficient reagent volume based on the Daily Workload statistics entered under
Setup » System » Cycle Option tab

» Can enter the estimated number of CBC/DIFF and CBC cycles run per day
» Default value for CBC/DIFF Runs Per Day is 40; for CBC Runs Per Day is 10

» Cycle estimates are used to determine if sufficient reagent is available to complete
the daily workload; check is done during Startup

» If reagent volume is insufficient to complete the estimated daily workload, the
message Reagent(s) Low. Insufficient Reagents To Complete Daily Workload. appears

* Performs a background count and check at the end of the Startup routine and displays
the results as either Passed or Failed across the bottom of the Reagents window

Note: Background count is an analysis cycle on reagents without the blood sample.

* Cycle in progress status bar at the base of the Reagents window provides a visual display
of how close the routine is to completion

e If Autoprint is enabled, results automatically print when the routine is complete

* Perform quality control checks before running patient specimens according to your
laboratory protocol

Two Ways to Initiate a Startup

Automatic

e If automatic startup is selected under System Setup and the system is powered off, when
system (Analyzer then Workstation) is powered back on, software automatically
performs the Startup routine

* Recommended setting
* Default setting when the instrument is installed
* To set up this automatic feature (if it is disabled):

» At the Menu bar, click Setup » System

» Type Administrator password then press or click @

» Click Cycle Option tab
» At the Startup box, click the empty box next to Automatic (¥" appears in box)

» C(Click @ to save the selection and exit the window

On Demand
2 I Ilf . ., . .
* At the icon bar, click Q to initiate a Startup routine
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STARTUP SCREENS

Reagents Window

ot ]

File Cucles Diagnostics Setup  Help

_IEjJJLBIjJJJZQQQLJdeEEJJ o0

Worklist | Fun | Fesults | Cuality Assurance |
~Feagent Staty

Reagent [RINSE [Fix |HGE LvsE |WEC LYSE |DILUENT

Lot Number: |01 02C01 442 [nn402E 00005 0202400846 [0402601264 0302000036

OpenedDate: | |03/14/2001 0341 472001 {031 4pz001 031 472001 0371 472001

Espiration Date: | | 15/16/2001 n4rz0/2001 |06 4r20m |n8s23/2001 |n8/11/2001

- Admin [Admin Admin [Adrmin Ascmin

Change All Reagents | LChange Heagentl
—Startup System
Background WEC RBC HEE FLT Analyzer
Results IPassed IPassed IPassed IPassed Cannection
Statusz

Feagents I FeagentLog I Startup Log I Error Log ICaIibratiDn LDgI MaintenanceLDgl Service Log I

| | | [ 0347200 133233

* Also referred to as the Analyzer / Logs window

* Displays system status in three boxes:
» Reagent Status box provides an overview of the status of each reagent
» Startup box shows the background status of the last completed Startup

» System box provides a visual indication as to whether or not the Analyzer and
Workstation are communicating
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Reagent Status Box

Field Information
Reagent Displays the reagent name
Lot Number Displays operator entry that identifies the specific reagent container

connected to the Analyzer

Opened Date Displays the date the reagent in that container began to be used for
sample analysis

Expiration Date Displays the new reagent container’s expiration date as manually
selected by the operator from a drop-down calendar; if operator does
not select a date, current date is displayed

Operator Displays the User name logon information in the Workstation when
the reagent was changed
Fill Level Displays the percentage of reagent still available in the container
System Box
* Provides a visual of the communication connection status between the Analyzer and the
Workstation:

» If Analyzer and Workstation are communicating, background behind the
“lightening bolt” is green

» If Analyzer and Workstation are not communicating, background behind the
“lightening bolt” is red

* Connection status indicated in the System box must correlate with the connection status
indicated by the System State indicators (two circles) in the top right corner:

» If background behind the lightening bolt is green, the right circle must also be green
» If background behind the lightening bolt is red, the left circle must also be red

* Two tools for monitoring system connection status:
» Lightening bolt only appears on the Reagents window

» System State indicators (two circles) provide continuous system connection status
information, regardless of the window being displayed

Startup Box
* Displays background status of the last completed Startup

e Shows status on a Passed/Failed basis:

» “Passed” is displayed on a green background when a parameter is within the
internal background limit

» “Failed” is displayed on a red background when a parameter is outside the
acceptable internal background limit

* If background results are not within acceptable limits after the first background check:
» Analyzer automatically performs the background count up to two more times
» Only the status of the final background check is recorded

* Numeric background results may be reviewed by accessing the Startup Log

» Click on Analyzer / Logs tab » Startup Log tab
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Startup Log

botoan ]

File  Cucles Diagnostics Setup Help

S5 T aadiD] s O] §1 S WY 2 e

worklist | Pun | PResuis | Quality Assurance  AnalyzeriLogs |
—Startup
Date / Time WBC | RBC | HGB | PLT | Status |Comment
4 031442001 13:12:28 0o nao oo 1 Paszed  Ewerpthing OF
03/14/2001 09:55:03 0.0 0.00 0.a a Paszed
Rl I 2
Bk WEBC REC HGE FLT
Limits ID.3 ID.D3 ID.3 I?

[¥ Prompt User For Comments Add Comments

Eeanents I Beagentlog | tartup LUG' ErrorLog ICaIibratiun LDgI Idaintenance LDgI Service LDgI

| | [ [ D3/14/2001 13.37:48

* Maintains the most recent 50 entries displaying the most recent log entry at the top of
the log and the oldest entry at the bottom of the log

* Rollover is first in, first out when the 515t entry is added
* Allows an operator to review numeric background results

* Preset background limits, listed at the bottom of the window, aid in the evaluation of
results that fall outside these acceptable background limits
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Information Fields

Field Function
Date/Time Displays when the Startup was completed
WBC Displays the numeric white blood cell background result determined

during that Startup

RBC Displays the numeric red blood cell background result determined
during that Startup

HGB Displays the numeric hemoglobin background result determined
during that Startup

PLT Displays the numeric platelet background result determined during
that Startup
Status Startup background status indication:

* Field contains the word “Passed” backlighted in green when all
background results are within the designated Background Limits

* Field contains the word “Failed” backlighted in red when one or
more background results exceed the preset Background Limits
Comment Displays any comments entered by operator performing the Startup:

* Optional entry that provides an opportunity for the operator to
type a personal observation or appraisal

* Operator may use the Add Comments button to access the Add
Comments box, as desired; highlight the specific log entry before
clicking the Add Comments button

o If the Prompt User For Comments check box is checked (¥'), the
Add Comments box pops up automatically at the end of Startup,
after the background check is complete

Note: When Add Comments box is displayed, operator cannot
access any other window until they either:

» Enter a comment then click @ to save and exit the box

or

» Click x to exit the box without entering a comment
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Indications of a Failed Background
* On the Reagents window:

>

>

Message appears in the Startup box

When a parameter is outside the acceptable background limit, the word “Failed” is
displayed on a red background inside the parameter box

For example, if the WBC background exceeds the preset WBC background limit, the
word “Failed” (on a red background) appears inside the WBC box

* On the Startup Log:

>

>

Message appears in the Status field

“Failed” (on a red background) appears in the Status field when one or more
background results exceed the internal background limits

Note: If “Failed” displayed on a red background appears but all the background
results are acceptable, the instrument most likely made an entry on the Error Log.

Numeric results must be compared with the displayed background limits to
determine which parameter or parameters exceeded the acceptable preset limits

How to Handle a Failed Background

If One or More Background Results Failed
* C(Click E‘E Ii“- to redo Startup routine

* If Startup continues to fail, contact your Beckman Coulter Representative

If All Background Results Passed but the Startup Log Status Displays Failed

Note: When “Failed” is displayed on a red background in the Startup Log Status column but
all the background results are acceptable, the instrument probably made an entry on the Error

Log.

* Click the Startup Log tab and evaluate numeric results to verify all background results are
within acceptable background limits

Note: May also click the Run tab to view Startup results.

* If “Failed” displayed on a red background appears in Status column but all the
background results are acceptable:

>

>

>

Double-click either System State indicator to quickly access Error Log

Check last entry on the Error Log

Verity the date and time correlate with this incident

Locate message in the Error Messages table in the Operator’s Guide, Chapter 11
Complete suggested action

For more assistance, contact your Beckman Coulter Representative
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» STARTUP SUMMARY

Before starting this summary, verify both Workstation and Analyzer power are ON. If the
system is powered OFFE, do not use this summary. Use the System Power Up Summary instead.

1 Preliminary Checks
» If the Workstation screen is blank, power on the monitor.
*  Verify the green circle is displayed in the upper right corner.
* Check the waste container level.

» If the container needs to be replaced, change the container using the Replacing a
Waste Container Summary as a guide.

* Make sure the Printer is ready to print.
» If the paper supply is insufficient, add paper.
» Make sure the power is ON and ready to print.

2 Perform the Startup
* Click ﬁ to initiate a Startup routine.

* Monitor the Cycle in progress : Startup status bar, as desired.

* Hard copy of the results prints automatically if the Auto-Print function is enabled.

3 Review Results
*  Once the Startup routine is complete, verify Passed is displayed for each parameter.

» If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.

Note: If the Add Comments box automatically appears, click x to exit.

2 J |IJ' . .. .
» Click ﬂ to initiate another Startup routine.

» If the Startup continues to fail, contact your Beckman Coulter Representative.
* Save individual or log printout if required by your accreditation agency.
* Add comments as desired.

» If the Add Comments box appeared automatically, type in your personal observation
or appraisal.

» To access the Add Comments box, click Startup Log tab » Add Comments button then
type your personal observation or appraisal inside the box.

» Click @ to save your comments.

4 Perform Quality Control Checks

* Perform quality control checks before running patient specimens according to your
laboratory’s protocol.

> >
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MINI PRIME
* Primes reagent lines including ACeT 5diff Diluent, ACeT 5diff Hgb Lyse, ACeT 5diff
WBC Lyse, and ACT 5diff Fix

* Does not preform a background count
* To initiate a Mini Prime:
» At the Menu bar, select Cycles » Mini Prime

» Cycle in progress : Mini Prime status bar provides a visual display of how close the
routine is to completion

STARTUP VERSUS MINI PRIME

When to do a Startup versus When to do a Mini Prime
e Startup must be done before running patient samples or controls:
» After a Shutdown
» Anytime the Analyzer has set idle (uncycled) more than four hours
*  Mini Prime must be done before running patient samples or controls:

» Anytime the Analyzer has set idle (uncycled) more than two hours but less than
four hours

» Anytime the Analyzer is powered off then back on again

Note: If your laboratory selected Startup be done automatically when the Analyzer
is powered up, a Mini Prime is not necessary.
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AUTOCLEAN FUNCTION

* Analyzer automatically performs an Autoclean cycle after a specified number of analyses
* Default number of analyses is 75
* May select from 1 to 75 analyses based on your laboratory’s desired protocol
*  When the designated number of analyses is reached:
» ACeT 5diff Rinse reagent is delivered to the baths assembly
» Cycle takes approximately 2 minutes
* To change the frequency:
» At the Menu bar, click Setup » System

» Type Administrator password then press or click @

» Click Cycle Option tab

» At the Autoclean Frequency box, highlight the current number then type the
desired number of analyses between Autoclean routines

» Click @ to save the selection and exit the window

SHUTDOWN

* Shutdown is a sequence of automated Analyzer cycles designed to exchange the ACeT
5diff reagents inside the diluter with ACeT 5diff Rinse reagent

* Allowing ACeT 5diff Rinse reagent to remain in the instrument a minimum of
30 minutes minimizes protein buildup in the instrument

* Perform a Shutdown once every 24 hours that the instrument is in use

e Startup must be completed prior to running patient specimens or controls
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» SHUTDOWN SUMMARY

1 Perform Instrument Shutdown

. i _'-_'_-:. M to initiate a Shutdown routine.
* Monitor the Cycle in progress : Shutdown status bar, as desired.

2 Shut Down Computer then Power Off Analyzer and PC

When Shutdown is complete, a message box appears:

Ac.T 5diff Workstation Information

Shutdown cycle completed. Press OK to Shutdown computer.
During computer Shutdown Switch off Analyzer.

* Click OK to shut down the computer.
* Turn off the Analyzer power switch.
*  Wait for the “It is now safe to turn off computer” message to appear.

* Turn off the PC power switch.

Notes:

» Allow ACeT 5diff Rinse reagent to remain in the instrument a minimum of 30
minutes.

»  Wait at least 30 seconds before performing the Power Up and Log On procedures.

» After doing Shutdown, you must do a Power Up and Startup before running patient
specimens or controls.

> >
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SETUP OPTIONS

OBJECTIVES

When the subject is complete, you will be able to . . .
* Enter data under System including the communications definition if a host computer is
in use.

* Enter data under Quality Assurance to reflect your laboratory’s decisions regarding
XM analysis, automatic printing, and shift designations.

* Enter data under Patients to include flagging limits, display formats, and print options.
* Set up the initial control files under Quality Assurance » Control tab.
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| MENU TREE

This is a menu tree of the Workstation software. Use this menu tree as a reference, as needed.

File

New archive
Open archive
Close archive
Backup database
Restore database
Delete database
Logout

Cycles

Startup

Shutdown

System Reset Cycle
Mini Prime
Backflush

Extended Cleaning

Diagnostics
Operator
Hardware Systems
Reset Hardware
Motors
Valves
Traverse Service
Position
Park Syringes
Diluter Systems
Drain Baths
Rinse
Cleaning Cycles
Prime Reagents
Cycles
Service
(Service Password)

Setup Help
Patients 4 Contents
(Administrator Password) Print Manual
Flagging and Messaging About

Parameters (including RUO)
Reports

Quality Assurance

(Administrator Password)

General
Calibration
Shifts

System

(Administrator Password)

General

== Date/Time

== Physician/Location

— Communication

LIS/HIS
Variable Format

= Printer

== Cycle Option

= Units

== Analyzer

= Config. Save/Restore

== |anguage

72050108
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SETUP MENU OPTIONS

At the Menu bar, select Setup

SYSTEM SETUP

Setup drop-down menu consists of three items

>

>

>

Patients
Quality Assurance
System

All Setup options require the Administrator Password 123 for access

To save changes:

>

>

Click to save the entry and remain on the window

or

Click @ to save the entry and exit the window

A red prompt is displayed on the window when it's necessary to restart the application
after making a change; user is automatically logged out of the application

All the options available in the Setup area of the Workstation software are listed here

>

>

>

Refer to the menu tree on the opposite page as needed
Each menu item is listed with a short description

For details, see Appendix A of the Instructions For Use manual.

To access these options, at the Menu bar:

| 4

>

>

Select Setup »> System

Type Administrator Password then press or click @

Click General tab and a group of sub-option tabs appear

To save changes:

>

>

Click to save the entry and remain on the window

or

Click @ to save the entry and exit the window

For additional details, see Appendix A of the Instructions For Use manual.

Date/Time Tab

PN 4277205BA

Allows the operator to adjust the current date and/or time (for example, daylight savings
time)

Allows the operator to select a date and/or time format for display

>

>

Default date setting is MM/dd/yyyy (month/day/year)

Default time setting is hh:mm:ss ampm (hours:minutes:seconds AM/PM)
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Physician/Location Tab
* This is where you can delete Physician and/or Location names that are no longer needed.

* Once deleted, they will no longer appear in the drop-down lists of the Add/Edit Worklist
screen but they will remain with stored patient results.

Communication Tab

LIS /HIS Tab

* Host computer definition

* Configures the communication format for transfer of sample information to a host
computer

* Allows you to enable or disable the automatic transmission of control results to a host
computer

Variable Format
* Additional host computer definition used only for the variable format

Printer Tab

* Can access the Windows-NT Printer Properties window
* (Can add a printer

* Only certified printers recommended by Beckman Coulter ensure proper printing of
designated codes and flags

Cycle Option Tab
* Daily Workload:
» Can enter the estimated number of CBC/DIFF and CBC cycles run per day
» Default value for CBC/DIFF Runs Per Day is 40; for CBC Runs Per Day, is 10

» Cycle estimates are used to determine if sufficient reagent is available to complete
the daily workload; check is done during Startup

» If reagent volume is insufficient to complete the estimated daily workload, the
message Reagent(s) Low. Insufficient Reagents To Complete Daily Workload appears

* Autoclean Frequency:

» Enter number of cycles 1 to 75 that will run before an automatic Autoclean is run by
the system

» Default value is 75
e Startup:

» Can select whether or not the system will automatically run a Startup whenever the
system power is turned off then back on

» Automatic Startup is the default setting
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QUALITY ASSURANCE SETUP

Units Tab

* Select the appropriate reporting unit format for the laboratory
* Format used to report numeric results
* Default setting is US

* Changing the units requires restarting the application; user is automatically logged out of
the application

Analyzer Tab

* Accepts entry of the Analyzer’s serial number

Config Save / Restore Tah

* Selecting Save allows laboratory to save the Analyzer setup and/or the Workstation setup
to a floppy disk

» Recommended after installation and after making any changes

* Selecting Restore allows laboratory to select a directory to restore a previous setup file
(from the Analyzer setup and/or the Workstation setup) using the information
previously saved on the floppy disk

* Selecting Print provides a hard copy of the current Analyzer or Workstation setup

Language Tab

* Used to select the language displayed by the Workstation’s software
* Allows selection of English, French, German, Italian, or Spanish

* Default setting is English

QUALITY ASSURANCE SETUP
e At the Menu bar:
» Select Setup » Quality Assurance

»  Type Administrator Password then press or click @

* To save changes:

» Click to save the entry and remain on the window

or
» Click @ to save the entry and exit the window

* For additional details, see Appendix A of the Instructions For Use manual.
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General Tab

*  Window contains five areas:

» Reserved Lot Number

» CV Limits
» XM Options
» IQAPID

» Auto-Print

Reserved Lot Numbers
* Can list CBC controls files 1 through 12

* Can list CBC/DIFF control files 13 through 24

* Reserved lot numbers allow a control to be processed using the Run window rather than
the Control window

CV Limits
*  Only the QC CV limits can be changed

* Reproducibility and calibration CV limits are set by the manufacturer

XM Options

* Allows selection of either 3 or 9 parameter mode for XM analysis

* Default setting is Off

10AP ID

* This is where you enter your instrument’s IQAP ID number

* Required in order to download control file data to diskette for submission to IQAP

Auto-Print
* Control box allows selection or deselection of Auto-Print of the control report

* Repro box allows selection or deselection of Auto-Print of the reproducibility report
* (alibration box allows selection or deselection of Auto-Print of the calibration report

* Default setting is Off for all three options

Calibration Tab

* Displays the current calibration factors, the date the calibration factors were modified,
and the operator who authorized the changes

* At the end of the calibration process, these values are replaced with new calibration
values
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Shifts Tab

* Used to separate the control files into different shifts

* May select 24 hour shift or multiple shifts

* If 24 Hour Shift is selected, shift 1 through 3 fields are disabled and blank

e If Multiple Shifts is selected, the From column is enabled and the To column is disabled
» Gaps in time between shifts is not permitted

» When a change is made in the From column, the preceding To column
automatically increments or decrement to prevent any time gap between shifts

PATIENTS SETUP
e At the Menu bar:
» Select Setup > Patients

» Type Administrator Password then press or click @

* To save changes:

» Click to save the entry and remain on the window

or

» Click @ to save the entry and exit the window

* For additional details, see Appendix A of the Instructions For Use manual.

Flagging and Messaging Tab
* Possible to have 20 different flagging sets
» Flagging sets 1 through 6 contains default values
» Flagging set 1 is named Standard Range and cannot be edited

» Flagging sets 2 through 6 action limits and patient limits may be edited as desired,
except age may not be edited

» Additional flagging sets may be set up in the 7 through 20 rows
* Must select one flagging set as a default set

» Default setting is the Standard Range flagging set

» May change this default setting as desired

* To edit flagging sets 2 through 6 or add new flagging sets, must click the Setup button to
access the Flags and Messages window

Flags and Messages Window
Note: The Flags Sensitivity and Thresholds tab is for Service use only.
* May create a flagging set by copying an existing flagging set then editing new flagging set
as desired (except the age range)
* Two factors necessary to set up a flagging set are:
» Flagging Set Name

» Limits (Patient and Action)
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PATIENTS SETUP
* If patient results are outside the Patient Limits in the selected flagging set, result is
flagged
» H for a result above the upper patient limit (limits in the Patient H column)
» L for a result below the lower patient limit (limits in the Patient L column)
» Numeric result and flag are displayed with a yellow background
* If patient results are outside the Action Limits in the selected flagging set, result is
flagged
» HH for a result above the upper action limit (limits in the Action H column)
» LL for a result below the lower action limit (limits in the Action L column)
» Numeric result and flag are displayed with a red background
» Generates an interpretive message based on specific parameter results
Note: Interpretive messages are detailed in the Instructions For Use manual,
Chapter 9
Parameters Tah

Displays the parameters the ACeT 5diff CP hematology analyzer is able of directly
measure, derive from a histogram, derive from the DiffPlot, or compute

Enable / Disable RUO Parameters

RUO (Research Use Only) parameters
Parameter defined as “For Research Use Only. Not for use in diagnostic procedures.”
Six RUO parameters on this instrument

» Two platelet parameters: Pct (Plateletcrit) and PDW (Platelet Distribution Width)

» Four white blood cell parameters: ATL % and # (percentage and absolute number
of atypical lymphocytes) and IMM % and # (percentage and absolute number of
immature cells)

» In the United States, when an RUO parameter label is displayed, printed, and/or
transmitted, the message For Research Use Only. Not for use in diagnostic procedures.
is displayed, printed, and/or transmitted

Default setting is Disabled
» Button reflects the opposite state of the current RUO parameter selection
» When button displays Enable RUO Parameters, RUO parameters are disabled

Changing the state from Disabled to Enabled (or vice versa) requires restarting the
application; user is automatically logged out of the application

If enabled for use in the United States, system prints an RUO Certificate that must be
completed and returned to Beckman Coulter as instructed

PN 4277205BA



SETUP OPTIONS 3
PATIENTS SETUP

Reports Tab

*  Window contains six areas:
» Reports Headers (six different header positions are available)
» Auto-Print
» # of Copy
» Report Format
» Printed Parameters

» Enable

Reports Headers
* Sets up the banner for the top of each printout

* Provides space for six different header entries

* May enter up to 25 alphanumeric characters in each header

Auto-Print

* Allows selection of the Auto-Print option

* Default setting is Off

* If automatic printing is desired, allows selection of All, Normals, or Selected Abnormals
* Selected Abnormal categories include:

» If No Parameter Value selected, patient reports without at least one numeric value
automatically print

» If With Parameter Flags selected, patient reports with at least one parameter flag
automatically print

» If Outside Patient Limits selected, patient reports containing at least one parameter
result falling below the low or above the high patient limits of the selected flagging
set automatically print

» If Outside Action Limits selected, patient reports containing at least one parameter
result falling below the low or above the high action limits of the selected flagging
set automatically print

# of Copy
* Default setting is 1

Report Format
* Three report format options are available

* Default setting is Option 1 (full report)

Printed Parameters
* Select the parameters you want to appear on the printed report
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Enable

* Six options are available under this category.
Note: With the exception of the Raw Values option, each default setting is enabled .
» Range - patient limit ranges are printed on the report when this option is enabled
» Messages - messages are printed on the report when this option is enabled
» Detailed Flags - detailed flagging prints on the report when this option is enabled,
if this option is disabled [0 (no v"), simplified flagging prints

Note: On the Run window, the Flags and Messages label changes to Suspect and
Messages when this option is disabled (simplified flagging prints).

» Diffplot Thresholds - thresholds are printed with Diffplot when this option is enabled

» Histogram Thresholds - thresholds are printed with each histogram when this option
is enabled

 Default setting for Raw Values is disabled O (no v)
» When enabled, raw values print on the report (which may be useful to service)

» Do not enable [ this option unless your Beckman Coulter Representative
instructs you to enable this option!
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INITIAL SET UP OF CONTROL FILES

* Control files are set up through the Control window (not using the Setup option on the
Menu bar as the other set ups were in this topic)

* To display the Control window, click on the Quality Assurance tab
* 12 CBC control files and 12 CBC/DIFF control files are available for set up

» CBC control files (1 through 12) contain fields for entering only CBC parameter
values

» CBC/DIFF control files (13 through 24) contain fields for entering values for CBC
and DIFF parameters

» CBC and CBC/DIFF files are type specific and should be set up with a control that
correlates:

— Control that monitors only CBC parameters should be set up in a CBC control
file, not a CBC/DIFF file

— Control that monitors both CBC and DIFF parameters should be set up in a
CBC/DIFF control file, not a CBC file

* There are two ways to set up a control file:

» Control disk download (transfer data from control disk to Workstation)

» Manual entry of information from control package insert (type everything)
* ACeT 5diff Control Plus is the recommend cell control

» Quality control material for monitoring CBC and DIFF parameters

» Three levels of control: Low, Normal, High

* Controls may be processed with the Control window displayed or on the Run window if
the lot number for that control is reserved

» Later when controls are covered in more detail, you will run controls into the files
you are setting up

» If you are interested in running controls on the Run window, after a control file is
set up, reserve the lot number by accessing the Reserved Lot Number box as
follows:

At the Menu bar, click Setup » Quality Assurance » type Administrator Password 123

then press or click @ » click General tab, if necessary

Set Up

* Since initial control file set up is less involved than management of a control file
containing results, initial set up is being included with these other set up options.

* Get the control disk for the controls you need set up then use the instructions under the
Initial Set Up of Control Files Summary heading to set up these files

Note: The Instructions For Use manual has the procedure for setting up control files
manually should you ever need it.

*  When it is time to record stored control results and set up other control files, use the
Control File Management Summary
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> INITIAL SET UP OF CONTROL FILES SUMMARY

12

Setting Up a Control File

Note: Before starting this set up, obtain the control disk for the controls you plan to set up.

1 Select the File
* Click the Quality Assurance tab to display the Control window.

Note: If the Control window is not displayed, click the Controls tab at the bottom.
* Choose a CBC/DIFF file from the Select Control drop-down menu.

2 Access the Setup Control Window
* C(Click the Setup Control button.

3 Download the Control Data from the Disk
* Insert the control disk into the floppy drive.

e Select the Download Values button.
e Select the control level then click @ .

* Select Commercial as the source of control material (if it is not already displayed).

e Print if desired then click @ .

4 Reserve the Control Lot Number
*  (Click Setup > Quality Assurance.

* Type the password then click @ .

* Click the General tab, if necessary.

* Click the box in the Reserved column that corresponds to the desired control lot.
* Click @ :

5 Set Up Another Level of Control, if applicable

IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up control file are
included in the statistical data for the new file. Delete all controls runs before starting to run the new control.

* Review, print, and delete other files, as applicable.
* Choose another empty, inactive file from the Select Control drop-down menu.

* Repeat steps 2, 3, and 4.

> >

Note: This summary is only for initial set up of control files; therefore, it is not included in
the Summary Pages. The next time you set up a control file, use the Control File Management
Summary.
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OBJECTIVES

When the subject is complete, you will be able to . . .

Controls
* Explain the storage and handling requirements.

* State the open-vial stability.

* Define an event.

* State indications of instability or deterioration.

* Prepare and run ACeT 5diff Control Plus.

* Recognize an out-of-limit result on the control window.
* Explain what to do if a cell control result is out-of-limits.

* Explain the statistics associated with the control files and graphs.

Interlaboratory Quality Assurance Program (1QAP)
* Explain the purpose of the Interlaboratory Quality Assurance Program (IQAP).

Control File Management

* Review numeric and graphic control data for errors and make appropriate corrections.
* Print control file data.

* Exclude individual control runs.

* Delete a control file.

* Properly set up control files for running ACeT 5diff Control Plus.

* Establish running means and expected ranges for BASO % and #.

* Explain how to make changes to an existing control file.

Optional Checks

* Explain the purpose of a reproducibility check.

* Explain the purpose of a carryover check.

XM Analysis
* Explain the purpose XM analysis.

* Explain why the use of RBC indices is so effective in the XM analysis.

* Define the terms batch, mean values, and limits as they apply to the XM analysis.
* State the minimum number of samples collected for an XM batch.

* Describe the three areas of the XM graph.

* Identify the problem parameter (or parameters) causing an XM batch to be
out-of-control.
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COULTER® ACeT™ 5diff CONTROL PLUS

* Recommended cell control
*  Quality control material for monitoring CBC and DIFF parameters

* Three levels of control: Low, Normal, High

Storage
e Control must be stored at 2 to 8°C (35 to 46°F)

» Storage of the control product in the cap down (inverted) position is not recommended

» Might require additional mixing for complete resuspension of cellular components

Proper Handling

Prepare Cell Controls according to the Package Insert Instructions
e Warm control vials at ambient temperature for at least 15 minutes before mixing

* Mix gently by hand using the 8 x 8 x 8 method twice

» After the second mixing, check the sides and bottom of the tube to verify the control
is mixed completely

» Overmixing causes hemolysis which indicates product deterioration
* Do not use mechanical mixers or rotators

* Return to the refrigerator within 30 minutes to ensure stated open-vial stability

Stability

Open-Vial Stability
* Open-vial stability stated on the package insert is listed according to days or events
(whichever comes first)

* An event occurs anytime an operator completes the following sequence:
» Removes a control vial from the refrigerator
» Allows the control vial to stand at room temperature 15 minutes
» Mixes the control vial gently by hand using the 8 x 8 x 8 method two times
» Aspirates sample
» Returns the control vial to the refrigerator within 30 minutes

*  MCV and/or RDW parameters may show trending through the product’s shelf life;
however, this is inherent to the product and should not be considered an indicator of
product instability

Indications of Instability
* Aslight pink color to the supernatant is normal

* Inability to obtain expected values in the absence of known instrument problems or
gross hemolysis (darkly colored supernatant) indicates deterioration of the control
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Running ACeT 5diff Control Plus

Control is designed with a pierceable cap

Use the instrument’s piercing capability to prevent spillage and reduce biohazard
exposure

Make sure the cap is secure before placing the well-mixed, closed control vial in sample
position 1 of tube holder #1 or sample position 4 of tube holder #2

Make sure tube holder sample position is rotated to the pierce position before closing the
cap-pierce door (pierce position is the 12 o’clock position)

Although control levels may be run in any order, Low, Normal, then High provides the
best statistical results

Controls may be processed with the Control window displayed or on the Run window if
the lot number for that control is reserved

Do not preassign controls into the Worklist

Hard copy of the results (in a line list format) prints automatically if the Auto-Print
function is enabled

BASO % and # mean values and expected ranges

» Establish your running mean and expected range for BASO % and # according to
your laboratory protocol

Using the Run Window to Run Controls

Identifier entered in the Sample ID field is compared to the list of Reserved lot numbers
If the identifier in the Sample ID field matches a Reserved lot number:
» Corresponding entry fields are automatically completed

» Workstation places the results in the appropriate control file based on the
information entered in the Sample ID field

» Control results are displayed in the patient sample format but are flagged as a
control

— 1If a control result is lower than the expected range low limit, the parameter
field backlights in yellow and out-of-limit result is flagged with an L

— If a control result is higher than the expected range high limit, the parameter
field backlights in yellow and the out-of-limit result is flagged with an H

» Cannot see how the results of this control relates to other stored control results until
you access the Control window

If the control lot number is not reserved:

» Software searches for a duplicate sample ID number throughout the current active
archive then among the sample ID numbers waiting to be processed, the number is
accepted only if it is unique

» Control results are stored as a patient not a control
» Control results are flagged as a patient

» Any control with an unreserved lot number must be processed with the Control
window displayed (showing the control file for that specific lot number of control)
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Reviewing Control Results

File Cycles Diagnostics Setup Help
Gpel Bl 08 | ] ] O] | § LB W 2 o9 |

Worklist | Pun || Pesults  Guality Assurance | AnalyzerfLogs |
S elect Contral Includ Date/Time wBC | RBC | HGE HCT MCV Iil
[CONTROL 15 CBC/DIFF 7] ¥ [15/02/2004 03:47 AM 24 237 6.5 180 76
; ¥ 07/30/2004 03:54 AM 26 239 65 183 76
Lot Mumber:
0704 ¥ 07/25/2004 05:45 AM 26 237 £.4 180 76
vtation D ¥ 07/26/2004 02:16 PM 26 239 65 18.2 76
wpiration 0 ate: ) -
T o [7/26/2004 D3:56 AM 25 232 65 177 w
4 »
Level: |—I—I _I
Low N = ] ] ] ] ]
; Mean 25 23 E5 180 7
Source:
T Add Camment | 25D 014 0.05 0og 04z 065
; zCy 267 1.03 067 1.18 043
SDh'”S' = Target 26 233 £5 18.4 77
Setup Corivel_ | Limit 0.4 012 0.4 15 4
Delta Diff 01 0.03 0o 04 1
WEC / RBC / HGB | HCT / MCV / MCH | MCHC / RDW / PLT | MPV / NE /LY | MO / EO 7 BA | NE# 7 Ly# / MO# | E034 | +|
B -- Control Data RBC -- Control Data HGB -- Control Data
prlli] s 2348 e 6.5 "
04 ==zo==eoemzeeeeseeooeeieass D12 mrmmreme st 04 ==zo==eoemzeeeeseeooeeieass
Contols | Beproducibility |__Calibration | 104P e

Tabular Results
* The most recent control results are displayed and printed first (at the top)

* Operator can add a comment to a selected set of results using the comment button
* Control results are compared to expected ranges:
» When a result exceeds the low limit, an L is displayed next to the result
» When a result exceeds the upper limit, an H is displayed next to the result
* Each control file can store more than 100 runs:
» Must scroll to see older data
» History of previous control results may be helpful during troubleshooting process

» After 400th control is run into a file, message Result Could Not Be Saved (File Full)
appears; no further runs can be stored in this control file

*  When a % CV exceeds the QC CV limit for that parameter, the parameter field
containing the out-of-limit % CV value backlights red
To access QC CV limits:

At the Menu bar, click on Setup » Quality Assurance » type Password then click @ »
click General tab, if necessary
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* Operator may decide to exclude an analysis:

» Control results should only be excluded immediately if you can trace an operator
error to the unacceptable results

» Excluding too many runs can cover up an instrument problem and bias results

Graphs

Tabs

WEC / RBC / HGB | HCT / MCV / MCH | MCHC / RDW / PLT | MPV / NE /LY | MO 7 EO 7 BA | NE# 7 LY# 7 MO# | EO4 | >
WBC -- Control Data RBC -- Control Data HGB -- Control Data
+03 SSSSS-ZZZ-C-ZZZ-ZZZSZS-ZSZ-ZSZSZ-ZS-SZSZSZ=S=Sz +0.13 SSSSSSSZ-ZZZZZ-ZZZSZZZ-ZSZS-Z-ZSZSZS-Z-ZSoS:o=S +05 SSSSSSSZSSZZZZZZZZSZ-ZSZS-ZSZ--ZS-Z-D=SDo
a9 . ——— 4.72 134 ——
Ds SSSSSSSSSSSSSSSSSSSSSSSSSS=S=SS -0'7::::::::::::::::::::::::::::: 05 SSSSSSSSSSSSSSSSSSSSSSSSSS=S=S
Parameter
Upper (+) limit \ RBC -- Contral Data
-I-D1B R e R e R e R e R e R R
Thumbnail
Target value 4.72 graph
L8
Lower (-) limt— | AoSEEiSSCSEREEEiiEiiiiiiiiiis
7205052A
Last included run
Tabs

* Each of seven tabs allows access to three thumbnail graphs at a time
Note: All seven tabs appear even when a CBC file is selected.
* From left to right, clicking the graph tab provides access to the following parameters:

» 1f WBC /RBC / HGB tab selected, thumbnail graphs for the WBC count, RBC count,
and hemoglobin parameters are displayed

» If HCT/MCV / MCH tab selected, thumbnail graphs for the hematocrit, Mean Cell
Volume, and Mean Cell Hemoglobin parameters are displayed

» If MCHC / RDW / PLT tab selected, thumbnail graphs for the Mean Cell Hemoglobin
Concentration, Red cell Distribution Width, and platelet parameters are displayed

» If MPV/NE/LY tab selected, thumbnail graphs for the Mean Platelet Volume,
neutrophil %, and lymphocyte % parameters are displayed
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» 1fMO/EO/BA tab selected, thumbnail graphs for the monocyte %, eosinophil %, and
basophil % are displayed

» If NE#/LY#/MO# tab selected, thumbnail graphs for the neutrophil absolute number,
lymphocyte absolute number, and monocyte absolute number are displayed

» If EO#/BA# tab selected, thumbnail graphs for the eosinophil absolute number and
basophil absolute number are displayed (only set with two graphs instead of three)

Thumbnail Graphs

* Each thumbnail graph contains three areas
» A central line representing the actual mean value for that parameter

» A line above mean value (central line) represents the upper limit and a line below
the mean value represents the lower limit boundaries

» Area showing dashes is the out-of-limit area
* Each thumbnail graph displays the last 10 data points that are included in the statistics
» Last data point included in the graph is located on the far right

» Data points are not displayed for control runs that are excluded from the control file

Expanded Graphs

*  When a thumbnail graph is double-clicked, graph expands to display up to 100 data
points

* Only data points for control runs included in the statistics are displayed

» After the first 100 controls are processed, this option always displays the plot points for
the most recent 100 controls

* Provides a history of previous control results which may serve as an aid during the
troubleshooting process

* After the 100th control is run, the graph begins to rollover where the oldest control run is
deleted to make space for the newest control run

* Most recent data point included in the graph is located on the far right

* Data points are not displayed for control runs that are excluded from the control file
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Graphing Control File Data Facilitates Monitoring

* Graphing provides a convenient mechanism that allows daily inspection for trends,
shifts, outliers, and/or other violations of the laboratory’s quality assurance guidelines

* Data plotted on a graph:
» Allows easy visual detection of “in control” and “out of control” results
» Allows faster detection of subtle developing problems

* Different kinds of changes suggest different sources for error

* Graphing is ideal for spotting trends and shifts

Trend
* Gradual change in 5 or more consecutive results, all going upward or all going
downward

Contral Data

Upper (+) limit

Target value

Lower () limit —————————————

* Systematic drift or trend in control values suggests that a problem is progressively
developing

* Generally due to the deterioration of a reagent or control material

Shift

* Sudden or abrupt change in 5 or more consecutive results all above or all below the
mean

Contral Data

Upper (+) limit

Target value

Lower (-) limit ———

* This type of systematic error is usually associated with the malfunction of the instrument
or an error in technique
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QOutlier
* Single result that falls outside the upper or lower limit

* Chance probability for a value to be outside the limit is about one time out of every 20
times control is run

* In the example below, run #6 (from the right) illustrates an outlier; notice plot point is
located inside the upper double line

Control Data

Upper (+) limit

Target value

Lower (-) limit ——————

*  With computerized graphing, small double-lined area typically serves as a limit for the
plot point

* Since plot point for an outlier cannot extend beyond this set boundary, operator must
look at the numeric results to determine if the result in question is slightly outside the
limit or greatly exceeds the limit according to the laboratory’s protocol

* If the numeric result for the outlier is only slightly beyond the limit, it may be a
statistical outlier (control value is out by chance)

* To confirm a statistical outlier, operator must run the control one more time

»  If the result of the rerun is now in-control, the analytic run is accepted and both
runs (the statistical outlier and the acceptable rerun) are to be included in control
data

» If rerun of control reflects the same parameter(s) as still being out-of-control, there
may be a control or system problem

*  When considering a control problem:
» Any change in the control material may cause control to be out
» Control must be handled carefully as instructed on the package insert

» If control material is treated roughly, stored improperly, or used beyond the
expiration date, results may be outside the limits

» Generally only one level of control or one vial shows the problem

*  When considering a system problem:
» Any change to the instrument regarding the test system may cause controls to be out
» Usually affects more than one level of control

* Important considerations when a statistical outlier occurs:

» Frequency of outlier occurrences should be carefully monitored; high outlier
frequency may indicate an underlying problem with the instrument, control
material, or operator technique

» When a single control result is analyzed and the run is repeated, the original control
result should remain in the control file and used in the statistical calculations
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Guidelines for Acceptable Operation

* Performance specifications for your instrument are located in Operator’s Guide,
Chapter 3

* Laboratory may choose to use Beckman Coulter assigned values or may choose to
establish their own laboratory means

* Instrument is considered well maintained and operating correctly if before current cell
control lot(s) expire, on the new lot(s) of cell control, the laboratory:

>

Confirms recovered mean values are within the TABLE OF EXPECTED RESULTS
or

Establishes its own mean values and acceptable ranges and periodically reevaluates
those means

For More Basic Concepts
* Consider ordering Basic Concepts of Quality Control, PN 4235526

>

>

Designed for someone with little or no quality assurance experience

If desired, contact your Beckman Coulter Representative to order a printed copy

¢ Information covered in this booklet includes:

Note: This list is not inclusive.

>

>

>

>

>

Fundamental components of a quality assurance program
Definitions of common terminology

How to read a package insert

Difference between a control and a calibrator

Why calibration is necessary

How to determine if a control is “in” or “out”
What to do if a control is “in”

What to do if a control is “out”

Outliers

Trends

Shifts

Interlaboratory Quality Assurance Program (IQAP)

* Booklet also contains a glossary and a self-evaluation

10
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» RUNNING COULTER ACeT 5diff CONTROL PLUS SUMMARY

1 Get the Workstation Ready

To run controls with the Control window open To run controls with the Run window open

¢ (Click the Quality Assurance tab. * (Click the Run tab.

*  From the Select Control drop-down Note: To use this option, the control
menu, locate the control file that lot number must be reserved. If you
correlates with the lot number of are not familiar with this protocol, use
control you wish to run. the Control window to run the

controls.

¢ Enter the control lot number as the
next Sample ID.

ON s N=r

2 Prepare the Control according to the Package Insert

*  Warm controls at room temperature for 15 minutes.
* Control levels may be processed in any order.
* Mix the control vial using the 8 x 8 x 8 method.

» Do not use a mechanical mixer!

» Inspect the control vial to ensure all cells are uniformly distributed, if not, repeat the
8 x 8 x 8 method of mixing again.

3 Run the Control

* At the tube holder, make sure sample position is in the pierce position (12 o’clock).
(In tube holder #1, use sample position 1; in tube holder #2, use sample position 4.)

* Place the well-mixed, closed-vial of control in sample position 1.

* Close the cap-pierce door.

4 Review Results
Note: A hard copy of the results prints automatically if the Auto-Print function is enabled.

*  Verify control results are within the acceptable ranges.
e Ifaresult is out-of-limits:
» Rerun the control after gently remixing the control vial.
or
» Refer to When CBC/DIFF Control is Outside Its Expected Ranges that follows.
* Compare the results of this run with previous runs, as desired

» To evaluate stored numerical data or evaluate the graphs for the presence of shifts or
trends, the Control window must be displayed.

» Click Quality Assurance tab to display the Control window, if needed.
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12

When CBC/DIFF Control is Outside Its Expected Ranges

1. Check for a control problem.

Ensure the control material was properly mixed. If not, mix it according to the
package insert.

If the control was processed in the Control window, make sure the control file with
the correct lot number was selected.

If the control was processed in the Run window, make sure the lot number was
entered correctly and verify the lot number is reserved.

Unless you have established your own running mean and/or expected ranges, make
sure the setup information (assigned values and expected ranges) matches the
control package insert. If they do not, change the control setup information to
match the package insert.

If any of the above problems exist, rerun the control; otherwise, proceed to the next
check.

2. Rerun the control to determine if the out-of-limit result is a statistical outlier. If the rerun
reflects the same parameter(s) as still being out-of-control, proceed to the next check.

3. Ensure the control material was not contaminated by running another vial or level of
control. Follow the instructions on the package insert for proper handling. If the results
are still out, proceed to the next step.

4.  Perform the Extended Cleaning procedure in the Instructions For Use, Chapter 11.

Use the Online Help to locate this procedure:

a.

b.

C.

f.

> >

Click &2/
(]

Click on Contents. The table of contents appears in the left frame.
Inside the left frame, click on 11 Diagnostics to list the headings in that chapter.

Scroll through the headings and click on Extended Cleaning. The cleaning procedure
appears inside the right frame.

Complete the procedure.

» Follow the instructions on the Workstation screen.
or
» Print a copy of the instructions.

- Right click on the procedure (anywhere inside the right frame).
- Click Print on the pop-up menu.
- Click OK to initiate printing.

Note: All the information under the primary heading is printed. Locate the
Extended Cleaning instructions and complete the procedure as written.

Rerun the control.

» If the results are acceptable, run other control levels that need to be processed
then resume normal operation.

» If the results are still out, call your Beckman Coulter Representative to help you
troubleshoot.
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» MAKING CHANGES TO A CONTROL FILE CURRENTLY IN USE SUMMARY

Use this summary only if you need to make a change in a control file that is currently in use
and only if you are changing an individual item:

* To correct a typographical error.
or
* To edit an assigned value (obtained from the Table of Expected Results) to a running

mean (established by the laboratory).

If you need to make a set up change (such as changing the lot number), use the Control File
Management Summary.

1 Select the File
* Click the Quality Assurance tab » Control tab to display the Control window.

* Choose the existing file you want to change from the Select Control drop-down menu.

2 Access the Setup Control Window
* C(Click the Setup Control button.

3 Make the Changes

e Enter the new information.

4 Verify All Changes

¢ Check all entries are correct.

. Click @ .

» If control runs are stored in this file:

— When the Do You Want The Existing Results To Be Saved? message appears,
click on the desired action.

— Selected action makes the requested changes then exits the window.

» If no control runs are stored in this file, requested changes are saved before exiting
the window.

* Control file statistics are recalculated based on the changes.

> >
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IQAP (Interlaboratory Quality Assurance Program)

Coulter Interlaboratory Quality Assurance Program is a service offered to all regular
users of ACeT 5diff Control Plus cell controls

It complements a laboratory’s in-house quality control program by providing peer group
comparisons for each lot number of a given control product run on the same instrument
type

The assessment is completely independent of the assay value issued when the product
was supplied

A separate IQAP manual (PN 4206266) is available with information on enrollment, data
submission, understanding the IQAP report, and troubleshooting IQAP problems

Note: In software version 2.00 and above you can download your control file data to
diskette for submission to IQAP. See the Instructions For Use Manual or Help System for
more details.

CONTROL FILE MANAGEMENT

14

Once a control file is initially set up, the file is considered an existing control file
Two types of existing control files:
» Control file that contains control run data (may be either current or old data)

» Control file with no stored control run data because the file is either newly set up or
has had all its control runs deleted from it

12 CBC control files and 12 CBC/DIFF control files are available for set up:

» CBC control files (1 through 12) contain fields for entering CBC parameter values
only

» CBC/DIFF control files (13 through 24) contain fields for entering CBC and DIFF
parameter values

» CBC and CBC/DIFF files are type specific and should correlate with the control
When setting up a control file:

» You can enter all of the information manually or you can download data from the
control disk included in your control kit (software version 2.00 and above)

» Most information is selected from a drop-down menu

» If manually typing parameter values and limits, use to move from field to field.
Refer to the Instructions For Use manual for the complete procedure.

» If your laboratory designates a specific file for running each low, normal, or high
control, it will not be necessary to enter the expected range during setup since the
expected ranges are not deleted when the results are deleted

Initial set up of the control files is located under Topic 3, Setup Options
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» CONTROL FILE MANAGEMENT SUMMARY

Review the Numeric Control Data and Graphs, if applicable

1 Locate the Control File
* Click the Quality Assurance tab to display the Control window.

* Choose the specific file you want to review from the Select Control drop-down
menu.

2 Review the Graphs

* Double-click on any thumbnail graph you wish to review.
* Look for any skewed or out-of-limit plot points.

e Check for a shift or a trend.

3 Review Numeric Data
* Review % CV of all parameters (press (] to see additional parameters).

e Ifa CVis high, scroll through the rows and examine each run for results mistakenly
run into the file (the graph review should correlate).

* May review and manage the data by shifts, if desired.

* Exclude any mistakes from the control calculations.
» Locate the control that needs to be excluded from the calculations.
» C(Click the to the left of that control (inside the Include column).

» [ (an empty check box) indicates those control results are no longer being
included in the control calculations. N = is decreased by 1.

» Repeat as needed.

Print the Control File Data

* C(Click @ :

*  Print All Rows is preselected but if a hard copy of the graphs is also desired select the
Print All Rows and L J Graphs option.

* If you are submitting data for IQAP evaluation, print a second copy.

Delete the Control File Data

e C(Click E )

* Choose Erase All rows from the drop-down menu.

Note: All the control results are deleted. Target values and +/- limits remain in the
control file and may not need to be entered if the same type and level of control is set up
again in that same file.
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Set Up the New Lot Number of Commercial Control

IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up control file are
included in the statistical data for the new file. Delete all controls runs before starting to run the new control.

Note: Before starting this set up, obtain the control disk for the controls you plan to set up.

1

]

Select the File
* Click the Quality Assurance tab to display the Control window.

Note: If the Control window is not displayed, click the Controls tab at the bottom.
* Choose a CBC/DIFF file from the Select Control drop-down menu.

Access the Setup Control Window
e C(Click the Setup Control button.

Download the Control Data from the Disk
* Insert the control disk into the floppy drive.

e Select the Download Values button.
e Select the control level then click @ .

* Select Commercial as the source of control material (if it is not already displayed).

e Print if desired then click @ .

Reserve the Control Lot Number
e Click Setup » Quality Assurance.

* Type the password then click @ .

* Click the General tab, if necessary.

* Click the box in the Reserved column that corresponds to the desired control lot.
- Click ().

Set Up Another Level of Control, if applicable

IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up control file are
included in the statistical data for the new file. Delete all controls runs before starting to run the new control.

* Review, print, and delete other files, as applicable.
* Choose another empty, inactive file from the Select Control drop-down menu.

* Repeat steps 2, 3, and 4.

> >
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OPTIONAL CHECKS
Reproducibility Check

* Check measures how close several results (from the same specimen) are to each other; in
other words, this check measures repeatability or precision

* Check may be done using CBC or CBC/DIFF panel

* For best results, a fresh, normal whole-blood specimen must be used

* One normal, fresh whole-blood specimen is cycled at least 5, but no more than 11 times
* CV or Coefficient of Variation is a percentage of deviation from the mean

* Results that exceed the limits appear against a red background

* Reproducibility does not measure accuracy, but true accuracy is not possible unless the
instrument is precise

* Performing a reproducibility check before performing a calibration may catch
imprecision problems that may affect the calibration process

* Procedure is located in the Operator’s Guide, Chapter 11

Carryover Check
* Carryover is the interaction of the previous sample with the current sample

* High to low carryover check verifies the high results of one sample do not affect the low
results of the next sample

* Check is done by analyzing a whole-blood specimen with high values followed by a
whole-blood specimen with low values; each specimen is run consecutively in triplicate

* Carryover is calculated as follows:

1st low sample — 3rd low sample
1st high sample — 3rd low sample

% Carryover = x 100
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XM ANALYSIS

XM ANALYSIS

Quality Assurance Tool

* XM analysis is a quality assurance method that allows a laboratory to continuously
monitor the performance of their automated hematology system and thus control the
quality of their reported results by monitoring their patient results

* Since this quality assurance tool is based on patient results:

» The more patient samples processed per day, the more frequent the system
monitoring

» Proper monitoring is best accomplished if the laboratory runs more than 100
patient samples per day

» Running less than 100 patient samples per day means the system is not checked
frequently enough to be considered a viable form of quality assurance

» If your laboratory processes less than 100 samples per day but you still like to
consider using this form of control, checking with your regulatory agencies may
help you make a final decision

* Any method used for quality control must use a material that meets two requirements:
» Material must be stable
» Material must be similar in content to the patient samples that will be analyzed

* XM analysis meets these requirements:

» Uses the patient samples themselves as a material so the similarity requirement is
met

» Uses the red blood cell indices (MCV, MCH, and MCHC) so the stability
requirement is met

* No additional cost to the laboratory because the method uses patient sample results

* Concept of this analysis is based on X Analysis developed by Dr. Brian Bull but is
modified to include the selection of additional parameters:

» May select the more traditional three parameter analysis that includes MCV, MCH,
and MCHC

or

» May select a nine parameter analysis that includes WBC, RBC, HGB, HCT, RDW,
PLT as well as MCV, MCH, and MCHC

* Traditional three parameter evaluation focuses on the more stable RBC indices
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RBC Indices

MCV, MCH, and MCHC are relatively stable parameters:

>

RBC indices that comprise the 3-parameter XM analysis are very tightly controlled
by the body because the red cells function best within a very narrow range of size
and hemoglobin content

Other parameters such as the white blood cells and platelets that are included in the
9-parameter XM analysis tend to have a wider physiological range and are,
therefore, not as predictable as the red cell indices

Are typically stable for an individual patient from day to day

Are stable for a patient population over time

>

Many hospitalized patients have been investigated and it has been found that there
is no significant day-to-day or week-to-week variability in the mean of their indices

Establishing Mean Values

For the 3 Parameter XM Analysis
A constant for each RBC index (MCV, MCH, or MCHC)

XM mean values should reflect the entire patient population of the laboratory:

>

Patient population of a general hospital usually includes samples from all patient
age groups, disease states and many hematologically “normal” samples

A patient population that includes only one age group or only one disease state will
yield different target values than a patient population that includes all groups

As long as the patient population remains constant, the XM mean values of each index
also remain constant

If the patient population changes, the mean of an index may also change and needs to be
reevaluated

May want to start with the target values suggested by Dr. Brian Bull for his X Analysis:

>

>

>

MCV =89.5
MCH = 30.5
MCHC = 34.0

If you begin with these values, your laboratory must then evaluate and adjust them
for their own patient population

Results from at least 250, but ideally 1000 blood samples should be collected to find
your laboratory’s XM mean values

Results should include all types of patients (oncology, presurgical, OB, dialysis, out
patients, and so forth)

For the 9 Parameter XM Analysis

MCV, MCH, and MCHC are part of these nine parameters so the information under the
Heading For the 3 Parameter XM Analysis still applies

For the other six parameters, your laboratory must evaluate the results of your
population and decide what represents an acceptable mean value for each parameter to
begin establishing the XM mean values for your patient population
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Getting Started

Turning the XM Analysis ON
* Default setting for XM analysis is Off

» XM tab is invisible when Quality Assurance tab is selected
* To activate XM analysis:

» At the Menu bar, select Setup » Quality Assurance

» Type the Administrator Password then press or click @

» At the XM Options box, select 3 Param (parameters) or 9 Param (parameters)

*  Once activated, laboratory must establish their own mean values (XM limits)

Enter XM Mean Values and Limits
¢ XM mean values and limits must be entered in the Workstation

Click Quality Assurance tab » XM tab » Setup XM Limits button
¢ In the XM Limits box:

» Type the mean values established by your laboratory (or for MCV, MCH, and MCHC
the values suggested by Dr. Bull)

» Multiply each mean value by 5% and type this number in the +/- box (5% is only a
suggested percentage. While establishing the means that reflect your patient
population, you may wish to use a higher percentage.)

For example, if for MCV you use Dr. Bull’s suggested mean of 89.5 and a 5% limit.
XM mean value x percentage = +/- value  (89.5 x 0.05 = 4.5)

You would enter the 89.5 as the mean value and 4.5 as the limit. The Workstation
will calculate the upper and lower limits and display them as a whole number. In
this case, the upper limit would be 94 and the lower limit, 85. The upper and lower
limits are displayed in whole numbers.

*  Once your laboratory has established the XM mean values for your population:
» Enter new mean values and limits.

» For MCV, MCH, and MCHC, adjust the 5% limits according to your laboratory
protocol.

For example:

MCV XM mean value x percent limit = +/- value for MCV
MCH XM mean value x percent limit = +/- value for MCH
MCHC XM mean value x percent limit = +/- value for MCHC

» Due to the wide physiological range for the other six parameter, you may wish to
use a higher percent limit than you use for the MCV, MCH, and MCHC parameters
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Using the XM Analysis
*  When XM option is turned on, the:

>

Workstation stores results of all patient samples (including any repeat samples) as
they are cycled

XM analysis is performed on sets of 20 patient results at regular intervals
(each patient set is referred to as a batch)

» Stored results being displayed on the current batch table may be accessed by clicking the
Batch Details button:

>

If the 3 parameter XM option is selected, table shows the MCV, MCH, and MCHC
parameter results collected towards this batch of 20

If the 9 parameter XM option is selected, table shows the WBC, RBC, HGB, HCT,
MCV, MCH, MCHC, PLT, and RDW parameter results collected towards this batch
of 20

Note: It is necessary to use the scroll bar to view the MCHC, PLT, and RDW
parameter results.

¢ Results stored on the current batch table cannot be deleted from the table

* Samples that will not be stored on the current batch table and, therefore, not used in the
XM batch analysis calculation include:

>

>

>

>

>

>

Samples processed in the reproducibility mode of operation

Samples processed in the calibration mode of operation

Controls processed with the Control window displayed

Controls (with reserved lot numbers) processed with the Run window displayed
Blank samples

Patient samples with at least one non-numeric result

*  When the batch of 20 patient samples is completed, the Workstation performs the
XM analysis and determines the batch mean of each parameter:

>

>

Calculation done automatically by the Workstation

This batch mean is not a simple average value of the patients’ parameter results, but
a type of “weighted moving average” that statistically allows the small batch of 20
patient samples to appear as if it were a larger set of approximately 100 samples

*  Workstation then compares each batch mean to its expected XM mean value

>

>

Results are displayed on the XM Batch Means table on the XM window

If the batch mean is inside the expected XM limits, the batch is said to be IN and the
instrument is functioning properly

If the batch mean is outside the expected XM limits, the batch is said to be OUT:
— One or more parameters are not close enough to the expected XM mean values
— An H or L flag appears beside the out-of-limit results

— Red XM icon appears to the left of the System State indicators (connection
status circles in the upper right corner)
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Reviewing XM Data

XM Batch Table

* Table appearing on the XM window that collects completed batch information
* Used to view the calculated batch means for the last 60 batches of 20 samples
* Most recent batch is located at the bottom of the table

* May be used to identify the affected parameters and to determine the direction and
amount of the change

* After the first 60 batches are completed, this option always displays the last 60
completed batches

» Provides a history of recent batch means which may serve as an aid during the
troubleshooting process

»  After the 60t batch is completed, the table begins to rollover where the oldest batch
results are deleted to make space for the last completed batch results

» Individual batches cannot be deleted
* Details of a selected batch may be viewed by clicking the Batch Details button
» Table that collects the individual sample results

» Individual samples cannot be deleted from the batch of 20 samples

XM Graphs
* Three graphs are displayed at a time

» If 3 parameter XM option is selected, MCV, MCH, and MCHC graphs are all
displayed at one time

» 1f 9 parameter XM option is selected, three tabs are available for selecting the three
graph grouping for display:

— If the left tab is selected, the WBC, RBC, and HGB graphs are displayed
— If the middle tab is selected, the HCT, MCV, and MCH graphs are displayed
— 1If the right tab is selected, the MCHC, RDW, and PLT graphs are displayed

* Used to view the batch means in relationship to the XM mean value and XM limit for the
corresponding index

* Graphs are good for identifying trends and shifts
* Each graph contains three areas
» A central line representing the actual XM mean value for that parameter

» A line above XM mean value (central line) represents the upper limit and a line
below the XM mean value represents the lower limit boundaries

» Area showing dashes is the out-of-limit area
* Each graph displays the last 10 data points
*  When a graph is double-clicked, the graph expands to include the last 60 data points
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After the first 60 batches are completed, this option always displays the plot points for
the last 60 completed batches

>

Provides a history of recent batch means which may serve as an aid during the
troubleshooting process

After the 60t batch is completed, the graph begins to rollover where the oldest
batch results are deleted to make space for the last completed batch results

What Causes a Batch to go “Out-of-Limits”?

Change in the patient population

An instrument problem may exist

A calibration problem may exist

A reagent problem may exist

Troubleshooting when an XM Batch is “Out”

Consider a Change in the Patient Population

Is there a change in the overall patient population?

>

>

>

One or more new patient types were added to the population
One or more patient types are no longer part of the population

Possible seasonal change of the patient population (hospitals or clinics in resort
areas)

If a change in the overall patient population is probable,

>

>

Future XM batch results will also be outside the limits

New XM mean values based on the current population must be established and
entered in the computer

If a change in the overall patient population is not probable, it is possible that the patient
population has not really changed but just appears to have changed because the batch of
20 patients does not truly represent the total population

Check for Non-Reportable Results and/or Non-Random Sampling

An XM batch may go outside the XM limits because the batch is biased by
physiologically impossible results caused by a reagent or instrument problem, or by
physiologically abnormal specimen

Use the Batch Details window to check for non-reportable results and/or non-random
sampling

>

Non-reportable results where a batch of patients is biased by short samples,
physiologically impossible results and/or erroneous data accumulated before a
reagent or instrument problem was identified and solved

Non-random patient sampling where a batch of patients is biased by several
abnormal patients of one particular type (oncology, neonatal and so forth)
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Consider an Instrument Problem Exists

* Consider an instrument problem only if:
» A change in the patient population is doubtful
» All the results in the current XM batch are reportable (physiologically possible)
» Random sampling is verified
* Instrument problems cause XM batch results to go “out” and stay out
» Can be a gradual change:
— 1If caused by a calibration drift, should go back within limits after calibration

— If caused by a component going bad over time, should go back within limits
after the component is replaced

» Can be a sudden change:

— 1If caused by a component failure, should go back within limits after the
component is replaced

— 1If caused by any number of instrument problems, should go back within limits
after the problem is fixed

Assessing the Situation

* Review the XM graphs and XM batch means to identify the out-of-limit parameter and
note the direction of the change (increased or decreased)

* The physiological range of some parameters, like WBCs and Plts, makes it difficult to
assess if a problem really exists or the diversity of the values has cause the problem

* Generally more than one parameter may show a change

* Itis also important to note any parameter that may still be inside the limit but shows a
significant change

* (Call your Beckman Coulter Representative if you need assistance.
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OBJECTIVES

CALIBRATION

When the subject is complete, you will be able to . . .

PN 4277205BA

Explain the purpose of calibration.

Tell when one needs to verify calibration.

Perform the preliminary procedures.

Perform the calibration procedure in Chapter 10 of the Operator’s Guide.

Demonstrate how to access the Calibration Log.



CALIBRATION

NOTES
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CALIBRATION

CALIBRATION

* A procedure used to standardize the instrument by determining its deviation from
calibration references and applying any necessary correction factors

* Never use calibration to adjust for an instrument problem

*  Verify the ambient room temperature is typical for the laboratory and within the
instrument’s operating range (16 to 34°C; 61 to 93°F)

* In the normal process of tracking data for an extended period of time, your laboratory
can make a specific decision to recalibrate a given parameter

* Never adjust to a specific value based on an individual sample result

When to Calibrate

* Atinstallation, before you begin analyzing samples

* After Service has replaced a major analytical component such as the sampling syringe or
an aperture

* If your Beckman Coulter Representative suggests you calibrate

When to Verify Calibration
* As dictated by your laboratory procedures, local, or national regulations
*  When controls show evidence of unusual trends

*  When controls exceed the manufacturer’s defined acceptable limits

PRELIMINARY CALIBRATION PROCEDURES

* Procedures designed to ensure the instrument is operating optimally

* Recommend a thorough review of data stored in current control and, if applicable,
XM files to note any possible bias that might require a change in a calibration factor

* Thorough review of IQAP data is also recommended

Pre-Calibration Checks

Check Reagent and Waste Containers
*  Check reagent volumes to ensure sufficient volume to complete calibration procedures

» As needed, use the Changing Reagent Summary to replace any container with
insufficient reagent with a new reagent container

* Check the waste container level

» If needed, use the Replacing a Waste Container Summary as a guide
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Ensure the Analyzer is Clean

 If the instrument is routinely shut down with ACeT 5diff Rinse reagent for at least
30 minutes every 24 hours it is in use:

» Do a Startup
» Run commercial cell controls

* If the instrument is not routinely shut down with ACeT 5diff Rinse reagent for at least 30
minutes every 24 hours the instrument is in use:

» Do the Extended Cleaning procedure in Chapter 11 of the Instructions For Use
manual

» Do a Startup

» Run commercial cell controls

CALIBRATION PROCEDURE
* Beckman Coulter recommends using COULTER® ACeT™ 5diff Cal Calibrator
* May calibrate one or more CBC parameters including WBC, RBC, Hgb, Hct, and PlIt
» Operator selects those parameters to be calibrated via the Select Parameters boxes

* Carefully follow the instructions on the COULTER® ACeT™ 5diff Cal Calibrator package
insert and the Auto-Calibration instructions in Chapter 10 of the Operator’s Guide
anytime calibration is performed

» Before accumulating calibration data, prime the instrument using two normal
whole-blood specimens and the calibrator material

» 11 is the maximum number of runs that can be displayed in this window
» Never accept a calibration factor based on less than five calibrator runs
* Perform each analysis using well-mixed calibrator

» Before the first sample is aspirated, make sure the calibrator is mixed according to
the instructions on the package insert

» Insert the tube correctly into:

— slot #1 of Tube Holder #1, or

— slot #4 of Tube Holder #2
» Close the tube holder door to begin analysis
» Each time the tube holder door opens

— remove the calibrator tube

— mix thoroughly

— replace the calibrator tube

— close the tube holder door

» Analyze the calibrator at least 5 but no more than 11 times
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CALIBRATION
CALIBRATION PROCEDURE

» Sample results should only be excluded if you can trace an operator error to the

unacceptable results

» Excluding too many runs can cover up an instrument problem and bias calibration

» Although the instrument can calculate the calibration statistics on three runs,
Beckman Coulter recommends calibration factors based on a minimum of five

acceptable results

From the Menu bar, selecting Quality Assurance tab » Calibration tab displays the

Calibration window

Calibration Window

Whorklist | Fun | Results

Modified Or:

By:

 —

Marne:

IEALI 1

Lot Mumber:

-

E wpiration D ate:

Eailigst Bun Date:

Setup Calibrat

Save Calibration |

Ac.T Sdiff

File Cycles Diagnostics  Setup Help

= WA WS o 1 s ) T

Q@

Cluality Agsurance | AnalyzerlLogs |

Include] wBCc | mBc | HeB | HCT | PT |
N =
Mean
New Cal Factor | N I N N
0Id Cal Factor 126,88 199.26 4367 20017 26159
%0V
Reference ¥alues
Select Parameters : ¥ i~ ¥ ¥ ¥

Controls IRegdeucibiIitx Calibaration |

| 03/14/2001 134618

Terms and Formulas used in the Calibration Procedure
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Number of ACeT 5diff Cal calibrator runs included in the statistics for the parameter

next to a set of results in the accumulated results table indicates that set of results is

included in the statistics

O (no v") indicates that set of results is not included in the statistics; therefore,
N may be less than the number of results displayed on the table
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Mean
* Average of the ACeT 5diff Cal calibrator runs

e (Calculation can be based on at least 5, but no more than 10 runs

New Cal Factor
e (Calibration Factor needed to recover the ACeT 5diff Cal Calibrator Reference Value

* Itis calculated and displayed regardless of whether or not you need to change it

Reference Value x Old Cal Factor

New Cal Factor = -
Calibrator Mean Value

0ld Cal Factor

* The current Calibration Factor in use by the analyzer

* Remains the current calibration factor until the save calibration function is performed

% CV
* Indicates the reproducibility of the ACeT 5diff Cal calibrator run
* Checked to ensure valid data is used as you are deciding whether or not to recalibrate
* Compared to the preset Cal CV limits displayed inside the CV Limits box
Setup > Quality Assurance » Administrator Password required » General tab

Reference Values
* The assigned value for each parameter

* Assigned value obtained from the ACeT 5diff Cal calibrator package insert

Calibration Log
* Click on Analyzer / Logs tab » Calibration Log tab to view the log

* Maintains the most recent 50 calibration entries displaying the most recent log entry at
the top of the log and the oldest entry at the bottom of the log

* Rollover is first in, first out when the 51st entry is added
* Log contains the following information fields

Note: It is necessary to scroll right to see some of these fields.
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Information Fields

Field Function
Date/Time Displays when the calibration was completed
Lot Number Displays the lot number of calibrator used to perform the calibration;

the word “Manual” appears in this field if the operator manually
enters the calibration factors

Opr Displays the User name logon information in the Workstation when
the calibration was completed

Expiration Date Displays operator entry identifying the expiration date for the
calibrator material used to perform the calibration; field is blank if
calibration factors are entered manually

Forced If checked, indicates the accepted calibration factors are not based on
ideal results (at least one CV was too high or at least one calibration
factor was not within specified limits) or the calibration factors were
entered manually

Never force a calibration without first consulting with a Beckman
Coulter Representative!

WBC Cal Factor Calibration factor used in determining the reported WBC count result

RBC Cal Factor Calibration factor used in determining the reported RBC count result
HGB Cal Factor Calibration factor used in determining the reported HGB result
HCT Cal Factor Calibration factor used in determining the reported HCT result
PLT Cal Factor Calibration factor used in determining the reported PLT count result

RDW Cal Factor Calibration factor used in determining the reported RDW result:
* Is not determined during Auto-Calibration

*  Must be determined using the Manual Calibration procedure in
Appendix C of the Operator’s Guide

*  Only appears if the calibration factor is manually entered

MPV Cal Factor Calibration factor used in determining the reported MPV result:
* Isnot determined during Auto-Calibration

* Must be determined using the Manual Calibration procedure in
Appendix C of the Operator’s Guide

*  Only appears if the calibration factor is manually entered
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CALIBRATION
CALIBRATION PROCEDURE

Comment Displays any comments entered by operator performing calibration:

* Optional entry that provides an opportunity for the operator to
type a personal observation or appraisal

*  Operator may use the Add Comments button to access the Add
Comments box, as desired

 If Prompt User For Comments check box is checked (v), the Add
Comments box pops up automatically at the end of calibration

Note: When Add Comments box is displayed, operator cannot
access any other window until they either:

» Enter a comment then click I";"' )| to save and exit the box

or

» Click x to exit the box without entering a comment

If ACeT 5diff CP Hematology Analyzer is a Backup Instrument

* If your ACeT 5diff CP system is being used as a backup to another COULTER
hematology analyzer, you may need to perform a manual calibration to determine the
RDW calibration factor

* See the instructions in Appendix C of the ACeT 5diff CP Operator’s Guide, as needed

* Operator should contact their Beckman Coulter Representative if there are questions
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OBJECTIVES

When the subject is complete, you will be able to . . .

Specimen Handling

* State the proper anticoagulant to use for specimens processed on an ACeT 5diff CP
hematology analyzer.

e State the minimum volume of blood needed for processing a specimen.

* State the maximum storage time prior to running a specimen for CBC versus CBC/DIFF
analysis.

* State the proper storage temperature.

* Properly insert a tube into the tube holder and close the cap-pierce door.

Specimen Identification
* Cite the window used to run patient specimens

* State the identifier that must be entered prior to running a patient specimen.
* (Cite three options for entering a sample ID.

* Explain the autonumbering feature.

* Demonstrate how to start autonumbering then how to cancel its usage.

* Cite two situations that allow the sample ID to be duplicated.

Flagging Sets
* Explain the purpose of a flagging set.
* Demonstrate how to set up a flagging set.
* Contrast patient ranges versus action ranges.

*  When given different scenarios by your instructor, cite the flagging set that would be
applied to the patient results.

Workflow Options
¢ Define Worklist.

* Explain how the database, archive, and worklist are related.

* Demonstrate how to create an archive.

* Explain how to identify when a previously closed archive is open.

* Identify the two reasons why your laboratory may want to use the Worklist.

* Run patient samples using the Worklist and without using the Worklist.

Detailed Run Results
e Name and define each area on the Run window.
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SPECIMEN HANDLING

SPECIMEN HANDLING

Specimen Collection

Approved Collection Devices and Control Vials

* Wide variety of specimen tubes, microcollection devices, and control vials are approved
for use on the ACeT 5diff CP hematology analyzer

* Closed-vial sampling is recommended for those evacuated collection tubes and control
vials with pierceable stoppers or caps

e For those evacuated collection tubes, microcollection devices, and calibrator vials
without pierceable stoppers or caps:

» Stopper or cap must be removed prior to sampling (open-vial sampling)

» Open-vial sampling increases the operator’s exposure to the whole-blood specimen
which is considered a biohazardous material

* List of approved specimen tubes, microcollection devices, and control vials is located in
Appendix D of the Operator’s Guide

Using Evacuated Collection Tubes
* Collect venous blood specimens in K3sEDTA or K;EDTA
» A proper proportion of whole blood to anticoagulant is critical
» Collect venous blood according to the tube manufacturer’s requirements

» K;3EDTA is the preferred anticoagulant

* At collection and before analysis, mix each blood specimen gently and thoroughly
according to the tube manufacturer’s recommendations and your laboratory’s protocol

Using Microcollection Devices

* Anticoagulated capillary specimens collected in a microcollection device may be
aspirated as an open-vial specimen

* Proper collection is critical to avoid micro-clots and/or debris

* Review and follow the collection and mixing instructions in the package insert provided
by the manufacturer

e Make sure the manufacturer’s minimum fill volume is achieved

Storage
* Run a CBC/Diff specimen within 24 hours of collection

* Run a CBC specimen within 48 hours of collection
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SPECIMEN HANDLING

Overview of Tube Holder Sample Positions

Tube Holder #1

&

oo,

/\9)‘ A bg ) 70

Tube Holder #2

~—r
7653099A

Note: This list below is not comprehensive. It is simply provides an overview of the tube
holders and the approved collection devices and control vials they accommodate. For a
detailed list, see Appendix D in the Operator’s Guide.

Tube Holder #1 Type of Collection Device or Control Vial

Sample Position o v

Most 13 mm x 75 mm evacuated specimen tubes containing
either K3sEDTA or K,EDTA for collecting whole-blood

volumes of 2 to 5 mL

v" COULTER® ACeT™ 5diff Control Plus control tubes

Sample Position (2]

Sample Position ® -

Sample Position 0o v
Tube Holder #2

Sample Position o -

Sample Position 0 -

Sample Position e -

Sample Position (4 :

v" COULTER® ACeT™ 5diff Cal Calibrator vial

Sarstedt Monovette® 11.5 mm x 66 mm specimen tube
collecting 2.7 mL of whole-blood

Becton-Dickinson Microtainer for collection of
0.25 to 0.50 mL of whole-blood

Becton-Dickinson Microtainer for collection of
0.25 to 0.50 mL of whole-blood

Becton-Dickinson 10.25 mm x 64 mm Vacutainer® for
collecting 3 mL of whole-blood

RAM Scientific microcollection device for collecting 125 pL
of whole-blood

13 mm x 75 mm specimen tube with multiple labels
COULTER® ACeT™ 5diff Control Plus control tubes
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SAMPLE IDENTIFICATION

SAMPLE IDENTIFICATION
* Patient samples must be processed with the Run window open (click Run tab)
* Sample identifiers may be entered on the Run window or on the Worklist

Note: A worklist is a list of samples with preassigned identification and demographic
information that are pending analysis. Details about using the Worklist are covered later.

Sample ID

* Sample ID is required to process a patient sample on this instrument

* Sample identifier may be entered in the Next Sample ID field on the Run window or in
the Sample ID field on the Worklist

* Up to 16 alphanumeric characters can be entered in either field

* Must be entered before the specimen can be processed

Options for Entering Sample ID

Manual Entry
* On the Run window inside the sample identification box:

» Sample ID for the next specimen can be manually typed into the Next Sample ID
field

» Two other entries can also be made inside this box
— Panel selection for the next specimen - default is CBC/DIFF

— Patient ID for the next specimen - optional entry of up to 25 alphanumeric
characters

*  On the Worklist:
» Sample ID for the next specimen can be manually typed into the Sample ID field

» Panel selection and other demographic information can also be entered for this
patient

Optional Bar-Code Reader
* Hand-held scanner for reading the bar-code label on a specimen tube

* Sample ID may be scanned into the Sample ID Next field on the Run window or into the
Sample ID field on the Worklist

*  Operator must press the button on the bar-code reader before scanning a label

* Risk of sample misidentification if the entire barcode is not captured with the bar-code
reader, especially with the interleaved 2-of-5 bar-code format

* Position the reader over the entire barcode to capture the entire sample ID

* An audible beep indicates the barcode was read successfully

*  Verify the correctness of each bar-code reading to ensure proper sample identification
* Barcode specifications are located in Appendix B of the Operator’s Guide

* Set up is performed by your Beckman Coulter Representative
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SAMPLE IDENTIFICATION

Autonumbering Feature

Instrument automatically assigns a sample ID (from 1 to 999999)

Sample ID number automatically increments by 1 from the previously assigned number
before each analysis

Autonumbering is turned on via the Add/Edit Worklist box; however, it is not necessary
to use the Worklist to use Autonumbering

»  Click Worklist tab » LJ"}" to display the Add/Edit Worklist box

» Inside the Autonumbering box, click [J to place a v inside the box (I); this
enables the option

» Enter the starting number (1 to 999999) for the first specimen

»  Click Apply to save the change

» C(Click x to exit the box

»  Click Run tab to verify the designated starting number is in the Sample ID Next field
» When the first specimen is processed:

— Designated starting number moves to the Sample ID In Progress field

— Number in the Sample ID Next field is one digit higher

When autonumbering is enabled, the sample ID number increments inside both the
Sample ID Next field on the Run window and the Sample ID field on the Worklist

Operator may override the current autonumber as desired; autonumbering automatically
begins again with the autonumber that was overwritten

Duplicate Sample ID Check

Workstation database maintains a record of all sample IDs processed
Identifier entered in the Sample ID field is compared to the list of Reserved lot numbers

» If the number matches a Reserved lot number, corresponding entry fields are
automatically completed

» If the number does not match a Reserved lot number, the software searches for a
duplicate sample ID number throughout the current active archive then among the
sample ID numbers waiting to be processed, the number is accepted only if it is
unique

If an operator enters a sample ID that has already been used,

» Message Patient Results With Matching Sample ID Already Exist. Existing Sample ID
Cannot Be Reused. Enter Another Sample ID or Use Rerun appears

» When operator clicks 0K, the message Halted Sample Processing. If Analyzing
Samples Please Verify The Next Sample ID Before Continuing. appears
Note: This duplicate check is not performed if % (the Rerun feature) is being used.

If your laboratory sample ID sequence repeats or if your laboratory is using the
autonumbering feature and the number sequence is being restarted on a daily, weekly, or
monthly cycle, a storage process called archiving must be done on a routine basis to clear
the current memory of used sample ID numbers
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FLAGGING SETS

* Archiving process
» Resets the duplicate sample ID process so that the sample IDs can be reused

» How often your laboratory archives depends on the frequency your laboratory
repeats sample IDs - daily?, weekly?, monthly?, annually?

Note: If you repeat sample IDs on an annual basis, it is recommended that you
archive monthly. Small archives are easier to navigate through and easier to manage
than large ones. Large archives may cause the system response time to decrease.

Rerunning a Patient Sample
*  When you want to repeat a sample, must use % (system’s Rerun feature)
* Due to the duplicate ID feature, if sample ID to be repeated was manually re-entered into

the instrument, a Duplicate Sample ID message appears and specimen cannot be
processed again

* (Can indicate you want to rerun any specimen from the Results window or the Detailed
Results window

* From Run window, can indicate you want to rerun the last specimen

*  When in the Detailed Results view and the operator clicks % :

» Sample Results Status box turns red to indicate a rerun is requested on this sample

» Sample Results Status box appears in the top right of the screen, just to the right of
the Panel field

» When specimen is rerun and the rerun results are displayed, Sample Results Status
box associated with the rerun results is white which indicates the most recent set of
results

— Run can be validated (Sample Results Status box turns green)

— Once validated (confirmed acceptable to report), specimen with that sample ID
number cannot be rerun

» Sample Results Status box associated with the original results remains red to
indicate the results are the old (or previous) results; this run cannot be validated

» Either set of results may be printed and/or transmitted

* In the Results List view, the first analysis and the rerun appear in the order processed

FLAGGING SETS

* A flagging set contains patient ranges and action ranges
* If a parameter result is outside the designated range, the result is flagged
e ACeT 5diff CP hematology analyzer provides the potential for 20 different flagging sets

* At the Menu bar, select Setup » Patients » Administrator Password » Flagging and Messaging
tab to locate the available flagging sets
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FLAGGING SETS

Pre-Defined Flagging Sets
*  When installed, the system has six pre-defined flagging sets

Flagging Set Number Flagging Set Name Age Range
1 Standard Range No defined range
2 Man >12 years
3 Woman >12 years
4 Newborn 0 to <= 30 days
5 Infant 1 month to < 6 years
6 Child >= 6 years to <= 12 years

* Standard Range is the default flagging set, but can change the default selection to any of
the 20 flagging sets to meet your laboratory’s needs

*  With the exception of the Standard Range flagging set, both action and patient ranges
may be edited to best fit your laboratory’s needs

Additional Flagging Sets
* Can add up to 14 additional flagging sets (numbers 7 through 20)

*  When an operator clicks the Setup button to set up another flagging set, the Standard
Range patient and action values are automatically copied into the table for the new
flagging set; values may be edited as desired

* Action and/or Patient Limits may be copied from one flagging set to another
Flagging

Patient Ranges

* [ flag appears to the right of the parameter result that is below the lower limit in the
Patient L column

* H flag appears to the right of the parameter result that is above the upper limit in the
Patient H column

* Yellow background accompanies the flag appearing inside the parameter result field

Action Ranges

* LI flag appears to the right of the parameter result that is below the lower limit in the
Action L column

* HH flag appears to the right of the parameter result that is above the upper limit in the
Action H column

* Red background accompanies the flag appearing inside the parameter result field

* May also generate an interpretive message
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FLAGGING SETS

6

Flagging Set Hierarchy
*  Worklist may be used to assign a flagging set

* Flagging set is automatically selected based on the gender and age (or date of birth)
entered on the Worklist unless a flagging set is manually selected by the operator

If both gender and age (or date of birth) are not entered and no flagging set is specified,
the following hierarchy is used to decide which flagging set will be applied to the results
for that particular sample ID
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WORKFLOW OPTIONS

WORKFLOW OPTIONS

*  Workflow patterns on the ACeT 5diff CP hematology analyzer evolve around whether or
not your laboratory will use a Worklist

*  Worklist provides several functions that may be important to your laboratory

» Provides a way to enter patient demographics such as patient name, gender, date of
birth, age, physician’s name, clinic location, and comments so that this information
can be linked with the final results for storage

» Allows a choice of flagging sets

Worklist
* A worklist is a list of work to be done
* Worklists are used to preassign identifiers and/or demographics for specimens that are
pending analysis
» Sample ID identifier is a required entry (up to 16 alphanumeric characters)

» Demographics include optional information such as patient ID, patient name,
gender, date of birth, age, physician’s name, clinic location, and comments

» Identifiers and demographic information must be entered before running the
patient specimen

» Sample ID is the only required entry; all other entries are optional

* Host transmission protocol can be established so that demographics are automatically
downloaded from the host computer to the Worklist

* After the specimen is processed, all entered information is printed on the final report,
stored in the active archive, and transmitted to a host computer (if applicable)

* To decide if using a worklist best fits your laboratory’s needs means considering several
factors including the type of information you desire archived (stored) in your database

Database, Archive, and Worklist Relationships

* On this system, the database is like a large electronic storage “cabinet” on the
Workstation’s hard drive

e Within the database, the archive is like a “file cabinet” and the worklist like a “folder”
within the file cabinet

Database Workis

mhive
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*  Workstation database maintains a record of all sample IDs processed
*  Worklist checks for duplicate sample IDs within the active archive (current archive)

* If your laboratory sample ID sequence repeats or if your laboratory is using the
autonumbering feature and the number sequence is being restarted on a daily, weekly, or
monthly cycle, archiving must be done on a routine basis to reset the duplicate sample
ID process so that the sample IDs can be reused

» How often your laboratory archives depends on the frequency your laboratory
repeats sample IDs - daily?, weekly?, monthly?, annually?

» If sample IDs are repeated annually or not repeated at all, monthly archiving is
recommended

» Small archives are easier to navigate through and manage than large ones

» Large archives may cause the system response time to decrease

Creating an Archive
* To store patient samples, an archive must be created

e At the Menu bar, select File » New archive

* Beckman Coulter recommends a new archive be created at frequent intervals to ensure
system processing is not affected by a large current archive

*  When a new archive is created:
» Previous archive is automatically closed
» New archive is now the current or active archive
» Create a new archive at least once a month

e  When a new archive is created, the date and time are recorded and act as the identifier
for that archive and remains with the archive for as long as it exists

* Itis not possible to close an active archive without creating a new archive!
» Action of selecting File » Close archive does not close an active archive

» Only way an active archive can be closed is to create a new archive

Using the Active Archive

* All analyzed results including reproducibility, blanks, controls, and calibrators are stored
in the active archive until another new archive is created

e Ifyour laboratory created an archive it is likely you will want to retrieve those results at
some time; therefore, the identifiers your laboratory chooses to use are important

* Sample ID cannot be duplicated within an active archive without using the Rerun feature

* Preassigned identifiers and/or demographics for each specimen and the results obtained
during sample analysis are linked together and are considered as a single archived
component within the archive

» Means that when an archive is closed, the Worklist information and parameter
result information for all the samples processed while the archive was the active
archive are stored at the same time
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WORKFLOW OPTIONS

12

Opening a Closed Archive

Sample analysis is not permitted while a previously closed archive is open!

Never attempt to open a previously closed archive while the active archive is still
accumulating data

To open a previously closed archive:
» At the Menu bar, select File » Open archive
— Table listing all closed archives appears
— Archive date is the date the archive was first created
» Click on the archive you wish to open
When a closed archive is opened:

» All analyzed samples are listed in the worklist format, including reproducibility,
blanks, controls, and calibrators

» Background color changes to “light green” to indicate you are reviewing archived,
not current, information

» At the Menu bar, select File » Close archive to close the open archive

Summary

Use the Worklist if choosing a flagging set or entering patient demographics is important
(either manually or via an automatic download from your host computer)

Using the Worklist

Adding New Entries to the Worklist

Click Worklist tab » d}'rl to display the Add/Edit Worklist box

Sample ID is still a required entry (up to 16 alphanumeric characters)
CBC/DIFF panel is default selection; select CBC panel from the drop-down box if desired
Flagging Set for a patient older than 12 years

» Flagging set is automatically selected based on the age and gender entered on the
Worklist unless a flagging set is manually selected by the operator

» If both age and gender are not entered and a flagging set is not selected, the default
flagging set is automatically selected when the Worklist entry is saved

» If the age and/or gender for an existing Worklist entry is modified, the flagging set is
automatically modified to match the new age and/or gender

Flagging Set for a patient 12 years old or younger

» Flagging set is automatically selected based on the age entered on the Worklist;
gender is not considered

» If the age for an existing Worklist entry is modified, the flagging set is automatically
modified to match the new age

Collect date must follow an eight-digit format; for example, 04 02 2001
Collect time uses AM/PM format

Comment field - may enter up to 50 alphanumeric characters
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*  When Patient ID field is selected for entry:
» List of existing Patient IDs with their respective patient names are listed

» If operator selects from the list, the existing patient demographics are automatically
entered into the respective fields

» Operator may choose to make a manual entry of up to 25 alphanumeric characters
* Patient Name field - may enter up to 30 alphanumeric characters
* If no date of birth is available, operator can enter the patient’s age
* Gender

» Unknown is the default

» Male or female may be selected from a drop-down box
* Physician field

» Select name from a list of physicians or manually enter

» May enter up to 30 alphanumeric characters
* Location field

» Select name from a list of locations or manually enter

» May enter up to 15 alphanumeric characters

* Click '-Jq_}'.l to make enter another specimen

*  When last entry to Worklist is complete, click fi?‘l to save entries and exit box

* If after the last entry operator clicks '-EL?'.] then @ , blank entry is inserted on
Worklist (because @ saves and exits)
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WORKFLOW OPTIONS

Using the Autonumbering Feature with the Worklist

Instrument automatically assigns a sample ID (from 1 to 999999)

Sample ID number automatically increments by 1 from the previously assigned number
before each analysis

Autonumbering is turned on via the Add/Edit Worklist box:

> Click Worklist tab > ‘S| to display the Add/Edit Worklist box

» Inside the Autonumbering box, click [ to place a v inside the box (F); this
enables the option

» Enter the number (1 to 999999) for the first specimen

» Click Apply to save the change

» C(Click x to exit the box

» Create the Worklist
» Click Run tab to verify the designated starting number is in the Sample ID Next field
» When the first specimen is processed,

— Designated starting number moves to the Sample ID In Progress field

— Number in the Sample ID Next field is next entry on the Worklist (which
should be one digit higher)

When autonumbering is enabled, the sample ID number increments inside both the
Sample ID Next field on the Run window and the Sample ID field on the Worklist

Operator may override the current autonumber as desired; autonumbering automatically
begins again with the autonumber that was overwritten

Processing Patient Samples Using the Worklist

14

Not necessary to process patient specimens in the Worklist order
If when you check the Sample ID Next field, you want to run a different specimen:

» Manually type the desired sample ID or scan the bar-code label on its specimen tube
into the Sample ID Next field

» System automatically matches the desired sample ID with the panel and
demographic information previously entered on the Worklist

» Ready to process the specimen
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» RUNNING PATIENT SAMPLES USING THE WORKLIST SUMMARY

Note: Use this summary only if you want to use the Worklist. If you do not want to run
samples using the Worklist, use the Running Patient Samples Without Using the Worklist Summary.

Get the Workstation Ready
Click Results tab to verify only the active archive is open (background is white).
» If the background is green, an old archive is open and must be closed.
» At the Menu bar, select File » Close archive to close the old archive.

1
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If, according to your laboratory protocol, it is time to create a new archive,

select File » New archive.
Click Worklist tab.

If the Worklist is Set Up Manually

Autonumbering OFF

cie ]

Inside the Add/Edit Worklist box:

Enter sample ID:
» Click on the Sample ID field.

» Manually type the ID number
at the keyboard.
or
Scan the specimen tube’s bar-code
label with the bar-code wand.

» Verify the ID number inside the
Sample ID field is correct.

CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.

Flagging set currently selected as default
is entered; select another flagging set
from the drop-down box, if desired.

Enter comment or other patient
demographic information as desired. (If
enter gender and/or age and a flagging
set is not manually selected, the flagging
set automatically changes accordingly.)

Click '-Jq_}'.l to save entries and clear the

box for entering the identifiers and
demographics for another specimen.

When the last entry to the Worklist is

complete, click @ to save and exit.
Click Run tab.

Autonumbering ON

cie ]

Inside the Add/Edit Worklist box:

Sample ID entry is automatic.

To override the autonumber with
another sample ID:

» Highlight the autonumber in the
Sample ID field.
» Manually type the desired sample
ID number at the keyboard.
» Verify the ID number inside the
Sample ID field is correct.
Note: Autonumbering automatically
begins again with the autonumber
that was overwritten.
CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.
Flagging set currently selected as default
is entered; select another flagging set
from the drop-down box, if desired.
Enter comment or other patient
demographic information as desired. (If
enter gender and/or age and a flagging
set is not manually selected, the flagging
set automatically changes accordingly.)

Click 'il?.l to save entries and clear the

box for entering the identifiers and
demographics for another specimen.

When the last entry to the Worklist is
complete, click @ to save and exit.
Click Run tab.
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If the Worklist is Downloaded from a Host Computer

Sample ID and patient demographics are automatically downloaded from the host
computer. (Information downloaded from the host computer cannot be edited.)

Click Run tab.

IN 52 N=r

Process the Sample

Check the Sample ID Next field for the next specimen to be processed.

Note: If you want to run another specimen, manually type the sample ID or scan the
bar-code label on the specimen tube. The system automatically matches the desired
sample ID with the panel and demographic information previously entered on the
Worklist.

Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change
the tube holder.

Mix the specimen gently but thoroughly according to your laboratory’s protocol.
If the specimen tube does not have a pierceable stopper, remove the stopper.

Place the well-mixed specimen tube in the sample position that best matches the tube.
Rotate the specimen tube to the pierce position (12 o’clock position), as needed.

Close the cap-pierce door to initiate the cycle.

Remove the specimen tube when the cap-pierce door automatically opens after
aspiration is complete. Notice the red LED is still glowing, the Analyzer is busy
processing the sample.

Overlap sample processing, if desired.
» Repeat step 2 to get ready for the next cycle.
» When the cycle is complete (green LED glows steady), go to step 3.

When the Cycle is Complete

Verify the sample results appear in the Run window.

Verity the sample ID entry and results before reporting.

Click ‘¢8| for a hard copy of the results.

Note: A hard copy prints automatically if the Auto-Print function is enabled.

Repeat steps 2 and 3 until all specimens are analyzed.

> >
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» RUNNING PATIENT SAMPLES WITHOUT USING THE WORKLIST SUMMARY

Note: Use this summary only if you do not want to use the Worklist. If you want to run
samples using the Worklist, use the Running Patient Samples Using the Worklist Summary.

1 Get the Workstation Ready

Click Results tab to verify only the active archive is open (background is white).

» If the background is green, an old archive is open and must be closed.
» At the Menu bar, select File » Close archive to close the old archive.

* If, according to your laboratory protocol, it is time to create a new archive,
select File » New archive.

¢ (Click Run tab.

Autonumbering OFF Autonumbering ON
* Enter Next Sample ID: * Next Sample ID entry is automatic.
» Click on the Sample ID Next field. To override the autonumber with
» Manually type the ID number another sample ID:
at the keyboard. » Highlight the autonumber in the
or Sample ID Next field.
Scan the specimen tube’s bar-code » Manually type the desired sample
label with the bar-code wand. ID number at the keyboard.
» Verify the ID number inside the » Verify the ID number inside the
Sample ID Next field is correct. Sample ID Next field is correct.
* CBC/DIFF is the default panel selection; Note: Autqnumbering automatically
or select CBC from the drop-down box. begins again with the autonumber

that was overwritten.

* CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.

Enter a Patient ID if desired.

¢ Enter a Patient ID if desired.

IN s N=r

2 Process the Sample

*  Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change
the tube holder.

* Mix the specimen gently but thoroughly according to your laboratory’s protocol.
* If the specimen tube does not have a pierceable stopper, remove the stopper.

* Place the well-mixed specimen tube in the sample position that best matches the tube.
Rotate the specimen tube to the pierce position (12 o’clock position), as needed.

* Close the cap-pierce door to initiate the cycle.

* Remove the specimen tube when the cap-pierce door automatically opens after
aspiration is complete. Notice the red LED is still glowing, the Analyzer is busy
processing the sample.

* Overlap sample processing, if desired.
» Go to step 3 to get ready for the next cycle.

» When the current cycle is complete, go to step 4.
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3 Prepare for the Next Cycle

Enter information for the next specimen while the current sample is being analyzed.

Autonumbering OFF
Enter Next Sample ID:
» Click on the Sample ID Next field.

» Manually type the ID number
at the keyboard.
or
Scan the specimen tube’s bar-code
label with the bar-code wand.

» Verify the ID number inside the
Sample ID Next field is correct.

CBC/DIFF is the default panel selection;
select CBC from the drop-down box, if
desired.

Enter a Patient ID if desired.
If you are overlapping, go to step 2.

If you are not overlapping, when the
cycle is complete (green LED glows
steady), go to step 4.

When the Current Cycle is Complete

Autonumbering ON
Next Sample ID entry is automatic.
To override the autonumber with
another sample ID:
» Highlight the autonumber in the
Sample ID Next field.

» Manually type the desired sample
ID number at the keyboard.

» Verify the ID number inside the
Sample ID Next field is correct.

Note: Autonumbering automatically
begins again with the autonumber
that was overwritten.

CBC/DIFF is the default panel selection;
select CBC from the drop-down box, if
desired.

Enter a Patient ID if desired.
If you are overlapping, go to step 2.

If you are not overlapping, when the
cycle is complete (green LED glows
steady), go to step 4.

Verity the current sample results appear in the Run window.

Verify the sample ID entry and results before reporting.

Click ‘¢8| for a hard copy of the results.

Note: A hard copy prints automatically if the Auto-Print function is enabled.

Repeat steps 2, 3, and 4 until all specimens are analyzed.

> >
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Run Window

SAMPLE ANALYSIS
DETAILED RUN RESULTS
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File _vcles Dlagr astics Setup Help

—I

2300fL

SENASNINE > NLNe 29|
klist | Results | \]uahwA:;u;\,nar'u:eI AnalyzerfLogs |
Seq#  Sample D Patient D Fatient Name Gender Date of Bith  Panel |
172 ||345e9 456778777 [Paul willams Male 07/25/1945 | [CBC/DIFF |_
Flagging Set Run Date / Time Comment
[Man [05/29/2001 03:16:24 PM | |
[
\|w3c [51 NE 56.0 NE#
LY 34.0 LyY#
RBC |4.98 |
e 31 MO 5.5 MO#
HGB |15.4 |
T MUY EOD 4.1 EOR
HCT |449 RDW |11.2
BA 0.4 BA#
MCV IEIEI
Abs
I Flags and Messages
IE’-5 [=)- Diffplot and Histogram Flags

ATL

Sample 1D Panel Patient ID

L In progress:

— Next: 34570] CBC/DIFF

?\?T?ﬁ’

51\355998?

L —

05/2\/2000 03:22:44 P

O Runtad

0 Sample ID and Patient Demographics
© DifPiot

0 Flags and Messages Area

© DiFF Parameter Results

0 PLT Histogram
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0 RBC Histogram

Q Sample Identification Box
O wsc/BASO Histogram
@ PLT Parameter Results
@ RBC Parameter Results
@ WsC Parameter Result
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Detailed Run Window Areas

The information in this section describes the various areas of the Detailed Run Results
window. Refer to the Run window example as needed.

File Cycles Diagr\istics Setup Help
a2 g 2z ATy | § ? 99
\
‘Worklist Run | Results |Duahh,‘»‘«zu;maruzel Analyzer/Logs I
Seq# Sample ID Patient ID Patient Name Gender Date of Bith  Panel |
172 IEBS IEB??S??? |PaulWiI\iams Male |D?/25/1845 CBC/DIFF |_
Flagging Set Run Date / Time Comment
[Man [05/29/2001 03:16:24 PM | |
\ [
\‘WBE [51 ‘ NE  [560 NE#  [287
T Ly  [340 Lo [174
. MCH A
I |311 MO |5.5 MO# |U.28
HGB |15.4 MCHC |34.4
T e | | E0 [0 EOf [0z
HCT 443 RDW |11.2
I | BA 04 BA#  [002
Moy [0
PLT 171 Flags and Messages
MPY 3.5 =)~ Diffplot and Histagram Flags
— ATL
10 \\
Sample ID | Panel Patient ID
In progress:
64— Next : 34570] CBC/DIFF 5;\3559397 -
\

[ [ \ [ \ [ D5/2\2001 03:22:44 PM

Click on the Run tab @ to display the Run window.

Note: Numbers like @ are inserted to help you locate a referenced area on the Run window
(located on the previous page).

Sample ID and Patient Demographics Area ®0
* Seq#
» Sequence number
» Automatically incremented by the software

» Unique chronological number for specimen sampling

* Sample ID
» Sample identification
» Alphanumeric character field, maximum of 16 characters

» Sample ID entry may be made in the Sample ID Next field inside the Sample
Identification box on the Run window or in the Sample ID field in the Add/Edit
Worklist box prior to analysis

» Field is compared to the list of Reserved lot numbers
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* Patient ID (Optional)
» Patient identification
» Alphanumeric character field, maximum of 25 characters

» Patient ID entry may be made in the Patient ID Next field inside the Sample
Identification box on the Run window or in the Patient ID field in the Add/Edit
Worklist box

» Duplicates are allowed
» Entry must be made prior to analysis

» May enter both patient ID and patient name in the Add/Edit Worklist box, if desired

* Patient Name (Optional)
» Name of the patient
» Alphanumeric character field, maximum of 30 characters
» Entry can only be made in the Patient Name field in the Add/Edit Worklist box
» Cannot add a patient name to results with a patient ID

» If a patient ID is not entered in the Add/Edit Worklist box, patient name can be
added while the Results List or the Detailed Results view is displayed

» Entry must be made prior to analysis

» May enter both patient name and patient ID in the Add/Edit Worklist box, if desired
* Gender (Optional)

» Male or Female
» Unknown displayed when a selection is not made

» Entry can only be made in the Gender field in the Add/Edit Worklist box prior to
analysis

» Entry required if you want the software to automatically select the most appropriate
flagging set for a patient older than 12 years

— Flagging set is automatically selected based on the age and gender entered on
the Worklist unless a flagging set is manually selected by the operator

— If both age and gender are not entered and a flagging set is not selected, the
default flagging set is automatically selected when the Worklist entry is saved

— Flagging set for a patient 12 years old or younger is automatically selected
based on the age entered on the Worklist; gender is not considered

— If the age and/or gender for an existing Worklist entry is modified, the flagging
set is automatically modified to match the new age and/or gender
* Date of Birth (Optional)
» Patient date of birth

» Date is displayed in the format selected by the laboratory under Setup » System »
Date/Time

» Entry can only be made in the Date of Birth field in the Add/Edit Worklist box prior
to analysis

» Field for displaying the patient’s age does not appear on the Run window
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>

Date of birth or age entry is required if you want the software to automatically select
the most appropriate flagging set

e Panel

>

v

v

v

v

Flagging set is automatically selected based on the age and gender entered on
the Worklist unless a flagging set is manually selected by the operator

If both age and gender are not entered and a flagging set is not selected, the
default flagging set is automatically selected when the Worklist entry is saved

Flagging set for a patient 12 years old or younger is automatically selected
based on the age entered on the Worklist; gender is not considered

If the age and/or gender for an existing Worklist entry is modified, the flagging
set is automatically modified to match the new age and/or gender

Displays the panel requested for this analysis
CBC/DIFF is the default panel selection
If CBC/DIFF panel selected, typically 20 parameters are reported

CBC parameters: WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt, MPV
DIFF parameters: NE%, NE#, LY%, LY#, MO%, MO#, EO%, EO#, BA%, BA#

If RUO (Research Use Only) parameters are enabled, Pct, PDW, IMM%, IMM#,
ATL%, and ATL# are also reported

If CBC panel selected, typically 10 parameters are reported

WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt, and MPV

— If RUO (Research Use Only) parameters are enabled, Pct and PDW are also

reported

Selection may be made in the Panel field inside the Sample Identification box on the
Run window or in the Panel field in the Add/Edit Worklist box prior to analysis

e Sample Results Status Box

>
>

>

22

Provides a visual of the sample’s review status

Box may be white, red, or green

White box indicates the current (latest) set of results

Red box indicates the sample is rerun and the results you are viewing are the old (or
previous) results; these results can be printed or transmitted

Green box indicates a current sample that has been reviewed and validated

— Once sample results are validated (confirmed acceptable to report), the

specimen with that sample ID number cannot be rerun

— Clicking & while viewing sample results validates those results
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Flagging Set
» Displays the flagging set being used for the results of this patient sample

» May be the Default flagging set, a flagging set assigned by the operator, or a flagging
set automatically selected by the software based on the patient’s gender and/or age
(or date of birth)

» Flagging Set for a patient older than 12 years

— Flagging set is automatically selected based on the age and gender entered on
the Worklist unless a flagging set is manually selected by the operator

— If both age and gender are not entered and a flagging set is not selected, the
default flagging set is automatically selected when the Worklist entry is saved

— 1If the age and/or gender for an existing Worklist entry is modified, the flagging
set is automatically modified to match the new age and/or gender

» Flagging Set for a patient 12 years old or younger

— Flagging set is automatically selected based on the age entered on the Worklist;
gender is not considered

— If the age for an existing Worklist entry is modified, the flagging set is
automatically modified to match the new age

v

If the operator wants to assign a flagging set, the selection must be made in the
Flagging Set field in the Add/Edit Worklist box prior to analysis
Run Date / Time

» Displays the date and time of this run

» Displayed in the format selected by the laboratory under Setup » System » Date/Time

» Automatic entry when the specimen is actually run

Comment (Optional)
» Displays observations or remarks made by the operator
» Alphanumeric character field, maximum of 50 characters
» Can only enter remarks into the Comment field of the Add/Edit Worklist box prior

to analysis

Other patient demographics such as physician and location are not displayed on the Run
window, but do appear on the printout if entered via the Add/Edit Worklist box prior to
analysis

23
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File Cycles Diagr\istics Setup Help

[P mey [o5
I )

Sample ID__ | Panel [\ Patient ID
\

In progress:

— Next: 34570 CBC/DIFF 5;\3889387

ATL

&l | )\ 0] ] IoRy §) 29 T 2 o0 |
Waorklist R\un | Results |Duahh,‘»‘«zu;maruzel Analyzer/Logs I
Seq# Sample ID Patient ID Patient Name Gender Date of Bith  Panel |
[172 " [3a5ea [4s6778777 [Paulwiliams Male | [07/25/1345 [CBC/DIFF |_
Flagging Set Run Date / Time Comment
@\ [Man [05/29/2001 03:16:24 PM | |
\‘[WBE B ‘ NE [0 NE® 257
ABC Ly  [340 Lo [174
m\ |26 (e |ER MO |55 MO#  [028
—_Hee 154 MEHC 344 E0  [41 Eo#  [o021
HET 449 RDW [112 BA ot N
Moy [0
@ PLT 171 Flags and Messages
[=I- Diffplot and Histogram Flags
0
]

o

CBC Parameter Results Areas @ 0 0 @ m @

*  WBC parameter result @ s displayed with the WBC/BASO histogram (9

1] 30
\ | 05/22001 03:22:44 PM

* RBC parameter results (119008 displayed with the RBC histogram (7]

* Platelet parameter results D are displayed with the PLT histogram (6]

DIFF Parameter Results Area 9

* Displays percentage and absolute number for each differential parameter
» NE and NE# = Neutrophil percentage (NE) and Neutrophil absolute number (NE#)

» LY and LY# = Lymphocyte percentage (LY) and Lymphocyte absolute number (LY#)
» MO and MO# = Monocyte percentage (MO) and Monocyte absolute number (MO#)
» EO and EO# = Eosinophil percentage (EO) and Eosinophil absolute number (EO#)
» BA and BA# = Basophil percentage (BA) and Basophil absolute number (BA#)

DiffPlot ©
* Displays the major white blood cell groups

» Lymphocytes
» Monocytes
» Neutrophils

» Eosinophils

* Basophil percentage is determined from the WBC/BASO histogram. (9]
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Flags and Messages Area (4]
* Displays various DiffPlot and histogram flags

* Displays interpretive messages
» Message is triggered from the flagging limits established by laboratory protocol
» Message indicates a possible pathological disorder
* Displays analytical alarms
» Alarm in the form of a message generated by the Analyzer
» Indicates a condition that may be related to Analyzer operation
» Also indicates if results will be influenced by this condition
* Area label depends on Detailed Flags setting located under Patient Setup

» At the Menu bar, select Setup » Patients » type Administrator Password » Reports tab »
Enable » Detailed Flags

» When Detailed Flags setting is enabled, Flags and Messages label appears on Run
window

» When Detailed Flags setting is disabled, Suspect and Messages label appears on Run
window
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DATA REVIEW

OBJECTIVES

When the subject is complete, you will be able to . . .

Data Storage and Retrieval
* Explain the purpose of an archive.

* Demonstrate how to create a current, active archive.

* Explain how to know if you are viewing a current, active archive or a previously closed
archive that has been opened.

* Describe the process of sorting samples results in an archive.

* Demonstrate how to search for the results of a specific sample.

* Demonstrate how to view the detailed results for a specific sample.

* Print single sample results from an archive in the tabular and detailed format.

* Tag and batch print a group of sample results in the preferred format, tabular or detailed.

* Tag and batch transmit a group of results from an archive to a host computer, if
applicable.

Basics of CBC/DIFF Analysis
* Briefly explain the Sequential Dilution System (SDS).

» State the Coulter Principle.

* State the relationship of resistance, cell volume, and pulse height.
* Define threshold, count periods, and voting.

* Explain the concept of channelization.

* Explain how pulses are used to develop a histogram.

* Briefly explain ACV Differential Technology.

WBC Parameters
* List the individual parameters that comprise the WBC Profile.

* Identify which parameters in the WBC Profile are directly measured, derived from the
WBC/BASO histogram, derived from the DiffPlot, or computed.

* Identify the flags that occur when the WBC count results do not agree.

RBC Parameters
* List the individual parameters that comprise the RBC Profile.

* Identify which parameters in the RBC Profile are directly measured, derived from the
RBC histogram, or computed.

*  Compute MCV, MCH, and MCHC results.

* Explain the process of building an RBC histogram.

* Explain the area of the RBC histogram used to determine the RDW parameter.
* Describe a typical RBC histogram.

* Identify the flags that occur when the RBC count results do not agree.
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Plt Parameters
* List the individual parameters that comprise the PLT Profile.

* Identify which parameters in the PLT Profile are directly measured, derived from the Plt
histogram, or computed.

* Explain the purpose of rinse flow system.

* Explain the process of building a PLT histogram.

* Explain the area of a typical PLT histogram used to determine the MPV parameter result.
* Explain the area of a typical PLT histogram used to determine the PDW parameter result.
* Describe a typical PLT histogram.

* Identify the flag that occurs when the PLT count results don’t agree.

* State the condition that generates an SCL flag.

*  When the MIC flag is generated, explain how you can determine if the platelet count and
associated parameters are reliable.

Flagging

* Demonstrate how to locate details concerning flags, interpretive messages, or analytical
alarms in the Instructions For Use manual.
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v

DATA STORAGE

Database
* Database in your ACeT 5diff CP hematology analyzer is capable of storing 10,000 results

* Stored data includes patient sample, blank, reproducibility, control, and calibrator results

* Because the database capacity is large, Beckman Coulter recommends a new archive be
created on a daily, weekly, or monthly basis

» Frequency is dependent on your laboratory workload and sample ID protocol

» Small archives are easier to navigate through and easier to manage than larger ones

Database Compacting
The database can store 10,000 results. To optimize performance, the system compacts the
database each time you log in.

After 10,000 results have been stored, at the next login, the system automatically deletes the
oldest results to reduce the database to 9,500 and allow additional results to be saved.
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DATA RETRIEVAL

An operator may sort, retrieve, review, print, or transmit data stored in either the current,
active archive or a closed archive (that’s been opened)

Sort:
>> ascending
<< descending

May sort using any
column except a
parameter result or
comment column.

Archive
(Active or Open)

Individual Sample

Results List II

Batch
Samples

Tag Selected
Samples

Y

Review

Numeric Results Print
. Numeric .
Review Results Detailed
Detailed Results Only Results

Transmit

Print

Numeric
Results
Only

Detailed
Results

Transmit |

7205022A

IMPORTANT Risk of compromising system functionality if you batch print and/or batch
transmit while receiving a Worklist download from a host and/or while analyzing samples
with Auto-Transmit and Auto-Print functions turned on. Always allow sample analysis and/or
the host download to complete before batch printing and/or batch transmitting.
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» ARCHIVED DATA QUICK REFERENCE

Verify the Desired Archive is Being Used
1 Click the Results tab to display the list of sample results.

2  Is this the archive you wish to use?

* If you wish to use the current, active archive:
» A white background indicates you are viewing the current, active archive.

» Alight green background indicates you are viewing a previously closed archive
that has been opened. At the Menu bar, select File » Close archive.

* If you wish to use a previously closed archive:
Note: Do not analyze patient samples when a previously closed archive is open.

» A white background indicates you are viewing the current, active archive. At
the Menu bar, select File » Open archive then select the date for the archive you
wish to use. When the archive opens, a light green background indicates you
are viewing a previously closed archive.

» A light green background indicates you are viewing a previously closed archive
that has been opened. If you are not sure that you are viewing the archive you
wish to use, at the Menu bar:

- Select File » Close archive to close this open archive.
- Select File » Open archive, the table of closed archives appears.
- Select the date for the archive you wish to use.

3  You may choose to sort, view, print, transmit, or delete selected or all results.

4  1f you open an archive, make sure you close the archive when your work is completed.

To Sort the Results List

At the Results window, you can sort information in ascending or descending order using any
column except a parameter result or comment column. In other words, you can sort by
Sample ID but not by an analysis parameter, such as WBC, RBC, Hgb, Plt, and so forth.

1 Click the title of the column you want sorted. For example, if you wish to sort by
sample ID, click the Sample ID column title.

* >>appearing next to the title indicates an ascending (low to high) sort order.
* << appearing next to the title indicates a descending (high to low) sort order.
* Repeating sequence for sort functions:

» Click once, sort ascending with a >> symbol in the column header

» Click again, sort descending with a << symbol in the column header

» Click again, defaults back to original order

» Click again, start again with sort ascending

* Sample IDs sort alphanumerically by character. For example, 10 will appear before 4
because it is being sorted by the “1”.

* Numbers appear in a sorted list before letters. For example, Sample ID 482 will
appear before Sample ID N482 (unless sorted in descending order).
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To Search for a Specific Sample
1 Scroll through the list of results to locate the sample ID.
or

2  Use the search feature:
* Click the Search Results tab at the bottom of the Results window.
*  Click Current Archive or Closed Archive.
* Click your choice of search criteria: Sample ID, Patient ID, or Patient Name.
* Type the chosen identifier.
* (lick the Search button.

To View Sample Results

1 To view numeric results, scroll right.

* You may choose to print or transmit the numeric sample results.

2 To view detailed results (results and histograms in the Run window format):
e Double-click the desired result.

or

e (lick @ to view the selected results.

Note: Click ‘ to review the previous result or ’ to review the next result,
as desired.

*  You may choose to print or transmit the detailed sample results.

e (lick @ to return to the Results List.
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To Output Sample Data: Print and Reprint / Transmit and Retransmit

To Print a Single Sample Data Set
1 At the selected set of sample results, click &8 | display the print menu.

2 Select the desired print format:
*  Print Summary List For Selected Rows (prints numeric results only)
or

* Print Patient Report For Selected Rows (prints Run view of results and histograms)

ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch
printing and batch transmission while running the system with the Auto-Print and
Auto-Transmit functions enabled. Performing all these activities with a large active archive
may affect system processing.

To Batch Print a Group of Samples
1  Display the list of sample results.

2  While pressing the key, click on each sample you wish to print. A black dot appears
in the far left column and the sample row is highlighted to indicate the sample is
selected.

3 Click %‘ to display the print menu.

4  Select the desired print format:
*  Print Summary List For Selected Rows (prints numeric results only)
or

*  Print Patient Report For Selected Rows (prints Run view of results and histograms)

ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch
printing and batch transmission while running the system with the Auto-Print and
Auto-Transmit functions enabled. Performing all these activities with a large active archive
may affect system processing.

To Batch Transmit a Group of Samples

Note: The transmit option also allows an operator to transmit the last result and all results.

1 Click the Results tab if you have not already done so.

2 While pressing the key, click on each sample you wish to transmit. A black dot
appears in the far left column and the sample row is highlighted to indicate the sample is
selected.

3 Click ®8] to display the transmit menu.

4  Select The selected results from the transmit menu.

> >
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BASICS OF CBC/DIFF ANALYSIS

Sample Dilutions
* During aspiration, whole blood is pulled into sampling probe:

» 53 pL of whole-blood aspirated when CBC/DIFF panel selected
» 30 pL of whole-blood aspirated when CBC panel selected

» Volume of sample aspirated from the specimen tube into sampling probe is
sufficient to make all the dilutions needed to develop parameter results for selected
panel

* Aspirated sample is partitioned as it is distributed to make a series of dilutions in a series
of baths located in the right side compartment; distribution technique referred to as the
Sequential Dilution System (SDS) technique

WBC/
BASO
RBC /
DIFF

e“ b
DILIHGB | ‘;‘/7
Rinse \ /\\ / 3
\ \

» Four dilutions are made for a CBC/DIFF panel analysis, including a dilution in the:
— DIL1/HGB bath,
— DIFF bath,
— RBC bath, and
— WBC/BASO bath.
» Three dilutions are made for a CBC panel analysis, including a dilution in the:
— DIL1/HGB bath,
— RBC bath, and
— WBC/BASO bath.

» Steps required to make these dilutions are detailed in Topic 8 of this Training Guide
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Dilution Used to Determine RBC and PLT Results
* Dilution made in RBC bath used to analyze red blood cells and platelets

* RBC bath dilution prepared in two stages:

» Primary dilution: 10 pL whole-blood is diluted with 1.7 mL of diluent in the
DIL1/HGB bath to form a 1:170 dilution (commonly referred to as first dilution)

» Secondary dilution: 42.5 pL of this first dilution is transferred to the RBC bath
where it is further diluted with 2.5 mL of diluent to form final 1:10,000 dilution

e Final 1:10,000 dilution inside RBC bath is used to:

» Determine RBC count

» Develop RBC histogram which is needed to obtain the Het, MCV, and RDW

parameter results

» Determine Plt count

» Develop PIt histogram which is needed to obtain MPV, Pct, and PDW parameter

results

Summary of Technical Characteristics for Obtaining RBC and Platelet Counts

Dilution Characteristics
Primary Dilution for RBC and PIt:
Initial volume of whole-blood
Volume ACeT 5diff Diluent
Primary dilution ratio
Secondary Dilution for RBC and PIt:
Volume of primary dilution
Volume ACeT 5diff Diluent
Secondary dilution ratio
Final dilution for RBC and PIt results
Reaction temperature
Measurement Characteristics
Method of analysis
Aperture diameter
Count vacuum
Count period

10 pL
1700 pL
1:170

42.5 L

2500 pL

1:58.8

1:170 x 1:58.8 = 1:10,000
35°C (95°F)

Coulter Principle
50 pm

200 mb (5.9 in. Hg)
2 x 5 seconds
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Dilution Used to Determine the Hemoglobin Result
* Final dilution made in DIL1/HGB bath is used to determine hemoglobin parameter result

* Final dilution in the DIL1/HGB bath is prepared in three phases:

» Phase 1: 10 pL whole-blood is diluted with 1.7 mL of diluent in the DIL1/HGB bath
to form a 1:170 dilution (commonly referred to as first dilution)

» Phase 2: 42.5 pL of this first dilution is removed and 0.40 mL of diluent is added
during an external probe wash

» Phase 3: 0.4 mL of Hgb Lyse reagent is added to form final 1:250 dilution

* Hemoglobin released by lysis of the red blood cells combines with potassium cyanide to
form a cyanmethemoglobin compound

* Hemoglobin concentration is determined based on transmittance of light through the
optical part of the DIL1/HGB bath using a spectrophotometric technique at a wavelength
of 550 nm

» Transmittance of sample dilution is compared to transmittance of a reagent blank

» Analyzer calculates Hgb using the blank and sample readings

Summary of Technical Characteristics for Measurement of Hemoglobin

Dilution Characteristics

Volume of whole-blood 10 L
Volume ACeT 5diff Diluent 1700 pL
Preliminary dilution ratio 1:170

Volume of the 1:170 dilution removed 42.5 pL
(for making the RBGC/PIt dilution)

Additional volume of ACeT 5diff Diluent 400 pL

Volume of ACeT 5diff Hgb Lyse 400 pL
Final dilution for Hgb determination 1:250
Reaction temperature 35°C (95°F)

Measurement Characteristics

Method of analysis Spectrophotometry
Wavelength 550 nm
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Dilutions Used to Determine the WBC Count and Differential
* Two dilutions are required to obtain WBC count and differential parameter results:

»  WBC/BASO dilution and
» DIFF dilution

WBC/BASO Dilution
* Final 1:200 dilution is prepared by simultaneously delivering 10 pL of whole-blood and
2.0 mL of WBC Lyse reagent into WBC/BASO bath

* Final 1:200 dilution inside the WBC/BASO bath is used to:

» Determine the WBC count, and

» Develop the WBC/BASO histogram, which is needed to obtain the BASO count
*  WBC count and BASO count are determined simultaneously
*  WBC count is determined twice using two different methodologies:

» Count obtained in the WBC/BASO bath is reference WBC count

» Second WBC count is determined in the flow cell during acquisition of the DiffPlot.
The dilution analyzed in the flow cell is prepared in the DIFF bath

» WBC count results from the two methodologies are compared and if the results
exceed predefined limits, the WBC count result is flagged

Note: The comparison between the WBC count from the WBC/BASO bath and the
WBC count from the flow cell is not performed when the CBC panel is selected or
when this option is disabled in setup.

Summary of Characteristics Required to Obtain WBC and BASO Results

Dilution Characteristics

Volume of whole-blood 10 pL
Volume ACeT 5diff WBC Lyse 2,000 pL
Dilution ratio 1:200
Reaction temperature 35°C (95°F)

Measurement Characteristics

Method of analysis Coulter Principle
Aperture diameter 80 pym

Count vacuum 200 mb (5.9 in. Hg)
Count period 2 x 6 seconds
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DIFF Dilution
* Final dilution inside the DIFF bath is prepared in three phases:

» Phase 1: 25 pL of whole-blood is delivered to DIFF bath in a flow of Fix reagent

» Phase 2: During a 12 second incubation period, Fix reagent lyses the red blood
cells, stabilizes the WBC in their native forms, and differentially stains lymphocytes,
monocytes, neutrophils, and eosinophils, with the eosinophils staining most
intensely

» Phase 3: 1.0 mL of diluent is added to DIFF bath to stop the cytochemical reaction
and form final 1:80 dilution

* Final 1:80 dilution is transferred to the flow cell where each cell is measured for
impedance or resistivity (volume) and absorbance (optical detection of cytochemistry
changes)

2) Second focused flow for optical detection

4 N

&4 NN

1) Primary focused flow for impedance

* Final 1:80 dilution prepared in DIFF bath is analyzed in flow cell to:

» Develop DiffPlot from which four of five leukocyte (white blood cell) populations
are determined: lymphocytes, monocytes, neutrophils, and eosinophils
Note: In a typical whole-blood sample, the basophil population (determined in the
WBC/BASO bath) is very small compared to the other four white blood cell
populations.

» Determine a second WBC count that is compared with the reference WBC count
determined in WBC/BASO bath; if WBC count results from the two methodologies
exceed predefined limits, WBC count result is flagged
Note: The comparison between the WBC count from the WBC/BASO bath and the
WBC count from the flow cell is not performed when the CBC panel is selected or
when this option is disabled in setup.
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Volume

Eos

DiffPlot developed with optical
transmission (absorbance) on the X-axis
and volume on the Y-axis

DiffPlot used to determine four of five
leukocyte (white blood cell) populations:

* Lymphocytes (Lymph)

Debris

*  Monocytes (Mono)
* Neutrophils (Neut)
* Eosinophils (Eos)

Absorbance

Summary of Technical Characteristics for Acquisition of the DiffPlot

Dilution Characteristics

Volume of whole-blood
Volume ACeT 5diff Fix
Volume ACeT 5diff Diluent
Final dilution ratio
Reaction temperature
Incubation duration
Measurement Characteristics

Method of analysis
Aperture diameter
Diameter of the flow
Volume injected
Injection duration
Data accumulation

25 L

1000 pL
1000 pL
1:80

35°C (95°F)
12 seconds

Impedance with hydrofocus
60 pm

42 pm

72 L

15 seconds

12 seconds

14
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MEASUREMENT PRINCIPLES

The Coulter Principle

* Electronic method for counting and sizing particles based on the fact that cells, which
are poor conductors of a weak current, interrupt the current flow

* Cells, suspended in a conductive diluent, are pulled through the aperture by a low
vacuum; this creates a momentary increase in resistance to the electronic flow

* Resistance creates a pulse that is sensed and counted by the instrument as a particle;
amount of resistance (the amplitude or height of each pulse) is directly related to the size
(volume) of the particle that produced it

* Impedance variation generated by the passage of nonconductive cells through a small,
calibrated aperture is used to determine the count (number of particles) and size
(volume) of the particles passing through the aperture within a given time period

* Used to analyze the final dilutions in the RBC bath and WBC/BASQO bath:

» RBC bath aperture sensor system determines the cell count and size of red blood
cells and platelets

»  WBC/BASO bath aperture sensor system determines the cell count and size of white
blood cells. Additionally, this system differentiates between basophils and other
white blood cells as related to the WBC Lyse specific lytic action on the white blood
cells inside this bath

Aperture Sensor System

Solution to be analyzed
Vacuum
constant

Current
constant

v
Analyzing

Electrodes electronic
circuit

Pulse Time 7650331A

* To sense particles using the Coulter Principle, a current flow is established so changes in
that flow can be monitored

* In this sensing system, an electrode is placed on each side of the aperture

» Most visible electrode (referred to as counting head) is the conductive metallic
housing attached to the front of the RBC and WBC/BASO baths

» Second electrode (referred to as the bath electrode) is not as conspicuous; this
electrode is located inside the bath

» Aperture located between the counting head and the bath electrode
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When count circuit is activated and an electronically conductive reagent is in the RBC or
WBC/BASO bath, an electric current continuously passes through the aperture; current
moving between the two electrodes establishes the electronic flow through the aperture

Once a sample is aspirated, an aliquot of that aspirated sample is diluted with reagent (an
electrolyte) and is delivered to the RBC or WBC/BASO bath using tangential flow (which
ensures proper mixing of the dilution)

When cells suspended in the conductive reagent are pulled through a calibrated
aperture, electrical resistance between the two electrodes increases proportionately with
the cell volume

Resistance creates a pulse that is sensed and counted as a particle by the Analyzer

Amount of resistance (amplitude of each pulse) is directly related to the size of the
particle that produced it

Generated pulses have a very low voltage, which amplification circuit increases so that
the electronic system can better analyze the pulses and eliminate the background noise

Thresholds

7
TN 6

T5 401l
T4 351 / \_Channel4 5 5
T3 301l Channel 3 g 4
T2 25 ﬂ Channe|2 = 3
T1 201l 1 Channel 1 9

il

Thresholds are electronically set size limits
Unwanted particles, such as debris, are excluded from analysis

Particles equal to or above the threshold are analyzed and particles below the threshold
are excluded

0 5 1015 20 25 30 35 40 45 50
C1 C2 C3 C4
Femtoliters

Histogram Development

The lowest threshold (T;) is sometimes referred to as the Base Threshold

Succession of thresholds are used to sort particles by size and produce a size distribution
curve
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* Area between two adjacent thresholds is called a Channel
» Channel 1 (C1) is between T; and T,

» Channel 2 (C2) is between T, and T3, and so forth

» Each threshold represents a size

DATA REVIEW
MEASUREMENT PRINCIPLES

» For a particle to be counted in a particular channel, it must be larger than or equal
to the lower threshold but smaller than the upper threshold

* To produce a particle size distribution curve or histogram, the number of particles is
plotted on the Y-axis as Relative Number of particles and the particle size (or volume) on
the X-axis as Femtoliters (fL)

* Histogram information may be used to determine the mean (average) size of the
particles, the dispersion of particles around the mean size, and subpopulations within a

main population.

e ACeT 5diff CP instruments develop three histograms: WBC/BASO, RBC, and PLT

Acquisition and Analysis Management
* Analyzer uses three microprocessors

PN 4277205BA

*  One microprocessor acts as Master and controls other two microprocessors

* Data acquisition and analysis is accomplished in two phases:

Acquisition and Analysis Acquisition and Analysis End of Cycle
Phase 1 Phase 2 Rinse
Microprocessor #1 Differential DiffPlot Platelet
(12 seconds) (2 x 5 seconds)
Microprocessor #2 WBC/BASO RBC
(2 x 6 seconds) (2 x 5 seconds)
Master Microprocessor Hgb Sample Hgb Blank

(3 x 1 second)

17
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Phase 1

Phase 2

18

Master microprocessor directs actions of two smaller microprocessors

Lasts 12 seconds

Microprocessor #1:

>

Collects raw data from the DIFF dilution that’s being transferred and sensed inside
the flow cell

Develops the DiffPlot
Determines a second WBC count in the flow cell during acquisition of the DiffPlot

Analyzes DiffPlot to determine the percentage of neutrophils, lymphocytes,
monocytes, and eosinophils

Microprocessor #2:

>

Collects raw data as low vacuum pulls the 1:200 dilution through the 80 pm
aperture in WBC/BASO bath

Raw data for determining WBC count and BASO count is collected over two
consecutive time periods of 6-seconds each

Note: These data collection time frames are commonly referred to as either count
periods or duplicate counting.

Raw data for developing WBC/BASO histogram is collected through two
consecutive time periods of 6-seconds each (for a total of 12 seconds)

Master microprocessor again directs actions of two smaller microprocessors

Lasts 10 seconds

Microprocessor #1:

>

Collects platelet raw data as low vacuum pulls 1:10,000 dilution through the
aperture in RBC bath

Raw data for determining PLT count is collected over two consecutive time periods
of 5-seconds each (duplicate counting)

Raw data for developing PLT histogram is collected through two consecutive time
periods of 5-seconds each (for a total of 10 seconds)

Microprocessor #2:

>

Collects RBC raw data as low vacuum pulls 1:10,000 dilution through the aperture
in RBC bath

Raw data for determining RBC count is collected over two consecutive time periods
of 5-seconds each (duplicate counting)

Raw data for developing RBC histogram is collected through two consecutive time
periods of 5-seconds each (for a total of 10 seconds)

Master microprocessor:

|

»

Reads sample hemoglobin concentration in DIL1/HGB bath three different times

Later when DIL1/HGB bath drains and is filled with Rinse reagent, reads the
concentration again to determine Hgb Blank
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Voting
* Instrument generates two counts on WBC, RBC, Hct, and Plt parameters that go through
the voting process

* Voting is comparison of the two results with each other to verify results are in close
agreement:

» If they agree, final reported result is the average of the two results

» If the results differ by more than a predefined limit, WBC, RBC, Hct, or Plt result is
flagged with a voteout V flag

Voteout Flagging
* If WBC result is flagged with a V, then the DIFF number results are also flagged with a V

* If RBC result is flagged with a V, then MCV, MCH, MCHC, and RDW results are replaced

by (----- ) code
e If Hct result is flagged with a V, then MCV and MCHC results are replaced by (- -- )
code

* If Plt count votes out, then Plt result is flagged with a V

* For more information about flagging, see Chapter 9 of the Instructions For Use manual.

ACV Differential Technology
* In DIFF (differential) bath, 25 pL of whole blood is mixed with 1,000 pL of
ACeT 5diff Fix reagent for 12 seconds, then stabilized with 1,000 pL of ACeT 5diff
Diluent for an additional three seconds
* Analyzer maintains the reagents and reaction at a regulated temperature of 35°C (95°F)

* Reaction in the DIFF bath lyses red blood cells, preserves leukocytes at their original
size, and differentially stains lymphocytes, monocytes, neutrophils, and eosinophils,
with eosinophils staining most intensely

* Each stained cell is individually focused by the Dual Focused Flow (DFF) system and
transported through the flow cell using sample pressure and diluent sheath flow
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Dual Focused Flow (DFF)

Optical
Aperture window 2
1 ample
“‘*-’@2/di|ution
"\ (s‘ &
Sheath Sample “ 52 AN
stream 1 injector ) 7
Sheath Sample [~ Sheath
stream 2 stream \“'@"" fluid

by 6150444

* DFF uses sheath fluid to surround and force cells suspended in diluent to pass one at a
time through the center of the flow cell (hydrodynamic focusing process)

» First sheath flow focuses sample through the impedance aperture

» Second sheath flow maintains the focused flow of cells as they exit the aperture into
the optical flow cell

* Hydrodynamic focusing in the flow cell enables accurate and rapid cell-by-cell
measurements on a large number of individual cells

* Sequential analyses for cell volume (impedance) and light absorbance are performed in
the flow cell:

» Total of 72 pL of sample from the DIFF bath is injected through the flow cell for
15 seconds

» Data for developing the DiffPlot is accumulated 12 seconds

» Flow cell incorporates a 60 pm aperture for cellular volume analysis and about a
40 pm measurement area for light absorbance

» Flow cell lamp is a 20 watt incandescent tungsten-halogen lamp

Focused Flow Impedance

* Focused flow impedance technology measures the electrical resistance of a cell as it
passes through the aperture in the flow cell

* Change in resistance is directly proportional to volume of the cell

Absorbance Cytochemistry

* As a cell passes through the optical portion of the flow cell, light is scattered in all
directions

* Sensor detects only forward scattered light

* Optical measurement is derived as a function of the amount of light lost due to
diffraction and absorbance, as compared to full transmission when no cell is present

* Collected signals are converted into voltage pulses and are processed
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* Magnitude of the voltage pulses are proportional to the physical and chemical
characteristics of the cells being analyzed; light absorbance is related to cellular contents
(granularity, nuclear content, and so forth) after cytochemical staining

* Measurements provide the information for lymphocytes, monocytes, neutrophils, and
eosinophils, and their precursors

Signal Processing
* Signals from the flow cell aperture and from the optical measurement are correlated by a
window of time
* Optical pulse must be detected within 100 to 300 microseconds of the impedance pulse;
otherwise, the signal is rejected
* Output signals from the focused flow impedance and the light absorbance measurements
are combined to define the WBC differential population clusters

2 2
S P
§ \ :?_ [~ kli%f?o
N @
VR [ ——— - Neut =os
/\I il Lylf%n
— Absorbance Debris

7615045A /\ » | Absorbance

Thresholds
*  Most of the population partition thresholds are fixed and give the limits of the
morphological normality of leukocytes
* Changes in the morphology of a population are expressed on the DiffPlot by a shifting of
the corresponding population; volume and absorbance thresholds are used to detect
shifting populations
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WBC PARAMETERS

WBC parameter results are generated from two different dilutions:
»  WBC/BASO dilution which is made and analyzed in WBC/BASO bath and
» DIFF dilution which is made in DIFF bath but analyzed in the flow cell

WBC/BASO Dilution

WBC and basophil counts are determined from 1:200 dilution made in WBC/BASO bath

To make this dilution, 10 pL of whole blood is mixed with 2,000 pL of ACeT 5diff WBC
Lyse reagent; reaction that occurs lyses the red blood cells and specifically differentiates
between basophils and other leukocytes by volume

WBC count and BASO count are determined simultaneously from final 1:200 dilution

WBC Count

When the CBC/DIFF Panel is Selected

PN 4277205BA

Analyzer compares data from the two 6-second count periods then votes and rejects any
questionable data; this is reference WBC count

When the two counts are compared:
» If two counts agree, reference WBC count reported
WBC count = Number of cells per volume x calibration factor
WBC count displayed and printed as: WBC = N x 103 cells /pL

» If two counts differ more than predefined limit, WBC result is flagged with a V and
DIFF absolute numbers are also flagged with a V

Second WBC count is determined in the flow cell during acquisition of DiffPlot:

Note: The comparison between the WBC count from the WBC/BASO bath and the WBC
count from the flow cell is not performed when the CBC panel is selected or when this
option is disabled in setup.

» If WBC count from flow cell exceeds WBC count from WBC/BASO bath by more
than a predefined amount, DIFF+ is displayed

» If WBC count from flow cell is less than WBC count from WBC/BASO bath by more
than a predefined amount, DIFF- is displayed

» When a DIFF- or a DIFF+ flag occurs, WBC count and all DIFF# parameters are
flagged with an *

23
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When the CBC Panel is Selected

Analyzer compares data from the two 6-second count periods then votes and rejects any
questionable data; this is reference WBC count

When two counts are compared:
» If two counts agree, reference WBC count is reported
WBC count = Number of cells per volume x calibration factor
WBC count displayed and printed as: WBC = N x 103 cells /uL

» If two counts differ more than a predefined limit, WBC result is flagged with a V.and
DIFF absolute numbers are also flagged with a V

BASO Count

Differentiation between basophils and other leukocytes is obtained by means of the
ACeT 5diff WBC Lyse-specific lytic action

Raw data for developing WBC/BASO histogram is collected through two consecutive
time periods of 6-seconds each (for a total of 12 seconds)

¢ ®

|
\
\ basophils
\

T I e
7615003A

Referencing the above illustration:
» Basophils are located in the area between thresholds labeled ® and ©

» One hundred percent (100%) of the leukocytes is represented by the total number
of nucleated particles plus the basophils within area between thresholds labeled

QOand O

» Basophil percentage is calculated from number of particles existing in the area
between thresholds labeled @ and ©

BASO count = Number of cells per volume x calibration factor in a percentage relative to
the number of counted cells (basophils plus other WBC nuclei)

BASO%
BASO count = WBC% X WBC count
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DIFF Dilution

DiffPlot Development

PN 4277205BA

DiffPlot developed from analysis of 1:80 DIFF dilution

DATA REVIEW
WBC PARAMETERS

From this DiffPlot, neutrophil %, lymphocyte %, monocyte %, and eosinophil % are

determined

To make 1:80 DIFF dilution:

» 25 puL of the whole-blood sample is mixed with 1,000 pL of ACeT 5diff Fix reagent;
Fix reagent lyses the red blood cells, stabilizes the white blood cells, and
differentially stains the lymphocytes, monocytes, neutrophils, and eosinophils, with
the eosinophils staining most intensely

»  After 12 seconds of incubation, 1,000 pL of ACeT 5diff Diluent reagent added to

stop cytochemical reaction

Dilution is injected through the flow cell 15 seconds; for 12 of these 15 seconds, data for
developing the DiffPlot is accumulated

DiffPlot analysis on ACeT 5diff CP hematology analyzer based on three essential

principles:

» Dual Focused Flow (DFF) fluid dynamics, which is a process by which individual
cells or particles are focused in a stream of diluent (hydrodynamic focusing)

» Volume measurement (Coulter Principle)

» Measurement of transmitted light with zero degree (0°) angle, which permits a
response proportional to the internal structure of each cell and its absorbance

From these measurements, a DiffPlot is developed with optical transmission

(absorbance) on the X-axis and volume on the Y-axis

DiffPlot regions include:

VOLUME

Monocytes

Neutrophils

Eosinophils

ABSORBANCE
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DiffPlot Regions Defined

Study of DiffPlot permits clear differentiation of four out of five leukocyte populations

In typical whole-blood sample, basophil population is very small when compared with
the other four white cell populations

Neutrophils

Neutrophils, with their cytoplasmic granules and segmented nuclei, scatter light
according to their morphological complexity

Hypersegmented neutrophil gives an increased optical response when compared to a
young neutrophil population

Higher the complexity of the cell, the further to the right they appear in the DiffPlot

Lymphs (Lymphocytes)

Lymphocytes, typically being small with regular shape are smaller in volume and lower
in absorbance than the other cells, and are positioned in the lower region of the DiffPlot

Normal lymphocyte populations typically have a homogeneous volume with a Gaussian
(bell-shaped) distribution

Large lymphocytes, reactive lymphoid forms, stimulated lymphocytes and plasma cells
are found in the upper portion of the lymphocyte region

Lower area of the lymphocyte zone is normally empty; however, when small
lymphocytes are present, a population may exist in this area

Presence of platelet aggregates is indicated by a distribution pattern that moves from the
DiffPlot origin into the lymphocyte region

NRBC cytoplasmic membranes lyse like those of mature erythrocytes; small nuclei that
remain appear in the debris and small lymphocyte regions

Monocytes

Monocytes are typically large cells with a kidney-shaped nucleus and agranular
(granule-free) cytoplasm

Cells neither scatter nor absorb large amounts of light and, therefore, are positioned in
the lower end of the absorbance axis

Due to their size, monocytes are clearly positioned high on the volume axis

Very large monocytes may be found in the IMM (immature cell) region

Eosinophils

With reagent action, eosinophils are the most intensely stained cells for optical
separation

Due to the staining and their size, eosinophils show higher absorbance than neutrophils,
but will be of similar volume

Debris

Platelets and debris from erythrocyte lysis represent the background debris population
located in the lower region of the DiffPlot
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Immature White Blood Cells
Blasts, Myelocytes,
Promyelocytes Metamyelocytes,
Immature Neutrophils
= — _
3 Immature Eosinophils
= | Agranular Eosinophils
Monocytes / Atypical Neutrophils
) Eosinophils
Atypical Lymphs,
Blasts  ——
N |
Bands/ Neutrophils
Lymphs
|
Abnormal _—| .
Lymphs \ Debris,
—__NRBCs,
Lyse Resistant RBCs,
ABSORBANCE Plt Aggregates

Immature Granulocytes

* Immature granulocytes are detected by their larger volume and by presence of granules
that increase the intensity of scattered light

* Due to their increased volume and similar absorbance, promyelocytes, myelocytes, and
metamyelocytes are located above the neutrophil population and are typically counted as
IMM cells; IMM cells are included in the reported neutrophil value

Band Cells

* Band cells are typically larger or of similar size to the neutrophils; however, due to their
low level of cellular complexity, they absorb less light

* Band cells tend to appear in the region between the neutrophils and the monocytes

Blast Cells

* Blast cells are generally larger than monocytes and have similar absorbance

*  When blast cells are present, generally located above the monocytes, which means they
will be included in the IMM cell count

* Small blasts will be located between the normal lymphocyte and monocyte populations

DiffPlot Thresholds

*  Most of the population partition thresholds are fixed and give the limits of the
morphological normality of leukocytes
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Changes in the morphology of a population are expressed on the DiffPlot by a shifting of
the corresponding population

Volume and absorbance thresholds are used to detect shifting populations

When populations in DiffPlot exceed limits set for that region, a review (R) flag occurs
on the DIFF parameter related to that region, and either DiffPlot and Histogram flags or
Analytical Alarms occur to indicate the area within the DiffPlot that is affected

If R flag occurs on a DIFF parameter, further investigate the result

Twelve different flags may occur related to the position of the populations within the
DiffPlot:

» CO (diff reject) » UM (upper monocyte)

» DB (debris) » LN (lower neutrophil)

» SL (small lymphocytes) » UN (upper neutrophil)

» SLI (small lymphocytes 1) » NE (neutrophil/eosinophil)
» NL (neutrophil/lymphocyte) » ATL (atypical lymphocytes)
» MN (monocyte/neutrophil) » IMM (immature cells)

See the Definition of DIFF Flags table in Chapter 9 of the Instructions For Use manual
for a lists of these flags and an illustration of the affected DiffPlot region; table also lists
suspected abnormalities

Flags, Interpretive Messages, and Analytical Alarms

For details concerning flags, interpretive messages, and analytical alarms associated with
WBC parameters, see Chapter 9 of the Instructions For Use manual

To use Online Help to locate flags, interpretive messages, or analytical alarms associated
with WBC parameters:

1) Click @

2) Click on Contents; table of contents appears in left frame
3) Inside left frame, click on 9 Data Review to list headings in that chapter

4) Scroll through headings and click on heading that interests you; information
appears inside right frame

5) Scroll to locate information concerning a specific flag, interpretive message, or
analytical alarm

or
Print a copy of the information

- Right click on the messages (anywhere inside right frame)
- Click Print on the pop-up menu

- Click OK to initiate printing

Note: All the information under the primary heading is printed; locate specific
flag, interpretive message, or analytical alarm information you need
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Category Parameter Source of Data

Directly Measured WBC Differential lysis using the
(White Blood Count) Coulter Principle
BA % Differential lysis using the

(Basophil Percentage)

Coulter Principle

Derived from the DiffPlot

NE %
(Neutrophil Percentage)

LY %
(Lymphocyte Percentage)

MO %
(Monocyte Percentage)

EO %
(Eosinophil Percentage)

ACV Technology

ACV Technology

ACV Technology

ACV Technology

Computed

NE #

(Neutrophil Absolute Number)
LY #

(Lymphocyte Absolute Number)
MO #

(Monocyte Absolute Number)
EO #

(Eosinophil Absolute Number)

BA #
(Basophil Absolute Number)

Neut% x WBC
100

Lymph% x WBC
100

Mono% x WBC
100

Eos% x WBC
100

Baso% x WBC
100

PN 4277205BA
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RBC PARAMETERS

RBC Dilution
e Final 1:10,000 dilution in RBC bath that is often referred to as RBC/PLT dilution
* RBC dilution contains red blood cells, white blood cells, and platelets:

» Thresholds are used to separate platelet pulses, which are much smaller, from the
red and white blood cell pulses

» Since white blood cells fall in red blood cell size range, they are counted and sized as
RBCs

RBC Count
¢ RBC count obtained from RBC/PLT dilution in RBC bath

* To obtain an RBC count result, Analyzer compares data from the two 5-second count
periods then votes and rejects any questionable data

*  When the two counts are compared:
» If two counts agree, RBC count is reported
RBC count = Number of cells counted per volume unit x calibration factor
RBC count displayed and printed as: RBC = N x 100 cells /pL
» If two counts differ more than a predefined limit, RBC result is flagged with a V and
MCV, MCH, MCHC, and RDW parameters are replaced with (- - - - - ) code

* Since white blood cells fall in the red blood cell size range, they are counted and sized as
RBCs when this 1:10,000 dilution is analyzed

Note: The WBCs are not gated out of the count because any interference is usually
insignificant; there are normally very few WBCs (thousands) in comparison to the
number of RBCs (millions). Only when the white count is markedly elevated is the red
cell count or histogram influenced.

Hematocrit Measurement

* Height of the pulse generated by the passage of a cell through the aperture is directly
proportional to the volume of the analyzed red blood cell

* Hematocrit (Hct) is the sum of all the digitized pulses

* Collects data from the two 5-second count periods then votes and rejects any
questionable data

*  When two hematocrit results are compared:
» If two values agree, Hct result is reported
Hct = Sum of digitized pulses x calibration factor
Hct displayed and printed as a percentage (%)
» If two values differ more than a predefined limit, Hct result is flagged with a V and
MCV and MCHC parameters are replaced with (- - - - - ) code
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RBC Histogram

In addition to being counted, red blood cells are categorized according to size (from
30 fL to 300 fL) by a 256-channel pulse-height analyzer

Pulse-height analyzer uses a number of thresholds to sort the particles into several size
(volume) categories and to develop a size distribution curve of the particles

Raw data for developing the RBC histogram is collected through two consecutive time
periods of 5-seconds each (for a total of 10 seconds)

RBC distribution curve reflects the native size of the red blood cells and any other
particle in red blood cell size range

Example of an RBC histogram with a normal RBC size distribution is shown below.

N

30 300
76160364

Information Obtained Using the RBC Histogram

RBC histogram provides the information for determining a helpful descriptor of the red
cell population, RDW (Red cell Distribution Width)

RBC histogram is also used to determine if a red blood cell population is typical; if not,
descriptive flagging is generated

RDW Determination

RDW (Red cell Distribution Width) is an index of the variation or spread in the size of
the red blood cells

Study of RBC distribution detects erythrocyte anomalies linked to anisocytosis and
enables clinician to follow evolution of the width of the curve relative to the cell number
and average volume:

» Generally, as the red cell variation increases, width of the distribution curve
broadens and visible asymmetry of the distribution curve is more likely

»  Width of the distribution curve, however, does not always indicate a true increase in
size variation

RDW index more accurately detects red cell variation than a visual inspection of the
histogram (unless two distinct populations of cells are present)

Note: A primarily microcytic population of red cells (decreased MCV) tends to have a
tighter distribution (lower SD) than a normocytic population. A primarily macrocytic
population of red cells (increased MCV) tends to have a wider distribution (higher SD)
than a normocytic population.
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Displayed and printed as a percentage, RDW is calculated using the standard deviation

(SD) of the RBC population and the MCV

K SD
MY = RDW (%)
where:

K = System constant
SD = Calculated standard deviation based on the red cell distribution

MCV = Mean Cell Volume of the red cells

RBC Distribution Flags
Once RBC distribution curve is developed, two positions on the distribution curve are

located:

RBC1  RBC2

N
300

30
76160574

RBC1 and RBC2 Thresholds
* Thresholds RBC1 and RBC2 define the MICRO and MACRO regions and are calculated
based on standard deviation (SD) of the RBC population
* RBCI threshold (monitoring area for microcytes) and RBC2 threshold (monitoring area
for macrocytes) identify the points on the curve that are +2 SD from the mean

Flags
MICRO flag is generated when the percentage of cells in the microcytic region compared
to the total number of RBCs exceeds the preset default limit of 5%

* MACRO flag is generated when the percentage of cells in the macrocytic region compared

to the total number of RBCs exceeds the preset default limit of 7.5%

* Laboratory may establish its own limits to replace the preset default values
Note: The MICRO and MACRO flags are independent of the Microcytosis and Macrocytosis

flags that are generated from the Low and High patient limits.

33
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Hgb Determination

Hgb

Addition of CBC lytic reagent disrupts the red cells to free the hemoglobin which then
combines with the potassium cyanide to form a stable cyanmethemoglobin compound

Converted hemoglobin is directly measured through the optical part of the DIL1/HGB
bath using a spectrophotometric technique at a wavelength of 550 nm; the photometric
technique is based on Beer’s Law

Transmittance of the sample dilution is compared with the transmittance of a reagent
blank; system calculates the Hgb using both the blank and sample readings:

Hgb result in g/dL represents: absorbance value obtained x calibration factor
Hgb displayed and printed as: Hgb = N g/dL

Blank Reading

Hgb blank value measured during the first patient cycle after a Startup cycle is stored as a
reference blank; blank must be greater than 2.5 Vdc

During each analysis cycle, Analyzer checks the measured Hgb blank against the stored
Hgb blank reference value

Note: If the new Hgb blank reference value is within 3% of the old reference value, the
Hgb blank reference value is changed to this new value.

Sample Reading

Value is based on the sample, diluent, and Hgb Lyse reagent mixture in the DIL1I/HGB
bath during sample measurement

Hgb Specific Flags

34

If the Hgb blank value is less than 2.5 Vdc, reject (R) flag occurs on Hgb value

If difference between the new Hgb blank reference value and the original Hgb blank
reference value is greater than 3%, review (R) flag is generated

If three consecutive review (R) flags occur on the Hgb blank reference value, (- - - - - )
code replaces the Hgb, MCH, and MCHC results

For each Hgb sample read value, Analyzer takes three readings; if the difference between
these readings exceeds the predefined limits, voteout (V) flag is generated

If the [(Hgb g/dL X 3)/Hct%] is <0.8 or >1.2, the RBC, Hgb, MCV, Hct, MCH, MCHC, Plt,
MPYV, Pct, and PDW will be flagged with *. The presence of this flag indicates that there
may have been an error in the analytical process.
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Calculations

MCV Calculation
*  MCV (Mean Cell Volume) is calculated using the Hct and the RBC count
* Displayed and printed in femtoliters (fL)
* (Calculation for MCV is:
Hct
RBC

x 10 = MCV (fL)

MCH Calculation

*  MCH (Mean Cell Hemoglobin) is calculated from the Hgb value and the RBC count and
describes the average weight of hemoglobin in a red cell

* Displayed and printed in picograms (pg)
* Calculation for MCH is:
Hgb

MCHC Calculation

* MCHC (Mean Cell Hemoglobin Concentration) is calculated using the Hgb and Hct
values and describes the average concentration of hemoglobin in the red blood cells

* Displayed and printed in grams per deciliter
* Calculation for MCHC is:
Hgb

—£~ % 100 = MCHC (g/dL
Het * (g/dL)

Flags, Interpretive Messages, and Analytical Alarms
* For details concerning flags, interpretive messages, and analytical alarms associated with
RBC parameters, see Chapter 9 of the Instructions For Use manual.

* To use Online Help to locate flags, interpretive messages, or analytical alarms associated
with RBC parameters:

1) Click gl

2) Click on Contents; table of contents appears in left frame
3) Inside left frame, click on 9 Data Review to list headings in that chapter

4)  Scroll through headings and click on the heading that interests you;
information appears inside right frame

5) Scroll to locate the information concerning a specific flag, interpretive message,
or analytical alarm

or

Print a copy of the information

- Right click on the messages (anywhere inside right frame)
- Click Print on the pop-up menu

- Click OK to initiate printing

Note: All the information under the primary heading is printed. Locate the
specific flag, interpretive message, or analytical alarm information you need.
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RBC Parameters

Category

Parameter

Source of Data

Directly Measured

RBC
(Red Blood Count)

Hgb
(Hemoglobin Concentration)

Coulter Principle

Photometric Measurement

Hct Coulter Principle
(Hematocrit)
Derived from the RDW RBC Histogram

RBC Histogram

(Red Cell Distribution Width)

(Developed using the Coulter Principle)

Computed

MCV

(Mean Cell Volume)

MCH

(Mean Corpuscular Hemoglobin)

MCHC
(Mean Corpuscular Hemoglobin Concentration)

Hct x 10
RBC

Hgb x 10
RBC

Hgb x 100
Hct

36
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PLATELET PARAMETERS
RBC Dilution

* Platelet parameters are obtained from RBC dilution

e Final 1:10,000 dilution in RBC bath that is often referred to as RBC/PLT dilution
* RBC dilution contains red blood cells, white blood cells, and platelets

* Platelet counting and sizing is done in RBC bath

* Thresholds are used to separate platelet pulses, which are much smaller, from the red
and white blood cell pulses

Pit Count
e Plt count is obtained from the RBC/PLT dilution in RBC bath

* To obtain a Plt count result, Analyzer compares the data from the two 5-second count
periods then votes and rejects any questionable data

*  When two counts are compared:
» If two counts agree, Plt count reported
Plt count = Number of cells counted per volume unit x calibration factor
Plt count displayed and printed as: Plt = N x 103 cells /pL
» If two counts differ more than the predefined limit, Plt result is flagged with a V

PLT Histogram

* Platelets are categorized according to size by a 256-channel pulse-height analyzer

* Pulse-height analyzer uses a number of thresholds to sort the particles into several size
(volume) categories and to develop a size distribution curve of the particles between 2 fL
and 30 fL

* Platelet histogram reflects the native size of the platelets and any other particle in the
platelet size range

* Tllustration that follows is a PLT histogram with a typical platelet size distribution:

3 25fL 30

76160998
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Information Obtained Using the PLT Histogram
* PLT histogram provides the information for determining a helpful descriptor of the
platelet population:
» MPV (Mean Platelet Volume)
» PDW (Platelet Distribution Width)

* PLT histogram is also used to determine if a platelet population is typical; if not,
descriptive flagging is generated

MPV Measurement
*  MPV (Mean Platelet Volume) is measured directly from analysis of the platelet
distribution curve

* MPV is displayed and printed in femtoliters (fL)

PDW Determination
* PDW (Platelet Distribution Width) is determined from the PLT histogram as the width
of the curve between S1 and S2

* In the illustration that follows, shows the area of the PLT histogram that used to
determine the PDW parameter result:

-~ - 15%

15% PO
St S2

7615002A

* In this example, S1 and S2 are placed so that:
» 15% of the platelets occur between 2 fL and S1
» 15% of the platelets occur between S2 and the variable upper threshold

Note: This threshold is explained under the Detecting Abnormal Platelet
Distributions heading that follows.

» PDW result is determined on the platelets between S1 and S2
* PDW parameter result is displayed and printed as a percentage (%)

* PDW is not an FDA approved parameter; therefore, this parameter label and result are
not routinely displayed in the United States, but may be routinely displayed in other
countries
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Detecting Abnormal Platelet Distributions
* Particles of approximately platelet size can interfere with platelet histogram and count
* Small particles, such as microbubbles or dust, can overlap the low end of the histogram

*  Microcytic red cells can intrude at the upper end of the histogram

Identifying a Normal Distribution

*  When platelet histogram is being evaluated, a mobile threshold can move from its
starting position at 25 fL to 18 fL

* Computer searches for a valley between the platelet and red cell populations

* Ifno valley is detected between 18 fL and 25 fL, threshold remains at 25 fL and no flag is
generated

* In the typical platelet distribution that follows, no valley is detected between 18 fL and
25 fL, the threshold remains at 25 fL and no flag is generated:

3 25fL 30
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Microcytic Interferences on the Upper End of the Platelet Distribution Curve
*  Microcytic red cells can intrude at the upper end of the platelet distribution curve
* If specimen contains microcytes, ACeT 5diff CP hematology analyzer may be able to

successfully eliminate the influence of this interference by repositioning the variable
threshold (25 fL threshold) and excluding the microcytes

Microcytic Interference with a Distinct Valley between 18 fL and 25 fL
* Ifintrusion of microcytes creates a valley between the 25 fL and the 18 fL thresholds, the
25 fL threshold is repositioned at the valley to minimize interference to platelet
parameter results

*  When this occurs, reported platelet result is acceptable; however, MIC (microcytes) flag
appears to alert operator that microcytes are present

* Illustration that follows is an example of microcytic interference with a valley between
18 fL and 25 fL:

2 18 25fL 30

76161008

Microcytic Interference with a Valley below 18 fL

* If microcytes are extremely small so that the valley between the platelet population and
the microcyte population falls below the 18 fL limit, threshold is placed at the 18 fL limit

*  When this occurs, MIC flag appears and the platelet count is flagged to alert the operator
that the extremely small microcytes present in this sample could not be eliminated

* Platelet count and associated parameters are not reliable and should be verified by an
alternative method; to effectively eliminate the microcytes, the Instructions For Use
manual suggests the customer use platelet rich plasma (PRP) or a manual count to verify
the results

* Illustration that follows is an example of microcytic interference with a valley below
18 fL:
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3 18 25fL 30

7616101B

Interference with No Distinct Valley

* Interference present in the upper area of the platelet distribution curve that blends with
the platelet population so that there is no clear distinction between the platelets and the
interference suggest the presence of schistocytes (fragmented red cells) or platelet
aggregates (platelet clumps)

* If threshold cannot be positioned in the 25 fL to 18 fL region, threshold defaults to the
18 fL position

* SCH (schistocytes) flag appears and the platelet count is flagged to alert the operator that
the interference (which is most likely either schistocytes or platelet clumps) could not be
eliminated

* Platelet count and associated parameters are not reliable and must be verified using an
alternative method

* Illustration that follows is an example of interference with no distinct valley:

>
2 18 25fL 30

76161028
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Interference on the Lower End of the Platelet Distribution Curve
* Particles that are approximately platelet size can interfere with platelet histogram and
count
* Small particles, such as microbubbles or dust, can interfere at the low end

e If number of pulses in the 2 to 3 fL region is higher than the predefined limits, an SCL
flag appears to alert the operator that a significant number of small cells or interference,
such as microbubbles, are present

* SCL appears under the Analytical Alarms heading, “Small Cells” appears under the
Interpretive Messages heading and “...” appears in place of PLT and MPV parameter
values

* Rerun the sample and verify the results.

* Tllustration that follows is an example of interference on the lower end of the platelet
distribution curve:

w—_—_—_—_—_ o o ———
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Pct Calculation
* Pct (plateletcrit or thrombocrit) is calculated according to the formula:

Plt (10°/uL) x MPV (fL)
10, 000

* Pct parameter result displayed and printed as a percentage (%)

= Pct%

* No clinical significance has been identified for Pct parameter

* Pct (and PDW) are not FDA approved parameters; therefore, these parameter labels and
results are not routinely displayed in the United States, but may be routinely displayed in
other countries

Rinse Flow System

* Rinse flow is a steady stream of ACeT 5diff Diluent reagent that flows behind the RBC
aperture during sensing periods

*  Without rinse flow (Figure A), there is a characteristic swirling of the dilution at the
outlet of the aperture so that red (or white) cells caught up in these eddies behind the
aperture may reenter the sensing zone and produce small pulses that could be counted as
platelets

* With rinse flow (Figure B), the steady stream of diluent prevents the formation of these
eddies

waste

Cell Cell
Sensing \o ™

P -
\ ) _ Swirling K /\Sensing

effect

No Rinse
rinse flow

N flow N
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Flags, Interpretive Messages, and Analytical Alarms

* For details concerning flags, interpretive messages, and analytical alarms associated with
platelet parameters, see Chapter 9 of the Instructions For Use manual

* To use Online Help to locate flags, interpretive messages, or analytical alarms associated
with platelet parameters:

1) Click ﬁ@

2) Click on Contents; table of contents appears in left frame

3) Inside left frame, click on 9 Data Review to list headings in that chapter

4) Scroll through headings and click on the heading that interests you;
information appears inside right frame

5) Scroll to locate the information concerning a specific flag, interpretive message,
or analytical alarm

or

Print a copy of the information

- Right click on the messages (anywhere inside right frame)

- Click Print on the pop-up menu
- Click OK to initiate printing

Note: All the information under the primary heading is printed. Locate the
specific flag, interpretive message, or analytical alarm information you need.

Platelet Parameters

Category Parameter Source of Data
Directly Measured Plt Coulter Principle
(Platelet Count)

Derived from the PLT Histogram | MPV Plt Histogram

(Mean Platelet Volume)

PDW
(Platelet Distribution Width)

(Developed using the Coulter Principle)

Plt Histogram
(Developed using the Coulter Principle)

Computed

Pct
(Plateletcrit)

Plt count x MPV
10
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BASIC TROUBLESHOOTING m

OBJECTIVES

When the subject is complete, you will be able to . . .

Accessing Principal Assemblies and Component Identification
* Name each principal assembly.

* Locate and name main components.

Cycle Description
* Identify the start conditions prior to initiating a cycle.

* Identify the pierce position.
* Cite the volume of sample aspirated for a CBC/DIFF panel versus a CBC panel.

* Tell whether the bubble placed between diluent and blood during aspiration is normal or
abnormal.

* Explain how the final RBC/Plt dilution is made, including the bath locations and
reagents used in the process.

* Explain how the WBC/BASO dilution is made, including the bath location and reagents
used in the process.

* Explain how the DIFF dilution is made, including the bath location and reagents used in
the process.

* Explain what portions of the cycle are eliminated by selecting the CBC panel.
* Explain how the tangential flow or reagent mixes the sample and reagent.
* Explain the purpose of the mixing bubbles entering the DIL1/HGB bath.

* Explain the purpose of the burn circuit.

Basic Troubleshooting Techniques

* Recognize an instrument problem based on:
» Abnormal sample results.
» Abnormal Startup results.
» Abnormal control results.
» Error messages.
* Demonstrate how to access the Error Log.

* Demonstrate that you can locate the Error Messages table in the Instructions For Use
manual.

* Use what you know about normal cycle flow and the derivation of parameter results to
troubleshoot.

* Isolate the components involved, when given a symptom.
* Reproducibility check:
» Explain the purpose of this check.

» State at least one situation when performing a reproducibility check would be
beneficial.

* Properly power down and power up the system as needed.
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Preventive Maintenance

* Perform the proper maintenance procedures based either on a time schedule or on an as
needed basis.

* Demonstrate how to access the Maintenance Log.

Replacement and Adjustment Procedures

* Locate and perform selected replacement and adjustment procedures such as replacing
the flow cell lamp.
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ACCESSING PRINCIPAL ASSEMBLIES AND COMPONENT IDENTIFICATION

ACCESSING PRINCIPAL ASSEMBLIES AND COMPONENT IDENTIFICATION
Cap Pierce Module

With the Door Open

Cap pierce
module

Tube Holders

Tube Holder #1 Position Designations for Tube Holder #1
@ Sample position 1

Sample position 2

Sample position 3

\
/

Sample position 4

Tube Holder #2 Position Designations for Tube Holder #2

@ Sample position 1
Sample position 2

Sample position 3

Sample position 4

Note: For a detailed list of specimen tubes available to use with these holders, refer to Appendix D in the
Instructions For Use manual. A summarized list is also available under Topic 6 in this Training Guide.
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Accessing the Right Side Compartment

Note: Use the special key to loosen the two captive screws securing the right side panel to the
instrument frame.

Right Side Compartment Components

Component Locations

Traverse
assembly

Sampling syringe
assembly

= /Waste syringe

Diluent
reservoir

Baths
assembly

* Allows operator to access hydraulic parts for maintenance operations

* Compartment is heated to ensure cytochemical reaction of the DIFF reagent with the
whole-blood sample is consistent

* Mandatory to keep this door locked when running control or patient samples to ensure
proper heating of the dilutions
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ACCESSING PRINCIPAL ASSEMBLIES AND COMPONENT IDENTIFICATION

Baths Assembly

>

@g = WBC/BASO counting head
Q@Q\ (external electrode)

\v( RBC/PLT counting head
(external electrode)

Hgb assembly
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Accessing the Left Side Compartment
Note: Use the 3 mm Allen wrench to remove the four hex screws securing the left side panel
to the instrument frame. Do not remove this panel unless the instrument is properly powered
down using the instructions in the SYSTEM POWER DOWN SUMMARY (summary page from this
Training Guide) or the Power Down the System procedure in Chapter 5 of the Instructions For
Use manual.

catch

Captive
knobs

7205004A

Allows access to the Main card (circuit card that controls Analyzer operation)
Allows access to additional hydraulic components maintained by service

Operator must remove this panel to access the flow cell lamp housing when lamp
replacement is necessary
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Left Side Compartment Components

Component Locations

Optical bench
assembly

Count NS

syringe 4] |

DIFF syringe

bl i
assembly Reagent syringe

assembly 7205005A

Must Remove the Top Cover to Access the Flow Cell Lamp

* To remove the top cover, operator must locate and remove five screws

» Left side panel must be removed to remove one screw securing the top cover to the

instrument frame; right side door must be opened to access the second screw
» Three screws secure the top cover to the back panel

* Removal of the left side panel and top cover allows easy access to the flow cell lamp
housing located on the optical bench

PN 4277205BA
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ACCESSING PRINCIPAL ASSEMBLIES AND COMPONENT IDENTIFICATION

Flow Cell Lamp Location on the Optical Bench

7653056A

Winged

5 — metal bracket

Keyed
» — metal bracket

N\

Power

housing

* Lamp replacement procedure located in the Instructions For Use manual, Chapter 11

To use Online Help to locate this procedure:

D

2)
3)
4)

5)

Click &2/
(]

Click on Contents; table of contents appears in left frame
Inside left frame, click on 11 Diagnostics to list headings in that chapter

Scroll through headings and click on Replacing the Flow Cell Lamp; replacement
procedure appears inside the right frame

Complete procedure as written:
a) Follow the instructions on the Workstation screen
or
b) Print a copy of the instructions
- Right click on procedure (anywhere inside right frame)
- Click Print on the pop-up menu
- Click OK to initiate printing

Note: All the information under the primary heading is printed. Locate the
flow cell lamp replacement instructions and complete the procedure as written.
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CYCLE DESCRIPTION

Start Conditions

Front of the Analyzer

\

ly.

©

I\

3

7]

7

* Cap-pierce door is open

* Green LED is glowing steady indicating the instrument is ready

Baths Assembly (in the Right Side Compartment)

DIL 1 DIFF RBC BASO
HGB WBC

* All baths (except the rinse chamber) are filled with clean diluent

PN 4277205BA
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CYCLE DESCRIPTION

Initiate Cycle

* Select appropriate tube holder

* Insert tube holder on the piercing mechanism and lock it in place

* Place the specimen tube in the tube holder opening that best correlates with size of the
specimen tube:

» Specimen tube may be an open tube or may be sealed with a pierceable stopper

» For best results, specimen tube must be well mixed before placing the tube in the
tube holder

*  Verify the specimen tube is in the pierce position (12 o’clock position)
» Tube holder may be rotated (clockwise or counterclockwise) as needed
* Close door to initiate the cycle

» Before closing the door, verify the green LED is glowing steady. When the green LED
is glowing steady, the instrument is ready to process a sample

» For best results, time between placing the well-mixed specimen tube inside the tube
holder and closing the door should be minimal
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CYCLE DESCRIPTION

Aspiration

Inside the Sampling Probe

Aspiration in the CBC/DIFF Mode Aspiration in the CBC Mode
Diluent
Air bubble Diluent
L Air bubble
— 53 pL sample — 30 pL sample

* Sampling probe moves above the pierce position

* Cap pierce mechanism senses the tube holder and determines which tube slot is in the
pierce position so the sampling probe can make the appropriate downward movement:

» If specimen tube has a pierceable stopper, sampling probe pierces the stopper and
continues its downward movement until the tip is submerged in the specimen

» If specimen tube is an open vial, sampling probe makes the same downward
movement until the tip is submerged in the specimen

» If specimen tube is not in the pierce position, cap-pierce mechanism makes these
same movements but aspirates air instead of sample

*  Volume of whole-blood aspirated into the sampling probe is sufficient to make all the
dilutions needed to develop parameter results for the selected panel:

» 53 pL of whole-blood aspirated when the CBC/DIFF panel selected
» 30 pL of whole-blood aspirated when the CBC panel selected

* Green and red LEDs alternately flash while the instrument is busy aspirating required
sample volume; when aspiration is complete, red LED glows steady as the cycle
progresses

* Additionally, all baths drain
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CYCLE DESCRIPTION
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Sample Partitioning

* Using the Sequential Dilution System (SDS) technique, aspirated sample is partitioned as
it is distributed to make a series of dilutions in a series of baths

*  When CBC/DIFF panel selected, three aliquots of the aspirated whole-blood sample are
used to make the dilutions

*  When CBC panel selected, only two aliquots of the aspirated whole-blood sample are
used to make dilutions.; DIFF aliquot is not needed in the CBC mode of operation

Sample Partitions inside the Sampling Probe when CBC/DIFF Panel is Selected

Diluent

Air bubble

Not used

DIFF dilution

WBC/BASO dilution

RBC/PLT/HGB first dilution

Not used
7616001A

After aspiration, aliquots of the whole-blood sample
are distributed to the various baths as follows:

3 pL sample aliquot at the tip of the probe is
discarded into the rinse chamber as the
exterior of the sampling probe is rinsed,
ensuring sample integrity

10 pL of sample is delivered to the DIL1/HGB
bath for use in preparing the primary RBC/Plt
dilution and for measuring Hgb value

10 pL of sample is delivered to the WBC/BASO
bath for the WBC/BASO count

25 pL of sample is delivered to the DIFF bath
for development of the DiffPlot

5 pL of remaining sample is discarded into the
rinse chamber

Sample Partitions inside the Sampling Probe when CBC Panel is Selected

Diluent

Air bubble

Not used

WBC/BASO dilution

RBC/PLT/HGB first dilution

Not used
7616056A

After aspiration, aliquots of the whole-blood sample
are distributed to the various baths as follows:

3 pL sample aliquot at the tip of the probe is
discarded into the rinse chamber as the
exterior of the sampling probe is rinsed,
ensuring sample integrity

10 pL of sample is delivered to the DIL1/HGB
bath for use in preparing the primary RBC/Plt
dilution and for measuring Hgb value

10 pL of sample is delivered to the WBC/BASO
bath for the WBC/BASO count

7 pL of remaining sample is discarded into the
rinse chamber
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CYCLE DESCRIPTION

Delivery
Baths Assembly
WBC/
BASO
RBC /
DIFF | /.
DILIHGB | ‘;‘/7
Rinse \/\\/ ),

* Each aliquotted sample is delivered to its appropriate bath

* Sample and reagent are delivered simultaneously using tangential flow
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CYCLE DESCRIPTION

Tangential Flow

Probe

Reagent \

input ﬁ ( Tangential flow

Bath 7616002A

* Each aliquotted sample is delivered to its appropriate bath using a tangential flow of
reagent which mixes the diluted sample and minimizes viscosity problems

* To create this tangential flow:

» Delivery port is positioned so that reagent is delivered tangentially to the wall of the
bath (In other words, the position of the delivery port allows the reagent to flow
along walls of the bath)

» Sampling probe tip must be properly aligned with the reagent delivery port on the
bath

* Simultaneous delivery of sample and reagent at a single point on the curved wall of the
bath sets up a flow that not only produces a thoroughly mixed dilution but also sets up a
consistent swirling motion that ensures reproducible sample delivery from the probe
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Phase 1 Sample Aspiration

BASIC TROUBLESHOOTING

CYCLE DESCRIPTION

Using the Sequential Dilution System (SDS) technique, aspirated sample is partitioned as
it is distributed to make a series of dilutions in a series of baths

When a CBC/DIFF panel selected, this series of dilutions occurs in 10 phases

Note: When a CBC panel is selected, phase 5 (making the DIFF dilution) and phase 7
(stopping the DIFF reaction) are not done because the DIFF was not selected. The
elimination of these phases means the volume of reagents used in making the DIFF
dilution (1.0 mL of ACeT 5diff Fix and 1.0 mL of ACeT 5diff Diluent) are not dispensed
and wasted.

53 pL of whole-blood is aspirated into the sampling probe from the specimen tube

Note: If a CBC panel is selected, 30 uL of whole-blood is aspirated.

Aspirated Whole-Blood

Diluent

Air bubble

— 53 pL sample

Partitioned Sample

Diluent

Air bubble

— Not used

— DIFF dilution

— WBC/BASO dilution

— Not used

— RBC/PLT/HGB first dilution

7616001A
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CYCLE DESCRIPTION

Phase 2 Initial Discard and External Probe Rinse

RINSE

* Horizontal traverse assembly positions sampling probe over rinse chamber

* 3 pL sample aliquot at the tip of the sampling probe is discarded into the rinse chamber
as exterior of sampling probe is rinsed

* Discarding 3 pL aliquot of aspirated sample helps ensure sample integrity

* After rinsing the outside of the sampling probe, three aliquots of the aspirated
whole-blood sample are distributed to make the dilutions for analysis
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CYCLE DESCRIPTION

Phase 3 Make the First Dilution

* Horizontal traverse assembly positions the sampling probe over DIL1/HGB (first
dilution/Hgb) bath

* Vertical traverse assembly moves the probe downward into the bath; probe tip is
positioned to produce a tangential flow when the sample and diluent are simultaneously
dispensed into the bath

* 10 pL of the whole-blood partitioned for making the first dilution is delivered to the
DIL1/HGB bath using a tangential flow of 1.7 mL of diluent

* Tangential flow of reagent mixes the sample and the diluent; mixing bubbles enter the
bath to make a uniform suspension of cells

e This 1:170 dilution commonly referred to as the first dilution
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CYCLE DESCRIPTION

Phase 4 Make the WBC/BASO Dilution

BASO
WBC

* Horizontal traverse assembly positions sampling probe over the WBC/BASO bath

* Vertical traverse moves the probe downward into the bath; tip of the probe is positioned
so that a tangential flow occurs as the 10 pL of the whole-blood sample and 2.0 mL of
WBC Lyse are simultaneously dispensed into the bath

* Tangential flow of reagent mixes the sample and reagent; mixing bubbles enter the bath
to make a uniform suspension of cells

*  WBC Lyse destroys the red blood cells and the specific lytic action on the white blood
cells differentiates the basophils from other WBCs

e This final 1:200 dilution is used to determine the WBC count; WBC/BASO histogram,
from which the BASO % is determined, is also generated from this dilution.

WBC/BASO Bath Dilution

Whole-blood volume 10 pL
Volume of ACeT 5diff WBC Lyse reagent 2000 pL
Dilution ratio 1:200
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Phase 5 Make the DIFF Dilution

* Horizontal traverse assembly moves sampling probe over DIFF bath
* Vertical traverse assembly moves probe downward into the bath

* Tip of probe is positioned so that a tangential flow occurs as 25 pL of the whole-blood
sample and 1.0 mL of Fix reagent are simultaneously dispensed into the bath

* Tangential flow of reagent mixes the sample and the Fix reagent; mixing bubbles enter
the bath to make a uniform suspension of cells

* Fix reagent lyses the red blood cells, stabilizes the WBCs in their native form, and
differentially stains the lymphocytes, monocytes, neutrophils, and eosinophils, with the
eosinophils staining most intensely
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Phase 6 Wash the Sampling Probe

RINSE

* Horizontal traverse assembly moves sampling probe over the rinse chamber

* Double rinse (interior and exterior) of sampling probe flushes all traces of residual
whole-blood sample from the probe into rinse chamber

» Rinsing probe’s interior removes whole-blood sample that was aspirated but not
used in making the dilutions:

— In CBC/DIFF mode, 5 pL is discarded in rinse chamber
— In CBC mode, 7 pL is discarded in rinse chamber

» Rinsing probe’s exterior removes all residual whole-blood from probe’s surface
which minimizes carryover
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Phase 7 Stop the DIFF Reaction

e After 25 pL of whole-blood sample and 1.0 mL of Fix reagent incubate 12 seconds,
staining process inside DIFF bath is completed by adding another 1.0 mL of diluent
which stops the cytochemical reaction.

* This final 1:80 dilution is sent to flow cell for generation of the DiffPlot

* Neutrophil %, lymphocyte %, monocyte %, and eosinophil % are determined from this
DiffPlot

DIFF Bath Dilution

Whole-blood volume 25 L
Volume of ACeT 5diff Fix reagent 1000 pL
Volume of ACeT 5diff Diluent 1000 pL
Final dilution ratio 1:80
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Phase 8 Aspiration from the First Dilution

* Horizontal traverse assembly moves sampling probe over the DIL1/HGB bath
* Vertical traverse assembly moves probe downward into the bath

* 425 puL of the 1:170 first dilution is aspirated into the sampling probe

Rinse the QOutside of the Sampling Probe

*  While still inside the DIL1/HGB bath, exterior of sampling probe is rinsed with 0.4 mL of
diluent

* Vertical traverse assembly moves probe up out of the bath
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Phase 9 Make the RBC/PIt Dilution

* Horizontal traverse assembly moves sampling probe over the RBC bath
* Vertical traverse assembly moves probe downward into the RBC bath

* Tip of the probe is positioned so that a tangential flow occurs as the 42.5 pL of 1:170
dilution obtained from the first dilution in the DIL1/HGB bath and 0.5 mL of diluent are
simultaneously dispensed into the bath

* An additional 2.0 mL of diluent is dispensed through the probe

e This final 1:10,000 dilution is analyzed to determine RBC count and Plt count; RBC and
PLT histograms are also generated from this dilution

RBC Bath Dilution
Volume 1:170 dilution from DIL1/HGB bath 42.5 uL

Volume of ACeT 5diff Diluent reagent 2500 pL

Final dilution ratio 1:10,000
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24

Phase 10 Make the Hemoglobin Dilution

Hgb Lyse reagent
/ delivery port

* 0.4 mL of Hgb Lyse is added to the bath

* Hgb Lyse reagent rapidly destroys the red blood cells and converts a substantial

proportion of the hemoglobin to a stable pigment so a hemoglobin value can be

determined

* Mixing bubbles enter bath to ensure a uniform dilution

* Hemoglobin value is photometrically determined from this final 1:250 dilution.

DIL1/HGB Bath Dilution

First dilution

Volume of first dilution removed
Volume of ACeT 5diff Hgb Lyse reagent
Volume of ACeT 5diff Diluent reagent

Final dilution ratio

1:170
42.5 L
400 pL
400 pL
1:250
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Final Dilutions for Analysis

7205020A

CYCLE DESCRIPTION | 8

Bath Dilution Final Dilution Ratio
DIL1/HGB Step 1 10 pL whole-blood sample + 1.7 mL diluent 1:250

Step 2 42.5 pL of the first dilution removed

0.40 mL diluent added during external probe wash

Step 3 0.4 mL Hgb Lyse reagent added
DIFF Step 1 25 pL whole-blood sample + 1.0 mL Fix reagent 1:80

Step 2 12 second incubation

Step 3 1.0 mL diluent added
RBC (and PIt) 42.5 pL of the first 1:170 dilution + 2.5 mL diluent 1:10,000
WBC/BASO 10 pL whole-blood sample + 2.0 mL WBC Lyse reagent 1:200

PN 4277205BA
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CYCLE DESCRIPTION

WBC and BASO Counting

WBC/BASO
counting bath

Bath electrode /\/ R

(internal electrode)

h C@
6} Sl

) Counting head
/ (external electrode)

7
N\ 77

%

7205023A

* Final 1:200 dilution inside the WBC/BASO bath is used to:
» Determine the WBC count, and
» Develop the WBC/BASO histogram, which is needed to obtain the BASO count

e When 10 pL of whole blood is mixed with 2,000 pL of ACeT 5diff WBC Lyse reagent in
the WBC/BASO bath, this reaction lyses the red blood cells and specifically differentiates
between basophils and other leukocytes by volume

* Itis important that the Analyzer maintains the reagents and reaction at a regulated
temperature of 35°C (95°F); therefore, the right side door must remain closed
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CYCLE DESCRIPTION

Solution to be analyzed
Vacuum

constant

Current
constant

v
Analyzing

Electrodes electronic
circuit

Pulse Time 7650331A

* Count syringe supplies a constant low vacuum to the WBC/BASO bath to pull the
diluted sample through an 80 pm aperture

* As each cell passes through aperture:
» Pulse is generated proportional to the cellular volume

» Total leukocyte count and basophil percentage are determined by specific thresholds
on the WBC/BASO histogram

*  WBC count and BASO count determined simultaneously
*  WBC count is determined twice using two different methodologies:
» Count obtained in WBC/BASO bath is the reference WBC count

» Second WBC count is determined in the flow cell during acquisition of the DiffPlot;
dilution analyzed in the flow cell is prepared in the DIFF bath

» WBC count results from the two methodologies are compared and if results exceed
predefined limits, WBC count result is flagged

Note: The comparison between the WBC count from the WBC/BASO bath and the
WBC count from the flow cell is not performed when the CBC panel is selected or
when this option is disabled in setup.
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CYCLE DESCRIPTION
DIFF Analysis
—-
Waste out
Sheath 1 ~__
Sheath 2 \
Sample flow
T for analysis DIFF bath Whole-blood sample,
Fix reagent, and

g d iluent
/dluen

h [ ]
Sample flow
to fill DIFF

syringe

* Final 1:80 dilution in the DIFF bath is sent to the flow cell for generation of the DiffPlot

* Analyzer must maintain reagents and reaction at a regulated temperature of 35°C (95°F);
therefore, the right side door must remain closed

* Each stained cell is individually focused by the Dual Focused Flow (DFF) system and
transported through the flow cell using sample pressure and diluent sheath flow

e 72 pL of sample from the DIFF bath is injected through the flow cell 15 seconds;
for 12 of these 15 seconds, data for developing the DiffPlot is accumulated

5
Sampl
— ample
“@E/dnution
|
Sy (i ;'A>

™. Sheath
~HE flid
N’
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CYCLE DESCRIPTION

Optical Apert_ure

. Electrodes
window

Detector

/

Light
source

injector

Sheath stream 2 Sheath stream 2

Sheath stream 1 Sample stream

* DFF uses sheath fluid to surround and force cells suspended in diluent to pass one at a
time through the center of the flow cell (hydrodynamic focusing process)

» First sheath flow focuses the sample through the impedance aperture

» Second sheath flow maintains the focused flow of cells as they exit the aperture into
the optical flow cell

* Hydrodynamic focusing in the flow cell enables accurate and rapid cell-by-cell
measurements on a large number of individual cells

* Sequential analyses for cell volume (impedance) and light absorbance are performed in
the flow cell
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CYCLE DESCRIPTION

Incident light
(Tungsten Flowcell Detector

halogen lamp) _ N —
I
|
[
L

— No cell
I /\ No absorbance / scatter
Base line signal

Small cell
Low absorbance / scatter
Low signal

Large granular cell
High absorbance / scatter
Moderate signal

Large stained granular cell
Very high absorbance / scatter

ll‘? VL‘FLV YYYYY

- N
»

)
|

Large signal

* Lymphocytes, monocytes, neutrophils, and eosinophils each have a unique nuclear and
morphology structure and staining intensity

* Light absorbance is related to cellular contents (granularity, nuclear content, and so
forth) after cytochemical staining

* As a cell passes through the optical portion of the flow cell, light is scattered in all
directions

» Sensor detects only forward scattered light

» Optical measurement is derived as a function of the amount of light lost due to
diffraction and absorbance, as compared to full transmission when no cell is present

» Collected signals are converted into voltage pulses and are processed

» Magnitude of the voltage pulses are proportional to the physical and chemical
characteristics of the cells being analyzed

» Measurements provide information for lymphocytes, monocytes, neutrophils, and
eosinophils, and their precursors
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Absorbance Debris
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/\ » | Absorbance

* Focused flow impedance technology measures the electrical resistance of a cell as it
passes through the aperture in the flow cell; change in resistance is directly proportional
to the volume of the cell

*  Output signals from the focused flow impedance and the light absorbance measurements
are combined to define the WBC differential population clusters
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RBC/PIt Counting and Sensing

— [ RBC/PLT

counting bath
P

Aperture

~ .
Bath electrode /\/ R

(internal electrode)

. Counting head
Tl / (external electrode)
)
5 / @Q@
hD

7205024A

e Final 1:10,000 dilution in RBC bath contains red blood cells, white blood cells, and
platelets

* Thresholds are used to separate the platelet pulses, which are much smaller, from the red
and white blood cell pulses

Note: Since white blood cells fall in the red blood cell size range, they are counted and
sized as RBCs. The WBCs are not sorted out because any interference is usually
insignificant; there are normally very few WBCs (thousands) in comparison to the
number of RBCs (millions). Only when the white count is markedly elevated is the red
cell count or histogram influenced.
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CYCLE DESCRIPTION

Solution to be analyzed
Vacuum

constant

Current
constant

v
Analyzing
electronic

circuit

Electrodes

Pulse Time 7650331A

* Count syringe supplies a constant low vacuum to the RBC bath to pull the diluted
sample through a 50 um aperture
* As each cell passes through the aperture, a pulse is generated proportional to the cellular
volume
* RBC aperture senses red blood cells and platelets:
» RBC count and PLT count are determined simultaneously
» RBC histogram is developed
» PLT histogram is developed
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CYCLE DESCRIPTION
01 Diluent
RBC bath WBC/BASO bath
RBC/Plt Ri
dilution Inse
ft
T e

* Rinse flow is a steady stream of ACeT 5diff Diluent reagent that flows behind the RBC
aperture during sensing periods

*  Without rinse flow, there is a characteristic swirling of the dilution at the outlet of the
aperture so that red (or white) cells caught up in these eddies behind the aperture may
reenter the sensing zone and produce small pulses that could be counted as platelets

* With rinse flow, the steady stream of diluent prevents the formation of these eddies
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Hemoglobin Sample Reading

Hgb assembly

7205025A

Hemoglobin concentration is determined based on the transmittance of light through the
optical part of DIL1/HGB bath using a spectrophotometric technique at a wavelength of
550 nm

Three one-second readings are collected on the 1:250 dilution

Completion of the Cycle

PN 4277205BA

The WBC bath drains and fills with ACeT 5diff Rinse reagent
Hemoglobin blank is read

Transmittance of hemoglobin sample reading is compared with the transmittance of the
reagent blank

Analyzer calculates the Hgb result based on both the blank and sample readings
Green LED glows steady; red LED no longer glows

Note: It is now okay to place another specimen tube in the tube holder and close the
cap-pierce door to begin another cycle.

Main card inside the Analyzer’s left compartment sends the sample results to the
Workstation
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BASIC TROUBLESHOOTING TECHNIQUES

How to Recognize an Instrument Problem
* By the data that is generated

» Start Up
» Commercial cell controls
» XM analysis
» Patient samples
> IQAP
* By the way the instrument functions . . . abnormalities in the sample flow

* By the error messages generated and recorded on the Error Log

Error Log
* C(Click on Analyzer / Logs tab » Error Log tab to view the log

* Shortcut to viewing the Error Log

Double click on one of the System State indicators

System State

indicators
R
File Cycles Diagnostics Setup Help
sl 5l W Al] ] O 6l il © ) ad
Worklist Fun I Eesults IEH,JaIii},a‘Au;w;w,n‘aru:eI Analyzer/Lons | |
“ Qamnle D Patiant 1Ty

* Maintains most recent 100 entries displaying the most recent log entry at the top of the
log and the oldest entry at the bottom of the log

* Rollover is first in, first out when the 1015t entry is added
* Log contains the following information fields

Note: It is necessary to scroll right to see some of these fields.
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Information Fields

Field Function
Date/Time Displays the date and time the error occurred
Opr Displays the User name logon information in the Workstation when

the error was entered in the log

Category Displays the category of error that was logged, either related to the
Analyzer or Workstation

Description Displays the error reported

Comment Displays any comments entered by the operator performing the error:

* Optional entry that provides an opportunity for the operator to
type a personal observation or appraisal

* Operator may use the Add Comments button to access the Add
Comments box, as desired

o If the Prompt User For Comments check box is checked (v'), the
Add Comments box pops up automatically when an error occurs
to prompt operator to enter a comment

Note: When Add Comments box is displayed, operator cannot
access any other window until they either:

» Enter a comment then click @ to save and exit

or

» Click x to exit the box without entering a comment

Error Messages
* Error messages with corrective actions are listed in Chapter 11 of the Instructions For
Use manual

* To use Online Help to locate these messages:

1) Click @

2) Click on Contents; table of contents appears in the left frame
3) Inside the left frame, click on 11 Diagnostics to list headings in that chapter

4)  Scroll through headings and click on System Errors; messages appear inside the
right frame

5) Scroll to locate message that appears in the Error Log
or
Print a copy of the messages
- Right click on the messages (anywhere inside the right frame)
- Click Print on the pop-up menu
- Click OK to initiate printing
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Three Steps to More Efficient Troubleshooting
1 Be completely familiar with normal operation
» Start Up, Sample Analysis, Shut Down
* Normal Sample Flow
» Know what should be happening during each part of the cycle

» Become familiar with the normal sounds of operation

2 Use alogical approach to obtain a clear symptom and isolate the components involved
* Use the error message information as a starting point

* Use your knowledge of sample flow

3  Acquire the knowledge and skills necessary to locate and correct problems
* Use the instrument
* Read the manuals and become familiar with the kind of information they contain

* (Call your Beckman Coulter Representative

Troubleshooting by Instrument Subsystems
* Three instrument subsystems:

» Electronic
» Reagent
» Fluidic
» Pneumatics (pressures and vacuums)

» Hydraulics (liquids)

Electronic Subsystem
e If there’s no power,

» Check to see if one of the indicator lights is on
» Check power switches

» Check plug connections

» Check fuse locations

* If the flow cell lamp is burned out, see Chapter 11 in the Instructions For Use manual

Reagent Subsystem

Level Sensing
* Level sensing is accomplished using two different types of sensors

» ACeT 5diff Diluent reagent level sensing uses optical sensor
» Sensing waste container level uses a float-level sensor

* Cycle counters monitor levels for those reagents housed inside the reagent compartment
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Replacement Procedures
* To replace a reagent, see the Changing Reagent Summary

* To replace a waste container, see the Replacing a Waste Container Summary

* To replace a stopper assembly, see the Instructions For Use manual

Reagent Related Problems
* May be contaminated

* May be expired
* May have been frozen causing the ingredients to separate

* May be the source of electrical interference due to electrolytic characteristics

Fluidic Subsystem

Key Components

* Tubing
e Valves
* Syringes

e Solenoids

Hydraulics
* Check tubing connections and routing

» At the reagent container
» Atall associated syringe assembly
» Throughout the Diluter part of the Analyzer

* Check associated syringes, valves, and solenoids

Pneumatics
¢ Low vacuum

» Generated by the count syringe
» Equivalent to 5.9 inches of mercury
» Also called aperture vacuum

» Pulls the dilutions through the RBC and WBC apertures and sweep flow diluent
behind the RBC aperture

* Pressure

» Used for dispensing reagents from pumps, opening pinch valves, and moving air
cylinder shafts
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Troubleshooting through Cycle Observation
* To successfully troubleshoot this instrument,

» Become completely familiar with normal sample flow
» Know what should be happening during each part of the cycle
» Be familiar with the normal sounds of operation

* This type of knowledge is gained mostly through experience

* To increase your familiarity and your comfort level with the normal sample flow of this
instrument, periodically review the Cycle Description in this Training Guide or the
Sample Analysis descriptions in Chapter 2 of the Instructions For Use manual

* Key Operator should know normal sample flow well enough to verbally describe the
normal operation sequence without the aid of a document

Troubleshooting using Special Procedures

Reproducibility Check

* Check measures how close several results (from the same specimen) are to each other; in
other words, this check measures repeatability or precision

*  Check may be done using CBC or CBC/DIFF panel

* For best results, a fresh, normal whole-blood specimen must be used

*  One normal, fresh whole-blood specimen is cycled at least 5, but no more than 11 times
* CV or Coefficient of Variation is a percentage of deviation from the mean

* Results that exceed the limits appear against a red background

* Reproducibility does not measure accuracy, but true accuracy is not possible unless the
instrument is precise

* Preforming a reproducibility check before performing a calibration may catch
imprecision problems that may affect the calibration process

* Procedure is located in the Instructions For Use manual, Chapter 11

Carryover Check
* Carryover is the interaction of the previous sample with the current sample

* High to low carryover check verifies the high results of one sample do not affect the low
results of the next sample

* Check is done by analyzing a whole-blood specimen with high values followed by a
whole-blood specimen with low values; each specimen is run consecutively in triplicate

* Carryover is calculated as follows:

1st low sample — 3rd low sample

1st high sample — 3rd low sample x 100

% Carryover =
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Power Down / Power Up

When performing certain replacement procedures, it may be necessary to power down
the system to prevent personal injury from electric shock

When the system needs to be powered down, proper sequence must be followed to
prevent damage to the system

When the system is powered up, proper sequence must be followed to ensure proper
connection between Workstation and Analyzer

» SYSTEM POWER DOWN SUMMARY

1 At the Workstation

42

Click E :

Select Quit Application.
Press or click @ .

Wait while the Workstation closes its program.

When the Begin Logon box appears, press + |At) + simultaneously.
Click Shut Down at the Logon Information box.

Select Shutdown then click OK at the Shutdown Computer box.

When the It is now safe to turn off your computer message appears, power the Workstation
computer off.

2 Atthe Analyzer

Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located
at the base of the left side panel.

If a replacement or maintenance procedure that requires you to open the Analyzer panels
is being performed, unplug the ac power cord. Either remove the cord from the
instrument (at the back panel, in the lower right corner) or from the ac wall outlet.

> >
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» SYSTEM POWER UP SUMMARY

1 Preliminary Checks
e Check the waste container level.

» If the container needs to be replaced, change the container using the Replacing a
Waste Container Summary as a guide.

e If the Automatic Startup and Auto-Print functions are enabled, make sure the Printer is
ready to print.

» If the paper supply is insufficient, add paper.
» Make sure the power is ON and ready to print.

» Verify the printer is properly configured according to your laboratory’s protocol.

2 Power Up the System

At the Analyzer

* If the ac power cord is unplugged, plug the cord into the instrument (at the back panel,
in the lower right corner) or the ac wall outlet, as applicable.

* Toggle the Power ON/OFF rocker switch ON (position —). This rocker switch is located
at the base of the left side panel.

*  Verify the red LED is glowing steady.

At the Workstation
* Power ON the Workstation computer.

*  Wait while the computer performs its internal checks.

*  When the Begin Logon box appears, press + (At) + simultaneously.
* Type the User name and Password then press or click OK to log on.

* Type your 3-character (alphanumeric) Operator ID.

*  Press (Enter] or click @ .

*  Wait for the Reagents window to appear.
*  Verify the background behind the lightening bolt is green.

Note: Analyzer and Workstation should begin communicating within 30 seconds. In the
upper right corner, the right circle should also be green.

* If the Automatic Startup function is enabled, Startup automatically activates.
» Monitor the Cycle in progress : Startup status bar, as desired.
» Hard copy of Startup results prints automatically if Auto-Print function is enabled.

» Go to step 4 to review results.
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3 Prepare the System for Processing Samples

IMPORTANT Risk of inaccurate results if the Analyzer is not properly prepared. Based on the scenarios
below, perform either a Startup or Mini Prime to prepare the Analyzer. It is not necessary to do both.

« [f the system was Shutdown before the power was turned off, do a Startup.

« |f the Analyzer has set idle (not cycled) more than 4 hours, do a Startup.

« |f the Analyzer was not Shutdown and has set idle (not cycled) less than 4 hours, do a Mini Prime.
« |f the Analyzer was powered off then back on again, do a Mini Prime.

Startup

] U II-" . PR .
* Click ﬂ to initiate a Startup routine.

» Monitor the Cycle in progress : Startup status bar, as desired.
» Hard copy of Startup results prints automatically if Auto-Print function is enabled.

* Go to step 4 to review results.

Mini Prime
e At the Menu bar, select Cycles » Mini Prime.

* Cycle in progress : Mini Prime status bar provides a visual display of how close the routine
is to completion.

*  When complete, resume normal operation.

4 Review Results

* Once the Startup routine is complete, verify Passed is displayed for each parameter.

» 1f Failed appears for any parameter, click Startup Log tab to evaluate numeric results.

Note: If the Add Comments box automatically appears, click x to exit.

2 J |IJ' . .. .
» Click ﬂ to initiate another Startup routine.

» If the Startup continues to fail, contact your Beckman Coulter Representative.

* Save individual or log printout if required by your accreditation agency.

Add Comments
* If the Add Comments box appeared automatically, type in your personal observation or
appraisal as desired.
* To access the Add Comments box, click Startup Log tab » Add Comments button then type
your personal observation or appraisal inside the box.

* Click @ to save your comments.

5 Perform Quality Control Checks

* Perform quality control checks before running patient specimens according to your
laboratory’s protocol.

> >
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PREVENTIVE MAINTENANCE

* Proper maintenance of your ACeT 5diff CP hematology analyzer is the best way to ensure
proper performance

* Failure to properly execute the maintenance procedures may compromise instrument
performance

Maintenance Schedules

* Maintenance procedures you perform are based either on a time schedule or on an as
needed basis

» Startup and Shutdown are daily maintenance procedures

» (Calibration is as needed or when required by your laboratory or regulatory agency
» Replacing reagents or the rinse drain filter are as needed procedures

» Extended cleaning is an as needed procedure

* Maintenance performed by your Beckman Service Representative is based on the number
of cycles; therefore, the frequency a maintenance procedure needs to be done is driven by
your laboratory’s workload

Maintenance Log
* Click on Analyzer / Logs tab » Maintenance Log tab to view the log

* Maintains the most recent 100 entries displaying the most recent log entry at the top of
the log and the oldest entry at the bottom of the log

* Rollover is first in, first out when the 1015t entry is added

* Some maintenance procedures, such as the Extended Cleaning procedure, automatically
add entries to the Maintenance Log

* If Prompt User For Comments check box is checked (v'), user is prompted to enter a
comment

* Log contains the following information fields

Note: It is necessary to scroll right to see some of these fields.
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Information Fields

Field Function

Date/Time Displays the time and date the log entry was made, which should
correlate with when the maintenance procedure was completed

Opr Displays the User name logon information in the Workstation when
the maintenance was completed

Note: To access the New Entry Log window cited below, you must click "ﬂf—"

Action Displays the maintenance that was performed (entry made by the
operator on the New Log Entry window)

Duration Displays the time it required the operator to complete the
maintenance (entry made by the operator on the New Log Entry
window)

Comment Displays any comments entered by the operator performing the
maintenance (entry made by the operator on the New Log Entry
window)

* Optional entry that provides an opportunity for the operator to
type a personal observation or appraisal

* Some maintenance procedures, such as the Extended Cleaning
procedure, add entries automatically to the Maintenance Log

*  Operator may also use the Add Comments button to access the
Add Comments box, as desired

o If the Prompt User For Comments check box is checked (v'), the
Add Comments box pops up automatically to prompt operator to
enter a comment

Note: When Add Comments box is displayed, operator cannot
access any other window until they either:

» Enter a comment then click FV' ,J to save and exit
or

» Click x to exit the box without entering a comment

SERVICE LOG

Function is similar to that of the Maintenance Log but is used by your Beckman Coulter
Service Representative to maintain a record of the service performed on ACeT 5diff CP
hematology analyzer in your laboratory

*  Must use the Service Password to access
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SUMMARY PAGES

OVERVIEW

What are Summary Pages?
Each summary is an abbreviated reference of essential operating instructions detailed in the
Instructions For Use manual. These abbreviated instructions are referred to as either
summary pages or operational summaries.

Purpose
Each summary page is an individual, stand-alone document that is designed for use in your
laboratory as a training aid and/or as a reference tool for a trained operator.

This chapter contains a master copy of each summary page. These pages may be copied for
use during training or as quick reference guides for trained operators while operating the
instrument.

Design
These summary pages are designed for ease of use by a newly trained operator as well as an
experienced operator. As you examine these summary pages, notice that each summary
consists of two levels of detail. The first level states the actual task (usually in bold) and the
second level contains abbreviated instructions (usually in a bulleted sequence) that an
operator may need to complete that task.

A novice operator is likely to need all this information, but as an operator’s skills develop, the
bulleted instructions will be needed less and less because the operator already knows how to
complete the stated task. An experienced operator is likely to use a summary page more as a
quick reference to make sure all required steps are completed in the proper sequence.

An experienced operator may also decide to use the Daily Operations Quick Reference to
guide them through familiar daily tasks.

Presentation in This Training Guide

Since these summary pages will be helpful in training other operators in your laboratory and
since they are designed to be used as reference tools after training is complete, it is important
for you, as the Key Operator, to become proficient in the use of this tool during this training.
To eliminate the need to flip back and forth between the topic and the summary masters, the
appropriate operational summaries are inserted within each topic. When an operational
summary is inserted in the training material, a rotated chevron (3) appears to the left of the
summary page title. For example, at the point of insertion, the Startup Summary would begin
with

» Startup Summary

Since this is a stand-alone summary for use after training is complete, some of the
instructions discussed in the training topic may be repeated in the summary. Two rotated
chevrons (3 ») mark the end of the inserted summary.
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SUMMARY PAGES

CONTENTS

Since these summary pages are designed to be used as stand-alone documents, consecutive
page numbering is not used on these pages.

Most operational summaries consist of either a single-side or a double-sided page. However,
to accommodate the few summaries that are three or four pages long, the footer for each
summary shows the total number of pages —for example, 2 0f 3 appears on page 2 of a
3-page summary and 1 0f 1 appears on a single page summary.

To assist you in locating a desired summary (since the page numbering is not sequential), the
summary pages are arranged in the following order.

Routine Procedures
e Startup

* Running COULTER® ACeT™ 5diff Control Plus

* Running Patient Samples Using the Worklist

* Running Patient Samples Without Using the Worklist
* Archived Data Quick Reference

* Shutdown

e System Power Down

* System Power Up

QC File Management
* Making Changes to a Control File Currently In Use

* Control File Management

Replacement Procedures
* Changing Reagent

* Replacing a Waste Container

Reference Tools
* Icons Quick Reference

* Tube Holders Quick Reference
* Online Help System Quick Reference
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STARTUP SUMMARY -

Before starting this summary, verify both Workstation and Analyzer power are ON. If the
system is powered OFE do not use this summary. Use the System Power Up Summary instead.

1 Preliminary Checks
» If the Workstation screen is blank, power on the monitor.
* Verify the green circle is displayed in the upper right corner.
* Check the waste container level.

» If the container needs to be replaced, change the container using the Replacing a
Waste Container Summary as a guide.

* Make sure the Printer is ready to print.
» If the paper supply is insufficient, add paper.
» Make sure the power is ON and ready to print.

2 Perform the Startup
* Click ﬁ to initiate a Startup routine.

* Monitor the Cycle in progress : Startup status bar, as desired.

* Hard copy of the results prints automatically if the Auto-Print function is enabled.

3 Review Results
*  Once the Startup routine is complete, verify Passed is displayed for each parameter.

» If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.

Note: If the Add Comments box automatically appears, click x to exit.

3 L |I.) . .. .
» Click Q to initiate another Startup routine.

» If the Startup continues to fail, contact your Beckman Coulter Representative.
* Save individual or log printout if required by your accreditation agency.
* Add comments as desired.

» If the Add Comments box appeared automatically, type in your personal observation
or appraisal.

» To access the Add Comments box, click Startup Log tab » Add Comments button then
type your personal observation or appraisal inside the box.

» Click @ to save your comments.

4 Perform Quality Control Checks

* Perform quality control checks before running patient specimens according to your
laboratory’s protocol.
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RUNNING COULTER® ACeT™ 5diff CONTROL PLUS SUMMARY -

1 Get the Workstation Ready

To run controls with the Control window open To run controls with the Run window open

¢ (Click the Quality Assurance tab. *  (Click the Run tab.

*  From the Select Control drop-down Note: To use this option, the control
menu, locate the control file that lot number must be reserved. If you
correlates with the lot number of are not familiar with this protocol, use
control you wish to run. the Control window to run the

controls.

¢ Enter the control lot number as the
next Sample ID.

IN 5o (N=

2 Prepare the Control according to the Package Insert
*  Warm controls at room temperature for 15 minutes.

* Control levels may be processed in any order.
* Mix the control vial using the 8 x 8 x 8 method.
» Do not use a mechanical mixer!

» Inspect the control vial to ensure all cells are uniformly distributed, if not, repeat the
8 x 8 x 8 method of mixing again.

3 Run the Control

* At the tube holder, make sure sample position is in the pierce position (12 o’clock).
(In tube holder #1, use sample position 1; in tube holder #2, use sample position 4.)

* Place the well-mixed, closed-vial of control in sample position 1.

* Close the cap-pierce door.

4 Review Results
Note: A hard copy of the results prints automatically if the Auto-Print function is enabled.

*  Verify control results are within the acceptable ranges.
e Ifaresult is out-of-limits:
» Rerun the control after gently remixing the control vial.
or
» Refer to When CBC/DIFF Control is Outside Its Expected Ranges that follows.
* Compare the results of this run with previous runs, as desired

» To evaluate stored numerical data or evaluate the graphs for the presence of shifts or
trends, the Control window must be displayed.

» Click Quality Assurance tab to display the Control window, if needed.

PN 4277205BA 10of2



RUNNING COULTER® ACeT™ 5diff CONTROL PLUS SUMMARY

20f2

When CBC/DIFF Control is Outside Its Expected Ranges

1.

Check for a control problem.

Ensure the control material was properly mixed. If not, mix it according to the
package insert.

If the control was processed in the Control window, make sure the control file with
the correct lot number was selected.

If the control was processed in the Run window, make sure the lot number was
entered correctly and verify the lot number is reserved.

Unless you have established your own running mean and/or expected ranges, make
sure the setup information (assigned values and expected ranges) matches the
control package insert. If they do not, change the control setup information to
match the package insert.

If any of the above problems exist, rerun the control; otherwise, proceed to the next
check.

Rerun the control to determine if the out-of-limit result is a statistical outlier. If the rerun
reflects the same parameter(s) as still being out-of-control, proceed to the next check.

Ensure the control material was not contaminated by running another vial or level of
control. Follow the instructions on the package insert for proper handling. If the results
are still out, proceed to the next step.

Perform the Extended Cleaning procedure in the Instructions For Use manual,
Chapter 11.

Use the Online Help to locate this procedure:

a.

b.

C.

f.

Click 2.
)
Click on Contents. The table of contents appears in the left frame.

Inside the left frame, click on 11 Diagnestics to list the headings in that chapter.

Scroll through the headings and click on Extended Cleaning. The cleaning procedure
appears inside the right frame.

Complete the procedure.

» Follow the instructions on the Workstation screen.
or

» Print a copy of the instructions.
- Right click on the procedure (anywhere inside the right frame).
- Click Print on the pop-up menu.
- Click OK to initiate printing.

Note: All the information under the primary heading is printed. Locate the
Extended Cleaning instructions and complete the procedure as written.

Rerun the control.

» If the results are acceptable, run other control levels that need to be processed
then resume normal operation.

» If the results are still out, call your Beckman Coulter Representative to help you
troubleshoot.
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RUNNING PATIENT SAMPLES USING THE WORKLIST SUMMARY -

Note: Use this summary only if you want to use the Worklist. If you do not want to run
samples using the Worklist, use the Running Patient Samples Without Using the Worklist Summary.

1 Get the Workstation Ready
* Click Results tab to verify only the active archive is open (background is white).

» If the background is green, an old archive is open and must be closed.
» At the Menu bar, select File » Close archive to close the old archive.

* 1If, according to your laboratory protocol, it is time to create a new archive,
select File » New archive.

e (Click Worklist tab.

If the Worklist is Set Up Manually
Autonumbering OFF

* Click ﬁ :

Inside the Add/Edit Worklist box:

Autonumbering ON

* (lick ﬁ .

Inside the Add/Edit Worklist box:

* Enter sample ID: .

» Click on the Sample ID field.

» Manually type the ID number
at the keyboard.
or
Scan the specimen tube’s bar-code
label with the bar-code wand.

» Verify the ID number inside the
Sample ID field is correct.
CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.
Flagging set currently selected as default
is entered; select another flagging set
from the drop-down box, if desired.

Enter comment or other patient
demographic information as desired. (If
enter gender and/or age and a flagging
set is not manually selected, the flagging
set automatically changes accordingly.)

Click '-Jq_}'.l to save entries and clear the

box for entering the identifiers and
demographics for another specimen.

When the last entry to the Worklist is

complete, click @ to save and exit.
Click Run tab.

Sample ID entry is automatic.

To override the autonumber with
another sample ID:

» Highlight the autonumber in the
Sample ID field.

» Manually type the desired sample
ID number at the keyboard.

» Verify the ID number inside the
Sample ID field is correct.
Note: Autonumbering automatically
begins again with the autonumber
that was overwritten.

CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.

Flagging set currently selected as default
is entered; select another flagging set
from the drop-down box, if desired.

Enter comment or other patient
demographic information as desired. (If
enter gender and/or age and a flagging
set is not manually selected, the flagging
set automatically changes accordingly.)

Click '-Jq_}'.l to save entries and clear the

box for entering the identifiers and
demographics for another specimen.

When the last entry to the Worklist is
complete, click @ to save and exit.
Click Run tab.
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| RUNNING PATIENT SAMPLES USING THE WORKLIST SUMMARY

20f2

If the Worklist is Downloaded from a Host Computer

Sample ID and patient demographics are automatically downloaded from the host
computer. (Information downloaded from the host computer cannot be edited.)

Click Run tab.

IN 52 N=r

Process the Sample

Check the Sample ID Next field for the next specimen to be processed.

Note: If you want to run another specimen, manually type the sample ID or scan the
bar-code label on the specimen tube. The system automatically matches the desired
sample ID with the panel and demographic information previously entered on the
Worklist.

Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change
the tube holder.

Mix the specimen gently but thoroughly according to your laboratory’s protocol.
If the specimen tube does not have a pierceable stopper, remove the stopper.

Place the well-mixed specimen tube in the sample position that best matches the tube.
Rotate the specimen tube to the pierce position (12 o’clock position), as needed.

Close the cap-pierce door to initiate the cycle.

Remove the specimen tube when the cap-pierce door automatically opens after
aspiration is complete. Notice the red LED is still glowing, the Analyzer is busy
processing the sample.

Overlap sample processing, if desired.
» Repeat step 2 to get ready for the next cycle.
» When the cycle is complete (green LED glows steady), go to step 3.

When the Cycle is Complete

Verify the sample results appear in the Run window.

Verify the sample ID entry and results before reporting.

Click | for a hard copy of the results.

Note: A hard copy prints automatically if the Auto-Print function is enabled.

Repeat steps 2 and 3 until all specimens are analyzed.
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RUNNING PATIENT SAMPLES WITHOUT USING THE WORKLIST SUMMARY -

Note: Use this summary only if you do not want to use the Worklist. If you want to run
samples using the Worklist, use the Running Patient Samples Using the Worklist Summary.

1 Get the Workstation Ready

Click Results tab to verify only the active archive is open (background is white).

» If the background is green, an old archive is open and must be closed.
» At the Menu bar, select File » Close archive to close the old archive.

* If, according to your laboratory protocol, it is time to create a new archive,
select File » New archive.

¢ (Click Run tab.

Autonumbering OFF Autonumbering ON
* Enter Next Sample ID:

> Click on the Sample ID Next field. To override the autonumber with

» Manually type the ID number another sample ID:
at the keyboard.

* Next Sample ID entry is automatic.

» Highlight the autonumber in the

or .
Sample ID Next field.
Scan the specimen tube’s bar-code P

label with the bar-code wand. » Manually type the desired sample

ID ber at the keyboard.
»  Verify the ID number inside the humber at the keyboar

Sample ID Next field is correct.

CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.

» Verify the ID number inside the
Sample ID Next field is correct.

Note: Autonumbering automatically
begins again with the autonumber
that was overwritten.

* CBC/DIFF is the default panel selection;
or select CBC from the drop-down box.

Enter a Patient ID if desired.

e Enter a Patient ID if desired.

&
N i (N=r
2 Process the Sample

*  Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change
the tube holder.

* Mix the specimen gently but thoroughly according to your laboratory’s protocol.
* If the specimen tube does not have a pierceable stopper, remove the stopper.

* Place the well-mixed specimen tube in the sample position that best matches the tube.
Rotate the specimen tube to the pierce position (12 o’clock position), as needed.

* Close the cap-pierce door to initiate the cycle.

* Remove the specimen tube when the cap-pierce door automatically opens after
aspiration is complete. Notice the red LED is still glowing, the Analyzer is busy
processing the sample.

* Overlap sample processing, if desired.
» Go to step 3 to get ready for the next cycle.

» When the current cycle is complete, go to step 4.
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RUNNING PATIENT SAMPLES WITHOUT USING THE WORKLIST SUMMARY

20f2

3 Prepare for the Next Cycle

Enter information for the next specimen while the current sample is being analyzed.

Autonumbering OFF
Enter Next Sample ID:
» Click on the Sample ID Next field.

» Manually type the ID number
at the keyboard.
or
Scan the specimen tube’s bar-code
label with the bar-code wand.

» Verify the ID number inside the
Sample ID Next field is correct.

CBC/DIFF is the default panel selection;
select CBC from the drop-down box, if
desired.

Enter a Patient ID if desired.
If you are overlapping, go to step 2.

If you are not overlapping, when the
cycle is complete (green LED glows
steady), go to step 4.

When the Current Cycle is Complete

Autonumbering ON

Next Sample ID entry is automatic.

To override the autonumber with
another sample ID:

» Highlight the autonumber in the
Sample ID Next field.

» Manually type the desired sample
ID number at the keyboard.

» Verify the ID number inside the
Sample ID Next field is correct.

Note: Autonumbering automatically
begins again with the autonumber
that was overwritten.
CBC/DIFF is the default panel selection;
select CBC from the drop-down box, if
desired.

Enter a Patient ID if desired.
If you are overlapping, go to step 2.

If you are not overlapping, when the
cycle is complete (green LED glows
steady), go to step 4.

Verify the current sample results appear in the Run window.

Verity the sample ID entry and results before reporting.

Click ¢8| for a hard copy of the results.

Note: A hard copy prints automatically if the Auto-Print function is enabled.

Repeat steps 2, 3, and 4 until all specimens are analyzed.
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ARCHIVED DATA QUICK REFERENCE -

Verify the Desired Archive is Being Used
1 Click the Results tab to display the list of sample results.

2 Is this the archive you wish to use?
* If you wish to use the current, active archive:
» A white background indicates you are viewing the current, active archive.

» Alight green background indicates you are viewing a previously closed archive
that has been opened. At the Menu bar, select File » Close archive.

* If you wish to use a previously closed archive:
Note: Do not analyze patient samples when a previously closed archive is open.

» A white background indicates you are viewing the current, active archive. At
the Menu bar, select File » Open archive then select the date for the archive you
wish to use. When the archive opens, a light green background indicates you
are viewing a previously closed archive.

» Alight green background indicates you are viewing a previously closed archive
that has been opened. If you are not sure that you are viewing the archive you
wish to use, at the Menu bar:

- Select File » Close archive to close this open archive.
- Select File » Open archive, the table of closed archives appears.

- Select the date for the archive you wish to use.
3  You may choose to sort, view, print, transmit, or delete selected or all results.

4  1f you open an archive, make sure you close the archive when your work is completed.

To Sort the Results List

At the Results window, you can sort information in ascending or descending order using any
column except a parameter result or comment column. In other words, you can sort by
Sample ID but not by an analysis parameter, such as WBC, RBC, Hgb, Plt, and so forth.

1 Click the title of the column you want sorted. For example, if you wish to sort by
sample ID, click the Sample ID column title.

* >>appearing next to the title indicates an ascending (low to high) sort order.
* << appearing next to the title indicates a descending (high to low) sort order.
* Repeating sequence for sort functions:

» Click once, sort ascending with a >> symbol in the column header

» Click again, sort descending with a << symbol in the column header

» Click again, defaults back to original order

» Click again, start again with sort ascending

* Sample IDs sort alphanumerically by character. For example, 10 will appear before 4
because it is being sorted by the “1”.

* Numbers appear in a sorted list before letters. For example, Sample ID 482 will
appear before Sample ID N482 (unless sorted in descending order).
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ARCHIVED DATA QUICK REFERENCE

To Search for a Specific Sample
1 Scroll through the list of results to locate the sample ID.
or

2  Use the search feature:
* Click the Search Results tab at the bottom of the Results window.
*  Click Current Archive or Closed Archive.
* Click your choice of search criteria: Sample ID, Patient ID, or Patient Name.
* Type the chosen identifier.
* (lick the Search button.

To View Sample Results

1 To view numeric results, scroll right.

* You may choose to print or transmit the numeric sample results.

2 To view detailed results (results and histograms in the Run window format):
e Double-click the desired result.

or

e (lick @ to view the selected results.

Note: Click ‘ to review the previous result or ’ to review the next result,
as desired.

*  You may choose to print or transmit the detailed sample results.

e (lick @ to return to the Results List.
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ARCHIVED DATA QUICK REFERENCE

To Output Sample Data: Print and Reprint / Transmit and Retransmit

To Print a Single Sample Data Set
1 At the selected set of sample results, click &8 | display the print menu.

2 Select the desired print format:
*  Print Summary List For Selected Rows (prints numeric results only)
or

* Print Patient Report For Selected Rows (prints Run view of results and histograms)

ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch
printing and batch transmission while running the system with the Auto-Print and
Auto-Transmit functions enabled. Performing all these activities with a large active archive
may affect system processing.

To Batch Print a Group of Samples
1  Display the list of sample results.

2 While pressing the key, click on each sample you wish to print. A black dot appears
in the far left column and the sample row is highlighted to indicate the sample is
selected.

3 Click &#] w0 display the print menu.

4  Select the desired print format:
*  Print Summary List For Selected Rows (prints numeric results only)
or

* Print Patient Report For Selected Rows (prints Run view of results and histograms)

ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch
printing and batch transmission while running the system with the Auto-Print and
Auto-Transmit functions enabled. Performing all these activities with a large active archive
may affect system processing.

To Batch Transmit a Group of Samples

Note: The transmit option also allows an operator to transmit the last result and all results.

1 Click the Results tab if you have not already done so.

2 While pressing the key, click on each sample you wish to transmit. A black dot
appears in the far left column and the sample row is highlighted to indicate the sample is
selected.

3 Click ®8] to display the transmit menu.

4  Select The selected results from the transmit menu.
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1 Perform Instrument Shutdown

il to initiate a Shutdown routine.

* Monitor the Cycle in progress : Shutdown status bar, as desired.

2 Shut Down Computer then Power Off Analyzer and PC

When Shutdown is complete, a message box appears:

Ac.T 5diff Workstation Information

Shutdown cycle completed. Press OK to Shutdown computer.
During computer Shutdown Switch off Analyzer.

* Click OK to shut down the computer.
* Turn off the Analyzer power switch.
*  Wait for the “It is now safe to turn off computer” message to appear.

* Turn off the PC power switch.

Notes:

» Allow ACeT 5diff Rinse reagent to remain in the instrument a minimum of 30
minutes.

»  Wait at least 30 seconds before performing the Power Up and Log On procedures.

» After doing Shutdown, you must do a Power Up and Startup before running patient
specimens or controls.
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SYSTEM POWER DOWN SUMMARY -

1 At the Workstation

Click E :

Select Quit Application.

Press or click @ .

Wait while the Workstation closes its program.

When the Begin Logon box appears, press + |At) + simultaneously.
Click Shut Down at the Logon Information box.

Select Shutdown then click 0K at the Shutdown Computer box.

When the It is now safe to turn off your computer message appears, power the Workstation
computer off.

2 At the Analyzer

PN 4277205BA

Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located
at the base of the left side panel.

If a replacement or maintenance procedure that requires you to open the Analyzer panels
is being performed, unplug the ac power cord. Either remove the cord from the
instrument (at the back panel, in the lower right corner) or from the ac wall outlet.
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SYSTEM POWER UP SUMMARY -

1 Preliminary Checks
e Check the waste container level.

» If the container needs to be replaced, change the container using the Replacing a
Waste Container Summary as a guide.

* If the Automatic Startup and Auto-Print functions are enabled, make sure the Printer is
ready to print.

» If the paper supply is insufficient, add paper.
» Make sure the power is ON and ready to print.

»  Verify the printer is properly configured according to your laboratory’s protocol.

2 Power Up the System

At the Analyzer

* If the ac power cord is unplugged, plug the cord into the instrument (at the back panel,
in the lower right corner) or the ac wall outlet, as applicable.

* Toggle the Power ON/OFF rocker switch ON (position —). This rocker switch is located
at the base of the left side panel.

* Verify the red LED is glowing steady.

At the Workstation
* Power ON the Workstation computer.

*  Wait while the computer performs its internal checks.

*  When the Begin Logon box appears, press + (At) + simultaneously.
* Type the User name and Password then press or click OK to log on.

* Type your 3-character (alphanumeric) Operator ID.

e Press (Enter] or click @ .

e Wait for the Reagents window to appear.
*  Verify the background behind the lightening bolt is green.

Note: Analyzer and Workstation should begin communicating within 30 seconds. In the
upper right corner, the right circle should also be green.

e If the Automatic Startup function is enabled, Startup automatically activates.
» Monitor the Cycle in progress : Startup status bar, as desired.
» Hard copy of Startup results prints automatically if Auto-Print function is enabled.

» Go to step 4 to review results.
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SYSTEM POWER UP SUMMARY

3 Prepare the System for Processing Samples

IMPORTANT Risk of inaccurate results if the Analyzer is not properly prepared. Based on the scenarios
below, perform either a Startup or Mini Prime to prepare the Analyzer. It is not necessary to do both.

« [f the system was Shutdown before the power was turned off, do a Startup.

« |f the Analyzer has set idle (not cycled) more than 4 hours, do a Startup.

« |f the Analyzer was not Shutdown and has set idle (not cycled) less than 4 hours, do a Mini Prime.
« |f the Analyzer was powered off then back on again, do a Mini Prime.

Startup

ale,
* Click ﬂ to initiate a Startup routine.
» Monitor the Cycle in progress : Startup status bar, as desired.
» Hard copy of Startup results prints automatically if Auto-Print function is enabled.
* Go to step 4 to review results.
Mini Prime
e At the Menu bar, select Cycles » Mini Prime.

* Cycle in progress : Mini Prime status bar provides a visual display of how close the routine
is to completion.

*  When complete, resume normal operation.

4 Review Results
* Once the Startup routine is complete, verify Passed is displayed for each parameter.

» 1f Failed appears for any parameter, click Startup Log tab to evaluate numeric results.

Note: If the Add Comments box automatically appears, click x to exit.

2 J |IJ' . .. .
» Click ﬂ to initiate another Startup routine.

» If the Startup continues to fail, contact your Beckman Coulter Representative.

* Save individual or log printout if required by your accreditation agency.

Add Comments
* If the Add Comments box appeared automatically, type in your personal observation or
appraisal as desired.

* To access the Add Comments box, click Startup Log tab » Add Comments button then type
your personal observation or appraisal inside the box.

* Click @ to save your comments.

5 Perform Quality Control Checks
* Perform quality control checks before running patient specimens according to your
laboratory’s protocol.
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MAKING CHANGES TO A CONTROL FILE CURRENTLY IN USE SUMMARY -

Use this summary only if you need to make a change in a control file that is currently in use
and only if you are changing an individual item:

* To correct a typographical error.
or
* To edit an assigned value (obtained from the Table of Expected Results) to a running

mean (established by the laboratory).

If you need to make a set up change (such as changing the lot number), use the Control File
Management Summary.

1 Select the File
* Click the Quality Assurance tab » Control tab to display the Control window.

* Choose the existing file you want to change from the Select Control drop-down menu.

2 Access the Setup Control Window
* C(Click the Setup Control button.

3 Make the Changes

¢ Enter the new information.

4 Verify All Changes

* Check all entries are correct.

. Click @ .

» If control runs are stored in this file:

— When the Do You Want The Existing Results To Be Saved? message appears,
click on the desired action.

— Selected action makes the requested changes then exits the window.

» If no control runs are stored in this file, requested changes are saved before exiting
the window.

* Control file statistics are recalculated based on the changes.
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CONTROL FILE MANAGEMENT SUMMARY -

Review the Numeric Control Data and Graphs, if applicable

1 Locate the Control File
* Click the Quality Assurance tab to display the Control window.

* Choose the specific file you want to review from the Select Control drop-down
menu.

2 Review the Graphs
* Double-click on any thumbnail graph you wish to review.

* Look for any skewed or out-of-limit plot points .

¢ Check for a shift or a trend.

3 Review Numeric Data
* Review % CV of all parameters (press (=] to see additional parameters).

* Ifa CVis high, scroll through the rows and examine each run for results mistakenly
run into the file (the graph review should correlate).

* May review and manage the data by shifts, if desired.
* Exclude any mistakes from the control calculations.

» Locate the control that needs to be excluded from the calculations.
» Click the to the left of that control (inside the Include column).

» [ (an empty check box) indicates those control results are no longer being
included in the control calculations. N = is decreased by 1.

» Repeat as needed.

Print the Control File Data

. Click @ .

*  Print All Rows is preselected but if a hard copy of the graphs is also desired select the
Print All Rows and L J Graphs option.

* If you are submitting data for IQAP evaluation, print a second copy.
Delete the Control File Data
* Click m@ .

* Choose Erase All row from the drop-down menu.

Note: All the control results are deleted. Target values and +/- limits remain in the
control file and may not need to be entered if the same type and level of control is set up
again in that same file.
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CONTROL FILE MANAGEMENT SUMMARY

Set Up the New Lot Number of Commercial Control

IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up control file are
included in the statistical data for the new file. Delete all controls runs before starting to run the new control.

Note: Before starting this set up, obtain the control disk for the controls you plan to set up.

1 Select the File
* Click the Quality Assurance tab to display the Control window.

Note: If the Control window is not displayed, click the Controls tab at the bottom.
* Choose a CBC/DIFF file from the Select Control drop-down menu.

2 Access the Setup Control Window
e C(Click the Setup Control button.

3 Download the Control Data from the Disk
* Insert the control disk into the floppy drive.

¢ Select the Download Values button.

e Select the control level then click @ .

* Select Commercial as the source of control material (if it is not already displayed).

e Print if desired then click @ .

4 Reserve the Control Lot Number
e Click Setup » Quality Assurance.

* Type the password then click @ .

* Click the General tab, if necessary.

* Click the box in the Reserved column that corresponds to the desired control lot.
- Click ().

5 Set Up Another Level of Control, if applicable

IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up control file are
included in the statistical data for the new file. Delete all controls runs before starting to run the new control.

* Review, print, and delete other files, as applicable.
* Choose another empty, inactive file from the Select Control drop-down menu.

* Repeat steps 2, 3, and 4.
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CHANGING REAGENT SUMMARY -

Note: If all reagents are being changed, see Chapter 11 of the Instructions For Use manual.

1 Verify a New Reagent Container is Needed
* Display the Reagents window by choosing Analyzer/Logs tab » Reagents tab.

* Check reagent levels to determine which reagent triggered the REAGENT LOW LEVEL
message.

» Check all levels because more than one may be low.

» Obtain a new unopened container of each reagent that according to your
laboratory’s protocol requires the reagent to be changed.

ON &

2 Replace the Reagent Container

* Open the new reagent container.

* Remove the stopper assembly from the old container then transfer it directly to the new
container and tighten to ensure an adequate seal.

Note: If the lower part of the assembly touches you or anything outside the container,
flood that lower part of the assembly with distilled water then wipe it with a lint-free
tissue.

* Put the cap from the new container onto the empty container.

* Properly dispose of the empty bottle according to your laboratory’s protocol.

3 Record the New Reagent Information
* At the Reagents window, click Change Reagent.

* Choose the reagent that was changed from the drop-down menu.
* Type the new lot number.
Note: Today’s date automatically appears in the Opened Date box.
* Choose the Expiration Date (or open container stability) from the drop-down calendar.

» For all reagents except ACeT™ 5diff Hgb Lyse reagent, select the date printed on the
reagent container.

» For the ACeT 5diff Hgb Lyse reagent which has a 90 day open container stability,
select the date that is 90 days from today.

* Click 0 J| to save the information and return to the Reagents window.

4 Wait for the Reagent Lines to Prime
* System automatically primes the reagent and updates the level indicator.

Note: Reagent level may not be displayed at 100% due to this priming.

* Once priming is complete, continue normal operation.
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REPLACING A WASTE CONTAINER SUMMARY -

Note: If the waste container is not full and the waste alarm is chirping (beeping) at regular
intervals, replace the 9 Volt alkaline battery in the waste sensor alarm.

Power Off the System

At the Workstation

* C(Click E :

* Select Quit Application.

* Press (Enter] or click @ .

*  Wait while the Workstation closes its program.

*  When the Begin Logon box appears, press + |At) + simultaneously.
* Click Shut Down at the Logon Information box.

* Select Shutdown then click 0K at the Shutdown Computer box.

*  When the It is now safe to turn off your computer message appears, power the Workstation
computer off.

At the Analyzer

* Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located
at the base of the left side panel.

ON F

Replace the Waste Container
* (Clearly mark or apply a waste label to an empty 20 L container.

* Using biohazardous precautions:
» Carefully remove the cap (with waste sensor attached) from the full waste container.

» Transfer the waste assembly directly to the empty waste container and tighten.

Neutralize and Disinfect the Waste Before Capping the Container
* For 20 liters of waste liquid, add the following to the waste container:

» 250 mL of sodium hypochlorite solution (if 12% available chlorine) or 500 mL of
sodium hypochlorite solution (if 6% available chlorine) to disinfect waste.

» 50 mL of 200 g/L sodium hydroxide solution to prevent gas from forming if the
container is being capped.

* Dispose of the biohazardous waste according to your laboratory’s protocol.
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REPLACING A WASTE CONTAINER SUMMARY

4 Power Up the System

At the Analyzer

* Toggle the Power ON/OFF rocker switch ON (position —). This rocker switch is located
at the base of the left side panel.

*  Verify the red LED is glowing steady.

At the Workstation
* Power ON the Workstation computer.

*  Wait while the computer performs its internal checks.

*  When the Begin Logon box appears, press + (At) + simultaneously.
* Type the User name and Password then press or click OK to log on.

* Type your 3-character (alphanumeric) Operator ID.

*  Press (Enter] or click @ .

*  Wait for the Reagents window to appear.
*  Verify the background behind the “lightening bolt” is green.

Note: Analyzer and Workstation should begin communicating within 30 seconds. In the
upper right corner, the right circle should also be green.

5 Prepare the System for Processing Samples
* If the Automatic Startup function is enabled:

» Startup routine was automatically activated when the power was toggled back ON.

»  Cycle in progress : Startup status bar provides a visual display of how close the
routine is to completion.

» When complete, resume normal operation.
e If the Automatic Startup function is not enabled:
» At the Menu bar, select Cycles » Mini Prime.

» Cycle in progress : Mini Prime status bar provides a visual display of how close the
routine is to completion.

» When complete, resume normal operation.

2 of 2 PN 4277205BA



ICON QUICK REFERENCE -

T
% Print K| Rerun Sample
»8 Transmit Iil Load Sample
' A |.'f
@ Delete a Startup

Find Shutdown
Previous .—|" Logout or Exit
Next LED) Help

Add Cancel

Edit @ 0K
=

Results / List Save

EEEE D E

Validate .@ Restore Defaults

Q‘) System State

(Double-click to quickly
access the Error Log)

PN 4277205BA 1 of 1






PN 4277205BA

Tube Holder #1

TUBE HOLDERS QUICK REFERENGE -

N

-

J/\g){ A kgt 10

Tube Holder #2

7653099A

This is a simplified overview of tube holders and the approved collection devices and control
vials they accommodate. For a comprehensive list with specific details, see Appendix D in the
Instructions For Use manual.

Tube Holder #1

Position 0

Position 0

Position 9

Position 0

Tube Holder #2

Position 0
Position 0
Position 9

Position 0

Types of Collection Devices or Control Vials

v

Most 13 mm x 75 mm evacuated specimen tubes containing
either K3EDTA or K,EDTA for collecting whole-blood volumes

of 2to 5mL

v" COULTER® ACeT™ 5diff Control Plus control tubes

v/ COULTER® ACeT™ 5diff Cal Calibrator vial

Sarstedt Monovette® 11.5 mm x 66 mm specimen tube
collecting 2.7 mL of whole-blood

Becton-Dickinson Microtainer for collection of 0.25 to 0.50 mL
of whole-blood

Becton-Dickinson Microtainer for collection of 0.25 to 0.50 mL
of whole-blood

Becton-Dickinson 10.25 mm x 64 mm Vacutainer® for
collecting 3 mL of whole-blood

RAM Scientific microcollection device for collecting 125 pL of
whole-blood

13 mm x 75 mm specimen tube with mulitiple labels
COULTER® ACeT™ 5diff Control Plus control tubes
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ONLINE HELP SYSTEM QUICK REFERENCE -

Accessing Online Help

ATTENTION: In the event that you cannot access the ACeT 5diff Cap Pierce Online Help System,
contact your Beckman Coulter Representative.

Using the COULTER® ACeT™ 5diff CP Workstation

* Click @ to display the Help screen

Using Your COULTER ACeT 5diff CP Hematology Analyzer Operator Manuals CD-ROM
ATTENTION: Do not use this CD-ROM on your ACeT 5diff CP Workstation.

1 Turn on your personal or office desktop PC and allow it to boot up.
Refer to the PC manual for instructions, as needed.

2  Insert the CD-ROM into the CD-ROM drive.
e If Autorun is enabled on your PC, the PC automatically launches the program.
e If Autorun is disabled on your PC, do steps 3 through 4.
3 Locate the Start. HTM file (CD-ROM drive letter:\Start. HTM):
* (lick the Windows Start button.
*  Click Run.
*  (Click Browse and locate the CD-ROM drive.
* Double-click the CD-ROM drive letter (usually D or E).

4  Double-click Start. HTM to launch the program.

5  Click For Viewing (or For Printing) as desired.

Moving or Resizing the Help Screen
1 Access online Help.

2  To move the Help window:
* Click the title bar and hold down the left mouse button.
* Move the mouse to drag the window to a new location.

¢ Release the mouse button when the window is located as desired.

3  To resize the Help window:
* Move the cursor over the window border until the arrows appear.
* Click the left mouse button and drag the border to resize the window.

¢ Release the mouse button when the window is the desired size.
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ONLINE HELP SYSTEM QUICK REFERENCE

Opening / Closing the Topics Pane

1

Access online Help.

2 Click the arrows to close the topics pane.

3  Click Contents, Index, Illustrations, Tables, or Search to re-open the topics pane.

Viewing Help Topics

1

Access online Help.

2  Navigate through Help as needed:

* Click Contents to browse through topics by heading.
e (Click Index to see a list of index entries.

* (Click Tables to see a list of tables.

*  Click lllustrations to see a list of illustrations.

* Click Search to search for words or phrases.

* Click Home to return to main Help screen.
Move through topics as needed:
* Click 'x;:' to display the previous topic in the sequence.
* Click 'i;‘x' to display the next topic in the sequence.
* Click '-'E':I to display the previous link.
View referenced or related topics:

* Click the highlighted words in a topic body to link directly to the referenced topic.

* (lick a word in the highlighted hierarchy — at the top of the topic — to change topic
levels. The current topic’s position also appears in the hierarchy.

To view information not visible in the Help window, scroll through the window by using
the scroll bar.

Using the Contents Option

1

2
3
4
9

2 0f4

Access online Help.

Click Contents to browse through topics by heading.

Select a top-level heading to expand and view its sub-topic headings.

Select a sub-heading to display information about that topic in the Content pane.

Use the scroll bar to scroll through the information.
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ONLINE HELP SYSTEM QUICK REFERENCE

Using the Index Option

1 Access online Help.

Click Index.

2
3  Click the letter corresponding with the list of index entries you want to see.
4  Scroll through the topics as needed.

9

Click a number after the index entry to display information about that topic.

Using the Tables Option

1 Access online Help.

2 Click Tables to display the list of tables.

3 Scroll through the tables to locate the table you want to view.
4

Click the table to display it on the screen.

Using the lllustrations Option

1 Access online Help.

2 Click lllustrations to display the list of illustrations.

3  Scroll through the illustrations to locate the table you want to view.
4

Click the illustration to display it on the screen.

Using the Search Option

1 Access online Help.

2 Click Search to display the search field.
3 Type the word you want to locate.
4

Click Search. If the word you typed appears in the document, each instance where it
appears will be shown.
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ONLINE HELP SYSTEM QUICK REFERENCE

Printing Operator Manuals

To Print the Instructions For Use Manual from the Workstation

Note: Prints with the same page breaks and document structure as the printed document that
is available by order.

1 At the Menu bar, click Help » Contents » Print Manual.

2 Click Print.

3  Define what pages you want to print. You can print all or part of the document.
4

Follow the instructions on the screen.

To Print Operator Manuals from the CD-ROM

Note: Prints with the same page breaks and document structure as the printed document that
is available by order.

ATTENTION: Do not use this CD-ROM on your ACeT 5diff CP Workstation.

1 Turn on your personal or office desktop PC and allow it to boot up.
Refer to the PC manual for instructions, as needed.

2 Insert the CD-ROM into the CD-ROM drive.

e If Autorun is enabled on your PC, the PC automatically launches the program.
(The contents of this CD-ROM are not installed on your PC.)

e If Autorun is disabled on your PC, do steps 3 through 4.

3  Locate the Start. HTM file (CD-ROM drive letter:\Start. HTM):
* (Click the Windows Start button.
e (Click Run.
* (Click Browse and locate the CD-ROM drive.
* Double-click the CD-ROM drive letter (usually D or E).

Double-click Start. HTM to launch the Home page.
Select a language.
Under the name of the manual you wish to print, click For Printing.

Define what pages you want to print. You can print all or part of the document.

o N o a1 A

Follow the instructions on the screen.
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OFFICIAL TRAINING DOCUMENTATION
(for COULTER® ACeT™ 5diff CP Hematology Analyzer Training)

Laboratory

Address

Phone

ACeT 5diff CP Serial Number

Key Operator

Training Dates

Instructions

The overall objectives for COULTER ACeT 5diff CP Hematology Analyzer Key Operator
training are listed below. Each objective is a comprehensive statement of what an operator
should be able to do when training is complete. Please review these objectives and place a
check mark (v) next to any objectives that both the Trainer and Trainee agree are completed
either during this training or through previous knowledge. Write N/A (not applicable) inside
the block if the objective does not apply to this Trainee.

Checklist

Your signature at the end of this checklist indicates agreement that the Trainee is able to . . .

Locate important procedures in the Instructions For Use manual including:
Startup and Shutdown procedures
Quality Assurance and Calibration procedures
Sample Analysis procedures
Reagent replacement procedures
Troubleshooting procedures
Identify basic instrument components and describe their functions
Correctly perform Startup and Shutdown procedures

Explain the importance of the Startup and Shutdown procedures and the
frequency with which they should be performed

Perform appropriate Quality Assurance checks

Review, delete, and set up control files
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TRAINING CHECKLIST

Comments

Prepare IQAP data for submission, if applicable
Perform all preliminary procedures required for calibration

Perform calibration with COULTER® ACeT™ 5diff Cal Calibrator and document
the results according to your laboratory’s protocol

Perform Sample Analysis using their preferred workflow pattern
(with or without Worklist)

Look up samples in the current, active archive
Explain how to open a closed archive

Understand the basics principles of parameter derivation and state if a parameter
result is directly measured, determined using ACV technology, derived from a
histogram, or computed

Review data and recognize if a DiffPlot is normal or abnormal
Review data and recognize if an RBC and/or Plt histogram is typical or atypical
Explain what a particular flag indicates when provided with an example

Recognize an instrument problem based on abnormal sample results, abnormal
Startup, abnormal control results, and/or error messages

Trainee Signature Trainer Signature
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TRADEMARKS -

ACeT, Beckman Coulter, the BECKMAN COULTER logo, and COULTER are trademarks of
Beckman Coulter, Inc.

All other trademarks, service marks, products, or services are trademarks or registered
trademarks of their respective holders.
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Documentation
COULTER® ACe T™ 5diff CP Hematology Analyzer Documentation

= |nstructions For Use Use and Function  Operation Principles ® Specifications/Characteristics ¢
PN 624021 Precautions/Hazards * Running Samples * Reviewing Results * Calibration ¢
Diagnostics * Instrument Setup * Log Sheets » Manual Calibration  References ©
Glossary ¢ Abbreviations ¢ Index

= Host Transmission Defines requirements for interfacing the system with a host computer.
Specification
PN 4277065

» Training Guide Provides training information for using the CP system.
PN 4277205

= Daily Operations Provides abbreviated procedures for the experienced operator.

Quick Reference
PN 4277315
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	COULTER® AC•T™ 5diff Cap Pierce Hematology Analyzer
	Operator’s Training Guide
	WARNINGS AND PRECAUTIONS
	WARNINGS, CAUTIONS, and IMPORTANTS alert you as follows:
	-
	-
	-

	WARNING Risk of operator injury if:
	r All doors, covers and panels are not closed and secured in place prior to and during instrument...
	r The integrity of safety interlocks and sensors is compromised.
	r Instrument alarms and error messages are not acknowledged and acted upon.
	r You contact moving parts.
	r You mishandle broken parts.
	r Doors, covers and panels are not opened, closed, removed and/or replaced with care.
	r Improper tools are used for troubleshooting.
	r Keep doors, covers and panels closed and secured in place while the instrument is in use.
	r Take full advantage of the safety features of the instrument. Do not defeat safety interlocks a...
	r Acknowledge and act upon instrument alarms and error messages.
	r Keep away from moving parts.
	r Report any broken parts to your Beckman Coulter Representative.
	r Open/remove and close/replace doors, covers and panels with care.
	r Use the proper tools when troubleshooting.

	CAUTION System integrity might be compromised and operational failures might occur if:
	r This equipment is used in a manner other than specified. Operate the instrument as instructed i...
	r You introduce software that is not authorized by Beckman Coulter into your computer. Only opera...
	r You install software that is not an original copyrighted version. Only use software that is an ...

	IMPORTANT If you purchased this product from anyone other than Beckman Coulter or an authorized B...


	REVISION STATUS
	Initial Issue, 6/01 Software version 1.03
	Issue B, 10/04 Software Version 2.00 Added information about the new features provided by softwar...
	Issue BA, 06/10 Software Version 2.00.
	Updates were made to the company corporate address.
	Note: Changes that are part of the most recent revision are indicated in text by a bar in the mar...
	This document applies to the latest software listed and higher versions. When a subsequent softwa...

	CONTENTS
	WARNINGS AND PRECAUTIONS
	REVISION STATUS,�iii
	INTRODUCTION,�vii
	1 GETTING TO KNOW YOUR INSTRUMENT,�1�1
	2 STARTUP / SHUTDOWN,�2�1
	3 SETUP OPTIONS,�3�1
	4 QUALITY ASSURANCE,�4�1
	5 CALIBRATION,�5�1
	6 SAMPLE ANALYSIS,�6�1
	7 DATA REVIEW,�7�1
	8 BASIC TROUBLESHOOTING,�8�1
	SUMMARY PAGES
	TRAINING CHECKLIST
	TRADEMARKS

	INTRODUCTION
	PURPOSE OF THIS DOCUMENT
	To provide an authorized trainer with corporately accepted training materials for instructing a n...

	DOCUMENTATION
	Several documents are available with your new instrument.
	r Instructions For Use manual, PN�624021, provides information about:
	t getting started,
	t running of your instrument,
	t reviewing results,
	t performing special procedures, such as cleaning, replacing, or adjusting an instrument component,
	t troubleshooting problems,
	t determining what the instrument does,
	t understanding how to safely operate the instrument,
	t powering up the instrument,
	t customizing the setup, and
	t running controls and samples.

	The information contained in the Instructions For Use manual can also be accessed using the AC•T ...
	r Host Transmission Specification, PN�4277065, defines the information needed to program the tran...
	r Operator Manuals CD-ROM, PN�RAX015, provides the operator manuals in two formats: one for viewi...
	Do not use the Operator Manuals CD-ROM at your AC•T 5diff CP Workstation. This CD-ROM is optimize...


	ABOUT THIS TRAINING GUIDE
	Scope
	This training guide is designed to support AC•T 5diff CP hematology analyzer training. This docum...

	Topics
	The materials in this guide support the training of eight different topics:
	r Topic 1 GETTING TO KNOW YOUR INSTRUMENT
	r Topic 2 STARTUP / SHUTDOWN
	r Topic 3 SET UP OPTIONS
	r Topic 4 QUALITY ASSURANCE
	r Topic 5 CALIBRATION
	r Topic 6 SAMPLE ANALYSIS
	r Topic 7 DATA REVIEW
	r Topic 8 BASIC TROUBLESHOOTING

	Each topic consists of several related subjects that may be used, as needed, in your training.

	Organization
	The eight individual topics contained in the Operator’s Training Guide are part of a larger organ...
	Explains how to use this training guide
	Heart of this document, each topic consists of multiple subjects and operational summaries relati...
	Master copy for use by the Key Operator in their laboratory once training is complete
	Method for documenting the specific training an operator receives

	Summary Pages
	Routine operational tasks detailed in the Operator’s Guide are abbreviated in this training docum...
	These summary pages contain essential operational instructions. As a result, it is important that...
	How to Identify an Inserted Summary
	When a summary is inserted in the training material, a rotated chevron (‰) appears to the left of...
	‰ Startup Summary

	Since this is a stand-alone summary for use after training is complete, some of the instructions ...


	Daily Operations Quick Reference
	Daily operational tasks detailed in the summary page format are further abbreviated in this Quick...
	r Startup when the power is already turned on
	r Running COULTER® AC•T™ 5diff Control Plus
	r Running patient samples (with or without using the Worklist)
	r Shutdown

	This Quick Reference tool is not designed to teach an operator how to run the instrument. It is d...

	Training Checklist
	This checklist provides the trainer with an official method to document the completion of trainin...
	When the training process is complete, we recommend that both the trainer and trainee sign the Tr...


	RESPONSIBILITIES
	Beckman Coulter’s Responsibility
	Beckman Coulter is responsible for instructing a Key Operator in the proper use and operation of ...
	Our goal is to provide your laboratory with high quality training that best fits your laboratory’...

	Key Operator’s Responsibility
	It is the Key Operator’s responsibility to train all other operators in their laboratory. To assi...


	CONVENTIONS
	This training guide uses the following conventions:
	r A primary window is the window displayed after you select one of the following tabs: Worklist, ...
	r Instructions assume operator is using the mouse for navigation.
	r Tabs are the major navigation tool.
	r Black text on a tab indicates the name of the window currently displayed. Although text is grey...
	r If an icon is active, it appears in color; if icon is inactive, the coloring is removed (greyed...
	r Software navigation to access a needed function or screen appears as a sequence of menu items s...
	r Bold indicates a menu item such as File or a tab such as Worklist.
	r Italics font indicates screen text and/or messages displayed by the instrument such as Calibrat...
	r Information that is to be typed is in Courier font such as type the password 123.
	r Instrument or system is sometimes used to refer to the AC•T 5diff Cap Pierce hematology analyze...
	r CP refers to cap pierce.
	r Note (in bold font) prefaces supplemental information.
	r An ATTENTION contains information that is important to remember or helpful when performing a pr...
	r Main card refers to the main circuit board (card) in the instrument.
	r RBC bath is sometimes referred to as RBC/Plt bath.
	r The terms “screen” and “window’ are used interchangeably.
	r AC•T 5diff Rinse reagent is sometimes referred to as Rinse.
	r AC•T 5diff Fix reagent is sometimes referred to as Fix.
	r AC•T 5diff Hgb Lyse reagent is sometimes referred to as Hgb Lyse.
	r AC•T 5diff WBC Lyse reagent is sometimes referred to as WBC Lyse.
	r AC•T 5diff Diluent reagent is sometimes referred to as Diluent.
	r ë indicates a key such as Û.
	r Ù indicates the operator needs to press and release the Tab key.
	r ë + ë indicates to press and hold the first key listed, then press the next key.
	r A rotated chevron (‰) placed to the left of a Summary Page title identifies an operational summ...
	‰ Changing Reagent Summary
	r Two rotated chevrons (‰ ‰) designate the end of an operational summary.


	SAFETY SYMBOLS
	Safety symbols alert you to potentially dangerous conditions. These symbols, together with text, ...
	Biohazard. Consider all materials (specimens, reagents, controls, and calibrators, and so forth) ...
	Wear standard laboratory attire and follow safe laboratory procedures when handling any material ...
	Probe hazard. The probe is sharp and may contain biohazardous materials, such as controls and cal...
	Avoid any unnecessary contact with the probe and probe area.

	GRAPHICS
	All graphics, including screens and printouts, are for illustration purposes only and must not be...


	GETTING TO KNOW YOUR INSTRUMENT
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Workstation
	r Locate and name the three major components of the computer system.
	r Locate and explain the function of specific keys on the keyboard.
	r Log on the Workstation using the proper User name and password.
	r Use the mouse to navigate through the software and select desired items or functions.
	r Locate the menu bar and access the pull-down text menus using the mouse.
	r Locate the tool bar and identify each icon and its purpose.
	r Quickly access a primary window by selecting its corresponding tab.
	r Use the buttons, fields, boxes, scrollable lists, and scroll bars as needed.
	r Explain the significance of the green, red, and yellow background colors.
	r Access and use the online Help system as needed.
	r Load paper in the printer and verify the printer is ready to print.

	Main Unit
	r Locate and name the hardware controls and indicators on an AC•T 5diff Cap Pierce (CP) hematolog...
	r Given an instrument that appears to be without power,
	t Tell whether it is powered down or in Standby.
	t Bring the instrument back into operation.

	r Reset the system.
	r Locate the cap pierce module and the two tube holders.
	r Explain how to select the proper tube holder and sample position.
	r Demonstrate how to properly change the tube holder.

	Single Point of Aspiration
	r Explain why the AC•T 5diff CP hematology analyzer is referred to as a single point of aspiratio...
	r Briefly overview closed-vial operation versus open-vial operation.
	r List four situations when open-vial operation may be necessary.

	Reagents
	r Locate the reagent compartment.
	r Name the reagents used on the AC•T 5diff CP hematology analyzer.
	r State if the reagent is used for CBC analysis, DIFF analysis, or both.
	r State the open container stability of each reagent used on an AC•T 5diff instrument.
	r Explain how to change reagents.
	r Explain how to handle and replace a waste container, if applicable.


	NOTES
	WORKSTATION
	Functions of the AC•T 5diff CP Workstation
	r Controls and monitors instrument operation
	r Displays, stores, outputs, and allows recall of sample results
	r Stores and graphs control results for the Quality Assurance program
	r Automatically calculates new calibration factors
	r Allows bidirectional communication with a host computer
	r Consists of three major components: the computer, the monitor, and the printer

	Major Components
	Computer
	r Must not use this system as a personal computer
	r Consists of hardware components and software
	r Hardware is the term used to describe the physical components of a computer system
	t Locate the following hardware components:
	H Power ON/OFF button
	H Power ON/OFF indicator light
	H Hard drive indicator and symbol
	H CD-ROM drive
	H Diskette drive


	r Software refers to a sequence of detailed instructions (called a program) that directs the comp...

	Monitor
	r Computer uses the monitor to visually display information
	r Locate the Power ON/OFF switch and the indicator that lights when power is on
	r Locate screen adjustment controls

	Printer
	r Used to either print a copy of the screen displayed on the monitor or of data stored in the com...
	r Locate the Power ON/OFF switch
	r Explain use of the ONLINE/OFFLINE button
	r Demonstrate how to load the paper
	r Demonstrate how to change the ink cartridge

	Bar-code Reader (Optional)
	r Hand-held scanner for reading the bar-code label on a specimen tube before sampling
	r Operator must press button on the bar-code reader before scanning a label
	r An audible beep indicates barcode was read successfully


	Keyboard
	r Direct line of communication between the operator and the computer containing the Workstation s...
	Layout
	r Alphanumeric keys:
	t Configured in a standard typewriter keyboard layout
	t Consists of all standard alphanumeric keys plus a handful of special computer keys and symbols

	r Ù
	t May be used to move from field to field on some windows

	r Ú
	t Works like the Shift Lock key on a typewriter
	t With Caps Lock on,
	H Pressing any alphabet key on the keyboard produces an uppercase letter
	H Pressing the Ü key plus a letter produces a lowercase letter
	H Only shifts the letter keys, all other keys on the keyboard remain the same


	r Numeric keypad:
	t Keypad contains the numbers 0 through 9, plus the period, an Û key, and various mathematical sy...
	t Can expedite manual entry of patient ID numbers and certain quality control entries

	r ê
	t Controls operation of the numeric keypad
	t Locate light that illuminates when Num Lock is turned on
	t With Num Lock turned on, numeric keypad produces numbers
	t Workstation keyboard is designed to be used with Num Lock turned on
	t With Num Lock turned off, numeric keypad on a typical keyboard doubles as a cursor keypad

	r Cursor control keys:
	t è æ ç é
	H Also called arrow keys
	H Directional keys for moving the cursor
	H Used to highlight menu items, scroll up and down screens, or move to a field on a screen to ent...

	t ä and å�may be used to page through stored sample and control data
	t â and ã�may be used to locate the beginning or the end of stored data

	r Keys not used with the Workstation:��à, Éthrough �Ô,� Õ, È, and� ß
	r Û
	t Mainly used to select a highlighted menu or submenu option which then activates a change in the...
	t Do not use Û to bring up the Primary Window as pressing this key may activate a command
	t Do not use Û to save new information on any setup screen
	t Keyboard has two Û keys; both work identically

	r Å and ×
	t Modifier keys that have no action by themselves but can be used in conjunction with other keys ...
	t Must simultaneously press Å+ ×+ á to log onto the Workstation



	Software
	r Workstation software is based on Windows-NT
	r Familiarity with Windows conventions and use is beneficial but not required
	Initial Windows-NT Logon
	r When the software initially loads, a Windows-NT logon window appears
	r Logon Information box is where you enter user name and password information

	User Names and Passwords
	r When logging on the system, required to type a user name
	r Type one of the following:
	t BCI (for normal operation), or
	t Admin (for special procedures)

	r For normal operation (which is the majority of the time):
	t Log on using BCI as the User name
	t 123 is password for BCI User name
	t Once operator enters the password for BCI, the system prompts for the Operator ID

	r For special procedures and only when instructed to by a Beckman Coulter Representative:
	t Log on using the Admin User name provided to you at the time it is needed


	Operator ID
	r A 3-character (alphanumeric) ID of your choice which uniquely identifies you as the current ope...
	r Enter your Operator ID after logging on. The system then automatically loads the Workstation ap...

	Software Passwords
	r Various Workstation software areas, such as Setup and Calibration, require an “Administrator” p...
	r When “Administrator” password is requested, type 123 to gain access to that particular software...
	r Other Workstation software areas, such as service diagnostics, requires a “Service” password be...


	Logging On the Workstation
	r When the Begin Logon box is displayed on the Workstation screen, operator must follow the instr...
	r When Logon Information box appears:
	t Type BCI as the User name (User name for normal operation)
	t Press Ù
	t Type 123 (Password for BCI User name)
	t Press Û or click OK to log on

	r When the following window appears:
	t Type your 3-character Operator ID
	t Press Û or click

	r Wait for Analyzer�/�Logs window to appear
	r Verify background behind (lightening bolt) is green
	Note: Analyzer and Workstation should begin communicating within 30 seconds. In the upper right c...

	Primary Windows
	Primary Window (Analyzer�/�Logs)
	r First window to appear after log on
	r May also be referred to as Reagents window
	r Primary naviagation window
	t Provides operator with quick access to other primary windows via tabs
	t Use the mouse to select the desired tab
	t Each primary window can be reached within two tab selections


	Tab Selections
	r Five main tab options appear across the top of the Analyzer�/�Logs window
	From left to right:
	t Worklist
	t Run
	t Results
	t Quality Assurance
	t Analyzer/Logs

	r Analyzer/Logs is the selected main tab option after log on
	r Sub-options appear across the bottom of the window when a main tab is selected
	r Reagents, Reagent Log, Startup Log, Error Log, Calibration Log, Maintenance Log, and Service Lo...
	r Analyzer/Logs and Reagents appear in black print to identify the current primary window being d...
	r Any window accessed using a tab is considered a primary window
	r All other tabs are functional even though they appear greyed-out
	r Any other tab may be selected any time, as desired

	Table of Tab Options and Sub-Options
	r Following table provides an overview of the various displays that can be accessed from the prim...
	t Five main tab options are in bold
	t Associated sub-options are indented under each main tab, as applicable

	r Descriptions are not inclusive
	r Additional information concerning these selections is detailed in other sections of this traini...
	Analyzer / Logs
	r Provides access to various logs via the tabs at the bottom of the window.
	Reagents

	r Displays current reagent status and the background status of the last completed Startup.
	r This is the default display.
	Reagent Log

	r Tab used to access the Reagent Log display.
	r Maintains most recent 50 entries displaying the most recent log entry at the top of the log and...
	r Rollover is first in, first out when the 51st entry is added.
	r Additional information about reagents and the Reagent Log is located under the REAGENTS heading...
	Startup Log

	r Tab used to access the Startup Log display.
	r Maintains most recent 50 entries displaying the most recent log entry at the top of the log and...
	r Rollover is first in, first out when the 51st entry is added.
	r Additional information about Startup and the Startup Log is located in Topic 2 (Startup / Shutd...
	Error Log

	r Tab used to access the Error Log display.
	r Maintains most recent 100 entries displaying the most recent log entry at the top of the log an...
	r Rollover is first in, first out when the 101st entry is added.
	r Additional information about the Error Log is located under the BASIC TROUBLESHOOTING TECHNIQUE...
	Calibration Log

	r Tab used to access the Calibration Log display.
	r Maintains the most recent 50 entries displaying the most recent log entry at the top of the log...
	r Rollover is first in, first out when the 51st entry is added.
	r Additional information about calibration and the Calibration Log is located in Topic 5 (Calibra...
	Maintenance Log

	r Tab used to access the Maintenance display.
	r Maintains the most recent 100 entries displaying the most recent log entry at the top of the lo...
	r Rollover is first in, first out when the 101st entry is added.
	r Additional information about preventive maintenance and the Maintenance Log is located under th...
	Service Log

	r Tab used to access the Service Log display.
	r Must use the Service Password to access.
	r Function is similar to that of the Maintenance Log.
	r Used by your Beckman Coulter Service Representative to maintain a record of the service perform...
	r Maintains the most recent 100 entries displaying the most recent log entry at the top of the lo...
	r Rollover is first in, first out when the 101st entry is added.
	Quality Assurance

	r When this tab is selected, the display provides access to various quality assurance techniques ...
	Controls

	r Displays recent runs (up to five) for the selected file and designated shift unless zero (24�ho...
	r Shift times are configured by the individual laboratory during set up.
	r Control source may be commercial or patient.
	r Control types may be CBC or CBC/DIFF.
	r Control levels may be Low, Normal, or High.
	r Up to three thumbnail graphs are displayed at a time.
	t Display is determined via selection of the mini-tab.
	t Up to the last 10 data points are displayed.
	t Runs are plotted right to left with the last included entry on the right.
	t Data points are not displayed for any control run excluded from the control file.

	r Additional control information is located in Topic 4 (Quality Assurance).
	Reproducibility

	r Tab used to access the Reproducibility display.
	r Study may be done using the CBC or CBC/DIFF panel.
	r Reproducibility studies are done to check the instrument precision.
	r Precision is the ability to obtain the same results, time after time, on the same sample.
	r Reproducibility, precision, and repeatability are synonymous terms.
	r Additional reproducibility information is located in Topic 4 (Quality Assurance) and Topic�8 (B...
	Calibration

	r Tab used to access the Calibration display.
	r Calibration is needed to establish the accuracy of the instrument.
	r Accuracy is how close a test result is to the true value.
	r Calibration is performed using a special reference material such as COULTER® AC•T™ 5diff Cal ca...
	r Additional calibration information is located in Topic 5 (Calibration).
	IQAP

	r Tab is used to access the IQAP download screen
	r Refer to the Help System or Instructions For Use manual for the IQAP download procedure
	XM

	r Tab used to access the XM display.
	r XM tab is only visible if the XM option is On. Default setting is Off.
	(Setup�tt Quality Assurance�tt Enter Password�tt General tab�tt XM Options)
	r XM analysis is:
	t An on going method of monitoring your automated hematology analyzer.
	t Similar to XB analysis in that it uses a weighted moving average of patient sample results.
	t An optional form of quality control that your laboratory may or may not choose to use.

	r If your laboratory decides to use the XM option, you may choose to monitor either three paramet...
	r Laboratory must establish their own mean values.
	r Additional information about the XM option is located in Topic 4 (Quality Assurance).
	Results

	r When this tab is selected, the Result List appears.
	r Result List is a sortable listing of processed samples in the current active archive.
	r To view the Detailed Results, first highlight the desired patient then click , the Results/List...
	r If the Detailed Results view is currently displayed and the operator clicks the Results/List ic...
	r There are two tabs at the bottom of the window. Results and Search Results.
	r Detailed information concerning how parameter results are generated and reviewed is located in ...
	Results

	r Select this tab for routine Result List activities.
	Search Results

	r Select this tab to search for results based on your choice of criteria:
	t Sample ID
	t Patient ID
	t Patient Name

	r Can search either current or closed archives
	Run

	r When this tab is selected, the Run window appears.
	r Displays the results for the last sample analyzed (blank, calibration, reproducibility, control...
	r Displays the next sample ID to be processed if samples are preassigned in the Worklist or auton...
	r A Sample ID must be entered prior to processing a sample.
	r Detailed information concerning the processing of patient samples is located in Topic 6 (Sample...
	Worklist

	r When this tab is selected, the Worklist appears. A worklist is a list of work to be done. This ...
	r Entries may be received (via download) from a host computer or individually added by the operator.
	r Detailed information concerning the Worklist and its usage is located in Topic�6 (Sample Analys...


	Other Navigation Tools
	r Menu bar allows access to pull-down menus
	r Tool bar (may also be referred to as Icon bar)
	r Text buttons access secondary windows

	Primary Windows versus Secondary Windows
	r Primary windows are those accessed by clicking on a tab; any other window (usually accessed by ...
	r Menu bar and tool bar (icon bar) are:
	t Active while primary window displayed
	H Options can be selected
	H Icons that appear in color are active

	t Not active while a secondary window or box is displayed
	H Options cannot be selected
	H Icons that appear in color are not active
	H Must click either �(to save and exit) or (to cancel and exit)





	SOFTWARE MENU TREE
	Software Icons
	r Icons depict executable functions
	r Icon activity correlates with window function:
	t If icon active, it appears in color
	t If icon inactive, coloring is removed (greyed-out)
	Print
	Rerun Sample

	Transmit
	Load Sample

	Delete
	Startup

	Find
	Shutdown

	Previous
	Logout or Exit

	Next
	Help

	Add
	Cancel

	Edit
	OK

	Results�/�List
	Save

	Validate
	Restore Defaults
	System State
	(Double-click to quickly ��access the Error Log)





	ONLINE HELP
	Using the Online Help System on Your AC•T 5diff CP Hematology Analyzer
	r Help system is an electronic version of the Instructions For Use manual that includes:
	t Table of contents
	t Index for finding information quickly
	t Glossary of definitions

	r Access online Help one of two ways:
	t Click on the icon bar
	or
	t From Menu bar, select Help�tt Contents

	Note: In the event that you cannot access the AC•T 5diff Cap Pierce Online Help System from your ...
	r Three options available from the Help menu:
	t Contents
	Allows operator to search for information on specific system-related topics
	t Print Manual
	Allows operator to print the Instructions For Use manual in whole or in part (prints with the sam...
	t About
	Shows the software version currently installed on Workstation


	Using Your AC•T 5diff CP Hematology Analyzer Operator Manuals CD-ROM
	r An Operator Manuals CD-ROM was shipped with your instrument
	r CD-ROM contains:
	t COULTER® AC•T™ 5diff CP Hematology Analyzer Instructions For Use manual (.PDF and�.HTML files)
	t COULTER® AC•T™ 5diff CP Hematology Analyzer Host Transmission Specification, English (.PDF file)
	t Adobe® Acrobat® Reader 4.0 (or higher) for reading the�.PDF files

	r Allows you to access the same information you can access through the Help menu on the AC•T 5dif...
	ATTENTION: The Workstation PC that is part of your laboratory’s AC•T 5diff CP system is configure...
	Minimum System Requirements for Using the CD-ROM
	r Do not use the CD-ROM on your AC•T 5diff CP Workstation
	r You can use this CD-ROM on any PC that meets these minimum requirements:
	t Microsoft® Internet Explorer 4.0 (or higher) for displaying the .HTML files
	t An IBM® PC or compatible with a CD-ROM drive
	t A Microsoft® operating system: Windows® 95, Windows 98, Windows 2000, Windows ME, or Windows NT...
	t 32 MB RAM
	t Display settings: 800�x�600 and 256 colors


	Launching the Manual from the CD-ROM
	r CD-ROM contents do not automatically install on your PC
	r Can view or print direct from the CD-ROM
	t View option is an�.HTML file that looks and responds the same as your AC•T 5diff CP Workstation...
	t Print option is a�.PDF file that prints the Instructions For Use manual in whole or in part (pr...

	r Contact your Beckman Coulter Representative if you cannot access the Instructions For Use manua...


	Viewing the Instructions For Use Manual
	r Viewing the Instructions For Use manual using your AC•T 5diff CP online Help system or the View...
	r Both are�.HTML files
	r When the Help window is accessed, operator may:
	t Move or resize the window
	t Open or close topic panes

	r Screen that appears when an operator
	t From the Menu bar, selects Help�tt Contents
	or
	t From the icon bar, clicks


	Help Screen
	r Screen that appears when Contents is selected from Help menu:
	b
	Closes the topics pane when selected
	c

	Displays the menu options for the online Help
	d

	Allows an operator to navigate through the Help
	e

	Displays the contents of the selected Help topic
	f

	Displays the topics (contents, illustrations, or tables)
	g

	Displays the Index letters (only when Index is selected)


	General Instructions for Using Help
	r Help window is divided into three panes: Banner, Topics, and Content
	r Banner pane contains the Help menu and navigational arrows
	r Topics pane displays different lists based on the Help menu options selected
	r Content pane displays information on the selected topic
	r Easiest way to find specific information is to use the contents or index lists
	Help Menu Options
	Home
	r Displays title screen
	Contents

	r Displays list of top-level subject headings
	r Select a top-level heading to expand and view its sub-topic headings
	r Select a sub-heading to display information about that topic in the Content pane
	Index

	r Displays list of index entries sorted alphabetically
	r From the box that appears, select a letter or symbol to display an alphabetically sorted list o...
	r Scroll through the topics and select the number after an index entry to view that topic
	Illustrations

	r Displays list of illustrations from all topics
	r Scroll through the list and select the illustration you want to view
	Tables

	r Displays list of tables from all topics
	r Scroll through the list and select the table you want to view
	Search

	r Used to locate specific words
	r Click inside the Search for: text box and type one or more words separated by spaces; do not us...
	r Select OK button to begin search through the Help topics
	r When search complete, lists all the topics that contain those specific words
	r Scroll through the list and select the topic you want to view
	?

	r Allows operator to view Help file for using Help

	Navigational Aids
	r Click to display the previous topic in the sequence
	r Click to display the next topic in the sequence
	r Click to display the previous link
	r Click to slide the Topics pane off the screen
	t Selecting an option from the Help menu slides Topics pane back into the screen
	t Icon may not be visible in some browsers
	t Alternative method to reduce/enlarge the width of the Topics pane is to use slider bar located ...



	‰ ONLINE HELP SYSTEM QUICK REFERENCE
	Accessing Online Help
	ATTENTION: In the event that you cannot access the AC•T 5diff Cap Pierce Online Help System, cont...
	Using the COULTER® AC•T™ 5diff CP Workstation
	r Click to display the Help screen

	Using Your COULTER AC•T 5diff CP Hematology Analyzer Operator Manuals CD-ROM
	ATTENTION: Do not use this CD-ROM on your AC•T 5diff CP Workstation.
	1 Turn on your personal or office desktop PC and allow it to boot up. Refer to the PC manual for ...
	2 Insert the CD-ROM into the CD-ROM drive.
	r If Autorun is enabled on your PC, the PC automatically launches the program.
	r If Autorun is disabled on your PC, do steps 3 through 4.

	3 Locate the Start.HTM file (CD-ROM�drive letter:\Start.HTM):
	r Click the Windows Start button.
	r Click Run.
	r Click Browse and locate the CD-ROM drive.
	r Double-click the CD-ROM drive letter (usually D or E).

	4 Double-click Start.HTM to launch the program.
	5 Click For Viewing (or For Printing) as desired.


	Moving or Resizing the Help Screen
	1 Access online Help.
	2 To move the Help window:
	r Click the title bar and hold down the left mouse button.
	r Move the mouse to drag the window to a new location.
	r Release the mouse button when the window is located as desired.

	3 To resize the Help window:
	r Move the cursor over the window border until the arrows appear.
	r Click the left mouse button and drag the border to resize the window.
	r Release the mouse button when the window is the desired size.


	Opening / Closing the Topics Pane
	1 Access online Help.
	2 Click the arrows to close the topics pane.
	3 Click Contents, Index, Illustrations, Tables, or Search to re-open the topics pane.

	Viewing Help Topics
	1 Access online Help.
	2 Navigate through Help as needed:
	r Click Contents to browse through topics by heading.
	r Click Index to see a list of index entries.
	r Click Tables to see a list of tables.
	r Click Illustrations to see a list of illustrations.
	r Click Search to search for words or phrases.
	r Click Home to return to main Help screen.

	3 Move through topics as needed:
	r Click to display the previous topic in the sequence.
	r Click to display the next topic in the sequence.
	r Click to display the previous link.

	4 View referenced or related topics:
	r Click the highlighted words in a topic body to link directly to the referenced topic.
	r Click a word in the highlighted hierarchy – at the top of the topic�– to change topic levels. T...

	5 To view information not visible in the Help window, scroll through the window by using the scro...

	Using the Contents Option
	1 Access online Help.
	2 Click Contents to browse through topics by heading.
	3 Select a top-level heading to expand and view its sub-topic headings.
	4 Select a sub-heading to display information about that topic in the Content pane.
	5 Use the scroll bar to scroll through the information.

	Using the Index Option
	1 Access online Help.
	2 Click Index.
	3 Click the letter corresponding with the list of index entries you want to see.
	4 Scroll through the topics as needed.
	5 Click a number after the index entry to display information about that topic.

	Using the Tables Option
	1 Access online Help.
	2 Click Tables to display the list of tables.
	3 Scroll through the tables to locate the table you want to view.
	4 Click the table to display it on the screen.

	Using the Illustrations Option
	1 Access online Help.
	2 Click Illustrations to display the list of illustrations.
	3 Scroll through the illustrations to locate the table you want to view.
	4 Click the illustration to display it on the screen.

	Using the Search Option
	1 Access online Help.
	2 Click Search to display the search field.
	3 Type the word you want to locate.
	4 Click Search. If the word you typed appears in the document, each instance where it appears wil...
	T

	Printing Operator Manuals
	To Print the Instructions For Use Manual from the Workstation
	Note: Prints with the same page breaks and document structure as the printed document that is ava...
	1 At the Menu bar, click Help�tt Contents�tt Print Manual.
	2 Click Print.
	3 Define what pages you want to print. You can print all or part of the document.
	4 Follow the instructions on the screen.

	To Print Operator Manuals from the CD-ROM
	Note: Prints with the same page breaks and document structure as the printed document that is ava...
	ATTENTION: Do not use this CD-ROM on your AC•T 5diff CP Workstation.
	1 Turn on your personal or office desktop PC and allow it to boot up. Refer to the PC manual for ...
	2 Insert the CD-ROM into the CD-ROM drive.
	r If Autorun is enabled on your PC, the PC automatically launches the program. (The contents of t...
	r If Autorun is disabled on your PC, do steps 3 through 4.

	3 Locate the Start.HTM file (CD-ROM�drive letter:\Start.HTM):
	r Click the Windows Start button.
	r Click Run.
	r Click Browse and locate the CD-ROM drive.
	r Double-click the CD-ROM drive letter (usually D or E).

	4 Double-click Start.HTM to launch the Home page.
	5 Select a language.
	6 Under the name of the manual you wish to print, click For Printing.
	7 Define what pages you want to print. You can print all or part of the document.
	8 Follow the instructions on the screen.
	‰ ‰





	ANALYZER
	Controls and Indicators
	WARNING Risk of operator injury when covers and doors are not closed and secured in place before ...
	POWER On/Off Rocker Switch
	r Main POWER On/Off switch located on the left side of the Analyzer
	r Recommend the Main Power be left on at all times to increase the stability of electronic compon...

	Red and Green LEDs (Light Emitting Diodes)
	r Used to quickly identify instrument status
	r If either light is glowing, Main Power is ON; if neither light is glowing, analyzer power is OFF
	r When green LED is glowing, instrument is ready for operation
	r When red LED is glowing, instrument is busy or in a standby state


	Tube Holders
	r Two tube holders are available for accommodating various size specimen tubes, microcollection d...
	r Identifying characteristics
	t Tube holder #1 has one dot in its center; tube holder #2 has two dots
	t Sample positions within the tube holder are notched to correlate with the number assigned to th...
	t Slot numbering sequence in tube holder #1 is counterclockwise; slot numbering sequence in tube ...
	Slot Designations for Tube Holder #1
	b
	Position 1
	c
	Position 2
	d
	Position 3
	e
	Position 4
	Note: Tube Holder #1 has one dot in the center.
	b
	Position 1
	c
	Position 2
	d
	Position 3
	e
	Position 4
	Note: Tube Holder #2 has two dots in the center.


	r Tube holders are interchangeable
	t To remove, rotate and pull the holder off the metal shaft
	t To exchange, slide the desired holder over the metal shaft then rotate the tube holder until it...


	Approved Collection Devices and Control Vials
	r Each specimen tube, microcollection device, and control vial approved for use with these tube h...
	r Detailed list of whole-blood collection devices and control vials approved for use with these h...
	t Lists whole-blood collection devices and control vials compatible with the cap-pierce mechanism...
	t List is not a recommendation for using one tube in preference to another nor does it guarantee ...

	r Summarized tube list is available in the Sample Analysis section of this training guide
	r For those evacuated collection tubes, microcollection devices, and calibrator vials without pie...
	t Stopper or cap must be removed prior to sampling (open-vial sampling)
	t Open-vial sampling increases the operator’s exposure to the whole-blood specimen which is consi...


	Operation
	Single Point Aspiration System
	r Means there is only one pierce position
	r Specimen tube vial must be in the pierce position for the sample to be aspirated
	r If the specimen tube is in any other slot:
	t Cap-pierce door may not close
	t If cap-pierce door does close (which initiates the cycle), analyzer aspirates air and results r...


	Pierce Position
	r Single-point of aspiration is the 12 o’clock position
	r Holder can be manually rotated (clockwise or counterclockwise as needed) to position the desire...
	r An open or closed collection device or vial may be placed in the tube slot
	r Sampling probe pierces a closed-vial specimen tube before aspirating the sample
	r May run specimen tubes with or without bar-code labels
	r If a bar-code label is used, barcode must be scanned before placing the specimen tube in the tu...

	Cap Pierce Door
	r Closing the door initiates a cycle
	r When the door is pushed into its closed position:
	t Red and green LEDs alternately flash approximately six seconds then the red LED glows steady th...
	t Four switches inside the cap-pierce mechanism sense the indentations on the side of the tube ho...
	t Door opens automatically when the aspiration is complete

	r If the door is closed and the Analyzer is not cycling, click��to open the door


	Panels
	r Samples are processed as either a CBC/DIFF or CBC panel
	CBC/DIFF Panel
	r Default panel
	r Aspirates 53�µL of sample from the specimen tube (or vial) via the sampling probe
	r Reports 20 parameters
	t CBC parameters: WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt,
	t and MPV
	t DIFF parameters: NE%, NE#, LY%, LY#, MO%, MO#, EO%, EO#, BA%, and BA#

	r If RUO (Research Use Only) is enabled, six additional parameters are reported
	t Qualitative parameters that must not be used for the purpose of diagnosis
	t RUO parameters include Pct, PDW, IMM%, IMM#, ATL%, and ATL#


	CBC Panel
	r Must be selected before the specimen is processed
	r Aspirates 30�µL of sample from the specimen tube (or vial) via the sampling probe
	r Reports 10 CBC parameters only
	t WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt, and MPV

	r If RUO (Research Use Only) is enabled, two additional parameters are reported
	t Qualitative parameters that must not be used for the purpose of diagnosis
	t RUO parameters include Pct and PDW

	r Final results are calculated automatically



	NOTES
	REAGENTS
	To obtain the optimum performance characteristics stated in the Instructions For Use manual, use ...
	AC•T 5diff Diluent
	Purple

	r Isotonic solution that dilutes the sample
	r Stabilizes cell membranes
	r Conducts aperture current
	r Provides the sheath medium for focused flow through the flow cell

	r Rinses analyzer components after analysis
	r Contains less than 0.1% sodium azide which may cause an explosion if not properly flushed down ...
	¸
	¸
	AC•T 5diff Hgb Lyse
	Orange


	r Disrupts erythrocytes (lysis)
	r Frees hemoglobin
	r Reduces cellular debris
	r Converts hemoglobin to a stable cyanide-containing pigment
	r Contains potassium cyanide, a quarternary ammonium salt; special instructions are provided for ...
	¸
	AC•T 5diff WBC Lyse
	Yellow


	r Dilutes the sample for the total WBC count
	r Specifically differentiates between the basophils and other white blood cells for the basophil ...

	r Lyses red blood cells
	r Reduces cellular debris
	¸
	¸
	AC•T 5diff Fix
	Green

	r Lyses red blood cells
	r Preserves the white blood cells in their native state
	r Stains the granules of eosinophils, neutrophils, and monocytes
	r Provides the dilution used to differentiate the white blood cell subpopulations using the absor...
	¸
	AC•T 5diff Rinse
	Blue


	r Cleans and rinses the diluter parts
	r Prevents protein buildup
	r Eliminates routine aperture bleaching
	¸
	¸

	Reagent Container Locations
	Accessing the Reagent Compartment
	r Pushing on the reagent compartment door allows access to on-board reagent bottles
	From left to right:
	t AC•T 5diff Rinse reagent bottle
	t AC•T 5diff Fix reagent bottle
	t AC•T 5diff WBC Lyse reagent bottle
	t AC•T 5diff Hgb Lyse reagent bottle

	r 20 liter AC•T 5diff Diluent reagent container generally sits on floor below the instrument
	r If a waste container is being used, this container tends to be placed near the diluent container


	Storage and Handling
	r Always handle the reagents as instructed in the Instructions For Use manual
	r All reagents should be stored and used at an ambient temperature of 18˚C to 25˚C
	r Discard any reagent that has been or that you suspect has been frozen.

	Before Using a Reagent
	r Gently mix by inversion
	r Allow sufficient time for any microbubbles to dissipate
	Note: Microbubbles may increase the background count and affect parameter results.

	When Changing a Reagent
	r Do not pool reagents; pouring reagents from one container to another may contaminate the new re...
	r Always make sure the label on the stopper assembly tubing correlates with the reagent name on t...
	r When transferring the stopper assembly from the old container to the new container, do not touc...
	t If the pickup tube portion of a stopper assembly is contaminated during transfer, bacterial and...
	t Contamination may cause unacceptable background results especially for platelets
	t If a pickup tube touches you or anything outside the container, flood the pickup tube with dist...

	r Always correlate the position of the color-coded reagent bottle with the color-coded label atta...
	IMPORTANT Risk of misleading results. If a reagent is connected in the wrong position, contaminat...

	Reagent Lot Numbers
	r Reagent lot numbers contain 11 alphanumeric characters consisting of five numeric digits, an al...
	For example, lot number for AC•T 5diff Diluent might be 00102D00002
	r If an operator tries to enter an invalid lot number, a message appears


	Reagent Log
	r Click on Analyzer / Logs tab�tt Reagent Log tab to view the log
	r Maintains most recent 50 entries displaying the most recent log entry at the top of the log and...
	r Rollover is first in, first out when the 51st entry is added
	r Log contains the following information fields
	Note: It is necessary to scroll right to see some of these fields.
	Information Fields
	Date/Time
	Displays when the reagent change was made
	Reagent
	Displays operator entry which identifies the reagent that was changed
	Lot Number
	Displays operator entry that identifies the specific reagent container connected to the Analyzer
	Opened Date
	Displays the date the reagent in that container began to be used for sample analysis
	Opr
	Displays the User name logon information in the Workstation when the reagent was changed
	Expiration Date
	r Displays the new reagent container’s expiration date as manually selected by the operator from ...
	r If operator does not select a date, current date is displayed
	Comment
	Displays any comments entered by the operator changing the reagent:

	r Optional entry that provides an opportunity for the operator to type a personal observation or ...
	r Operator may use the Add Comments button to access the Add Comments box, as desired
	r If the Prompt User For Comments check box is checked (¸), the Add Comments box pops up automati...
	r If the Prompt User For Comments check box is checked (¸), the Add Comments box pops up automati...
	Note: When Add Comments box is displayed, operator cannot access any other window until they either:
	t Enter a comment then click to save and exit the box
	or
	t Click to exit the box without entering a comment



	Before Disposing of a Reagent or Its Container
	r Always dispose of reagents and containers according to your laboratory’s guidelines
	r If disposing expired AC•T 5diff Hgb Lyse reagent, always follow the instructions for eliminatin...
	Note: See the Instructions For Use manual for specific instructions.

	Before Disposing of a Waste Container
	r If waste is being collected in a container, it must always be considered a biohazard and theref...
	r To disinfect 20 liters of waste liquid:
	t 250 mL of sodium hypochlorite solution (12% available chlorine) should either be placed in the ...
	t Sodium hypochlorite solution with 12% available chlorine may be ordered from a chemical company...
	t 500 mL of a good quality household bleach may also be used
	Note: Since household bleach only has about 6% available chlorine, the volume must be doubled.

	r If the waste container is to be capped:
	t Always follow the instructions for neutralizing the waste before capping the container for disp...
	t Non-neutralized waste may produce gas which can build up pressure in a capped container
	t Neutralize waste after removing the waste container but before capping the container for disposal

	Note: See the replacement procedure in Chapter 11 of the Instructions For Use manual or the Repla...

	‰ CHANGING REAGENT SUMMARY
	Note: If all reagents are being changed, see Chapter 11 of the Instructions For Use manual.
	1 Verify a New Reagent Container is Needed
	r Display the Reagents window by choosing Analyzer/Logs tab�tt Reagents tab.
	r Check reagent levels to determine which reagent triggered the REAGENT LOW LEVEL message.
	t Check all levels because more than one may be low.
	t Obtain a new unopened container of each reagent that according to your laboratory’s protocol re...


	2 Replace the Reagent Container
	r Open the new reagent container.
	r Remove the stopper assembly from the old container then transfer it directly to the new contain...
	Note: If the lower part of the assembly touches you or anything outside the container, flood that...
	r Put the cap from the new container onto the empty container.
	r Properly dispose of the empty bottle according to your laboratory’s protocol.

	3 Record the New Reagent Information
	r At the Reagents window, click Change Reagent.
	r Choose the reagent that was changed from the drop-down menu.
	r Type the new lot number.
	Note: Today’s date automatically appears in the Opened Date box.
	r Choose the Expiration Date (or open container stability) from the drop-down calendar.
	t For all reagents except AC•T™ 5diff Hgb Lyse reagent, select the date printed on the reagent co...
	t For the AC•T 5diff Hgb Lyse reagent which has a 90 day open container stability, select the dat...

	r Click to save the information and return to the Reagents window.

	4 Wait for the Reagent Lines to Prime
	r System automatically primes the reagent and updates the level indicator.
	Note: Reagent level may not be displayed at 100% due to this priming.
	r Once priming is complete, continue normal operation.

	‰ ‰

	‰ REPLACING A WASTE CONTAINER SUMMARY
	Note: If the waste container is not full and the waste alarm is chirping (beeping) at regular int...
	1 Power Off the System
	At the Workstation
	r Click .
	r Select Quit Application.
	r Press Û or click .
	r Wait while the Workstation closes its program.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Click Shut Down at the Logon Information box.
	r Select Shutdown then click OK at the Shutdown Computer box.
	r When the It is now safe to turn off your computer message appears, power the Workstation comput...

	At the Analyzer
	r Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located at the ba...


	2 Replace the Waste Container
	r Clearly mark or apply a waste label to an empty 20�L container.
	r Using biohazardous precautions:
	t Carefully remove the cap (with waste sensor attached) from the full waste container.
	t Transfer the waste assembly directly to the empty waste container and tighten.


	3 Neutralize and Disinfect the Waste Before Capping the Container
	r For 20 liters of waste liquid, add the following to the waste container:
	t 250�mL of sodium hypochlorite solution (if 12% available chlorine) or 500�mL of sodium hypochlo...
	t 50�mL of 200 g/L sodium hydroxide solution to prevent gas from forming if the container is bein...

	r Dispose of the biohazardous waste according to your laboratory’s protocol.

	4 Power Up the System
	At the Analyzer
	r Toggle the Power ON/OFF rocker switch ON (position�–). This rocker switch is located at the bas...
	r Verify the red LED is glowing steady.

	At the Workstation
	r Power ON the Workstation computer.
	r Wait while the computer performs its internal checks.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Type the User name and Password then press Û or click OK to log on.
	r Type your 3-character (alphanumeric) Operator ID.
	r Press Û or click .
	r Wait for the Reagents window to appear.
	r Verify the background behind the “lightening bolt” is green.
	Note: Analyzer and Workstation should begin communicating within 30 seconds. In the upper right c...


	5 Prepare the System for Processing Samples
	r If the Automatic Startup function is enabled:
	t Startup routine was automatically activated when the power was toggled back ON.
	t Cycle in progress�:�Startup status bar provides a visual display of how close the routine is to...
	t When complete, resume normal operation.

	r If the Automatic Startup function is not enabled:
	t At the Menu bar, select Cycles�tt Mini Prime.
	t Cycle in progress�:�Mini Prime status bar provides a visual display of how close the routine is...
	t When complete, resume normal operation.


	‰ ‰



	STARTUP / SHUTDOWN
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Startup
	r Initiate a Startup.
	r Recognize an out-of-limit result on the Reagents window.
	r Identify the Reagent Status, Startup, and System areas of the Reagent window.
	r Cite the two ways to monitor Analyzer connection status.
	r Access the Startup Log.
	r Add a comment to the Startup Log.
	r Explain how to handle an unacceptable background result.

	Mini Prime
	r Initiate a Mini Prime.
	r State the difference between a Startup and a Mini Prime.
	r Identify when to do a Startup versus when to do a Mini Prime.

	Autoclean Function
	r Explain the purpose for the Autoclean function.
	r Set up the Autoclean function based on your laboratory’s desired protocol.

	Shutdown
	r Initiate a Shutdown.
	r State how often a Shutdown must be performed.
	r State the minimum time the AC•T 5diff Rinse reagent should stay in the instrument while in Shut...

	NOTES

	STARTUP
	r Startup must be completed before running patient specimens or controls anytime AC•T 5diff Rinse...
	r Startup routine is a sequence of automated Analyzer cycles designed to exchange the AC•T 5diff ...
	r Also primes the AC•T 5diff Hgb Lyse, AC•T 5diff WBC Lyse, and AC•T 5diff Fix reagent lines to p...
	r Checks for sufficient reagent volume based on the Daily Workload statistics entered under Setup...
	t Can enter the estimated number of CBC/DIFF and CBC cycles run per day
	t Default value for CBC/DIFF Runs Per Day is 40; for CBC Runs Per Day is 10
	t Cycle estimates are used to determine if sufficient reagent is available to complete the daily ...
	t If reagent volume is insufficient to complete the estimated daily workload, the message Reagent...

	r Performs a background count and check at the end of the Startup routine and displays the result...
	Note: Background count is an analysis cycle on reagents without the blood sample.
	r Cycle in progress status bar at the base of the Reagents window provides a visual display of ho...
	r If Autoprint is enabled, results automatically print when the routine is complete
	r Perform quality control checks before running patient specimens according to your laboratory pr...
	Two Ways to Initiate a Startup
	Automatic
	r If automatic startup is selected under System Setup and the system is powered off, when system ...
	r Recommended setting
	r Default setting when the instrument is installed
	r To set up this automatic feature (if it is disabled):
	t At the Menu bar, click Setup�tt System
	t Type Administrator password then press Û or click
	t Click Cycle Option tab
	t At the Startup box, click the empty box next to Automatic (¸ appears in box)
	t Click �to save the selection and exit the window


	On Demand
	r At the icon bar, click �to initiate a Startup routine


	STARTUP SCREENS
	Reagents Window
	r Also referred to as the Analyzer�/�Logs window
	r Displays system status in three boxes:
	t Reagent Status box provides an overview of the status of each reagent
	t Startup box shows the background status of the last completed Startup
	t System box provides a visual indication as to whether or not the Analyzer and Workstation are c...

	Reagent Status Box
	Reagent
	Lot Number
	Opened Date
	Displays the date the reagent in that container began to be used for sample analysis
	Expiration Date
	Displays the new reagent container’s expiration date as manually selected by the operator from a ...
	Operator
	Displays the User name logon information in the Workstation when the reagent was changed
	Fill Level
	Displays the percentage of reagent still available in the container

	System Box
	r Provides a visual of the communication connection status between the Analyzer and the Workstation:
	t If Analyzer and Workstation are communicating, background behind the “lightening bolt” is green
	t If Analyzer and Workstation are not communicating, background behind the “lightening bolt” is red

	r Connection status indicated in the System box must correlate with the connection status indicat...
	t If background behind the lightening bolt is green, the right circle must also be green
	t If background behind the lightening bolt is red, the left circle must also be red

	r Two tools for monitoring system connection status:
	t Lightening bolt only appears on the Reagents window
	t System State indicators (two circles) provide continuous system connection status information, ...


	Startup Box
	r Displays background status of the last completed Startup
	r Shows status on a Passed/Failed basis:
	t “Passed” is displayed on a green background when a parameter is within the internal background ...
	t “Failed” is displayed on a red background when a parameter is outside the acceptable internal b...

	r If background results are not within acceptable limits after the first background check:
	t Analyzer automatically performs the background count up to two more times
	t Only the status of the final background check is recorded

	r Numeric background results may be reviewed by accessing the Startup Log
	t Click on Analyzer / Logs tab�tt Startup Log tab



	Startup Log
	r Maintains the most recent 50 entries displaying the most recent log entry at the top of the log...
	r Rollover is first in, first out when the 51st entry is added
	r Allows an operator to review numeric background results
	r Preset background limits, listed at the bottom of the window, aid in the evaluation of results ...
	Information Fields
	Date/Time
	WBC
	RBC
	HGB
	Displays the numeric hemoglobin background result determined during that Startup
	PLT
	Displays the numeric platelet background result determined during that Startup
	Status
	Startup background status indication:
	r Field contains the word “Passed” backlighted in green when all background results are within th...
	r Field contains the word “Failed” backlighted in red when one or more background results exceed ...

	Comment
	Displays any comments entered by operator performing the Startup:
	r Optional entry that provides an opportunity for the operator to type a personal observation or ...
	r Operator may use the Add Comments button to access the Add Comments box, as desired; highlight ...
	r If the Prompt User For Comments check box is checked (¸), the Add Comments box pops up automati...
	Note: When Add Comments box is displayed, operator cannot access any other window until they either:
	t Enter a comment then click to save and exit the box
	or
	t Click to exit the box without entering a comment




	Indications of a Failed Background
	r On the Reagents window:
	t Message appears in the Startup box
	t When a parameter is outside the acceptable background limit, the word “Failed” is displayed on ...
	t For example, if the WBC background exceeds the preset WBC background limit, the word “Failed” (...

	r On the Startup Log:
	t Message appears in the Status field
	t “Failed” (on a red background) appears in the Status field when one or more background results ...
	Note: If “Failed” displayed on a red background appears but all the background results are accept...
	t Numeric results must be compared with the displayed background limits to determine which parame...


	How to Handle a Failed Background
	If One or More Background Results Failed
	r Click �to redo Startup routine
	r If Startup continues to fail, contact your Beckman Coulter Representative

	If All Background Results Passed but the Startup Log Status Displays Failed
	Note: When “Failed” is displayed on a red background in the Startup Log Status column but all the...
	r Click the Startup Log tab and evaluate numeric results to verify all background results are wit...
	Note: May also click the Run tab to view Startup results.
	r If “Failed” displayed on a red background appears in Status column but all the background resul...
	t Double-click either System State indicator to quickly access Error Log
	t Check last entry on the Error Log
	t Verify the date and time correlate with this incident
	t Locate message in the Error Messages table in the Operator’s Guide, Chapter�11
	t Complete suggested action
	t For more assistance, contact your Beckman Coulter Representative





	‰ STARTUP SUMMARY
	Before starting this summary, verify both Workstation and Analyzer power are ON. If the system is...
	1 Preliminary Checks
	r If the Workstation screen is blank, power on the monitor.
	r Verify the green circle is displayed in the upper right corner.
	r Check the waste container level.
	t If the container needs to be replaced, change the container using the Replacing a Waste Contain...

	r Make sure the Printer is ready to print.
	t If the paper supply is insufficient, add paper.
	t Make sure the power is ON and ready to print.


	2 Perform the Startup
	r Click �to initiate a Startup routine.
	r Monitor the Cycle in progress�:�Startup status bar, as desired.
	r Hard copy of the results prints automatically if the Auto-Print function is enabled.

	3 Review Results
	r Once the Startup routine is complete, verify Passed is displayed for each parameter.
	t If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.
	Note: If the Add Comments box automatically appears, click to exit.
	t Click �to initiate another Startup routine.
	t If the Startup continues to fail, contact your Beckman Coulter Representative.

	r Save individual or log printout if required by your accreditation agency.
	r Add comments as desired.
	t If the Add Comments box appeared automatically, type in your personal observation or appraisal.
	t To access the Add Comments box, click Startup Log tab�tt Add Comments button then type your per...
	t Click to save your comments.


	4 Perform Quality Control Checks
	r Perform quality control checks before running patient specimens according to your laboratory’s ...
	‰ ‰



	MINI PRIME
	r Primes reagent lines including AC•T 5diff Diluent, AC•T 5diff Hgb Lyse, AC•T 5diff WBC Lyse, an...
	r Does not preform a background count
	r To initiate a Mini Prime:
	t At the Menu bar, select Cycles�tt Mini Prime
	t Cycle in progress�:�Mini Prime status bar provides a visual display of how close the routine is...


	STARTUP VERSUS MINI PRIME
	When to do a Startup versus When to do a Mini Prime
	r Startup must be done before running patient samples or controls:
	t After a Shutdown
	t Anytime the Analyzer has set idle (uncycled) more than four hours

	r Mini Prime must be done before running patient samples or controls:
	t Anytime the Analyzer has set idle (uncycled) more than two hours but less than four hours
	t Anytime the Analyzer is powered off then back on again
	Note: If your laboratory selected Startup be done automatically when the Analyzer is powered up, ...



	AUTOCLEAN FUNCTION
	r Analyzer automatically performs an Autoclean cycle after a specified number of analyses
	r Default number of analyses is 75
	r May select from 1 to 75 analyses based on your laboratory’s desired protocol
	r When the designated number of analyses is reached:
	t AC•T 5diff Rinse reagent is delivered to the baths assembly
	t Cycle takes approximately 2�minutes

	r To change the frequency:
	t At the Menu bar, click Setup�tt System
	t Type Administrator password then press Û or click
	t Click Cycle Option tab
	t At the Autoclean Frequency box, highlight the current number then type the desired number of an...
	t Click �to save the selection and exit the window


	SHUTDOWN
	r Shutdown is a sequence of automated Analyzer cycles designed to exchange the AC•T 5diff reagent...
	r Allowing AC•T 5diff Rinse reagent to remain in the instrument a minimum of 30�minutes minimizes...
	r Perform a Shutdown once every 24 hours that the instrument is in use
	r Startup must be completed prior to running patient specimens or controls
	‰ SHUTDOWN SUMMARY
	1 Perform Instrument Shutdown
	r Click �to initiate a Shutdown routine.
	r Monitor the Cycle in progress�:�Shutdown status bar, as desired.

	2 Shut Down Computer then Power Off Analyzer and PC
	When Shutdown is complete, a message box appears:
	r Click OK to shut down the computer.
	r Turn off the Analyzer power switch.
	r Wait for the “It is now safe to turn off computer” message to appear.
	r Turn off the PC power switch.
	Notes:
	t Allow AC•T 5diff Rinse reagent to remain in the instrument a minimum of 30 minutes.
	t Wait at least 30 seconds before performing the Power Up and Log On procedures.
	t After doing Shutdown, you must do a Power Up and Startup before running patient specimens or co...


	‰ ‰



	SETUP OPTIONS
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.

	MENU TREE
	SETUP MENU OPTIONS
	System setup
	Date/Time Tab
	Physician/Location Tab
	Communication Tab
	LIS /HIS Tab
	Variable Format

	Printer Tab
	Cycle Option Tab
	Units Tab
	Analyzer Tab
	Config Save / Restore Tab
	Language Tab

	QUALITY ASSURANCE SETUP
	General Tab
	Reserved Lot Numbers
	CV Limits
	XM Options
	IQAP ID
	Auto-Print

	Calibration Tab
	Shifts Tab

	Patients setup
	Flagging and Messaging Tab
	Flags and Messages Window

	Parameters Tab
	Enable / Disable RUO Parameters

	Reports Tab
	Reports Headers
	Auto-Print
	# of Copy
	Report Format
	Printed Parameters
	Enable


	INITIAL SET UP OF CONTROL FILES
	Set Up
	Setting Up a Control File
	1 Select the File
	2 Access the Setup Control Window
	3 Download the Control Data from the Disk
	4 Reserve the Control Lot Number
	5 Set Up Another Level of Control, if applicable
	‰ ‰




	QUALITY ASSURANCE
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Controls
	r Explain the storage and handling requirements.
	r State the open-vial stability.
	r Define an event.
	r State indications of instability or deterioration.
	r Prepare and run AC•T 5diff Control Plus.
	r Recognize an out-of-limit result on the control window.
	r Explain what to do if a cell control result is out-of-limits.
	r Explain the statistics associated with the control files and graphs.

	Interlaboratory Quality Assurance Program (IQAP)
	r Explain the purpose of the Interlaboratory Quality Assurance Program (IQAP).

	Control File Management
	r Review numeric and graphic control data for errors and make appropriate corrections.
	r Print control file data.
	r Exclude individual control runs.
	r Delete a control file.
	r Properly set up control files for running AC•T 5diff Control Plus.
	r Establish running means and expected ranges for BASO�% and�#.
	r Explain how to make changes to an existing control file.

	Optional Checks
	r Explain the purpose of a reproducibility check.
	r Explain the purpose of a carryover check.

	XM Analysis
	r Explain the purpose XM analysis.
	r Explain why the use of RBC indices is so effective in the XM analysis.
	r Define the terms batch, mean values, and limits as they apply to the XM analysis.
	r State the minimum number of samples collected for an XM batch.
	r Describe the three areas of the XM graph.
	r Identify the problem parameter (or parameters) causing an XM batch to be out-of-control.


	NOTES
	COULTER® AC•T™ 5diff CONTROL PLUS
	r Recommended cell control
	r Quality control material for monitoring CBC and DIFF parameters
	r Three levels of control: Low, Normal, High
	Storage
	r Control must be stored at 2 to 8˚C (35 to 46˚F)
	r Storage of the control product in the cap down (inverted) position is not recommended
	t Might require additional mixing for complete resuspension of cellular components


	Proper Handling
	Prepare Cell Controls according to the Package Insert Instructions
	r Warm control vials at ambient temperature for at least 15 minutes before mixing
	r Mix gently by hand using the 8 x 8 x 8 method twice
	t After the second mixing, check the sides and bottom of the tube to verify the control is mixed ...
	t Overmixing causes hemolysis which indicates product deterioration

	r Do not use mechanical mixers or rotators
	r Return to the refrigerator within 30 minutes to ensure stated open-vial stability


	Stability
	Open-Vial Stability
	r Open-vial stability stated on the package insert is listed according to days or events (whichev...
	r An event occurs anytime an operator completes the following sequence:
	t Removes a control vial from the refrigerator
	t Allows the control vial to stand at room temperature 15 minutes
	t Mixes the control vial gently by hand using the 8 x 8 x 8 method two times
	t Aspirates sample
	t Returns the control vial to the refrigerator within 30 minutes

	r MCV and/or RDW parameters may show trending through the product’s shelf life; however, this is ...

	Indications of Instability
	r A slight pink color to the supernatant is normal
	r Inability to obtain expected values in the absence of known instrument problems or gross hemoly...


	Running AC•T 5diff Control Plus
	r Control is designed with a pierceable cap
	r Use the instrument’s piercing capability to prevent spillage and reduce biohazard exposure
	r Make sure the cap is secure before placing the well-mixed, closed control vial in sample positi...
	r Make sure tube holder sample position is rotated to the pierce position before closing the cap-...
	r Although control levels may be run in any order, Low, Normal, then High provides the best stati...
	r Controls may be processed with the Control window displayed or on the Run window if the lot num...
	r Do not preassign controls into the Worklist
	r Hard copy of the results (in a line list format) prints automatically if the Auto-Print functio...
	r BASO�% and�# mean values and expected ranges
	t Establish your running mean and expected range for BASO�% and�# according to your laboratory pr...

	Using the Run Window to Run Controls
	r Identifier entered in the Sample ID field is compared to the list of Reserved lot numbers
	r If the identifier in the Sample ID field matches a Reserved lot number:
	t Corresponding entry fields are automatically completed
	t Workstation places the results in the appropriate control file based on the information entered...
	t Control results are displayed in the patient sample format but are flagged as a control
	H If a control result is lower than the expected range low limit, the parameter field backlights ...
	H If a control result is higher than the expected range high limit, the parameter field backlight...

	t Cannot see how the results of this control relates to other stored control results until you ac...

	r If the control lot number is not reserved:
	t Software searches for a duplicate sample ID number throughout the current active archive then a...
	t Control results are stored as a patient not a control
	t Control results are flagged as a patient
	t Any control with an unreserved lot number must be processed with the Control window displayed (...



	Reviewing Control Results
	Tabular Results
	r The most recent control results are displayed and printed first (at the top)
	r Operator can add a comment to a selected set of results using the comment button
	r Control results are compared to expected ranges:
	t When a result exceeds the low limit, an L is displayed next to the result
	t When a result exceeds the upper limit, an H is displayed next to the result

	r Each control file can store more than 100 runs:
	t Must scroll to see older data
	t History of previous control results may be helpful during troubleshooting process
	t After 400th control is run into a file, message Result Could Not Be Saved (File Full) appears; ...

	r When a % CV exceeds the QC CV limit for that parameter, the parameter field containing the out-...
	To access QC CV limits:
	At the Menu bar, click on Setup�tt Quality Assurance�tt type Password then click �tt click Genera...
	r Operator may decide to exclude an analysis:
	t Control results should only be excluded immediately if you can trace an operator error to the u...
	t Excluding too many runs can cover up an instrument problem and bias results


	Graphs
	Tabs
	r Each of seven tabs allows access to three thumbnail graphs at a time
	Note: All seven tabs appear even when a CBC file is selected.
	r From left to right, clicking the graph tab provides access to the following parameters:
	t If WBC / RBC / HGB tab selected, thumbnail graphs for the WBC count, RBC count, and hemoglobin ...
	t If HCT / MCV / MCH tab selected, thumbnail graphs for the hematocrit, Mean Cell Volume, and Mea...
	t If MCHC / RDW / PLT tab selected, thumbnail graphs for the Mean Cell Hemoglobin Concentration, ...
	t If MPV / NE / LY tab selected, thumbnail graphs for the Mean Platelet Volume, neutrophil�%, and...
	t If MO / EO / BA tab selected, thumbnail graphs for the monocyte�%, eosinophil�%, and basophil�%...
	t If NE# / LY# / MO# tab selected, thumbnail graphs for the neutrophil absolute number, lymphocyt...
	t If EO# / BA# tab selected, thumbnail graphs for the eosinophil absolute number and basophil abs...


	Thumbnail Graphs
	r Each thumbnail graph contains three areas
	t A central line representing the actual mean value for that parameter
	t A line above mean value (central line) represents the upper limit and a line below the mean val...
	t Area showing dashes is the out-of-limit area

	r Each thumbnail graph displays the last 10 data points that are included in the statistics
	t Last data point included in the graph is located on the far right
	t Data points are not displayed for control runs that are excluded from the control file


	Expanded Graphs
	r When a thumbnail graph is double-clicked, graph expands to display up to 100 data points
	r Only data points for control runs included in the statistics are displayed
	r After the first 100 controls are processed, this option always displays the plot points for the...
	r Provides a history of previous control results which may serve as an aid during the troubleshoo...
	r After the 100th control is run, the graph begins to rollover where the oldest control run is de...
	r Most recent data point included in the graph is located on the far right
	r Data points are not displayed for control runs that are excluded from the control file


	Graphing Control File Data Facilitates Monitoring
	r Graphing provides a convenient mechanism that allows daily inspection for trends, shifts, outli...
	r Data plotted on a graph:
	t Allows easy visual detection of “in control” and “out of control” results
	t Allows faster detection of subtle developing problems

	r Different kinds of changes suggest different sources for error
	r Graphing is ideal for spotting trends and shifts
	Trend
	r Gradual change in 5 or more consecutive results, all going upward or all going downward
	r Systematic drift or trend in control values suggests that a problem is progressively developing
	r Generally due to the deterioration of a reagent or control material

	Shift
	r Sudden or abrupt change in 5 or more consecutive results all above or all below the mean
	r This type of systematic error is usually associated with the malfunction of the instrument or a...

	Outlier
	r Single result that falls outside the upper or lower limit
	r Chance probability for a value to be outside the limit is about one time out of every 20 times ...
	r In the example below, run #6 (from the right) illustrates an outlier; notice plot point is loca...
	r With computerized graphing, small double-lined area typically serves as a limit for the plot point
	r Since plot point for an outlier cannot extend beyond this set boundary, operator must look at t...
	r If the numeric result for the outlier is only slightly beyond the limit, it may be a statistica...
	r To confirm a statistical outlier, operator must run the control one more time
	t If the result of the rerun is now in-control, the analytic run is accepted and both runs (the s...
	t If rerun of control reflects the same parameter(s) as still being out-of-control, there may be ...

	r When considering a control problem:
	t Any change in the control material may cause control to be out
	t Control must be handled carefully as instructed on the package insert
	t If control material is treated roughly, stored improperly, or used beyond the expiration date, ...
	t Generally only one level of control or one vial shows the problem

	r When considering a system problem:
	t Any change to the instrument regarding the test system may cause controls to be out
	t Usually affects more than one level of control

	r Important considerations when a statistical outlier occurs:
	t Frequency of outlier occurrences should be carefully monitored; high outlier frequency may indi...
	t When a single control result is analyzed and the run is repeated, the original control result s...



	Guidelines for Acceptable Operation
	r Performance specifications for your instrument are located in Operator’s Guide, Chapter�3
	r Laboratory may choose to use Beckman Coulter assigned values or may choose to establish their o...
	r Instrument is considered well maintained and operating correctly if before current cell control...
	t Confirms recovered mean values are within the TABLE OF EXPECTED RESULTS
	or
	t Establishes its own mean values and acceptable ranges and periodically reevaluates those means


	For More Basic Concepts
	r Consider ordering Basic Concepts of Quality Control, PN�4235526
	t Designed for someone with little or no quality assurance experience
	t If desired, contact your Beckman Coulter Representative to order a printed copy

	r Information covered in this booklet includes:
	Note: This list is not inclusive.
	t Fundamental components of a quality assurance program
	t Definitions of common terminology
	t How to read a package insert
	t Difference between a control and a calibrator
	t Why calibration is necessary
	t How to determine if a control is “in” or “out”
	t What to do if a control is “in”
	t What to do if a control is “out”
	t Outliers
	t Trends
	t Shifts
	t Interlaboratory Quality Assurance Program (IQAP)

	r Booklet also contains a glossary and a self-evaluation


	‰ RUNNING COULTER AC•T 5diff CONTROL PLUS SUMMARY
	1 Get the Workstation Ready
	To run controls with the Control window open
	r Click the Quality Assurance tab.
	r From the Select Control drop-down menu, locate the control file that correlates with the lot nu...

	To run controls with the Run window open
	r Click the Run tab.
	Note: To use this option, the control lot number must be reserved. If you are not familiar with t...
	r Enter the control lot number as the next Sample ID.


	2 Prepare the Control according to the Package Insert
	r Warm controls at room temperature for 15 minutes.
	r Control levels may be processed in any order.
	r Mix the control vial using the 8 x 8 x 8 method.
	t Do not use a mechanical mixer!
	t Inspect the control vial to ensure all cells are uniformly distributed, if not, repeat the 8 x ...


	3 Run the Control
	r At the tube holder, make sure sample position is in the pierce position (12 o’clock).
	(In tube holder #1, use sample position 1; in tube holder #2, use sample position 4.)
	r Place the well-mixed, closed-vial of control in sample position 1.
	r Close the cap-pierce door.

	4 Review Results
	Note: A hard copy of the results prints automatically if the Auto-Print function is enabled.
	r Verify control results are within the acceptable ranges.
	r If a result is out-of-limits:
	t Rerun the control after gently remixing the control vial.
	or
	t Refer to When CBC/DIFF Control is Outside Its Expected Ranges that follows.

	r Compare the results of this run with previous runs, as desired
	t To evaluate stored numerical data or evaluate the graphs for the presence of shifts or trends, ...
	t Click Quality Assurance tab to display the Control window, if needed.



	When CBC/DIFF Control is Outside Its Expected Ranges
	1. Check for a control problem.
	r Ensure the control material was properly mixed. If not, mix it according to the package insert.
	r If the control was processed in the Control window, make sure the control file with the correct...
	r If the control was processed in the Run window, make sure the lot number was entered correctly ...
	r Unless you have established your own running mean and/or expected ranges, make sure the setup i...
	r If any of the above problems exist, rerun the control; otherwise, proceed to the next check.
	2. Rerun the control to determine if the out-of-limit result is a statistical outlier. If the rer...
	3. Ensure the control material was not contaminated by running another vial or level of control. ...
	4. Perform the Extended Cleaning procedure in the Instructions For Use, Chapter�11.
	Use the Online Help to locate this procedure:

	a. Click .
	b. Click on Contents. The table of contents appears in the left frame.
	c. Inside the left frame, click on 11 Diagnostics to list the headings in that chapter.
	d. Scroll through the headings and click on Extended Cleaning. The cleaning procedure appears ins...
	e. Complete the procedure.
	t Follow the instructions on the Workstation screen.
	or
	t Print a copy of the instructions.
	-���Right click on the procedure (anywhere inside the right frame).
	-���Click Print on the pop-up menu.
	-���Click OK to initiate printing.
	Note: All the information under the primary heading is printed. Locate the Extended Cleaning inst...

	f. Rerun the control.
	t If the results are acceptable, run other control levels that need to be processed then resume n...
	t If the results are still out, call your Beckman Coulter Representative to help you troubleshoot.
	‰ ‰




	‰ Making Changes to a Control File CURRENTLY IN USE SUMMARY
	Use this summary only if you need to make a change in a control file that is currently in use and...
	r To correct a typographical error.
	or
	r To edit an assigned value (obtained from the Table of Expected Results) to a running mean (esta...

	If you need to make a set up change (such as changing the lot number), use the Control File Manag...
	1 Select the File
	r Click the Quality Assurance tab�tt Control tab to display the Control window.
	r Choose the existing file you want to change from the Select Control drop-down menu.

	2 Access the Setup Control Window
	r Click the Setup Control button.

	3 Make the Changes
	r Enter the new information.

	4 Verify All Changes
	r Check all entries are correct.
	r Click� .
	t If control runs are stored in this file:
	H When the Do You Want The Existing Results To Be Saved? message appears, click on the desired ac...
	H Selected action makes the requested changes then exits the window.

	t If no control runs are stored in this file, requested changes are saved before exiting the window.

	r Control file statistics are recalculated based on the changes.
	‰ ‰

	IQAP (Interlaboratory Quality Assurance Program)
	r Coulter Interlaboratory Quality Assurance Program is a service offered to all regular users of ...
	r It complements a laboratory’s in-house quality control program by providing peer group comparis...
	r The assessment is completely independent of the assay value issued when the product was supplied
	r A separate IQAP manual (PN 4206266) is available with information on enrollment, data submissio...
	Note: In software version 2.00 and above you can download your control file data to diskette for ...

	CONTROL FILE MANAGEMENT
	r Once a control file is initially set up, the file is considered an existing control file
	r Two types of existing control files:
	t Control file that contains control run data (may be either current or old data)
	t Control file with no stored control run data because the file is either newly set up or has had...

	r 12 CBC control files and 12 CBC/DIFF control files are available for set up:
	t CBC control files (1 through 12) contain fields for entering CBC parameter values only
	t CBC/DIFF control files (13 through 24) contain fields for entering CBC and DIFF parameter values
	t CBC and CBC/DIFF files are type specific and should correlate with the control

	r When setting up a control file:
	t You can enter all of the information manually or you can download data from the control disk in...
	t Most information is selected from a drop-down menu
	t If manually typing parameter values and limits, use Ù to move from field to field. Refer to the...
	t If your laboratory designates a specific file for running each low, normal, or high control, it...

	r Initial set up of the control files is located under Topic 3, Setup Options


	‰ CONTROL FILE MANAGEMENT SUMMARY
	Review the Numeric Control Data and Graphs, if applicable
	1 Locate the Control File
	r Click the Quality Assurance tab to display the Control window.
	r Choose the specific file you want to review from the Select Control drop-down menu.

	2 Review the Graphs
	r Double-click on any thumbnail graph you wish to review.
	r Look for any skewed or out-of-limit plot points.
	r Check for a shift or a trend.

	3 Review Numeric Data
	r Review�%CV of all parameters (press é to see additional parameters).
	r If a CV is high, scroll through the rows and examine each run for results mistakenly run into t...
	r May review and manage the data by shifts, if desired.
	r Exclude any mistakes from the control calculations.
	t Locate the control that needs to be excluded from the calculations.
	t Click the to the left of that control (inside the Include column).
	t (an empty check box) indicates those control results are no longer being included in the contro...
	t Repeat as needed.



	Print the Control File Data
	r Click .
	r Print All Rows is preselected but if a hard copy of the graphs is also desired select the Print...
	r If you are submitting data for IQAP evaluation, print a second copy.

	Delete the Control File Data
	r Click .
	r Choose Erase All rows from the drop-down menu.
	Note: All the control results are deleted. Target values and +/- limits remain in the control fil...

	Set Up the New Lot Number of Commercial Control
	IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up contro...
	Note: Before starting this set up, obtain the control disk for the controls you plan to set up.
	1 Select the File
	r Click the Quality Assurance tab to display the Control window.
	Note: If the Control window is not displayed, click the Controls tab at the bottom.
	r Choose a CBC/DIFF file from the Select Control drop-down menu.

	2 Access the Setup Control Window
	r Click the Setup Control button.

	3 Download the Control Data from the Disk
	r Insert the control disk into the floppy drive.
	r Select the Download Values button.
	r Select the control level then click .
	r Select Commercial as the source of control material (if it is not already displayed).
	r Print if desired then click .

	4 Reserve the Control Lot Number
	r Click Setup�tt Quality Assurance.
	r Type the password then click .
	r Click the General tab, if necessary.
	r Click the box in the Reserved column that corresponds to the desired control lot.
	r Click .

	5 Set Up Another Level of Control, if applicable
	IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up contro...
	r Review, print, and delete other files, as applicable.
	r Choose another empty, inactive file from the Select Control drop-down menu.
	r Repeat steps 2, 3, and 4.
	‰ ‰


	OPTIONAL CHECKS
	Reproducibility Check
	r Check measures how close several results (from the same specimen) are to each other; in other w...
	r Check may be done using CBC or CBC/DIFF panel
	r For best results, a fresh, normal whole-blood specimen must be used
	r One normal, fresh whole-blood specimen is cycled at least 5, but no more than 11 times
	r CV or Coefficient of Variation is a percentage of deviation from the mean
	r Results that exceed the limits appear against a red background
	r Reproducibility does not measure accuracy, but true accuracy is not possible unless the instrum...
	r Performing a reproducibility check before performing a calibration may catch imprecision proble...
	r Procedure is located in the Operator’s Guide, Chapter 11

	Carryover Check
	r Carryover is the interaction of the previous sample with the current sample
	r High to low carryover check verifies the high results of one sample do not affect the low resul...
	r Check is done by analyzing a whole-blood specimen with high values followed by a whole-blood sp...
	r Carryover is calculated as follows:


	NOTES
	XM ANALYSIS
	Quality Assurance Tool
	r XM analysis is a quality assurance method that allows a laboratory to continuously monitor the ...
	r Since this quality assurance tool is based on patient results:
	t The more patient samples processed per day, the more frequent the system monitoring
	t Proper monitoring is best accomplished if the laboratory runs more than 100 patient samples per...
	t Running less than 100 patient samples per day means the system is not checked frequently enough...
	t If your laboratory processes less than 100 samples per day but you still like to consider using...

	r Any method used for quality control must use a material that meets two requirements:
	t Material must be stable
	t Material must be similar in content to the patient samples that will be analyzed

	r XM analysis meets these requirements:
	t Uses the patient samples themselves as a material so the similarity requirement is met
	t Uses the red blood cell indices (MCV, MCH, and MCHC) so the stability requirement is met

	r No additional cost to the laboratory because the method uses patient sample results
	r Concept of this analysis is based on XB Analysis developed by Dr. Brian Bull but is modified to...
	t May select the more traditional three parameter analysis that includes MCV, MCH, and MCHC
	or
	t May select a nine parameter analysis that includes WBC, RBC, HGB, HCT, RDW, PLT as well as MCV,...

	r Traditional three parameter evaluation focuses on the more stable RBC indices

	RBC Indices
	r MCV, MCH, and MCHC are relatively stable parameters:
	t RBC indices that comprise the 3-parameter XM analysis are very tightly controlled by the body b...
	t Other parameters such as the white blood cells and platelets that are included in the 9-paramet...

	r Are typically stable for an individual patient from day to day
	r Are stable for a patient population over time
	t Many hospitalized patients have been investigated and it has been found that there is no signif...


	Establishing Mean Values
	For the 3 Parameter XM Analysis
	r A constant for each RBC index (MCV, MCH, or MCHC)
	r XM mean values should reflect the entire patient population of the laboratory:
	t Patient population of a general hospital usually includes samples from all patient age groups, ...
	t A patient population that includes only one age group or only one disease state will yield diff...

	r As long as the patient population remains constant, the XM mean values of each index also remai...
	r If the patient population changes, the mean of an index may also change and needs to be reevalu...
	r May want to start with the target values suggested by Dr. Brian Bull for his XB Analysis:
	t MCV = 89.5
	t MCH = 30.5
	t MCHC = 34.0
	t If you begin with these values, your laboratory must then evaluate and adjust them for their ow...
	t Results from at least 250, but ideally 1000 blood samples should be collected to find your labo...
	t Results should include all types of patients (oncology, presurgical, OB, dialysis, out patients...


	For the 9 Parameter XM Analysis
	r MCV, MCH, and MCHC are part of these nine parameters so the information under the Heading�For t...
	r For the other six parameters, your laboratory must evaluate the results of your population and ...


	Getting Started
	Turning the XM Analysis ON
	r Default setting for XM analysis is Off
	t XM tab is invisible when Quality Assurance tab is selected

	r To activate XM analysis:
	t At the Menu bar, select Setup�tt Quality Assurance
	t Type the Administrator Password then press Û or click
	t At the XM Options box, select 3 Param (parameters) or 9 Param (parameters)

	r Once activated, laboratory must establish their own mean values (XM limits)

	Enter XM Mean Values and Limits
	r XM mean values and limits must be entered in the Workstation
	Click Quality Assurance tab�tt XM tab�tt Setup XM Limits button
	r In the XM Limits box:
	t Type the mean values established by your laboratory (or for MCV, MCH, and MCHC the values sugge...
	t Multiply each mean value by 5% and type this number in the +/- box (5% is only a suggested perc...
	For example, if for MCV you use Dr. Bull’s suggested mean of 89.5 and a 5% limit.
	XM mean value x percentage = +/- value������(89.5 x 0.05 = 4.5)
	You would enter the 89.5 as the mean value and 4.5 as the limit. The Workstation will calculate t...

	r Once your laboratory has established the XM mean values for your population:
	t Enter new mean values and limits.
	t For MCV, MCH, and MCHC, adjust the 5% limits according to your laboratory protocol.
	For example:
	MCV XM mean value x percent limit = +/- value for MCV
	MCH XM mean value x percent limit = +/- value for MCH
	MCHC XM mean value x percent limit = +/- value for MCHC
	t Due to the wide physiological range for the other six parameter, you may wish to use a higher p...



	Using the XM Analysis
	r When XM option is turned on, the:
	t Workstation stores results of all patient samples (including any repeat samples) as they are cy...
	t XM analysis is performed on sets of 20 patient results at regular intervals (each patient set i...

	r Stored results being displayed on the current batch table may be accessed by clicking the Batch...
	t If the 3 parameter XM option is selected, table shows the MCV, MCH, and MCHC parameter results ...
	t If the 9 parameter XM option is selected, table shows the WBC, RBC, HGB, HCT, MCV, MCH, MCHC, P...
	Note: It is necessary to use the scroll bar to view the MCHC, PLT, and RDW parameter results.

	r Results stored on the current batch table cannot be deleted from the table
	r Samples that will not be stored on the current batch table and, therefore, not used in the XM b...
	t Samples processed in the reproducibility mode of operation
	t Samples processed in the calibration mode of operation
	t Controls processed with the Control window displayed
	t Controls (with reserved lot numbers) processed with the Run window displayed
	t Blank samples
	t Patient samples with at least one non-numeric result

	r When the batch of 20 patient samples is completed, the Workstation performs the XM�analysis and...
	t Calculation done automatically by the Workstation
	t This batch mean is not a simple average value of the patients’ parameter results, but a type of...

	r Workstation then compares each batch mean to its expected XM mean value
	t Results are displayed on the XM Batch Means table on the XM window
	t If the batch mean is inside the expected XM limits, the batch is said to be IN and the instrume...
	t If the batch mean is outside the expected XM limits, the batch is said to be OUT:
	H One or more parameters are not close enough to the expected XM mean values
	H An H or L flag appears beside the out-of-limit results
	H Red XM icon appears to the left of the System State indicators (connection status circles in th...



	Reviewing XM Data
	XM Batch Table
	r Table appearing on the XM window that collects completed batch information
	r Used to view the calculated batch means for the last 60 batches of 20 samples
	r Most recent batch is located at the bottom of the table
	r May be used to identify the affected parameters and to determine the direction and amount of th...
	r After the first 60 batches are completed, this option always displays the last 60 completed bat...
	t Provides a history of recent batch means which may serve as an aid during the troubleshooting p...
	t After the 60th batch is completed, the table begins to rollover where the oldest batch results ...
	t Individual batches cannot be deleted

	r Details of a selected batch may be viewed by clicking the Batch Details button
	t Table that collects the individual sample results
	t Individual samples cannot be deleted from the batch of 20 samples


	XM Graphs
	r Three graphs are displayed at a time
	t If 3 parameter XM option is selected, MCV, MCH, and MCHC graphs are all displayed at one time
	t If 9 parameter XM option is selected, three tabs are available for selecting the three graph gr...
	H If the left tab is selected, the WBC, RBC, and HGB graphs are displayed
	H If the middle tab is selected, the HCT, MCV, and MCH graphs are displayed
	H If the right tab is selected, the MCHC, RDW, and PLT graphs are displayed


	r Used to view the batch means in relationship to the XM mean value and XM limit for the correspo...
	r Graphs are good for identifying trends and shifts
	r Each graph contains three areas
	t A central line representing the actual XM mean value for that parameter
	t A line above XM mean value (central line) represents the upper limit and a line below the XM me...
	t Area showing dashes is the out-of-limit area

	r Each graph displays the last 10 data points
	r When a graph is double-clicked, the graph expands to include the last 60 data points
	r After the first 60 batches are completed, this option always displays the plot points for the l...
	t Provides a history of recent batch means which may serve as an aid during the troubleshooting p...
	t After the 60th batch is completed, the graph begins to rollover where the oldest batch results ...



	What Causes a Batch to go “Out-of-Limits”?
	r Change in the patient population
	r An instrument problem may exist
	r A calibration problem may exist
	r A reagent problem may exist

	Troubleshooting when an XM Batch is “Out”
	Consider a Change in the Patient Population
	r Is there a change in the overall patient population?
	t One or more new patient types were added to the population
	t One or more patient types are no longer part of the population
	t Possible seasonal change of the patient population (hospitals or clinics in resort areas)

	r If a change in the overall patient population is probable,
	t Future XM batch results will also be outside the limits
	t New XM mean values based on the current population must be established and entered in the computer

	r If a change in the overall patient population is not probable, it is possible that the patient ...

	Check for Non-Reportable Results and/or Non-Random Sampling
	r An XM batch may go outside the XM limits because the batch is biased by physiologically impossi...
	r Use the Batch Details window to check for non-reportable results and/or non-random sampling
	t Non-reportable results where a batch of patients is biased by short samples, physiologically im...
	t Non-random patient sampling where a batch of patients is biased by several abnormal patients of...



	Consider an Instrument Problem Exists
	r Consider an instrument problem only if:
	t A change in the patient population is doubtful
	t All the results in the current XM batch are reportable (physiologically possible)
	t Random sampling is verified

	r Instrument problems cause XM batch results to go “out” and stay out
	t Can be a gradual change:
	H If caused by a calibration drift, should go back within limits after calibration
	H If caused by a component going bad over time, should go back within limits after the component ...

	t Can be a sudden change:
	H If caused by a component failure, should go back within limits after the component is replaced
	H If caused by any number of instrument problems, should go back within limits after the problem ...


	Assessing the Situation
	r Review the XM graphs and XM batch means to identify the out-of-limit parameter and note the dir...
	r The physiological range of some parameters, like WBCs and Plts, makes it difficult to assess if...
	r Generally more than one parameter may show a change
	r It is also important to note any parameter that may still be inside the limit but shows a signi...
	r Call your Beckman Coulter Representative if you need assistance.





	CALIBRATION
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	r Explain the purpose of calibration.
	r Tell when one needs to verify calibration.
	r Perform the preliminary procedures.
	r Perform the calibration procedure in Chapter 10 of the Operator’s Guide.
	r Demonstrate how to access the Calibration Log.


	NOTES
	CALIBRATION
	r A procedure used to standardize the instrument by determining its deviation from calibration re...
	r Never use calibration to adjust for an instrument problem
	r Verify the ambient room temperature is typical for the laboratory and within the instrument’s o...
	r In the normal process of tracking data for an extended period of time, your laboratory can make...
	r Never adjust to a specific value based on an individual sample result
	When to Calibrate
	r At installation, before you begin analyzing samples
	r After Service has replaced a major analytical component such as the sampling syringe or an aper...
	r If your Beckman Coulter Representative suggests you calibrate

	When to Verify Calibration
	r As dictated by your laboratory procedures, local, or national regulations
	r When controls show evidence of unusual trends
	r When controls exceed the manufacturer’s defined acceptable limits


	Preliminary Calibration procedures
	r Procedures designed to ensure the instrument is operating optimally
	r Recommend a thorough review of data stored in current control and, if applicable, XM�files to n...
	r Thorough review of IQAP data is also recommended
	Pre-Calibration Checks
	Check Reagent and Waste Containers
	r Check reagent volumes to ensure sufficient volume to complete calibration procedures
	t As needed, use the Changing Reagent Summary to replace any container with insufficient reagent ...

	r Check the waste container level
	t If needed, use the Replacing a Waste Container Summary as a guide


	Ensure the Analyzer is Clean
	r If the instrument is routinely shut down with AC•T 5diff Rinse reagent for at least 30�minutes ...
	t Do a Startup
	t Run commercial cell controls

	r If the instrument is not routinely shut down with AC•T 5diff Rinse reagent for at least 30 minu...
	t Do the Extended Cleaning procedure in Chapter 11 of the Instructions For Use manual
	t Do a Startup
	t Run commercial cell controls



	Calibration Procedure
	r Beckman Coulter recommends using COULTER® AC•T™ 5diff Cal Calibrator
	r May calibrate one or more CBC parameters including WBC, RBC, Hgb, Hct, and Plt
	t Operator selects those parameters to be calibrated via the Select Parameters boxes

	r Carefully follow the instructions on the COULTER® AC•T™ 5diff Cal Calibrator package insert and...
	t Before accumulating calibration data, prime the instrument using two normal whole-blood specime...
	t 11 is the maximum number of runs that can be displayed in this window
	t Never accept a calibration factor based on less than five calibrator runs

	r Perform each analysis using well-mixed calibrator
	t Before the first sample is aspirated, make sure the calibrator is mixed according to the instru...
	t Insert the tube correctly into:
	H slot #1 of Tube Holder #1, or
	H slot #4 of Tube Holder #2

	t Close the tube holder door to begin analysis
	t Each time the tube holder door opens
	H remove the calibrator tube
	H mix thoroughly
	H replace the calibrator tube
	H close the tube holder door

	t Analyze the calibrator at least 5 but no more than 11 times

	r Operator may decide to exclude an analysis
	t Sample results should only be excluded if you can trace an operator error to the unacceptable r...
	t Excluding too many runs can cover up an instrument problem and bias calibration
	t Although the instrument can calculate the calibration statistics on three runs, Beckman Coulter...

	r From the Menu bar, selecting Quality Assurance tab�tt Calibration tab displays the Calibration ...
	Calibration Window
	Terms and Formulas used in the Calibration Procedure
	N=
	r Number of AC•T 5diff Cal calibrator runs included in the statistics for the parameter
	r next to a set of results in the accumulated results table indicates that set of results is incl...
	r (no ¸) indicates that set of results is not included in the statistics; therefore, N may be les...

	Mean
	r Average of the AC•T 5diff Cal calibrator runs
	r Calculation can be based on at least 5, but no more than 10 runs

	New Cal Factor
	r Calibration Factor needed to recover the AC•T 5diff Cal Calibrator Reference Value
	r It is calculated and displayed regardless of whether or not you need to change it

	Old Cal Factor
	r The current Calibration Factor in use by the analyzer
	r Remains the current calibration factor until the save calibration function is performed

	% CV
	r Indicates the reproducibility of the AC•T 5diff Cal calibrator run
	r Checked to ensure valid data is used as you are deciding whether or not to recalibrate
	r Compared to the preset Cal CV limits displayed inside the CV Limits box
	Setup�tt Quality Assurance�tt Administrator Password required�tt General tab

	Reference Values
	r The assigned value for each parameter
	r Assigned value obtained from the AC•T 5diff Cal calibrator package insert
	Calibration Log
	r Click on Analyzer / Logs tab�tt Calibration Log tab to view the log
	r Maintains the most recent 50 calibration entries displaying the most recent log entry at the to...
	r Rollover is first in, first out when the 51st entry is added
	r Log contains the following information fields
	Note: It is necessary to scroll right to see some of these fields.


	Information Fields
	Date/Time
	Displays when the calibration was completed
	Lot Number
	Displays the lot number of calibrator used to perform the calibration; the word “Manual” appears ...
	Opr
	Displays the User name logon information in the Workstation when the calibration was completed
	Expiration Date
	Displays operator entry identifying the expiration date for the calibrator material used to perfo...
	Forced
	If checked, indicates the accepted calibration factors are not based on ideal results (at least o...
	Never force a calibration without first consulting with a Beckman Coulter Representative!
	WBC Cal Factor
	Calibration factor used in determining the reported WBC count result
	RBC Cal Factor
	Calibration factor used in determining the reported RBC count result
	HGB Cal Factor
	Calibration factor used in determining the reported HGB result
	HCT Cal Factor
	Calibration factor used in determining the reported HCT result
	PLT Cal Factor
	Calibration factor used in determining the reported PLT count result
	RDW Cal Factor
	Calibration factor used in determining the reported RDW result:
	r Is not determined during Auto-Calibration
	r Must be determined using the Manual Calibration procedure in Appendix C of the Operator’s Guide
	r Only appears if the calibration factor is manually entered

	MPV Cal Factor
	Calibration factor used in determining the reported MPV result:
	r Is not determined during Auto-Calibration
	r Must be determined using the Manual Calibration procedure in Appendix C of the Operator’s Guide
	r Only appears if the calibration factor is manually entered

	Comment
	Displays any comments entered by operator performing calibration:
	r Optional entry that provides an opportunity for the operator to type a personal observation or ...
	r Operator may use the Add Comments button to access the Add Comments box, as desired
	r If Prompt User For Comments check box is checked (¸), the Add Comments box pops up automaticall...
	Note: When Add Comments box is displayed, operator cannot access any other window until they either:
	t Enter a comment then click to save and exit the box
	or
	t Click to exit the box without entering a comment


	If AC•T 5diff CP Hematology Analyzer is a Backup Instrument
	r If your AC•T 5diff CP system is being used as a backup to another COULTER hematology analyzer, ...
	r See the instructions in Appendix C of the AC•T 5diff CP Operator’s Guide, as needed
	r Operator should contact their Beckman Coulter Representative if there are questions

	SAMPLE ANALYSIS
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Specimen Handling
	r State the proper anticoagulant to use for specimens processed on an AC•T 5diff CP hematology an...
	r State the minimum volume of blood needed for processing a specimen.
	r State the maximum storage time prior to running a specimen for CBC versus CBC/DIFF analysis.
	r State the proper storage temperature.
	r Properly insert a tube into the tube holder and close the cap-pierce door.

	Specimen Identification
	r Cite the window used to run patient specimens
	r State the identifier that must be entered prior to running a patient specimen.
	r Cite three options for entering a sample ID.
	r Explain the autonumbering feature.
	r Demonstrate how to start autonumbering then how to cancel its usage.
	r Cite two situations that allow the sample ID to be duplicated.

	Flagging Sets
	r Explain the purpose of a flagging set.
	r Demonstrate how to set up a flagging set.
	r Contrast patient ranges versus action ranges.
	r When given different scenarios by your instructor, cite the flagging set that would be applied ...

	Workflow Options
	r Define Worklist.
	r Explain how the database, archive, and worklist are related.
	r Demonstrate how to create an archive.
	r Explain how to identify when a previously closed archive is open.
	r Identify the two reasons why your laboratory may want to use the Worklist.
	r Run patient samples using the Worklist and without using the Worklist.

	Detailed Run Results
	r Name and define each area on the Run window.




	NOTES
	SPECIMEN HANDLING
	Specimen Collection

	Approved Collection Devices and Control Vials
	r Wide variety of specimen tubes, microcollection devices, and control vials are approved for use...
	r Closed-vial sampling is recommended for those evacuated collection tubes and control vials with...
	r For those evacuated collection tubes, microcollection devices, and calibrator vials without pie...
	t Stopper or cap must be removed prior to sampling (open-vial sampling)
	t Open-vial sampling increases the operator’s exposure to the whole-blood specimen which is consi...

	r List of approved specimen tubes, microcollection devices, and control vials is located in Appen...

	Using Evacuated Collection Tubes
	r Collect venous blood specimens in K3EDTA or K2EDTA
	t A proper proportion of whole blood to anticoagulant is critical
	t Collect venous blood according to the tube manufacturer’s requirements
	t K3EDTA is the preferred anticoagulant

	r At collection and before analysis, mix each blood specimen gently and thoroughly according to t...

	Using Microcollection Devices
	r Anticoagulated capillary specimens collected in a microcollection device may be aspirated as an...
	r Proper collection is critical to avoid micro-clots and/or debris
	r Review and follow the collection and mixing instructions in the package insert provided by the ...
	r Make sure the manufacturer’s minimum fill volume is achieved
	Storage
	r Run a CBC/Diff specimen within 24 hours of collection
	r Run a CBC specimen within 48 hours of collection

	Overview of Tube Holder Sample Positions
	Note: This list below is not comprehensive. It is simply provides an overview of the tube holders...
	Sample Position B
	c Most 13�mm x 75�mm evacuated specimen tubes containing either K3EDTA or K2EDTA for collecting w...
	c COULTER® AC•T™ 5diff Control Plus control tubes
	Sample Position C
	c COULTER® AC•T™ 5diff Cal Calibrator vial
	Sample Position D
	c Sarstedt Monovette® 11.5�mm x 66�mm specimen tube collecting 2.7�mL of whole-blood
	Sample Position E
	c Becton-Dickinson Microtainer for collection of 0.25�to�0.50�mL of whole-blood
	Sample Position B
	c Becton-Dickinson Microtainer for collection of 0.25�to�0.50�mL of whole-blood
	Sample Position C
	c Becton-Dickinson 10.25�mm�x�64�mm Vacutainer® for collecting 3�mL of whole-blood
	Sample Position D
	c RAM Scientific microcollection device for collecting 125�µL of whole-blood
	Sample Position E
	c 13�mm x 75�mm specimen tube with multiple labels
	c COULTER® AC•T™ 5diff Control Plus control tubes


	SAMPLE IDENTIFICATION
	r Patient samples must be processed with the Run window open (click Run tab)
	r Sample identifiers may be entered on the Run window or on the Worklist
	Note: A worklist is a list of samples with preassigned identification and demographic information...
	Sample ID
	r Sample ID is required to process a patient sample on this instrument
	r Sample identifier may be entered in the Next Sample ID field on the Run window or in the Sample...
	r Up to 16 alphanumeric characters can be entered in either field
	r Must be entered before the specimen can be processed

	Options for Entering Sample ID


	Manual Entry
	r On the Run window inside the sample identification box:
	t Sample ID for the next specimen can be manually typed into the Next Sample ID field
	t Two other entries can also be made inside this box
	H Panel selection for the next specimen - default is CBC/DIFF
	H Patient ID for the next specimen - optional entry of up to 25 alphanumeric characters


	r On the Worklist:
	t Sample ID for the next specimen can be manually typed into the Sample ID field
	t Panel selection and other demographic information can also be entered for this patient


	Optional Bar-Code Reader
	r Hand-held scanner for reading the bar-code label on a specimen tube
	r Sample ID may be scanned into the Sample ID Next field on the Run window or into the Sample ID ...
	r Operator must press the button on the bar-code reader before scanning a label
	r Risk of sample misidentification if the entire barcode is not captured with the bar-code reader...
	r Position the reader over the entire barcode to capture the entire sample ID
	r An audible beep indicates the barcode was read successfully
	r Verify the correctness of each bar-code reading to ensure proper sample identification
	r Barcode specifications are located in Appendix B of the Operator’s Guide
	r Set up is performed by your Beckman Coulter Representative

	Autonumbering Feature
	r Instrument automatically assigns a sample ID (from 1 to 999999)
	r Sample ID number automatically increments by 1 from the previously assigned number before each ...
	r Autonumbering is turned on via the Add/Edit Worklist box; however, it is not necessary to use t...
	t Click Worklist tab�tt to display the Add/Edit Worklist box
	t Inside the Autonumbering box, click to place a ¸ inside the box (); this enables the option
	t Enter the starting number (1 to 999999) for the first specimen
	t Click Apply to save the change
	t Click to exit the box
	t Click Run tab to verify the designated starting number is in the Sample ID Next field
	t When the first specimen is processed:
	H Designated starting number moves to the Sample ID In Progress field
	H Number in the Sample ID Next field is one digit higher


	r When autonumbering is enabled, the sample ID number increments inside both the Sample ID Next f...
	r Operator may override the current autonumber as desired; autonumbering automatically begins aga...
	Duplicate Sample ID Check
	r Workstation database maintains a record of all sample IDs processed
	r Identifier entered in the Sample ID field is compared to the list of Reserved lot numbers
	t If the number matches a Reserved lot number, corresponding entry fields are automatically compl...
	t If the number does not match a Reserved lot number, the software searches for a duplicate sampl...

	r If an operator enters a sample ID that has already been used,
	t Message Patient Results With Matching Sample ID Already Exist. Existing Sample ID Cannot Be Reu...
	t When operator clicks OK, the message Halted Sample Processing. If Analyzing Samples Please Veri...

	Note: This duplicate check is not performed if (the Rerun feature) is being used.
	r If your laboratory sample ID sequence repeats or if your laboratory is using the autonumbering ...
	r Archiving process
	t Resets the duplicate sample ID process so that the sample IDs can be reused
	t How often your laboratory archives depends on the frequency your laboratory repeats sample IDs ...
	Note: If you repeat sample IDs on an annual basis, it is recommended that you archive monthly. Sm...


	Rerunning a Patient Sample
	r When you want to repeat a sample, must use (system’s Rerun feature)
	r Due to the duplicate ID feature, if sample ID to be repeated was manually re-entered into the i...
	r Can indicate you want to rerun any specimen from the Results window or the Detailed Results window
	r From Run window, can indicate you want to rerun the last specimen
	r When in the Detailed Results view and the operator clicks :
	t Sample Results Status box turns red to indicate a rerun is requested on this sample
	t Sample Results Status box appears in the top right of the screen, just to the right of the Pane...
	t When specimen is rerun and the rerun results are displayed, Sample Results Status box associate...
	H Run can be validated (Sample Results Status box turns green)
	H Once validated (confirmed acceptable to report), specimen with that sample ID number cannot be ...

	t Sample Results Status box associated with the original results remains red to indicate the resu...
	t Either set of results may be printed and/or transmitted

	r In the Results List view, the first analysis and the rerun appear in the order processed

	FLAGGING SETS
	r A flagging set contains patient ranges and action ranges
	r If a parameter result is outside the designated range, the result is flagged
	r AC•T 5diff CP hematology analyzer provides the potential for 20 different flagging sets
	r At the Menu bar, select Setup�tt Patients�tt Administrator Password�tt Flagging and Messaging t...
	Pre-Defined Flagging Sets
	r When installed, the system has six pre-defined flagging sets
	1

	Standard Range
	No defined range
	2

	Man
	>12 years
	3

	Woman
	>12 years
	4

	Newborn
	0 to <= 30 days
	5

	Infant
	1 month to < 6 years
	6

	Child
	>= 6 years to <= 12 years
	r Standard Range is the default flagging set, but can change the default selection to any of the ...
	r With the exception of the Standard Range flagging set, both action and patient ranges may be ed...

	Additional Flagging Sets
	r Can add up to 14 additional flagging sets (numbers 7 through 20)
	r When an operator clicks the Setup button to set up another flagging set, the Standard Range pat...
	r Action and/or Patient Limits may be copied from one flagging set to another

	Flagging


	Patient Ranges
	r L flag appears to the right of the parameter result that is below the lower limit in the Patien...
	r H flag appears to the right of the parameter result that is above the upper limit in the Patien...
	r Yellow background accompanies the flag appearing inside the parameter result field

	Action Ranges
	r LL flag appears to the right of the parameter result that is below the lower limit in the Actio...
	r HH flag appears to the right of the parameter result that is above the upper limit in the Actio...
	r Red background accompanies the flag appearing inside the parameter result field
	r May also generate an interpretive message
	Flagging Set Hierarchy
	r Worklist may be used to assign a flagging set
	r Flagging set is automatically selected based on the gender and age (or date of birth) entered o...
	r If both gender and age (or date of birth) are not entered and no flagging set is specified, the...

	WORKFLOW OPTIONS
	r Workflow patterns on the AC•T 5diff CP hematology analyzer evolve around whether or not your la...
	r Worklist provides several functions that may be important to your laboratory
	t Provides a way to enter patient demographics such as patient name, gender, date of birth, age, ...
	t Allows a choice of flagging sets

	Worklist
	r A worklist is a list of work to be done
	r Worklists are used to preassign identifiers and/or demographics for specimens that are pending ...
	t Sample ID identifier is a required entry (up to 16 alphanumeric characters)
	t Demographics include optional information such as patient ID, patient name, gender, date of bir...
	t Identifiers and demographic information must be entered before running the patient specimen
	t Sample ID is the only required entry; all other entries are optional

	r Host transmission protocol can be established so that demographics are automatically downloaded...
	r After the specimen is processed, all entered information is printed on the final report, stored...
	r To decide if using a worklist best fits your laboratory’s needs means considering several facto...

	Database, Archive, and Worklist Relationships
	r On this system, the database is like a large electronic storage “cabinet” on the Workstation’s ...
	r Within the database, the archive is like a “file cabinet” and the worklist like a “folder” with...
	r Workstation database maintains a record of all sample IDs processed
	r Worklist checks for duplicate sample IDs within the active archive (current archive)
	r If your laboratory sample ID sequence repeats or if your laboratory is using the autonumbering ...
	t How often your laboratory archives depends on the frequency your laboratory repeats sample IDs ...
	t If sample IDs are repeated annually or not repeated at all, monthly archiving is recommended
	t Small archives are easier to navigate through and manage than large ones
	t Large archives may cause the system response time to decrease




	Creating an Archive
	r To store patient samples, an archive must be created
	r At the Menu bar, select File�tt New archive
	r Beckman Coulter recommends a new archive be created at frequent intervals to ensure system proc...
	r When a new archive is created:
	t Previous archive is automatically closed
	t New archive is now the current or active archive
	t Create a new archive at least once a month

	r When a new archive is created, the date and time are recorded and act as the identifier for tha...
	r It is not possible to close an active archive without creating a new archive!
	t Action of selecting File�tt Close archive does not close an active archive
	t Only way an active archive can be closed is to create a new archive


	Using the Active Archive
	r All analyzed results including reproducibility, blanks, controls, and calibrators are stored in...
	r If your laboratory created an archive it is likely you will want to retrieve those results at s...
	r Sample ID cannot be duplicated within an active archive without using the Rerun feature
	r Preassigned identifiers and/or demographics for each specimen and the results obtained during s...
	t Means that when an archive is closed, the Worklist information and parameter result information...


	Opening a Closed Archive
	r Sample analysis is not permitted while a previously closed archive is open!
	r Never attempt to open a previously closed archive while the active archive is still accumulatin...
	r To open a previously closed archive:
	t At the Menu bar, select File�tt Open archive
	H Table listing all closed archives appears
	H Archive date is the date the archive was first created

	t Click on the archive you wish to open

	r When a closed archive is opened:
	t All analyzed samples are listed in the worklist format, including reproducibility, blanks, cont...
	t Background color changes to “light green” to indicate you are reviewing archived, not current, ...
	t At the Menu bar, select File�tt Close archive to close the open archive


	Summary
	r Use the Worklist if choosing a flagging set or entering patient demographics is important (eith...
	Using the Worklist

	Adding New Entries to the Worklist
	r Click Worklist tab�tt to display the Add/Edit Worklist box
	r Sample ID is still a required entry (up to 16 alphanumeric characters)
	r CBC/DIFF panel is default selection; select CBC panel from the drop-down box if desired
	r Flagging Set for a patient older than 12 years
	t Flagging set is automatically selected based on the age and gender entered on the Worklist unle...
	t If both age and gender are not entered and a flagging set is not selected, the default flagging...
	t If the age and/or gender for an existing Worklist entry is modified, the flagging set is automa...

	r Flagging Set for a patient 12 years old or younger
	t Flagging set is automatically selected based on the age entered on the Worklist; gender is not ...
	t If the age for an existing Worklist entry is modified, the flagging set is automatically modifi...

	r Collect date must follow an eight-digit format; for example, 04 02 2001
	r Collect time uses AM/PM format
	r Comment field - may enter up to 50 alphanumeric characters
	r When Patient ID field is selected for entry:
	t List of existing Patient IDs with their respective patient names are listed
	t If operator selects from the list, the existing patient demographics are automatically entered ...
	t Operator may choose to make a manual entry of up to 25 alphanumeric characters

	r Patient Name field - may enter up to 30 alphanumeric characters
	r If no date of birth is available, operator can enter the patient’s age
	r Gender
	t Unknown is the default
	t Male or female may be selected from a drop-down box

	r Physician field
	t Select name from a list of physicians or manually enter
	t May enter up to 30 alphanumeric characters

	r Location field
	t Select name from a list of locations or manually enter
	t May enter up to 15 alphanumeric characters

	r Click to make enter another specimen
	r When last entry to Worklist is complete, click to save entries and exit box
	r If after the last entry operator clicks then , blank entry is inserted on Worklist (because sav...

	Using the Autonumbering Feature with the Worklist
	r Instrument automatically assigns a sample ID (from 1 to 999999)
	r Sample ID number automatically increments by 1 from the previously assigned number before each ...
	r Autonumbering is turned on via the Add/Edit Worklist box:
	t Click Worklist tab�tt to display the Add/Edit Worklist box
	t Inside the Autonumbering box, click to place a ¸ inside the box (); this enables the option
	t Enter the number (1 to 999999) for the first specimen
	t Click Apply to save the change
	t Click to exit the box
	t Create the Worklist
	t Click Run tab to verify the designated starting number is in the Sample ID Next field
	t When the first specimen is processed,
	H Designated starting number moves to the Sample ID In Progress field
	H Number in the Sample ID Next field is next entry on the Worklist (which should be one digit hig...


	r When autonumbering is enabled, the sample ID number increments inside both the Sample ID Next f...
	r Operator may override the current autonumber as desired; autonumbering automatically begins aga...

	Processing Patient Samples Using the Worklist
	r Not necessary to process patient specimens in the Worklist order
	r If when you check the Sample ID Next field, you want to run a different specimen:
	t Manually type the desired sample ID or scan the bar-code label on its specimen tube into the Sa...
	t System automatically matches the desired sample ID with the panel and demographic information p...
	t Ready to process the specimen



	‰ RUNNING PATIENT SAMPLES USING THE WORKLIST SUMMARY
	Note: Use this summary only if you want to use the Worklist. If you do not want to run samples us...
	1 Get the Workstation Ready
	r Click Results tab to verify only the active archive is open (background is white).
	t If the background is green, an old archive is open and must be closed.
	t At the Menu bar, select File�tt Close archive to close the old archive.

	r If, according to your laboratory protocol, it is time to create a new archive, select File�tt N...
	r Click Worklist tab.

	If the Worklist is Set Up Manually
	r Click .
	Inside the Add/Edit Worklist box:
	r Enter sample ID:
	t Click on the Sample ID field.
	t Manually type the ID number at the keyboard.
	or
	Scan the specimen tube’s bar-code label with the bar-code wand.
	t Verify the ID number inside the Sample ID field is correct.

	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Flagging set currently selected as default is entered; select another flagging set from the dro...
	r Enter comment or other patient demographic information as desired. (If enter gender and/or age ...
	r Click to save entries and clear the box for entering the identifiers and demographics for anoth...
	r When the last entry to the Worklist is complete, click to save and exit.
	r Click Run tab.

	Autonumbering ON
	r Click .

	Inside the Add/Edit Worklist box:
	r Sample ID entry is automatic.
	To override the autonumber with another sample ID:
	t Highlight the autonumber in the Sample ID field.
	t Manually type the desired sample ID number at the keyboard.
	t Verify the ID number inside the Sample ID field is correct.
	Note: Autonumbering automatically begins again with the autonumber that was overwritten.

	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Flagging set currently selected as default is entered; select another flagging set from the dro...
	r Enter comment or other patient demographic information as desired. (If enter gender and/or age ...
	r Click to save entries and clear the box for entering the identifiers and demographics for anoth...
	r When the last entry to the Worklist is complete, click to save and exit.
	r Click Run tab.


	If the Worklist is Downloaded from a Host Computer
	r Sample ID and patient demographics are automatically downloaded from the host computer. (Inform...
	r Click Run tab.
	2 Process the Sample
	r Check the Sample ID Next field for the next specimen to be processed.
	Note: If you want to run another specimen, manually type the sample ID or scan the bar-code label...
	r Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change the ...
	r Mix the specimen gently but thoroughly according to your laboratory’s protocol.
	r If the specimen tube does not have a pierceable stopper, remove the stopper.
	r Place the well-mixed specimen tube in the sample position that best matches the tube. Rotate th...
	r Close the cap-pierce door to initiate the cycle.
	r Remove the specimen tube when the cap-pierce door automatically opens after aspiration is compl...
	r Overlap sample processing, if desired.
	t Repeat step 2 to get ready for the next cycle.
	t When the cycle is complete (green LED glows steady), go to step 3.


	3 When the Cycle is Complete
	r Verify the sample results appear in the Run window.
	r Verify the sample ID entry and results before reporting.
	r Click for a hard copy of the results.
	Note: A hard copy prints automatically if the Auto-Print function is enabled.
	r Repeat steps 2 and 3 until all specimens are analyzed.
	‰ ‰



	‰ RUNNING PATIENT SAMPLES WITHOUT USING THE WORKLIST SUMMARY
	Note: Use this summary only if you do not want to use the Worklist. If you want to run samples us...
	1 Get the Workstation Ready
	r Click Results tab to verify only the active archive is open (background is white).
	t If the background is green, an old archive is open and must be closed.
	t At the Menu bar, select File�tt Close archive to close the old archive.

	r If, according to your laboratory protocol, it is time to create a new archive, select File�tt N...
	r Click Run tab.
	r Enter Next Sample ID:
	t Click on the Sample ID Next field.
	t Manually type the ID number at the keyboard.
	or
	Scan the specimen tube’s bar-code label with the bar-code wand.
	t Verify the ID number inside the Sample ID Next field is correct.

	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Enter a Patient ID if desired.
	Autonumbering ON
	r Next Sample ID entry is automatic.
	To override the autonumber with another sample ID:
	t Highlight the autonumber in the Sample ID Next field.
	t Manually type the desired sample ID number at the keyboard.
	t Verify the ID number inside the Sample ID Next field is correct.
	Note: Autonumbering automatically begins again with the autonumber that was overwritten.

	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Enter a Patient ID if desired.


	2 Process the Sample
	r Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change the ...
	r Mix the specimen gently but thoroughly according to your laboratory’s protocol.
	r If the specimen tube does not have a pierceable stopper, remove the stopper.
	r Place the well-mixed specimen tube in the sample position that best matches the tube. Rotate th...
	r Close the cap-pierce door to initiate the cycle.
	r Remove the specimen tube when the cap-pierce door automatically opens after aspiration is compl...
	r Overlap sample processing, if desired.
	t Go to step 3 to get ready for the next cycle.
	t When the current cycle is complete, go to step 4.


	3 Prepare for the Next Cycle
	r Enter information for the next specimen while the current sample is being analyzed.
	r Enter Next Sample ID:
	t Click on the Sample ID Next field.
	t Manually type the ID number at the keyboard.
	or
	Scan the specimen tube’s bar-code label with the bar-code wand.
	t Verify the ID number inside the Sample ID Next field is correct.

	r CBC/DIFF is the default panel selection; select CBC from the drop-down box, if desired.
	r Enter a Patient ID if desired.
	r If you are overlapping, go to step 2.
	If you are not overlapping, when the cycle is complete (green LED glows steady), go to step 4.
	Autonumbering ON
	r Next Sample ID entry is automatic.
	To override the autonumber with another sample ID:
	t Highlight the autonumber in the Sample ID Next field.
	t Manually type the desired sample ID number at the keyboard.
	t Verify the ID number inside the Sample ID Next field is correct.
	Note: Autonumbering automatically begins again with the autonumber that was overwritten.

	r CBC/DIFF is the default panel selection; select CBC from the drop-down box, if desired.
	r Enter a Patient ID if desired.
	r If you are overlapping, go to step 2.
	If you are not overlapping, when the cycle is complete (green LED glows steady), go to step 4.


	4 When the Current Cycle is Complete
	r Verify the current sample results appear in the Run window.
	r Verify the sample ID entry and results before reporting.
	r Click for a hard copy of the results.
	Note: A hard copy prints automatically if the Auto-Print function is enabled.
	r Repeat steps 2, 3, and 4 until all specimens are analyzed.
	‰ ‰

	DETAILED RUN RESULTS
	Run Window
	Detailed Run Window Areas
	The information in this section describes the various areas of the Detailed Run Results window. R...
	Click on the Run tab B to display the Run window.
	Note: Numbers like B are inserted to help you locate a referenced area on the Run window (located...


	Sample ID and Patient Demographics Area C I
	r Seq #
	t Sequence number
	t Automatically incremented by the software
	t Unique chronological number for specimen sampling

	r Sample ID
	t Sample identification
	t Alphanumeric character field, maximum of 16 characters
	t Sample ID entry may be made in the Sample ID Next field inside the Sample Identification box on...
	t Field is compared to the list of Reserved lot numbers

	r Patient ID (Optional)
	t Patient identification
	t Alphanumeric character field, maximum of 25 characters
	t Patient ID entry may be made in the Patient ID Next field inside the Sample Identification box ...
	t Duplicates are allowed
	t Entry must be made prior to analysis
	t May enter both patient ID and patient name in the Add/Edit Worklist box, if desired

	r Patient Name (Optional)
	t Name of the patient
	t Alphanumeric character field, maximum of 30 characters
	t Entry can only be made in the Patient Name field in the Add/Edit Worklist box
	t Cannot add a patient name to results with a patient ID
	t If a patient ID is not entered in the Add/Edit Worklist box, patient name can be added while th...
	t Entry must be made prior to analysis
	t May enter both patient name and patient ID in the Add/Edit Worklist box, if desired

	r Gender (Optional)
	t Male or Female
	t Unknown displayed when a selection is not made
	t Entry can only be made in the Gender field in the Add/Edit Worklist box prior to analysis
	t Entry required if you want the software to automatically select the most appropriate flagging s...
	H Flagging set is automatically selected based on the age and gender entered on the Worklist unle...
	H If both age and gender are not entered and a flagging set is not selected, the default flagging...
	H Flagging set for a patient 12 years old or younger is automatically selected based on the age e...
	H If the age and/or gender for an existing Worklist entry is modified, the flagging set is automa...


	r Date of Birth (Optional)
	t Patient date of birth
	t Date is displayed in the format selected by the laboratory under Setup�tt System�tt Date/Time
	t Entry can only be made in the Date of Birth field in the Add/Edit Worklist box prior to analysis
	t Field for displaying the patient’s age does not appear on the Run window
	t Date of birth or age entry is required if you want the software to automatically select the mos...
	H Flagging set is automatically selected based on the age and gender entered on the Worklist unle...
	H If both age and gender are not entered and a flagging set is not selected, the default flagging...
	H Flagging set for a patient 12 years old or younger is automatically selected based on the age e...
	H If the age and/or gender for an existing Worklist entry is modified, the flagging set is automa...


	r Panel
	t Displays the panel requested for this analysis
	t CBC/DIFF is the default panel selection
	t If CBC/DIFF panel selected, typically 20 parameters are reported
	H CBC parameters:��WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt, MPV
	H DIFF parameters:��NE%, NE#, LY%, LY#, MO%, MO#, EO%, EO#, BA%, BA#
	H If RUO (Research Use Only) parameters are enabled, Pct, PDW, IMM%, IMM#, ATL%, and ATL# are als...

	t If CBC panel selected, typically 10 parameters are reported
	H WBC, RBC, Hgb, Hct, MCV, MCH, MCHC, RDW, Plt, and MPV
	H If RUO (Research Use Only) parameters are enabled, Pct and PDW are also reported

	t Selection may be made in the Panel field inside the Sample Identification box on the Run window...

	r Sample Results Status Box
	t Provides a visual of the sample’s review status
	t Box may be white, red, or green
	t White box indicates the current (latest) set of results
	t Red box indicates the sample is rerun and the results you are viewing are the old (or previous)...
	t Green box indicates a current sample that has been reviewed and validated
	H Once sample results are validated (confirmed acceptable to report), the specimen with that samp...
	H Clicking while viewing sample results validates those results


	r Flagging Set
	t Displays the flagging set being used for the results of this patient sample
	t May be the Default flagging set, a flagging set assigned by the operator, or a flagging set aut...
	t Flagging Set for a patient older than 12 years
	H Flagging set is automatically selected based on the age and gender entered on the Worklist unle...
	H If both age and gender are not entered and a flagging set is not selected, the default flagging...
	H If the age and/or gender for an existing Worklist entry is modified, the flagging set is automa...

	t Flagging Set for a patient 12 years old or younger
	H Flagging set is automatically selected based on the age entered on the Worklist; gender is not ...
	H If the age for an existing Worklist entry is modified, the flagging set is automatically modifi...

	t If the operator wants to assign a flagging set, the selection must be made in the Flagging Set ...

	r Run Date�/�Time
	t Displays the date and time of this run
	t Displayed in the format selected by the laboratory under Setup�tt System�tt Date/Time
	t Automatic entry when the specimen is actually run

	r Comment (Optional)
	t Displays observations or remarks made by the operator
	t Alphanumeric character field, maximum of 50 characters
	t Can only enter remarks into the Comment field of the Add/Edit Worklist box prior to analysis

	r Other patient demographics such as physician and location are not displayed on the Run window, ...

	CBC Parameter Results Areas g H J 1) 1! 1@
	r WBC parameter result 1@ is displayed with the WBC/BASO histogram J
	r RBC parameter results 1! are displayed with the RBC histogram H
	r Platelet parameter results 1) are displayed with the PLT histogram g

	DIFF Parameter Results Area F
	r Displays percentage and absolute number for each differential parameter
	t NE and NE#�=�Neutrophil percentage (NE) and Neutrophil absolute number (NE#)
	t LY and LY#�=�Lymphocyte percentage (LY) and Lymphocyte absolute number (LY#)
	t MO and MO#�=�Monocyte percentage (MO) and Monocyte absolute number (MO#)
	t EO and EO#�=�Eosinophil percentage (EO) and Eosinophil absolute number (EO#)
	t BA and BA#�=�Basophil percentage (BA) and Basophil absolute number (BA#)


	DiffPlot D
	r Displays the major white blood cell groups
	t Lymphocytes
	t Monocytes
	t Neutrophils
	t Eosinophils

	r Basophil percentage is determined from the WBC/BASO histogram. J

	Flags and Messages Area E
	r Displays various DiffPlot and histogram flags
	r Displays interpretive messages
	t Message is triggered from the flagging limits established by laboratory protocol
	t Message indicates a possible pathological disorder

	r Displays analytical alarms
	t Alarm in the form of a message generated by the Analyzer
	t Indicates a condition that may be related to Analyzer operation
	t Also indicates if results will be influenced by this condition

	r Area label depends on Detailed Flags setting located under Patient Setup
	t At the Menu bar, select Setup�tt Patients�tt type Administrator Password�tt Reports�tab�tt Enab...
	t When Detailed Flags setting is enabled, Flags and Messages label appears on Run window
	t When Detailed Flags setting is disabled, Suspect and Messages label appears on Run window




	DATA REVIEW
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Data Storage and Retrieval
	r Explain the purpose of an archive.
	r Demonstrate how to create a current, active archive.
	r Explain how to know if you are viewing a current, active archive or a previously closed archive...
	r Describe the process of sorting samples results in an archive.
	r Demonstrate how to search for the results of a specific sample.
	r Demonstrate how to view the detailed results for a specific sample.
	r Print single sample results from an archive in the tabular and detailed format.
	r Tag and batch print a group of sample results in the preferred format, tabular or detailed.
	r Tag and batch transmit a group of results from an archive to a host computer, if applicable.

	Basics of CBC/DIFF Analysis
	r Briefly explain the Sequential Dilution System (SDS).
	r State the Coulter Principle.
	r State the relationship of resistance, cell volume, and pulse height.
	r Define threshold, count periods, and voting.
	r Explain the concept of channelization.
	r Explain how pulses are used to develop a histogram.
	r Briefly explain ACV Differential Technology.

	WBC Parameters
	r List the individual parameters that comprise the WBC Profile.
	r Identify which parameters in the WBC Profile are directly measured, derived from the WBC/BASO h...
	r Identify the flags that occur when the WBC count results do not agree.

	RBC Parameters
	r List the individual parameters that comprise the RBC Profile.
	r Identify which parameters in the RBC Profile are directly measured, derived from the RBC histog...
	r Compute MCV, MCH, and MCHC results.
	r Explain the process of building an RBC histogram.
	r Explain the area of the RBC histogram used to determine the RDW parameter.
	r Describe a typical RBC histogram.
	r Identify the flags that occur when the RBC count results do not agree.

	Plt Parameters
	r List the individual parameters that comprise the PLT Profile.
	r Identify which parameters in the PLT Profile are directly measured, derived from the Plt histog...
	r Explain the purpose of rinse flow system.
	r Explain the process of building a PLT histogram.
	r Explain the area of a typical PLT histogram used to determine the MPV parameter result.
	r Explain the area of a typical PLT histogram used to determine the PDW parameter result.
	r Describe a typical PLT histogram.
	r Identify the flag that occurs when the PLT count results don’t agree.
	r State the condition that generates an SCL flag.
	r When the MIC flag is generated, explain how you can determine if the platelet count and associa...

	Flagging
	r Demonstrate how to locate details concerning flags, interpretive messages, or analytical alarms...


	DATA STORAGE
	Database
	r Database in your AC•T 5diff CP hematology analyzer is capable of storing 10,000 results
	r Stored data includes patient sample, blank, reproducibility, control, and calibrator results
	r Because the database capacity is large, Beckman Coulter recommends a new archive be created on ...
	t Frequency is dependent on your laboratory workload and sample ID protocol
	t Small archives are easier to navigate through and easier to manage than larger ones

	Database Compacting
	The database can store 10,000 results. To optimize performance, the system compacts the database ...
	After 10,000 results have been stored, at the next login, the system automatically deletes the ol...



	DATA RETRIEVAL
	An operator may sort, retrieve, review, print, or transmit data stored in either the current, act...
	IMPORTANT Risk of compromising system functionality if you batch print and/or batch transmit whil...

	‰ ARCHIVED DATA QUICK REFERENCE
	Verify the Desired Archive is Being Used
	1 Click the Results tab to display the list of sample results.
	2 Is this the archive you wish to use?
	r If you wish to use the current, active archive:
	t A white background indicates you are viewing the current, active archive.
	t A light green background indicates you are viewing a previously closed archive that has been op...

	r If you wish to use a previously closed archive:
	Note: Do not analyze patient samples when a previously closed archive is open.
	t A white background indicates you are viewing the current, active archive. At the Menu bar, sele...
	t A light green background indicates you are viewing a previously closed archive that has been op...
	-���Select File�tt Close archive to close this open archive.
	-���Select File�tt Open archive, the table of closed archives appears.
	-���Select the date for the archive you wish to use.


	3 You may choose to sort, view, print, transmit, or delete selected or all results.
	4 If you open an archive, make sure you close the archive when your work is completed.

	To Sort the Results List
	At the Results window, you can sort information in ascending or descending order using any column...
	1 Click the title of the column you want sorted. For example, if you wish to sort by sample�ID, c...
	r >> appearing next to the title indicates an ascending (low to high) sort order.
	r << appearing next to the title indicates a descending (high to low) sort order.
	r Repeating sequence for sort functions:
	t Click once, sort ascending with a >> symbol in the column header
	t Click again, sort descending with a << symbol in the column header
	t Click again, defaults back to original order
	t Click again, start again with sort ascending

	r Sample IDs sort alphanumerically by character. For example, 10 will appear before 4 because it ...
	r Numbers appear in a sorted list before letters. For example, Sample ID 482 will appear before S...


	To Search for a Specific Sample
	1 Scroll through the list of results to locate the sample ID.
	or

	2 Use the search feature:
	r Click the Search Results tab at the bottom of the Results window.
	r Click Current Archive or Closed Archive.
	r Click your choice of search criteria: Sample ID, Patient ID, or Patient Name.
	r Type the chosen identifier.
	r Click the Search button.


	To View Sample Results
	1 To view numeric results, scroll right.
	r You may choose to print or transmit the numeric sample results.

	2 To view detailed results (results and histograms in the Run window format):
	r Double-click the desired result.
	or
	r Click to view the selected results.
	Note: Click to review the previous result or to review the next result, as desired.
	r You may choose to print or transmit the detailed sample results.
	r Click to return to the Results List.


	To Output Sample Data:��Print and Reprint / Transmit and Retransmit
	To Print a Single Sample Data Set
	1 At the selected set of sample results, click to display the print menu.
	2 Select the desired print format:
	r Print Summary List For Selected Rows (prints numeric results only)
	or
	r Print Patient Report For Selected Rows (prints Run view of results and histograms)
	ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch printing and bat...


	To Batch Print a Group of Samples
	1 Display the list of sample results.
	2 While pressing the Å key, click on each sample you wish to print. A black dot appears in the fa...
	3 Click to display the print menu.
	4 Select the desired print format:
	r Print Summary List For Selected Rows (prints numeric results only)
	or
	r Print Patient Report For Selected Rows (prints Run view of results and histograms)
	ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch printing and bat...


	To Batch Transmit a Group of Samples
	Note: The transmit option also allows an operator to transmit the last result and all results.
	1 Click the Results tab if you have not already done so.
	2 While pressing the Å key, click on each sample you wish to transmit. A black dot appears in the...
	3 Click to display the transmit menu.
	4 Select The selected results from the transmit menu.
	‰ ‰





	NOTES
	BASICS OF CBC/DIFF ANALYSIS
	Sample Dilutions
	r During aspiration, whole blood is pulled into sampling probe:
	t 53�µL of whole-blood aspirated when CBC/DIFF panel selected
	t 30�µL of whole-blood aspirated when CBC panel selected
	t Volume of sample aspirated from the specimen tube into sampling probe is sufficient to make all...

	r Aspirated sample is partitioned as it is distributed to make a series of dilutions in a series ...
	t Four dilutions are made for a CBC/DIFF panel analysis, including a dilution in the:
	H DIL1/HGB bath,
	H DIFF bath,
	H RBC bath, and
	H WBC/BASO bath.

	t Three dilutions are made for a CBC panel analysis, including a dilution in the:
	H DIL1/HGB bath,
	H RBC bath, and
	H WBC/BASO bath.

	t Steps required to make these dilutions are detailed in Topic 8 of this Training Guide


	Dilution Used to Determine RBC and PLT Results
	r Dilution made in RBC bath used to analyze red blood cells and platelets
	r RBC bath dilution prepared in two stages:
	t Primary dilution:��10�µL whole-blood is diluted with 1.7�mL of diluent in the DIL1/HGB bath to ...
	t Secondary dilution:��42.5�µL of this first dilution is transferred to the RBC bath where it is ...

	r Final 1:10,000 dilution inside RBC bath is used to:
	t Determine RBC count
	t Develop RBC histogram which is needed to obtain the Hct, MCV, and RDW parameter results
	t Determine Plt count
	t Develop Plt histogram which is needed to obtain MPV, Pct, and PDW parameter results

	Summary of Technical Characteristics for Obtaining RBC and Platelet Counts
	Initial volume of whole-blood
	10�µL
	Volume AC•T 5diff Diluent
	1700�µL
	Primary dilution ratio
	1:170
	�����Secondary Dilution for RBC and Plt:
	Volume of primary dilution
	42.5�µL
	Volume AC•T 5diff Diluent
	2500�µL
	Secondary dilution ratio
	1:58.8
	Final dilution for RBC and Plt results
	1:170�x�1:58.8�=�1:10,000
	Reaction temperature
	35˚C (95˚F)
	Method of analysis
	Coulter Principle
	Aperture diameter
	50�µm
	Count vacuum
	200�mb (5.9�in. Hg)
	Count period
	2�x�5 seconds


	Dilution Used to Determine the Hemoglobin Result
	r Final dilution made in DIL1/HGB bath is used to determine hemoglobin parameter result
	r Final dilution in the DIL1/HGB bath is prepared in three phases:
	t Phase 1:��10�µL whole-blood is diluted with 1.7�mL of diluent in the DIL1/HGB bath to form a 1:...
	t Phase 2:��42.5�µL of this first dilution is removed and 0.40�mL of diluent is added during an e...
	t Phase 3:��0.4�mL of Hgb Lyse reagent is added to form final 1:250 dilution

	r Hemoglobin released by lysis of the red blood cells combines with potassium cyanide to form a c...
	r Hemoglobin concentration is determined based on transmittance of light through the optical part...
	t Transmittance of sample dilution is compared to transmittance of a reagent blank
	t Analyzer calculates Hgb using the blank and sample readings

	Summary of Technical Characteristics for Measurement of Hemoglobin
	.
	Volume of whole-blood
	10�µL
	Volume AC•T 5diff Diluent
	1700�µL
	Preliminary dilution ratio
	1:170
	42.5�µL
	Additional volume of AC•T 5diff Diluent
	400�µL
	Volume of AC•T 5diff Hgb Lyse
	400�µL
	Final dilution for Hgb determination
	1:250
	Reaction temperature
	35˚C (95˚F)
	Method of analysis
	Spectrophotometry
	Wavelength
	550�nm


	Dilutions Used to Determine the WBC Count and Differential
	r Two dilutions are required to obtain WBC count and differential parameter results:
	t WBC/BASO dilution and
	t DIFF dilution

	WBC/BASO Dilution
	r Final 1:200 dilution is prepared by simultaneously delivering 10�µL of whole-blood and 2.0�mL o...
	r Final 1:200 dilution inside the WBC/BASO bath is used to:
	t Determine the WBC count, and
	t Develop the WBC/BASO histogram, which is needed to obtain the BASO count

	r WBC count and BASO count are determined simultaneously
	r WBC count is determined twice using two different methodologies:
	t Count obtained in the WBC/BASO bath is reference WBC count
	t Second WBC count is determined in the flow cell during acquisition of the DiffPlot. The dilutio...
	t WBC count results from the two methodologies are compared and if the results exceed predefined ...
	Note: The comparison between the WBC count from the WBC/BASO bath and the WBC count from the flow...


	Summary of Characteristics Required to Obtain WBC and BASO Results
	Volume of whole-blood
	10�µL
	Volume AC•T 5diff WBC Lyse
	2,000�µL
	Dilution ratio
	1:200
	Reaction temperature
	35˚C (95˚F)
	Method of analysis
	Coulter Principle
	Aperture diameter
	80�µm
	Count vacuum
	200�mb (5.9�in. Hg)
	Count period
	2�x�6 seconds

	DIFF Dilution
	r Final dilution inside the DIFF bath is prepared in three phases:
	t Phase 1:��25�µL of whole-blood is delivered to DIFF bath in a flow of Fix reagent
	t Phase 2:��During a 12�second incubation period, Fix reagent lyses the red blood cells, stabiliz...
	t Phase 3:��1.0�mL of diluent is added to DIFF bath to stop the cytochemical reaction and form fi...

	r Final 1:80 dilution is transferred to the flow cell where each cell is measured for impedance o...
	r Final 1:80 dilution prepared in DIFF bath is analyzed in flow cell to:
	t Develop DiffPlot from which four of five leukocyte (white blood cell) populations are determine...
	Note: In a typical whole-blood sample, the basophil population (determined in the WBC/BASO bath) ...
	t Determine a second WBC count that is compared with the reference WBC count determined in WBC/BA...
	Note: The comparison between the WBC count from the WBC/BASO bath and the WBC count from the flow...

	DiffPlot developed with optical transmission (absorbance) on the X-axis and volume on the Y-axis
	r Lymphocytes (Lymph)
	r Monocytes (Mono)
	r Neutrophils (Neut)
	r Eosinophils (Eos)


	Summary of Technical Characteristics for Acquisition of the DiffPlot
	Volume of whole-blood
	25�µL
	Volume AC•T 5diff Fix
	1000�µL
	Volume AC•T 5diff Diluent
	1000�µL
	Final dilution ratio
	1:80
	Reaction temperature
	35˚C (95˚F)
	Incubation duration
	12�seconds
	Method of analysis
	Impedance with hydrofocus
	Aperture diameter
	60�µm
	Diameter of the flow
	42�µm
	Volume injected
	72�µL
	Injection duration
	15�seconds
	Data accumulation
	12�seconds



	MEASUREMENT PRINCIPLES
	The Coulter Principle
	r Electronic method for counting and sizing particles based on the fact that cells, which are poo...
	r Cells, suspended in a conductive diluent, are pulled through the aperture by a low vacuum; this...
	r Resistance creates a pulse that is sensed and counted by the instrument as a particle; amount o...
	r Impedance variation generated by the passage of nonconductive cells through a small, calibrated...
	r Used to analyze the final dilutions in the RBC bath and WBC/BASO bath:
	t RBC bath aperture sensor system determines the cell count and size of red blood cells and plate...
	t WBC/BASO bath aperture sensor system determines the cell count and size of white blood cells. A...

	Aperture Sensor System
	r To sense particles using the Coulter Principle, a current flow is established so changes in tha...
	r In this sensing system, an electrode is placed on each side of the aperture
	t Most visible electrode (referred to as counting head) is the conductive metallic housing attach...
	t Second electrode (referred to as the bath electrode) is not as conspicuous; this electrode is l...
	t Aperture located between the counting head and the bath electrode

	r When count circuit is activated and an electronically conductive reagent is in the RBC or WBC/B...
	r Once a sample is aspirated, an aliquot of that aspirated sample is diluted with reagent (an ele...
	r When cells suspended in the conductive reagent are pulled through a calibrated aperture, electr...
	r Resistance creates a pulse that is sensed and counted as a particle by the Analyzer
	r Amount of resistance (amplitude of each pulse) is directly related to the size of the particle ...
	r Generated pulses have a very low voltage, which amplification circuit increases so that the ele...

	Thresholds
	r Thresholds are electronically set size limits
	r Unwanted particles, such as debris, are excluded from analysis
	r Particles equal to or above the threshold are analyzed and particles below the threshold are ex...

	Histogram Development
	r The lowest threshold (T1) is sometimes referred to as the Base Threshold
	r Succession of thresholds are used to sort particles by size and produce a size distribution curve
	r Area between two adjacent thresholds is called a Channel
	t Channel 1 (C1) is between T1 and T2
	t Channel 2 (C2) is between T2 and T3, and so forth
	t Each threshold represents a size
	t For a particle to be counted in a particular channel, it must be larger than or equal to the lo...

	r To produce a particle size distribution curve or histogram, the number of particles is plotted ...
	r Histogram information may be used to determine the mean (average) size of the particles, the di...
	r AC•T 5diff CP instruments develop three histograms:��WBC/BASO, RBC, and PLT


	Acquisition and Analysis Management
	r Analyzer uses three microprocessors
	r One microprocessor acts as Master and controls other two microprocessors
	r Data acquisition and analysis is accomplished in two phases:
	Differential DiffPlot (12�seconds)
	Platelet (2 x 5�seconds)
	WBC/BASO (2 x 6�seconds)
	RBC (2 x 5�seconds)
	Hgb Sample (3 x 1�second)
	Hgb Blank

	Phase 1
	r Master microprocessor directs actions of two smaller microprocessors
	r Lasts 12�seconds
	r Microprocessor #1:
	t Collects raw data from the DIFF dilution that’s being transferred and sensed inside the flow cell
	t Develops the DiffPlot
	t Determines a second WBC count in the flow cell during acquisition of the DiffPlot
	t Analyzes DiffPlot to determine the percentage of neutrophils, lymphocytes, monocytes, and eosin...

	r Microprocessor #2:
	t Collects raw data as low vacuum pulls the 1:200 dilution through the 80�µm aperture in WBC/BASO...
	t Raw data for determining WBC count and BASO count is collected over two consecutive time period...
	Note: These data collection time frames are commonly referred to as either count periods or dupli...
	t Raw data for developing WBC/BASO histogram is collected through two consecutive time periods of...


	Phase 2
	r Master microprocessor again directs actions of two smaller microprocessors
	r Lasts 10�seconds
	r Microprocessor #1:
	t Collects platelet raw data as low vacuum pulls 1:10,000 dilution through the aperture in RBC bath
	t Raw data for determining PLT count is collected over two consecutive time periods of 5-seconds ...
	t Raw data for developing PLT histogram is collected through two consecutive time periods of 5-se...

	r Microprocessor #2:
	t Collects RBC raw data as low vacuum pulls 1:10,000 dilution through the aperture in RBC bath
	t Raw data for determining RBC count is collected over two consecutive time periods of 5-seconds ...
	t Raw data for developing RBC histogram is collected through two consecutive time periods of 5-se...

	r Master microprocessor:
	t Reads sample hemoglobin concentration in DIL1/HGB bath three different times
	t Later when DIL1/HGB bath drains and is filled with Rinse reagent, reads the concentration again...



	Voting
	r Instrument generates two counts on WBC, RBC, Hct, and Plt parameters that go through the voting...
	r Voting is comparison of the two results with each other to verify results are in close agreement:
	t If they agree, final reported result is the average of the two results
	t If the results differ by more than a predefined limit, WBC, RBC, Hct, or Plt result is flagged ...

	Voteout Flagging
	r If WBC result is flagged with a V, then the DIFF number results are also flagged with a V
	r If RBC result is flagged with a V, then MCV, MCH, MCHC, and RDW results are replaced by ( . . ....
	r If Hct result is flagged with a V, then MCV and MCHC results are replaced by ( . . . . . ) code
	r If Plt count votes out, then Plt result is flagged with a V
	r For more information about flagging, see Chapter 9 of the Instructions For Use manual.


	ACV Differential Technology
	r In DIFF (differential) bath, 25�µL of whole blood is mixed with 1,000�µL of AC•T 5diff Fix reag...
	r Analyzer maintains the reagents and reaction at a regulated temperature of 35˚C (95˚F)
	r Reaction in the DIFF bath lyses red blood cells, preserves leukocytes at their original size, a...
	r Each stained cell is individually focused by the Dual Focused Flow (DFF) system and transported...
	Dual Focused Flow (DFF)
	r DFF uses sheath fluid to surround and force cells suspended in diluent to pass one at a time th...
	t First sheath flow focuses sample through the impedance aperture
	t Second sheath flow maintains the focused flow of cells as they exit the aperture into the optic...

	r Hydrodynamic focusing in the flow cell enables accurate and rapid cell-by-cell measurements on ...
	r Sequential analyses for cell volume (impedance) and light absorbance are performed in the flow ...
	t Total of 72�µL of sample from the DIFF bath is injected through the flow cell for 15�seconds
	t Data for developing the DiffPlot is accumulated 12�seconds
	t Flow cell incorporates a 60�µm aperture for cellular volume analysis and about a 40�µm measurem...
	t Flow cell lamp is a 20 watt incandescent tungsten-halogen lamp


	Focused Flow Impedance
	r Focused flow impedance technology measures the electrical resistance of a cell as it passes thr...
	r Change in resistance is directly proportional to volume of the cell

	Absorbance Cytochemistry
	r As a cell passes through the optical portion of the flow cell, light is scattered in all direct...
	r Sensor detects only forward scattered light
	r Optical measurement is derived as a function of the amount of light lost due to diffraction and...
	r Collected signals are converted into voltage pulses and are processed
	r Magnitude of the voltage pulses are proportional to the physical and chemical characteristics o...
	r Measurements provide the information for lymphocytes, monocytes, neutrophils, and eosinophils, ...

	Signal Processing
	r Signals from the flow cell aperture and from the optical measurement are correlated by a window...
	r Optical pulse must be detected within 100 to 300 microseconds of the impedance pulse; otherwise...
	r Output signals from the focused flow impedance and the light absorbance measurements are combin...

	Thresholds
	r Most of the population partition thresholds are fixed and give the limits of the morphological ...
	r Changes in the morphology of a population are expressed on the DiffPlot by a shifting of the co...



	NOTES
	WBC PARAMETERS
	r WBC parameter results are generated from two different dilutions:
	t WBC/BASO dilution which is made and analyzed in WBC/BASO bath and
	t DIFF dilution which is made in DIFF bath but analyzed in the flow cell

	WBC/BASO Dilution
	r WBC and basophil counts are determined from 1:200 dilution made in WBC/BASO bath
	r To make this dilution, 10�µL of whole blood is mixed with 2,000�µL of AC•T 5diff WBC Lyse reage...
	r WBC count and BASO count are determined simultaneously from final 1:200 dilution

	WBC Count
	When the CBC/DIFF Panel is Selected
	r Analyzer compares data from the two 6-second count periods then votes and rejects any questiona...
	r When the two counts are compared:
	t If two counts agree, reference WBC count reported
	WBC count = Number of cells per volume x calibration factor
	WBC count displayed and printed as:��WBC = N x 103 cells /µL
	t If two counts differ more than predefined limit, WBC result is flagged with a V and DIFF absolu...

	r Second WBC count is determined in the flow cell during acquisition of DiffPlot:
	Note: The comparison between the WBC count from the WBC/BASO bath and the WBC count from the flow...
	t If WBC count from flow cell exceeds WBC count from WBC/BASO bath by more than a predefined amou...
	t If WBC count from flow cell is less than WBC count from WBC/BASO bath by more than a predefined...
	t When a DIFF- or a DIFF+ flag occurs, WBC count and all DIFF# parameters are flagged with an *


	When the CBC Panel is Selected
	r Analyzer compares data from the two 6-second count periods then votes and rejects any questiona...
	r When two counts are compared:
	t If two counts agree, reference WBC count is reported
	WBC count = Number of cells per volume x calibration factor
	WBC count displayed and printed as:��WBC = N x 103 cells /µL
	t If two counts differ more than a predefined limit, WBC result is flagged with a V and DIFF abso...



	BASO Count
	r Differentiation between basophils and other leukocytes is obtained by means of the AC•T 5diff W...
	r Raw data for developing WBC/BASO histogram is collected through two consecutive time periods of...
	r Referencing the above illustration:
	t Basophils are located in the area between thresholds labeled c�and�d
	t One hundred percent (100%) of the leukocytes is represented by the total number of nucleated pa...
	t Basophil percentage is calculated from number of particles existing in the area between thresho...

	r BASO count = Number of cells per volume x calibration factor in a percentage relative to the nu...

	DIFF Dilution
	r DiffPlot developed from analysis of 1:80 DIFF dilution
	r From this DiffPlot, neutrophil�%, lymphocyte�%, monocyte�%, and eosinophil�% are determined
	r To make 1:80 DIFF dilution:
	t 25�µL of the whole-blood sample is mixed with 1,000�µL of AC•T 5diff Fix reagent; Fix reagent l...
	t After 12�seconds of incubation, 1,000�µL of AC•T 5diff Diluent reagent added to stop cytochemic...

	r Dilution is injected through the flow cell 15�seconds; for 12 of these 15�seconds, data for dev...

	DiffPlot Development
	r DiffPlot analysis on AC•T 5diff CP hematology analyzer based on three essential principles:
	t Dual Focused Flow (DFF) fluid dynamics, which is a process by which individual cells or particl...
	t Volume measurement (Coulter Principle)
	t Measurement of transmitted light with zero degree (0˚) angle, which permits a response proporti...

	r From these measurements, a DiffPlot is developed with optical transmission (absorbance) on the ...
	r DiffPlot regions include:

	DiffPlot Regions Defined
	r Study of DiffPlot permits clear differentiation of four out of five leukocyte populations
	r In typical whole-blood sample, basophil population is very small when compared with the other f...
	Neutrophils
	r Neutrophils, with their cytoplasmic granules and segmented nuclei, scatter light according to t...
	r Hypersegmented neutrophil gives an increased optical response when compared to a young neutroph...
	r Higher the complexity of the cell, the further to the right they appear in the DiffPlot

	Lymphs (Lymphocytes)
	r Lymphocytes, typically being small with regular shape are smaller in volume and lower in absorb...
	r Normal lymphocyte populations typically have a homogeneous volume with a Gaussian (bell-shaped)...
	r Large lymphocytes, reactive lymphoid forms, stimulated lymphocytes and plasma cells are found i...
	r Lower area of the lymphocyte zone is normally empty; however, when small lymphocytes are presen...
	r Presence of platelet aggregates is indicated by a distribution pattern that moves from the Diff...
	r NRBC cytoplasmic membranes lyse like those of mature erythrocytes; small nuclei that remain app...

	Monocytes
	r Monocytes are typically large cells with a kidney-shaped nucleus and agranular (granule-free) c...
	r Cells neither scatter nor absorb large amounts of light and, therefore, are positioned in the l...
	r Due to their size, monocytes are clearly positioned high on the volume axis
	r Very large monocytes may be found in the IMM (immature cell) region

	Eosinophils
	r With reagent action, eosinophils are the most intensely stained cells for optical separation
	r Due to the staining and their size, eosinophils show higher absorbance than neutrophils, but wi...

	Debris
	r Platelets and debris from erythrocyte lysis represent the background debris population located ...


	Immature White Blood Cells
	Immature Granulocytes
	r Immature granulocytes are detected by their larger volume and by presence of granules that incr...
	r Due to their increased volume and similar absorbance, promyelocytes, myelocytes, and metamyeloc...

	Band Cells
	r Band cells are typically larger or of similar size to the neutrophils; however, due to their lo...
	r Band cells tend to appear in the region between the neutrophils and the monocytes

	Blast Cells
	r Blast cells are generally larger than monocytes and have similar absorbance
	r When blast cells are present, generally located above the monocytes, which means they will be i...
	r Small blasts will be located between the normal lymphocyte and monocyte populations


	DiffPlot Thresholds
	r Most of the population partition thresholds are fixed and give the limits of the morphological ...
	r Changes in the morphology of a population are expressed on the DiffPlot by a shifting of the co...
	r Volume and absorbance thresholds are used to detect shifting populations
	r When populations in DiffPlot exceed limits set for that region, a review (R) flag occurs on the...
	r If R flag occurs on a DIFF parameter, further investigate the result
	r Twelve different flags may occur related to the position of the populations within the DiffPlot:
	t CO (diff reject)
	t UM (upper monocyte)
	t DB (debris)
	t LN (lower neutrophil)
	t SL (small lymphocytes)
	t UN (upper neutrophil)
	t SL1 (small lymphocytes 1)
	t NE (neutrophil/eosinophil)
	t NL (neutrophil/lymphocyte)
	t ATL (atypical lymphocytes)
	t MN (monocyte/neutrophil)
	t IMM (immature cells)

	r See the Definition of DIFF Flags table in Chapter 9 of the Instructions For Use manual for a li...

	Flags, Interpretive Messages, and Analytical Alarms
	r For details concerning flags, interpretive messages, and analytical alarms associated with WBC ...
	r To use Online Help to locate flags, interpretive messages, or analytical alarms associated with...
	1) Click
	2) Click on Contents; table of contents appears in left frame
	3) Inside left frame, click on 9 Data Review to list headings in that chapter
	4) Scroll through headings and click on heading that interests you; information appears inside ri...
	5) Scroll to locate information concerning a specific flag, interpretive message, or analytical a...
	or
	Print a copy of the information
	-���Right click on the messages (anywhere inside right frame)
	-���Click Print on the pop-up menu
	-���Click OK to initiate printing
	Note: All the information under the primary heading is printed; locate specific flag, interpretiv...


	WBC Parameters

	NOTES
	RBC PARAMETERS
	RBC Dilution
	r Final 1:10,000 dilution in RBC bath that is often referred to as RBC/PLT dilution
	r RBC dilution contains red blood cells, white blood cells, and platelets:
	t Thresholds are used to separate platelet pulses, which are much smaller, from the red and white...
	t Since white blood cells fall in red blood cell size range, they are counted and sized as RBCs


	RBC Count
	r RBC count obtained from RBC/PLT dilution in RBC bath
	r To obtain an RBC count result, Analyzer compares data from the two 5-second count periods then ...
	r When the two counts are compared:
	t If two counts agree, RBC count is reported
	RBC count = Number of cells counted per volume unit x calibration factor
	RBC count displayed and printed as:��RBC = N x 106 cells /µL
	t If two counts differ more than a predefined limit, RBC result is flagged with a V and MCV, MCH,...

	r Since white blood cells fall in the red blood cell size range, they are counted and sized as RB...
	Note: The WBCs are not gated out of the count because any interference is usually insignificant; ...

	Hematocrit Measurement
	r Height of the pulse generated by the passage of a cell through the aperture is directly proport...
	r Hematocrit (Hct) is the sum of all the digitized pulses
	r Collects data from the two 5-second count periods then votes and rejects any questionable data
	r When two hematocrit results are compared:
	t If two values agree, Hct result is reported
	Hct = Sum of digitized pulses x calibration factor
	Hct displayed and printed as a percentage (%)
	t If two values differ more than a predefined limit, Hct result is flagged with a V and MCV and M...


	RBC Histogram
	r In addition to being counted, red blood cells are categorized according to size (from 30�fL to ...
	r Pulse-height analyzer uses a number of thresholds to sort the particles into several size (volu...
	r Raw data for developing the RBC histogram is collected through two consecutive time periods of ...
	r RBC distribution curve reflects the native size of the red blood cells and any other particle i...
	r Example of an RBC histogram with a normal RBC size distribution is shown below.
	Information Obtained Using the RBC Histogram
	r RBC histogram provides the information for determining a helpful descriptor of the red cell pop...
	r RBC histogram is also used to determine if a red blood cell population is typical; if not, desc...


	RDW Determination
	r RDW (Red cell Distribution Width) is an index of the variation or spread in the size of the red...
	r Study of RBC distribution detects erythrocyte anomalies linked to anisocytosis and enables clin...
	t Generally, as the red cell variation increases, width of the distribution curve broadens and vi...
	t Width of the distribution curve, however, does not always indicate a true increase in size vari...

	r RDW index more accurately detects red cell variation than a visual inspection of the histogram ...
	Note: A primarily microcytic population of red cells (decreased MCV) tends to have a tighter dist...
	r Displayed and printed as a percentage, RDW is calculated using the standard deviation (SD) of t...

	where:
	K = System constant
	SD = Calculated standard deviation based on the red cell distribution
	MCV = Mean Cell Volume of the red cells


	RBC Distribution Flags
	r Once RBC distribution curve is developed, two positions on the distribution curve are located:
	RBC1 and RBC2 Thresholds
	r Thresholds RBC1 and RBC2 define the MICRO and MACRO regions and are calculated based on standar...
	r RBC1 threshold (monitoring area for microcytes) and RBC2 threshold (monitoring area for macrocy...

	Flags
	r MICRO flag is generated when the percentage of cells in the microcytic region compared to the t...
	r MACRO flag is generated when the percentage of cells in the macrocytic region compared to the t...
	r Laboratory may establish its own limits to replace the preset default values
	Note: The MICRO and MACRO flags are independent of the Microcytosis and Macrocytosis flags that a...


	Hgb Determination
	r Addition of CBC lytic reagent disrupts the red cells to free the hemoglobin which then combines...
	r Converted hemoglobin is directly measured through the optical part of the DIL1/HGB bath using a...
	r Transmittance of the sample dilution is compared with the transmittance of a reagent blank; sys...
	Hgb result in g/dL represents:��absorbance value obtained x calibration factor
	Hgb displayed and printed as:��Hgb = N g/dL
	Hgb Blank Reading
	r Hgb blank value measured during the first patient cycle after a Startup cycle is stored as a re...
	r During each analysis cycle, Analyzer checks the measured Hgb blank against the stored Hgb blank...
	Note: If the new Hgb blank reference value is within 3% of the old reference value, the Hgb blank...

	Sample Reading
	r Value is based on the sample, diluent, and Hgb Lyse reagent mixture in the DIL1/HGB bath during...

	Hgb Specific Flags
	r If the Hgb blank value is less than 2.5�Vdc, reject (R) flag occurs on Hgb value
	r If difference between the new Hgb blank reference value and the original Hgb blank reference va...
	r If three consecutive review (R) flags occur on the Hgb blank reference value, (. . . . .) code ...
	r For each Hgb sample read value, Analyzer takes three readings; if the difference between these ...
	r If the [(Hgb g/dL X 3)/Hct%] is <0.8 or >1.2, the RBC, Hgb, MCV, Hct, MCH, MCHC, Plt, MPV, Pct,...


	Calculations
	MCV Calculation
	r MCV (Mean Cell Volume) is calculated using the Hct and the RBC count
	r Displayed and printed in femtoliters (fL)
	r Calculation for MCV is:

	MCH Calculation
	r MCH (Mean Cell Hemoglobin) is calculated from the Hgb value and the RBC count and describes the...
	r Displayed and printed in picograms (pg)
	r Calculation for MCH is:

	MCHC Calculation
	r MCHC (Mean Cell Hemoglobin Concentration) is calculated using the Hgb and Hct values and descri...
	r Displayed and printed in grams per deciliter
	r Calculation for MCHC is:


	Flags, Interpretive Messages, and Analytical Alarms
	r For details concerning flags, interpretive messages, and analytical alarms associated with RBC ...
	r To use Online Help to locate flags, interpretive messages, or analytical alarms associated with...
	1) Click
	2) Click on Contents; table of contents appears in left frame
	3) Inside left frame, click on 9 Data Review to list headings in that chapter
	4) Scroll through headings and click on the heading that interests you; information appears insid...
	5) Scroll to locate the information concerning a specific flag, interpretive message, or analytic...
	or
	Print a copy of the information
	-���Right click on the messages (anywhere inside right frame)
	-���Click Print on the pop-up menu
	-���Click OK to initiate printing
	Note: All the information under the primary heading is printed. Locate the specific flag, interpr...


	RBC Parameters

	PLATELET PARAMETERS
	RBC Dilution
	r Platelet parameters are obtained from RBC dilution
	r Final 1:10,000 dilution in RBC bath that is often referred to as RBC/PLT dilution
	r RBC dilution contains red blood cells, white blood cells, and platelets
	r Platelet counting and sizing is done in RBC bath
	r Thresholds are used to separate platelet pulses, which are much smaller, from the red and white...

	Plt Count
	r Plt count is obtained from the RBC/PLT dilution in RBC bath
	r To obtain a Plt count result, Analyzer compares the data from the two 5-second count periods th...
	r When two counts are compared:
	t If two counts agree, Plt count reported
	Plt count = Number of cells counted per volume unit x calibration factor
	Plt count displayed and printed as:��Plt = N x 103 cells /µL
	t If two counts differ more than the predefined limit, Plt result is flagged with a V


	PLT Histogram
	r Platelets are categorized according to size by a 256-channel pulse-height analyzer
	r Pulse-height analyzer uses a number of thresholds to sort the particles into several size (volu...
	r Platelet histogram reflects the native size of the platelets and any other particle in the plat...
	r Illustration that follows is a PLT histogram with a typical platelet size distribution:
	Information Obtained Using the PLT Histogram
	r PLT histogram provides the information for determining a helpful descriptor of the platelet pop...
	t MPV (Mean Platelet Volume)
	t PDW (Platelet Distribution Width)

	r PLT histogram is also used to determine if a platelet population is typical; if not, descriptiv...


	MPV Measurement
	r MPV (Mean Platelet Volume) is measured directly from analysis of the platelet distribution curve
	r MPV is displayed and printed in femtoliters (fL)

	PDW Determination
	r PDW (Platelet Distribution Width) is determined from the PLT histogram as the width of the curv...
	r In the illustration that follows, shows the area of the PLT histogram that used to determine th...
	r In this example, S1 and S2 are placed so that:
	t 15% of the platelets occur between 2�fL and S1
	t 15% of the platelets occur between S2 and the variable upper threshold
	Note: This threshold is explained under the Detecting Abnormal Platelet Distributions heading tha...
	t PDW result is determined on the platelets between S1 and S2

	r PDW parameter result is displayed and printed as a percentage (%)
	r PDW is not an FDA approved parameter; therefore, this parameter label and result are not routin...

	Detecting Abnormal Platelet Distributions
	r Particles of approximately platelet size can interfere with platelet histogram and count
	r Small particles, such as microbubbles or dust, can overlap the low end of the histogram
	r Microcytic red cells can intrude at the upper end of the histogram
	Identifying a Normal Distribution
	r When platelet histogram is being evaluated, a mobile threshold can move from its starting posit...
	r Computer searches for a valley between the platelet and red cell populations
	r If no valley is detected between 18�fL and 25�fL, threshold remains at 25�fL and no flag is gen...
	r In the typical platelet distribution that follows, no valley is detected between 18�fL and 25�f...

	Microcytic Interferences on the Upper End of the Platelet Distribution Curve
	r Microcytic red cells can intrude at the upper end of the platelet distribution curve
	r If specimen contains microcytes, AC•T 5diff CP hematology analyzer may be able to successfully ...

	Microcytic Interference with a Distinct Valley between 18�fL and 25�fL
	r If intrusion of microcytes creates a valley between the 25�fL and the 18�fL thresholds, the 25�...
	r When this occurs, reported platelet result is acceptable; however, MIC (microcytes) flag appear...
	r Illustration that follows is an example of microcytic interference with a valley between 18�fL ...

	Microcytic Interference with a Valley below 18�fL
	r If microcytes are extremely small so that the valley between the platelet population and the mi...
	r When this occurs, MIC flag appears and the platelet count is flagged to alert the operator that...
	r Platelet count and associated parameters are not reliable and should be verified by an alternat...
	r Illustration that follows is an example of microcytic interference with a valley below 18�fL:

	Interference with No Distinct Valley
	r Interference present in the upper area of the platelet distribution curve that blends with the ...
	r If threshold cannot be positioned in the 25�fL to 18�fL region, threshold defaults to the 18�fL...
	r SCH (schistocytes) flag appears and the platelet count is flagged to alert the operator that th...
	r Platelet count and associated parameters are not reliable and must be verified using an alterna...
	r Illustration that follows is an example of interference with no distinct valley:

	Interference on the Lower End of the Platelet Distribution Curve
	r Particles that are approximately platelet size can interfere with platelet histogram and count
	r Small particles, such as microbubbles or dust, can interfere at the low end
	r If number of pulses in the 2 to 3�fL region is higher than the predefined limits, an SCL flag a...
	r SCL appears under the Analytical Alarms heading, “Small Cells” appears under the Interpretive M...
	r Rerun the sample and verify the results.
	r Illustration that follows is an example of interference on the lower end of the platelet distri...


	Pct Calculation
	r Pct (plateletcrit or thrombocrit) is calculated according to the formula:
	r Pct parameter result displayed and printed as a percentage (%)
	r No clinical significance has been identified for Pct parameter
	r Pct (and PDW) are not FDA approved parameters; therefore, these parameter labels and results ar...

	Rinse Flow System
	r Rinse flow is a steady stream of AC•T 5diff Diluent reagent that flows behind the RBC aperture ...
	r Without rinse flow (Figure A), there is a characteristic swirling of the dilution at the outlet...
	r With rinse flow (Figure B), the steady stream of diluent prevents the formation of these eddies

	Flags, Interpretive Messages, and Analytical Alarms
	r For details concerning flags, interpretive messages, and analytical alarms associated with plat...
	r To use Online Help to locate flags, interpretive messages, or analytical alarms associated with...
	1) Click
	2) Click on Contents; table of contents appears in left frame
	3) Inside left frame, click on 9 Data Review to list headings in that chapter
	4) Scroll through headings and click on the heading that interests you; information appears insid...
	5) Scroll to locate the information concerning a specific flag, interpretive message, or analytic...
	or
	Print a copy of the information
	-���Right click on the messages (anywhere inside right frame)
	-���Click Print on the pop-up menu
	-���Click OK to initiate printing
	Note: All the information under the primary heading is printed. Locate the specific flag, interpr...


	Platelet Parameters

	NOTES

	BASIC TROUBLESHOOTING
	OBJECTIVES
	When the subject is complete, you will be able to�.�.�.
	Accessing Principal Assemblies and Component Identification
	r Name each principal assembly.
	r Locate and name main components.

	Cycle Description
	r Identify the start conditions prior to initiating a cycle.
	r Identify the pierce position.
	r Cite the volume of sample aspirated for a CBC/DIFF panel versus a CBC panel.
	r Tell whether the bubble placed between diluent and blood during aspiration is normal or abnormal.
	r Explain how the final RBC/Plt dilution is made, including the bath locations and reagents used ...
	r Explain how the WBC/BASO dilution is made, including the bath location and reagents used in the...
	r Explain how the DIFF dilution is made, including the bath location and reagents used in the pro...
	r Explain what portions of the cycle are eliminated by selecting the CBC panel.
	r Explain how the tangential flow or reagent mixes the sample and reagent.
	r Explain the purpose of the mixing bubbles entering the DIL1/HGB bath.
	r Explain the purpose of the burn circuit.

	Basic Troubleshooting Techniques
	r Recognize an instrument problem based on:
	t Abnormal sample results.
	t Abnormal Startup results.
	t Abnormal control results.
	t Error messages.

	r Demonstrate how to access the Error Log.
	r Demonstrate that you can locate the Error Messages table in the Instructions For Use manual.
	r Use what you know about normal cycle flow and the derivation of parameter results to troubleshoot.
	r Isolate the components involved, when given a symptom.
	r Reproducibility check:
	t Explain the purpose of this check.
	t State at least one situation when performing a reproducibility check would be beneficial.

	r Properly power down and power up the system as needed.

	Preventive Maintenance
	r Perform the proper maintenance procedures based either on a time schedule or on an as needed ba...
	r Demonstrate how to access the Maintenance Log.

	Replacement and Adjustment Procedures
	r Locate and perform selected replacement and adjustment procedures such as replacing the flow ce...


	ACCESSING PRINCIPAL ASSEMBLIES AND COMPONENT IDENTIFICATION
	Cap Pierce Module
	With the Door Open
	Tube Holders
	Position Designations for Tube Holder #1
	b
	Sample position 1
	c
	Sample position 2
	d
	Sample position 3
	e
	Sample position 4
	b
	Sample position 1
	c
	Sample position 2
	d
	Sample position 3
	e
	Sample position 4


	Accessing the Right Side Compartment
	Note: Use the special key to loosen the two captive screws securing the right side panel to the i...

	Right Side Compartment Components
	Component Locations
	r Allows operator to access hydraulic parts for maintenance operations
	r Compartment is heated to ensure cytochemical reaction of the DIFF reagent with the whole-blood ...
	r Mandatory to keep this door locked when running control or patient samples to ensure proper hea...

	Baths Assembly

	Accessing the Left Side Compartment
	Note: Use the 3�mm Allen wrench to remove the four hex screws securing the left side panel to the...
	r Allows access to the Main card (circuit card that controls Analyzer operation)
	r Allows access to additional hydraulic components maintained by service
	r Operator must remove this panel to access the flow cell lamp housing when lamp replacement is n...


	Left Side Compartment Components
	Component Locations
	Must Remove the Top Cover to Access the Flow Cell Lamp
	r To remove the top cover, operator must locate and remove five screws
	t Left side panel must be removed to remove one screw securing the top cover to the instrument fr...
	t Three screws secure the top cover to the back panel

	r Removal of the left side panel and top cover allows easy access to the flow cell lamp housing l...

	Flow Cell Lamp Location on the Optical Bench
	r Lamp replacement procedure located in the Instructions For Use manual, Chapter 11
	To use Online Help to locate this procedure:
	1) Click
	2) Click on Contents; table of contents appears in left frame
	3) Inside left frame, click on 11 Diagnostics to list headings in that chapter
	4) Scroll through headings and click on Replacing the Flow Cell Lamp; replacement procedure appea...
	5) Complete procedure as written:
	a) Follow the instructions on the Workstation screen
	��������or

	b) Print a copy of the instructions
	��������-���Right click on procedure (anywhere inside right frame)
	��������-���Click Print on the pop-up menu
	��������-���Click OK to initiate printing
	Note: All the information under the primary heading is printed. Locate the flow cell lamp replace...




	CYCLE DESCRIPTION
	Start Conditions
	Front of the Analyzer
	r Cap-pierce door is open
	r Green LED is glowing steady indicating the instrument is ready

	Baths Assembly (in the Right Side Compartment)
	r All baths (except the rinse chamber) are filled with clean diluent


	Initiate Cycle
	r Select appropriate tube holder
	r Insert tube holder on the piercing mechanism and lock it in place
	r Place the specimen tube in the tube holder opening that best correlates with size of the specim...
	t Specimen tube may be an open tube or may be sealed with a pierceable stopper
	t For best results, specimen tube must be well mixed before placing the tube in the tube holder

	r Verify the specimen tube is in the pierce position (12 o’clock position)
	t Tube holder may be rotated (clockwise or counterclockwise) as needed

	r Close door to initiate the cycle
	t Before closing the door, verify the green LED is glowing steady. When the green LED is glowing ...
	t For best results, time between placing the well-mixed specimen tube inside the tube holder and ...


	Aspiration
	Inside the Sampling Probe
	r Sampling probe moves above the pierce position
	r Cap pierce mechanism senses the tube holder and determines which tube slot is in the pierce pos...
	t If specimen tube has a pierceable stopper, sampling probe pierces the stopper and continues its...
	t If specimen tube is an open vial, sampling probe makes the same downward movement until the tip...
	t If specimen tube is not in the pierce position, cap-pierce mechanism makes these same movements...

	r Volume of whole-blood aspirated into the sampling probe is sufficient to make all the dilutions...
	t 53�µL of whole-blood aspirated when the CBC/DIFF panel selected
	t 30�µL of whole-blood aspirated when the CBC panel selected

	r Green and red LEDs alternately flash while the instrument is busy aspirating required sample vo...
	r Additionally, all baths drain


	Sample Partitioning
	r Using the Sequential Dilution System (SDS) technique, aspirated sample is partitioned as it is ...
	r When CBC/DIFF panel selected, three aliquots of the aspirated whole-blood sample are used to ma...
	r When CBC panel selected, only two aliquots of the aspirated whole-blood sample are used to make...
	Sample Partitions inside the Sampling Probe when CBC/DIFF Panel is Selected
	�
	After aspiration, aliquots of the whole-blood sample are distributed to the various baths as foll...
	r 3�µL sample aliquot at the tip of the probe is discarded into the rinse chamber as the exterior...
	r 10�µL of sample is delivered to the DIL1/HGB bath for use in preparing the primary RBC/Plt dilu...
	r 10�µL of sample is delivered to the WBC/BASO bath for the WBC/BASO count
	r 25�µL of sample is delivered to the DIFF bath for development of the DiffPlot
	r 5�µL of remaining sample is discarded into the rinse chamber


	Sample Partitions inside the Sampling Probe when CBC Panel is Selected
	�
	After aspiration, aliquots of the whole-blood sample are distributed to the various baths as foll...
	r 3�µL sample aliquot at the tip of the probe is discarded into the rinse chamber as the exterior...
	r 10�µL of sample is delivered to the DIL1/HGB bath for use in preparing the primary RBC/Plt dilu...
	r 10�µL of sample is delivered to the WBC/BASO bath for the WBC/BASO count
	r 7�µL of remaining sample is discarded into the rinse chamber



	Delivery
	Baths Assembly
	r Each aliquotted sample is delivered to its appropriate bath
	r Sample and reagent are delivered simultaneously using tangential flow

	Tangential Flow
	r Each aliquotted sample is delivered to its appropriate bath using a tangential flow of reagent ...
	r To create this tangential flow:
	t Delivery port is positioned so that reagent is delivered tangentially to the wall of the bath (...
	t Sampling probe tip must be properly aligned with the reagent delivery port on the bath

	r Simultaneous delivery of sample and reagent at a single point on the curved wall of the bath se...


	Preparing Dilutions
	r Using the Sequential Dilution System (SDS) technique, aspirated sample is partitioned as it is ...
	r When a CBC/DIFF panel selected, this series of dilutions occurs in 10 phases
	Note: When a CBC panel is selected, phase�5 (making the DIFF dilution) and phase�7 (stopping the ...
	Phase 1���Sample Aspiration
	r 53�µL of whole-blood is aspirated into the sampling probe from the specimen tube
	Note: If a CBC panel is selected, 30�µL of whole-blood is aspirated.

	S
	Phase 2���Initial Discard and External Probe Rinse
	r Horizontal traverse assembly positions sampling probe over rinse chamber
	r 3�µL sample aliquot at the tip of the sampling probe is discarded into the rinse chamber as ext...
	r Discarding 3�µL aliquot of aspirated sample helps ensure sample integrity
	r After rinsing the outside of the sampling probe, three aliquots of the aspirated whole-blood sa...

	Phase 3���Make the First Dilution
	r Horizontal traverse assembly positions the sampling probe over DIL1/HGB (first dilution/Hgb) bath
	r Vertical traverse assembly moves the probe downward into the bath; probe tip is positioned to p...
	r 10�µL of the whole-blood partitioned for making the first dilution is delivered to the DIL1/HGB...
	r Tangential flow of reagent mixes the sample and the diluent; mixing bubbles enter the bath to m...
	r This 1:170 dilution commonly referred to as the first dilution

	Phase 4���Make the WBC/BASO Dilution
	r Horizontal traverse assembly positions sampling probe over the WBC/BASO bath
	r Vertical traverse moves the probe downward into the bath; tip of the probe is positioned so tha...
	r Tangential flow of reagent mixes the sample and reagent; mixing bubbles enter the bath to make ...
	r WBC Lyse destroys the red blood cells and the specific lytic action on the white blood cells di...
	r This final 1:200 dilution is used to determine the WBC count; WBC/BASO histogram, from which th...
	Whole-blood volume
	10 µL
	Volume of AC•T 5diff WBC Lyse reagent
	2000 µL
	Dilution ratio
	1:200


	Phase 5���Make the DIFF Dilution
	r Horizontal traverse assembly moves sampling probe over DIFF bath
	r Vertical traverse assembly moves probe downward into the bath
	r Tip of probe is positioned so that a tangential flow occurs as 25�µL of the whole-blood sample ...
	r Tangential flow of reagent mixes the sample and the Fix reagent; mixing bubbles enter the bath ...
	r Fix reagent lyses the red blood cells, stabilizes the WBCs in their native form, and differenti...

	Phase 6���Wash the Sampling Probe
	r Horizontal traverse assembly moves sampling probe over the rinse chamber
	r Double rinse (interior and exterior) of sampling probe flushes all traces of residual whole-blo...
	t Rinsing probe’s interior removes whole-blood sample that was aspirated but not used in making t...
	H In CBC/DIFF mode, 5�µL is discarded in rinse chamber
	H In CBC mode, 7�µL is discarded in rinse chamber

	t Rinsing probe’s exterior removes all residual whole-blood from probe’s surface which minimizes ...


	Phase 7���Stop the DIFF Reaction
	r After 25�µL of whole-blood sample and 1.0�mL of Fix reagent incubate 12�seconds, staining proce...
	r This final 1:80 dilution is sent to flow cell for generation of the DiffPlot
	r Neutrophil�%, lymphocyte�%, monocyte�%, and eosinophil�% are determined from this DiffPlot
	Whole-blood volume
	25 µL
	Volume of AC•T 5diff Fix reagent
	1000 µL
	Volume of AC•T 5diff Diluent
	1000 µL
	Final dilution ratio
	1:80


	Phase 8���Aspiration from the First Dilution
	r Horizontal traverse assembly moves sampling probe over the DIL1/HGB bath
	r Vertical traverse assembly moves probe downward into the bath
	r 42.5�µL of the 1:170 first dilution is aspirated into the sampling probe

	Rinse the Outside of the Sampling Probe
	r While still inside the DIL1/HGB bath, exterior of sampling probe is rinsed with 0.4�mL of diluent
	r Vertical traverse assembly moves probe up out of the bath

	Phase 9���Make the RBC/Plt Dilution
	r Horizontal traverse assembly moves sampling probe over the RBC bath
	r Vertical traverse assembly moves probe downward into the RBC bath
	r Tip of the probe is positioned so that a tangential flow occurs as the 42.5�µL of 1:170 dilutio...
	r An additional 2.0�mL of diluent is dispensed through the probe
	r This final 1:10,000 dilution is analyzed to determine RBC count and Plt count; RBC and PLT hist...
	Volume 1:170 dilution from DIL1/HGB bath
	42.5 µL
	Volume of AC•T 5diff Diluent reagent
	2500 µL
	Final dilution ratio
	1:10,000


	Phase 10��Make the Hemoglobin Dilution
	r 0.4�mL of Hgb Lyse is added to the bath
	r Hgb Lyse reagent rapidly destroys the red blood cells and converts a substantial proportion of ...
	r Mixing bubbles enter bath to ensure a uniform dilution
	r Hemoglobin value is photometrically determined from this final 1:250 dilution.
	First dilution
	1:170
	Volume of first dilution removed
	42.5 µL
	Volume of AC•T 5diff Hgb Lyse reagent
	400 µL
	Volume of AC•T 5diff Diluent reagent
	400 µL
	Final dilution ratio
	1:250




	Final Dilutions for Analysis
	DIL1/HGB
	Step 1��10�µL whole-blood sample + 1.7�mL diluent
	Step 2��42.5�µL of the first dilution removed
	��0.40�mL diluent added during external probe wash
	Step 3��0.4�mL Hgb Lyse reagent added
	1:250
	DIFF
	Step 1��25�µL whole-blood sample + 1.0�mL Fix reagent
	Step 2��12�second incubation
	Step 3��1.0�mL diluent added

	1:80
	RBC (and Plt)
	42.5�µL of the first 1:170 dilution + 2.5�mL diluent

	1:10,000
	WBC/BASO
	10�µL whole-blood sample + 2.0�mL WBC Lyse reagent

	1:200


	WBC and BASO Counting
	r Final 1:200 dilution inside the WBC/BASO bath is used to:
	t Determine the WBC count, and
	t Develop the WBC/BASO histogram, which is needed to obtain the BASO count

	r When 10�µL of whole blood is mixed with 2,000�µL of AC•T 5diff WBC Lyse reagent in the WBC/BASO...
	r It is important that the Analyzer maintains the reagents and reaction at a regulated temperatur...
	r Count syringe supplies a constant low vacuum to the WBC/BASO bath to pull the diluted sample th...
	r As each cell passes through aperture:
	t Pulse is generated proportional to the cellular volume
	t Total leukocyte count and basophil percentage are determined by specific thresholds on the WBC/...

	r WBC count and BASO count determined simultaneously
	r WBC count is determined twice using two different methodologies:
	t Count obtained in WBC/BASO bath is the reference WBC count
	t Second WBC count is determined in the flow cell during acquisition of the DiffPlot; dilution an...
	t WBC count results from the two methodologies are compared and if results exceed predefined limi...
	Note: The comparison between the WBC count from the WBC/BASO bath and the WBC count from the flow...


	DIFF Analysis
	r Final 1:80 dilution in the DIFF bath is sent to the flow cell for generation of the DiffPlot
	r Analyzer must maintain reagents and reaction at a regulated temperature of 35˚C (95˚F); therefo...
	r Each stained cell is individually focused by the Dual Focused Flow (DFF) system and transported...
	r 72�µL of sample from the DIFF bath is injected through the flow cell 15�seconds; for 12 of thes...
	r DFF uses sheath fluid to surround and force cells suspended in diluent to pass one at a time th...
	t First sheath flow focuses the sample through the impedance aperture
	t Second sheath flow maintains the focused flow of cells as they exit the aperture into the optic...

	r Hydrodynamic focusing in the flow cell enables accurate and rapid cell-by-cell measurements on ...
	r Sequential analyses for cell volume (impedance) and light absorbance are performed in the flow ...
	r Lymphocytes, monocytes, neutrophils, and eosinophils each have a unique nuclear and morphology ...
	r Light absorbance is related to cellular contents (granularity, nuclear content, and so forth) a...
	r As a cell passes through the optical portion of the flow cell, light is scattered in all direct...
	t Sensor detects only forward scattered light
	t Optical measurement is derived as a function of the amount of light lost due to diffraction and...
	t Collected signals are converted into voltage pulses and are processed
	t Magnitude of the voltage pulses are proportional to the physical and chemical characteristics o...
	t Measurements provide information for lymphocytes, monocytes, neutrophils, and eosinophils, and ...

	r Focused flow impedance technology measures the electrical resistance of a cell as it passes thr...
	r Output signals from the focused flow impedance and the light absorbance measurements are combin...

	RBC/Plt Counting and Sensing
	r Final 1:10,000 dilution in RBC bath contains red blood cells, white blood cells, and platelets
	r Thresholds are used to separate the platelet pulses, which are much smaller, from the red and w...
	Note: Since white blood cells fall in the red blood cell size range, they are counted and sized a...
	r Count syringe supplies a constant low vacuum to the RBC bath to pull the diluted sample through...
	r As each cell passes through the aperture, a pulse is generated proportional to the cellular volume
	r RBC aperture senses red blood cells and platelets:
	t RBC count and PLT count are determined simultaneously
	t RBC histogram is developed
	t PLT histogram is developed

	r Rinse flow is a steady stream of AC•T 5diff Diluent reagent that flows behind the RBC aperture ...
	r Without rinse flow, there is a characteristic swirling of the dilution at the outlet of the ape...
	r With rinse flow, the steady stream of diluent prevents the formation of these eddies

	Hemoglobin Sample Reading
	r Hemoglobin concentration is determined based on the transmittance of light through the optical ...
	r Three one-second readings are collected on the 1:250 dilution

	Completion of the Cycle
	r The WBC bath drains and fills with AC•T 5diff Rinse reagent
	r Hemoglobin blank is read
	r Transmittance of hemoglobin sample reading is compared with the transmittance of the reagent blank
	r Analyzer calculates the Hgb result based on both the blank and sample readings
	r Green LED glows steady; red LED no longer glows
	Note: It is now okay to place another specimen tube in the tube holder and close the cap-pierce d...
	r Main card inside the Analyzer’s left compartment sends the sample results to the Workstation


	NOTES
	BASIC TROUBLESHOOTING TECHNIQUES
	How to Recognize an Instrument Problem
	r By the data that is generated
	t Start Up
	t Commercial cell controls
	t XM analysis
	t Patient samples
	t IQAP

	r By the way the instrument functions�.�.�.�abnormalities in the sample flow
	r By the error messages generated and recorded on the Error Log

	Error Log
	r Click on Analyzer / Logs tab�tt Error Log tab to view the log
	r Shortcut to viewing the Error Log
	Double click on one of the System State indicators
	r Maintains most recent 100 entries displaying the most recent log entry at the top of the log an...
	r Rollover is first in, first out when the 101st entry is added
	r Log contains the following information fields
	Note: It is necessary to scroll right to see some of these fields.
	Information Fields
	Date/Time
	Displays the date and time the error occurred
	Opr
	Displays the User name logon information in the Workstation when the error was entered in the log

	Category
	Displays the category of error that was logged, either related to the Analyzer or Workstation

	Description
	Displays the error reported
	Comment
	Displays any comments entered by the operator performing the error:
	r Optional entry that provides an opportunity for the operator to type a personal observation or ...
	r Operator may use the Add Comments button to access the Add Comments box, as desired
	r If the Prompt User For Comments check box is checked (¸), the Add Comments box pops up automati...
	Note: When Add Comments box is displayed, operator cannot access any other window until they either:
	t Enter a comment then click to save and exit
	or
	t Click to exit the box without entering a comment



	Error Messages
	r Error messages with corrective actions are listed in Chapter 11 of the Instructions For Use manual
	r To use Online Help to locate these messages:
	1) Click
	2) Click on Contents; table of contents appears in the left frame
	3) Inside the left frame, click on 11 Diagnostics to list headings in that chapter
	4) Scroll through headings and click on System Errors; messages appear inside the right frame
	5) Scroll to locate message that appears in the Error Log
	or
	Print a copy of the messages
	-���Right click on the messages (anywhere inside the right frame)
	-���Click Print on the pop-up menu
	-���Click OK to initiate printing



	Three Steps to More Efficient Troubleshooting
	1 Be completely familiar with normal operation
	r Start Up, Sample Analysis, Shut Down
	r Normal Sample Flow
	t Know what should be happening during each part of the cycle
	t Become familiar with the normal sounds of operation


	2 Use a logical approach to obtain a clear symptom and isolate the components involved
	r Use the error message information as a starting point
	r Use your knowledge of sample flow

	3 Acquire the knowledge and skills necessary to locate and correct problems
	r Use the instrument
	r Read the manuals and become familiar with the kind of information they contain
	r Call your Beckman Coulter Representative


	Troubleshooting by Instrument Subsystems
	r Three instrument subsystems:
	t Electronic
	t Reagent
	t Fluidic
	t Pneumatics��(pressures and vacuums)
	t Hydraulics��(liquids)



	Electronic Subsystem
	r If there’s no power,
	t Check to see if one of the indicator lights is on
	t Check power switches
	t Check plug connections
	t Check fuse locations

	r If the flow cell lamp is burned out, see Chapter 11 in the Instructions For Use manual

	Reagent Subsystem
	Level Sensing
	r Level sensing is accomplished using two different types of sensors
	t AC•T 5diff Diluent reagent level sensing uses optical sensor
	t Sensing waste container level uses a float-level sensor

	r Cycle counters monitor levels for those reagents housed inside the reagent compartment

	Replacement Procedures
	r To replace a reagent, see the Changing Reagent Summary
	r To replace a waste container, see the Replacing a Waste Container Summary
	r To replace a stopper assembly, see the Instructions For Use manual

	Reagent Related Problems
	r May be contaminated
	r May be expired
	r May have been frozen causing the ingredients to separate
	r May be the source of electrical interference due to electrolytic characteristics


	Fluidic Subsystem
	Key Components
	r Tubing
	r Valves
	r Syringes
	r Solenoids

	Hydraulics
	r Check tubing connections and routing
	t At the reagent container
	t At all associated syringe assembly
	t Throughout the Diluter part of the Analyzer

	r Check associated syringes, valves, and solenoids

	Pneumatics
	r Low vacuum
	t Generated by the count syringe
	t Equivalent to 5.9 inches of mercury
	t Also called aperture vacuum
	t Pulls the dilutions through the RBC and WBC apertures and sweep flow diluent behind the RBC ape...

	r Pressure
	t Used for dispensing reagents from pumps, opening pinch valves, and moving air cylinder shafts



	Troubleshooting through Cycle Observation
	r To successfully troubleshoot this instrument,
	t Become completely familiar with normal sample flow
	t Know what should be happening during each part of the cycle
	t Be familiar with the normal sounds of operation

	r This type of knowledge is gained mostly through experience
	r To increase your familiarity and your comfort level with the normal sample flow of this instrum...
	r Key Operator should know normal sample flow well enough to verbally describe the normal operati...

	Troubleshooting using Special Procedures
	Reproducibility Check
	r Check measures how close several results (from the same specimen) are to each other; in other w...
	r Check may be done using CBC or CBC/DIFF panel
	r For best results, a fresh, normal whole-blood specimen must be used
	r One normal, fresh whole-blood specimen is cycled at least 5, but no more than 11 times
	r CV or Coefficient of Variation is a percentage of deviation from the mean
	r Results that exceed the limits appear against a red background
	r Reproducibility does not measure accuracy, but true accuracy is not possible unless the instrum...
	r Preforming a reproducibility check before performing a calibration may catch imprecision proble...
	r Procedure is located in the Instructions For Use manual, Chapter 11

	Carryover Check
	r Carryover is the interaction of the previous sample with the current sample
	r High to low carryover check verifies the high results of one sample do not affect the low resul...
	r Check is done by analyzing a whole-blood specimen with high values followed by a whole-blood sp...
	r Carryover is calculated as follows:


	Power Down / Power Up
	r When performing certain replacement procedures, it may be necessary to power down the system to...
	r When the system needs to be powered down, proper sequence must be followed to prevent damage to...
	r When the system is powered up, proper sequence must be followed to ensure proper connection bet...


	‰ SYSTEM POWER DOWN SUMMARY
	1 At the Workstation
	r Click .
	r Select Quit Application.
	r Press Û or click .
	r Wait while the Workstation closes its program.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Click Shut Down at the Logon Information box.
	r Select Shutdown then click OK at the Shutdown Computer box.
	r When the It is now safe to turn off your computer message appears, power the Workstation comput...

	2 At the Analyzer
	r Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located at the ba...
	r If a replacement or maintenance procedure that requires you to open the Analyzer panels is bein...
	‰ ‰


	‰ SYSTEM POWER UP SUMMARY
	1 Preliminary Checks
	r Check the waste container level.
	t If the container needs to be replaced, change the container using the Replacing a Waste Contain...

	r If the Automatic Startup and Auto-Print functions are enabled, make sure the Printer is ready t...
	t If the paper supply is insufficient, add paper.
	t Make sure the power is ON and ready to print.
	t Verify the printer is properly configured according to your laboratory’s protocol.


	2 Power Up the System
	At the Analyzer
	r If the ac power cord is unplugged, plug the cord into the instrument (at the back panel, in the...
	r Toggle the Power ON/OFF rocker switch ON (position�–). This rocker switch is located at the bas...
	r Verify the red LED is glowing steady.

	At the Workstation
	r Power ON the Workstation computer.
	r Wait while the computer performs its internal checks.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Type the User name and Password then press Û or click OK to log on.
	r Type your 3-character (alphanumeric) Operator ID.
	r Press Û or click .
	r Wait for the Reagents window to appear.
	r Verify the background behind the lightening bolt is green.
	Note: Analyzer and Workstation should begin communicating within 30 seconds. In the upper right c...
	r If the Automatic Startup function is enabled, Startup automatically activates.
	t Monitor the Cycle in progress�:�Startup status bar, as desired.
	t Hard copy of Startup results prints automatically if Auto-Print function is enabled.
	t Go to step 4 to review results.



	3 Prepare the System for Processing Samples
	IMPORTANT Risk of inaccurate results if the Analyzer is not properly prepared. Based on the scena...
	r If the system was Shutdown before the power was turned off, do a Startup.
	r If the Analyzer has set idle (not cycled) more than 4 hours, do a Startup.
	r If the Analyzer was not Shutdown and has set idle (not cycled) less than 4 hours, do a Mini Prime.
	r If the Analyzer was powered off then back on again, do a Mini Prime.

	Startup
	r Click �to initiate a Startup routine.
	t Monitor the Cycle in progress�:�Startup status bar, as desired.
	t Hard copy of Startup results prints automatically if Auto-Print function is enabled.

	r Go to step 4 to review results.

	Mini Prime
	r At the Menu bar, select Cycles�tt Mini Prime.
	r Cycle in progress�:�Mini Prime status bar provides a visual display of how close the routine is...
	r When complete, resume normal operation.


	4 Review Results
	r Once the Startup routine is complete, verify Passed is displayed for each parameter.
	t If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.
	Note: If the Add Comments box automatically appears, click to exit.
	t Click �to initiate another Startup routine.
	t If the Startup continues to fail, contact your Beckman Coulter Representative.

	r Save individual or log printout if required by your accreditation agency.
	Add Comments
	r If the Add Comments box appeared automatically, type in your personal observation or appraisal ...
	r To access the Add Comments box, click Startup Log tab�tt Add Comments button then type your per...
	r Click to save your comments.


	5 Perform Quality Control Checks
	r Perform quality control checks before running patient specimens according to your laboratory’s ...
	‰ ‰

	PREVENTIVE MAINTENANCE
	r Proper maintenance of your AC•T 5diff CP hematology analyzer is the best way to ensure proper p...
	r Failure to properly execute the maintenance procedures may compromise instrument performance
	Maintenance Schedules
	r Maintenance procedures you perform are based either on a time schedule or on an as needed basis
	t Startup and Shutdown are daily maintenance procedures
	t Calibration is as needed or when required by your laboratory or regulatory agency
	t Replacing reagents or the rinse drain filter are as needed procedures
	t Extended cleaning is an as needed procedure

	r Maintenance performed by your Beckman Service Representative is based on the number of cycles; ...

	Maintenance Log
	r Click on Analyzer / Logs tab�tt Maintenance Log tab to view the log
	r Maintains the most recent 100 entries displaying the most recent log entry at the top of the lo...
	r Rollover is first in, first out when the 101st entry is added
	r Some maintenance procedures, such as the Extended Cleaning procedure, automatically add entries...
	r If Prompt User For Comments check box is checked�(¸), user is prompted to enter a comment
	r Log contains the following information fields
	Note: It is necessary to scroll right to see some of these fields.
	Information Fields
	Date/Time
	Displays the time and date the log entry was made, which should correlate with when the maintenan...

	Opr
	Displays the User name logon information in the Workstation when the maintenance was completed

	Note: To access the New Entry Log window cited below, you must click
	Action
	Displays the maintenance that was performed (entry made by the operator on the New Log Entry window)

	Duration
	Displays the time it required the operator to complete the maintenance (entry made by the operato...
	Comment
	Displays any comments entered by the operator performing the maintenance (entry made by the opera...
	r Optional entry that provides an opportunity for the operator to type a personal observation or ...
	r Some maintenance procedures, such as the Extended Cleaning procedure, add entries automatically...
	r Operator may also use the Add Comments button to access the Add Comments box, as desired
	r If the Prompt User For Comments check box is checked (¸), the Add Comments box pops up automati...
	Note: When Add Comments box is displayed, operator cannot access any other window until they either:
	t Enter a comment then click to save and exit
	or
	t Click to exit the box without entering a comment





	SERVICE LOG
	r Function is similar to that of the Maintenance Log but is used by your Beckman Coulter Service ...
	r Must use the Service Password to access



	SUMMARY PAGES
	OVERVIEW
	What are Summary Pages?
	Each summary is an abbreviated reference of essential operating instructions detailed in the Inst...

	Purpose
	Each summary page is an individual, stand-alone document that is designed for use in your laborat...
	This chapter contains a master copy of each summary page. These pages may be copied for use durin...

	Design
	These summary pages are designed for ease of use by a newly trained operator as well as an experi...
	A novice operator is likely to need all this information, but as an operator’s skills develop, th...
	An experienced operator may also decide to use the Daily Operations Quick Reference to guide them...

	Presentation in This Training Guide
	Since these summary pages will be helpful in training other operators in your laboratory and sinc...
	‰ Startup Summary
	Since this is a stand-alone summary for use after training is complete, some of the instructions ...


	CONTENTS
	Since these summary pages are designed to be used as stand-alone documents, consecutive page numb...
	Most operational summaries consist of either a single-side or a double-sided page. However, to ac...
	To assist you in locating a desired summary (since the page numbering is not sequential), the sum...
	Routine Procedures
	r Startup
	r Running COULTER® AC•T™ 5diff Control Plus
	r Running Patient Samples Using the Worklist
	r Running Patient Samples Without Using the Worklist
	r Archived Data Quick Reference
	r Shutdown
	r System Power Down
	r System Power Up

	QC File Management
	r Making Changes to a Control File Currently In Use
	r Control File Management

	Replacement Procedures
	r Changing Reagent
	r Replacing a Waste Container

	Reference Tools
	r Icons Quick Reference
	r Tube Holders Quick Reference
	r Online Help System Quick Reference



	STARTUP SUMMARY
	Before starting this summary, verify both Workstation and Analyzer power are ON. If the system is...
	1 Preliminary Checks
	r If the Workstation screen is blank, power on the monitor.
	r Verify the green circle is displayed in the upper right corner.
	r Check the waste container level.
	t If the container needs to be replaced, change the container using the Replacing a Waste Contain...

	r Make sure the Printer is ready to print.
	t If the paper supply is insufficient, add paper.
	t Make sure the power is ON and ready to print.


	2 Perform the Startup
	r Click �to initiate a Startup routine.
	r Monitor the Cycle in progress�:�Startup status bar, as desired.
	r Hard copy of the results prints automatically if the Auto-Print function is enabled.

	3 Review Results
	r Once the Startup routine is complete, verify Passed is displayed for each parameter.
	t If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.
	Note: If the Add Comments box automatically appears, click to exit.

	t Click �to initiate another Startup routine.
	t If the Startup continues to fail, contact your Beckman Coulter Representative.

	r Save individual or log printout if required by your accreditation agency.
	r Add comments as desired.
	t If the Add Comments box appeared automatically, type in your personal observation or appraisal.
	t To access the Add Comments box, click Startup Log tab�tt Add Comments button then type your per...
	t Click to save your comments.


	4 Perform Quality Control Checks
	r Perform quality control checks before running patient specimens according to your laboratory’s ...


	RUNNING COULTER® AC•T™ 5diff Control PLUS Summary
	1 Get the Workstation Ready
	To run controls with the Control window open
	r Click the Quality Assurance tab.
	r From the Select Control drop-down menu, locate the control file that correlates with the lot nu...

	To run controls with the Run window open
	r Click the Run tab.
	Note: To use this option, the control lot number must be reserved. If you are not familiar with t...
	r Enter the control lot number as the next Sample ID.


	2 Prepare the Control according to the Package Insert
	r Warm controls at room temperature for 15 minutes.
	r Control levels may be processed in any order.
	r Mix the control vial using the 8 x 8 x 8 method.
	t Do not use a mechanical mixer!
	t Inspect the control vial to ensure all cells are uniformly distributed, if not, repeat the 8 x ...


	3 Run the Control
	r At the tube holder, make sure sample position is in the pierce position (12 o’clock).
	(In tube holder #1, use sample position 1; in tube holder #2, use sample position 4.)
	r Place the well-mixed, closed-vial of control in sample position 1.
	r Close the cap-pierce door.

	4 Review Results
	Note: A hard copy of the results prints automatically if the Auto-Print function is enabled.
	r Verify control results are within the acceptable ranges.
	r If a result is out-of-limits:
	t Rerun the control after gently remixing the control vial.
	or
	t Refer to When CBC/DIFF Control is Outside Its Expected Ranges that follows.

	r Compare the results of this run with previous runs, as desired
	t To evaluate stored numerical data or evaluate the graphs for the presence of shifts or trends, ...
	t Click Quality Assurance tab to display the Control window, if needed.


	When CBC/DIFF Control is Outside Its Expected Ranges
	1. Check for a control problem.
	r Ensure the control material was properly mixed. If not, mix it according to the package insert.
	r If the control was processed in the Control window, make sure the control file with the correct...
	r If the control was processed in the Run window, make sure the lot number was entered correctly ...
	r Unless you have established your own running mean and/or expected ranges, make sure the setup i...
	r If any of the above problems exist, rerun the control; otherwise, proceed to the next check.

	2. Rerun the control to determine if the out-of-limit result is a statistical outlier. If the rer...
	3. Ensure the control material was not contaminated by running another vial or level of control. ...
	4. Perform the Extended Cleaning procedure in the Instructions For Use manual, Chapter�11.
	Use the Online Help to locate this procedure:

	a. Click .
	b. Click on Contents. The table of contents appears in the left frame.
	c. Inside the left frame, click on 11 Diagnostics to list the headings in that chapter.
	d. Scroll through the headings and click on Extended Cleaning. The cleaning procedure appears ins...
	e. Complete the procedure.
	t Follow the instructions on the Workstation screen.
	or
	t Print a copy of the instructions.
	-���Right click on the procedure (anywhere inside the right frame).
	-���Click Print on the pop-up menu.
	-���Click OK to initiate printing.
	Note: All the information under the primary heading is printed. Locate the Extended Cleaning inst...

	f. Rerun the control.
	t If the results are acceptable, run other control levels that need to be processed then resume n...
	t If the results are still out, call your Beckman Coulter Representative to help you troubleshoot.



	Running PATIENT SAMPLES USING THE WORKLIST Summary
	Note: Use this summary only if you want to use the Worklist. If you do not want to run samples us...
	1 Get the Workstation Ready
	r Click Results tab to verify only the active archive is open (background is white).
	t If the background is green, an old archive is open and must be closed.
	t At the Menu bar, select File�tt Close archive to close the old archive.

	r If, according to your laboratory protocol, it is time to create a new archive, select File�tt N...
	r Click Worklist tab.
	If the Worklist is Set Up Manually
	r Click .
	Inside the Add/Edit Worklist box:
	r Enter sample ID:
	t Click on the Sample ID field.
	t Manually type the ID number at the keyboard.
	or
	Scan the specimen tube’s bar-code label with the bar-code wand.
	t Verify the ID number inside the Sample ID field is correct.


	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Flagging set currently selected as default is entered; select another flagging set from the dro...
	r Enter comment or other patient demographic information as desired. (If enter gender and/or age ...
	r Click to save entries and clear the box for entering the identifiers and demographics for anoth...
	r When the last entry to the Worklist is complete, click to save and exit.
	r Click Run tab.

	Autonumbering ON
	r Click .

	Inside the Add/Edit Worklist box:
	r Sample ID entry is automatic.
	To override the autonumber with another sample ID:
	t Highlight the autonumber in the Sample ID field.
	t Manually type the desired sample ID number at the keyboard.
	t Verify the ID number inside the Sample ID field is correct.
	Note: Autonumbering automatically begins again with the autonumber that was overwritten.

	r CBC/DIFF is the default panel selection; or select CBC from the drop-down box.
	r Flagging set currently selected as default is entered; select another flagging set from the dro...
	r Enter comment or other patient demographic information as desired.(If enter gender and/or age a...
	r Click to save entries and clear the box for entering the identifiers and demographics for anoth...
	r When the last entry to the Worklist is complete, click to save and exit.
	r Click Run tab.


	If the Worklist is Downloaded from a Host Computer
	r Sample ID and patient demographics are automatically downloaded from the host computer. (Inform...
	r Click Run tab.


	2 Process the Sample
	r Check the Sample ID Next field for the next specimen to be processed.
	Note: If you want to run another specimen, manually type the sample ID or scan the bar-code label...
	r Verify the tube holder is appropriate for the specimen tube being analyzed. If not, change the ...
	r Mix the specimen gently but thoroughly according to your laboratory’s protocol.
	r If the specimen tube does not have a pierceable stopper, remove the stopper.
	r Place the well-mixed specimen tube in the sample position that best matches the tube. Rotate th...
	r Close the cap-pierce door to initiate the cycle.
	r Remove the specimen tube when the cap-pierce door automatically opens after aspiration is compl...
	r Overlap sample processing, if desired.
	t Repeat step 2 to get ready for the next cycle.
	t When the cycle is complete (green LED glows steady), go to step 3.


	3 When the Cycle is Complete
	r Verify the sample results appear in the Run window.
	r Verify the sample ID entry and results before reporting.
	r Click for a hard copy of the results.
	Note: A hard copy prints automatically if the Auto-Print function is enabled.
	r Repeat steps 2 and 3 until all specimens are analyzed.

	Running Patient Samples WITHOUT USING THE WORKLIST Summary
	1 Get the Workstation Ready
	2 Process the Sample
	3 Prepare for the Next Cycle
	4 When the Current Cycle is Complete

	ARCHIVED DATA QUICK REFERENCE
	Verify the Desired Archive is Being Used
	1 Click the Results tab to display the list of sample results.
	2 Is this the archive you wish to use?
	r If you wish to use the current, active archive:
	t A white background indicates you are viewing the current, active archive.
	t A light green background indicates you are viewing a previously closed archive that has been op...

	r If you wish to use a previously closed archive:
	Note: Do not analyze patient samples when a previously closed archive is open.
	t A white background indicates you are viewing the current, active archive. At the Menu bar, sele...
	t A light green background indicates you are viewing a previously closed archive that has been op...
	-���Select File�tt Close archive to close this open archive.
	-���Select File�tt Open archive, the table of closed archives appears.
	-���Select the date for the archive you wish to use.


	3 You may choose to sort, view, print, transmit, or delete selected or all results.
	4 If you open an archive, make sure you close the archive when your work is completed.

	To Sort the Results List
	At the Results window, you can sort information in ascending or descending order using any column...
	1 Click the title of the column you want sorted. For example, if you wish to sort by sample�ID, c...
	r >> appearing next to the title indicates an ascending (low to high) sort order.
	r << appearing next to the title indicates a descending (high to low) sort order.
	r Repeating sequence for sort functions:
	t Click once, sort ascending with a >> symbol in the column header
	t Click again, sort descending with a << symbol in the column header
	t Click again, defaults back to original order
	t Click again, start again with sort ascending

	r Sample IDs sort alphanumerically by character. For example, 10 will appear before 4 because it ...
	r Numbers appear in a sorted list before letters. For example, Sample ID 482 will appear before S...


	To Search for a Specific Sample
	1 Scroll through the list of results to locate the sample ID.
	or

	2 Use the search feature:
	r Click the Search Results tab at the bottom of the Results window.
	r Click Current Archive or Closed Archive.
	r Click your choice of search criteria: Sample ID, Patient ID, or Patient Name.
	r Type the chosen identifier.
	r Click the Search button.


	To View Sample Results
	1 To view numeric results, scroll right.
	r You may choose to print or transmit the numeric sample results.

	2 To view detailed results (results and histograms in the Run window format):
	r Double-click the desired result.
	or
	r Click to view the selected results.
	Note: Click to review the previous result or to review the next result, as desired.
	r You may choose to print or transmit the detailed sample results.
	r Click to return to the Results List.


	To Output Sample Data:��Print and Reprint / Transmit and Retransmit
	To Print a Single Sample Data Set
	1 At the selected set of sample results, click to display the print menu.
	2 Select the desired print format:
	r Print Summary List For Selected Rows (prints numeric results only)
	or
	r Print Patient Report For Selected Rows (prints Run view of results and histograms)
	ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch printing and bat...


	To Batch Print a Group of Samples
	1 Display the list of sample results.
	2 While pressing the Å key, click on each sample you wish to print. A black dot appears in the fa...
	3 Click to display the print menu.
	4 Select the desired print format:
	r Print Summary List For Selected Rows (prints numeric results only)
	or
	r Print Patient Report For Selected Rows (prints Run view of results and histograms)
	ATTENTION: Beckman Coulter recommends that you do not perform simultaneous batch printing and bat...


	To Batch Transmit a Group of Samples
	Note: The transmit option also allows an operator to transmit the last result and all results.
	1 Click the Results tab if you have not already done so.
	2 While pressing the Å key, click on each sample you wish to transmit. A black dot appears in the...
	3 Click to display the transmit menu.
	4 Select The selected results from the transmit menu.




	SHUTDOWN SUMMARY
	1 Perform Instrument Shutdown
	r Click �to initiate a Shutdown routine.
	r Monitor the Cycle in progress�:�Shutdown status bar, as desired.

	2 Shut Down Computer then Power Off Analyzer and PC
	When Shutdown is complete, a message box appears:
	r Click OK to shut down the computer.
	r Turn off the Analyzer power switch.
	r Wait for the “It is now safe to turn off computer” message to appear.
	r Turn off the PC power switch.
	Notes:
	t Allow AC•T 5diff Rinse reagent to remain in the instrument a minimum of 30 minutes.
	t Wait at least 30 seconds before performing the Power Up and Log On procedures.
	t After doing Shutdown, you must do a Power Up and Startup before running patient specimens or co...




	SYSTEM POWER DOWN Summary
	1 At the Workstation
	r Click .
	r Select Quit Application.
	r Press Û or click .
	r Wait while the Workstation closes its program.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Click Shut Down at the Logon Information box.
	r Select Shutdown then click OK at the Shutdown Computer box.
	r When the It is now safe to turn off your computer message appears, power the Workstation comput...

	2 At the Analyzer
	r Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located at the ba...
	r If a replacement or maintenance procedure that requires you to open the Analyzer panels is bein...


	SYSTEM POWER UP SUMMARY
	1 Preliminary Checks
	r Check the waste container level.
	t If the container needs to be replaced, change the container using the Replacing a Waste Contain...

	r If the Automatic Startup and Auto-Print functions are enabled, make sure the Printer is ready t...
	t If the paper supply is insufficient, add paper.
	t Make sure the power is ON and ready to print.
	t Verify the printer is properly configured according to your laboratory’s protocol.


	2 Power Up the System
	At the Analyzer
	r If the ac power cord is unplugged, plug the cord into the instrument (at the back panel, in the...
	r Toggle the Power ON/OFF rocker switch ON (position�–). This rocker switch is located at the bas...
	r Verify the red LED is glowing steady.

	At the Workstation
	r Power ON the Workstation computer.
	r Wait while the computer performs its internal checks.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Type the User name and Password then press Û or click OK to log on.
	r Type your 3-character (alphanumeric) Operator ID.
	r Press Û or click .
	r Wait for the Reagents window to appear.
	r Verify the background behind the lightening bolt is green.
	Note: Analyzer and Workstation should begin communicating within 30 seconds. In the upper right c...
	r If the Automatic Startup function is enabled, Startup automatically activates.
	t Monitor the Cycle in progress�:�Startup status bar, as desired.
	t Hard copy of Startup results prints automatically if Auto-Print function is enabled.
	t Go to step 4 to review results.



	3 Prepare the System for Processing Samples
	IMPORTANT Risk of inaccurate results if the Analyzer is not properly prepared. Based on the scena...
	r If the system was Shutdown before the power was turned off, do a Startup.
	r If the Analyzer has set idle (not cycled) more than 4 hours, do a Startup.
	r If the Analyzer was not Shutdown and has set idle (not cycled) less than 4 hours, do a Mini Prime.
	r If the Analyzer was powered off then back on again, do a Mini Prime.

	Startup
	r Click �to initiate a Startup routine.
	t Monitor the Cycle in progress�:�Startup status bar, as desired.
	t Hard copy of Startup results prints automatically if Auto-Print function is enabled.

	r Go to step 4 to review results.

	Mini Prime
	r At the Menu bar, select Cycles�tt Mini Prime.
	r Cycle in progress�:�Mini Prime status bar provides a visual display of how close the routine is...
	r When complete, resume normal operation.


	4 Review Results
	r Once the Startup routine is complete, verify Passed is displayed for each parameter.
	t If Failed appears for any parameter, click Startup Log tab to evaluate numeric results.
	Note: If the Add Comments box automatically appears, click to exit.

	t Click �to initiate another Startup routine.
	t If the Startup continues to fail, contact your Beckman Coulter Representative.

	r Save individual or log printout if required by your accreditation agency.
	Add Comments
	r If the Add Comments box appeared automatically, type in your personal observation or appraisal ...
	r To access the Add Comments box, click Startup Log tab�tt Add Comments button then type your per...
	r Click to save your comments.


	5 Perform Quality Control Checks
	r Perform quality control checks before running patient specimens according to your laboratory’s ...


	MAKING CHANGES TO A CONTROL FILE CURRENTLY IN USE SUMMARY
	Use this summary only if you need to make a change in a control file that is currently in use and...
	r To correct a typographical error.
	or
	r To edit an assigned value (obtained from the Table of Expected Results) to a running mean (esta...

	If you need to make a set up change (such as changing the lot number), use the Control File Manag...
	1 Select the File
	r Click the Quality Assurance tab�tt Control tab to display the Control window.
	r Choose the existing file you want to change from the Select Control drop-down menu.

	2 Access the Setup Control Window
	r Click the Setup Control button.

	3 Make the Changes
	r Enter the new information.

	4 Verify All Changes
	r Check all entries are correct.
	r Click� .
	t If control runs are stored in this file:
	H When the Do You Want The Existing Results To Be Saved? message appears, click on the desired ac...
	H Selected action makes the requested changes then exits the window.

	t If no control runs are stored in this file, requested changes are saved before exiting the window.

	r Control file statistics are recalculated based on the changes.


	CONTROL FILE MANAGEMENT SUMMARY
	Review the Numeric Control Data and Graphs, if applicable
	1 Locate the Control File
	r Click the Quality Assurance tab to display the Control window.
	r Choose the specific file you want to review from the Select Control drop-down menu.

	2 Review the Graphs
	r Double-click on any thumbnail graph you wish to review.
	r Look for any skewed or out-of-limit plot points .
	r Check for a shift or a trend.

	3 Review Numeric Data
	r Review %CV of all parameters (press é to see additional parameters).
	r If a CV is high, scroll through the rows and examine each run for results mistakenly run into t...
	r May review and manage the data by shifts, if desired.
	r Exclude any mistakes from the control calculations.
	t Locate the control that needs to be excluded from the calculations.
	t Click the to the left of that control (inside the Include column).
	t (an empty check box) indicates those control results are no longer being included in the contro...
	t Repeat as needed.



	Print the Control File Data
	r Click .
	r Print All Rows is preselected but if a hard copy of the graphs is also desired select the Print...
	r If you are submitting data for IQAP evaluation, print a second copy.

	Delete the Control File Data
	r Click .
	r Choose Erase All row from the drop-down menu.
	Note: All the control results are deleted. Target values and +/- limits remain in the control fil...

	Set Up the New Lot Number of Commercial Control
	IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up contro...
	Note: Before starting this set up, obtain the control disk for the controls you plan to set up.
	1 Select the File
	r Click the Quality Assurance tab to display the Control window.
	Note: If the Control window is not displayed, click the Controls tab at the bottom.
	r Choose a CBC/DIFF file from the Select Control drop-down menu.

	2 Access the Setup Control Window
	r Click the Setup Control button.

	3 Download the Control Data from the Disk
	r Insert the control disk into the floppy drive.
	r Select the Download Values button.
	r Select the control level then click .
	r Select Commercial as the source of control material (if it is not already displayed).
	r Print if desired then click .

	4 Reserve the Control Lot Number
	r Click Setup�tt Quality Assurance.
	r Type the password then click .
	r Click the General tab, if necessary.
	r Click the box in the Reserved column that corresponds to the desired control lot.
	r Click .

	5 Set Up Another Level of Control, if applicable
	IMPORTANT Risk of misleading control results. Old control runs remaining in a newly set up contro...
	r Review, print, and delete other files, as applicable.
	r Choose another empty, inactive file from the Select Control drop-down menu.
	r Repeat steps 2, 3, and 4.



	CHANGING REAGENT Summary
	Note: If all reagents are being changed, see Chapter 11 of the Instructions For Use manual.
	1 Verify a New Reagent Container is Needed
	r Display the Reagents window by choosing Analyzer/Logs tab�tt Reagents tab.
	r Check reagent levels to determine which reagent triggered the REAGENT LOW LEVEL message.
	t Check all levels because more than one may be low.
	t Obtain a new unopened container of each reagent that according to your laboratory’s protocol re...


	2 Replace the Reagent Container
	r Open the new reagent container.
	r Remove the stopper assembly from the old container then transfer it directly to the new contain...
	Note: If the lower part of the assembly touches you or anything outside the container, flood that...
	r Put the cap from the new container onto the empty container.
	r Properly dispose of the empty bottle according to your laboratory’s protocol.

	3 Record the New Reagent Information
	r At the Reagents window, click Change Reagent.
	r Choose the reagent that was changed from the drop-down menu.
	r Type the new lot number.
	Note: Today’s date automatically appears in the Opened Date box.
	r Choose the Expiration Date (or open container stability) from the drop-down calendar.
	t For all reagents except AC•T™ 5diff Hgb Lyse reagent, select the date printed on the reagent co...
	t For the AC•T 5diff Hgb Lyse reagent which has a 90 day open container stability, select the dat...

	r Click to save the information and return to the Reagents window.

	4 Wait for the Reagent Lines to Prime
	r System automatically primes the reagent and updates the level indicator.
	Note: Reagent level may not be displayed at 100% due to this priming.
	r Once priming is complete, continue normal operation.


	REPLACING A WASTE CONTAINER Summary
	Note: If the waste container is not full and the waste alarm is chirping (beeping) at regular int...
	1 Power Off the System
	At the Workstation
	r Click .
	r Select Quit Application.
	r Press Û or click .
	r Wait while the Workstation closes its program.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Click Shut Down at the Logon Information box.
	r Select Shutdown then click OK at the Shutdown Computer box.
	r When the It is now safe to turn off your computer message appears, power the Workstation comput...

	At the Analyzer
	r Toggle the Power On/Off rocker switch OFF (position O). This rocker switch is located at the ba...


	2 Replace the Waste Container
	r Clearly mark or apply a waste label to an empty 20�L container.
	r Using biohazardous precautions:
	t Carefully remove the cap (with waste sensor attached) from the full waste container.
	t Transfer the waste assembly directly to the empty waste container and tighten.


	3 Neutralize and Disinfect the Waste Before Capping the Container
	r For 20 liters of waste liquid, add the following to the waste container:
	t 250�mL of sodium hypochlorite solution (if 12% available chlorine) or 500�mL of sodium hypochlo...
	t 50�mL of 200 g/L sodium hydroxide solution to prevent gas from forming if the container is bein...

	r Dispose of the biohazardous waste according to your laboratory’s protocol.

	4 Power Up the System
	At the Analyzer
	r Toggle the Power ON/OFF rocker switch ON (position�–). This rocker switch is located at the bas...
	r Verify the red LED is glowing steady.

	At the Workstation
	r Power ON the Workstation computer.
	r Wait while the computer performs its internal checks.
	r When the Begin Logon box appears, press Å + × + á simultaneously.
	r Type the User name and Password then press Û or click OK to log on.
	r Type your 3-character (alphanumeric) Operator ID.
	r Press Û or click .
	r Wait for the Reagents window to appear.
	r Verify the background behind the “lightening bolt” is green.
	Note: Analyzer and Workstation should begin communicating within 30 seconds. In the upper right c...


	5 Prepare the System for Processing Samples
	r If the Automatic Startup function is enabled:
	t Startup routine was automatically activated when the power was toggled back ON.
	t Cycle in progress�:�Startup status bar provides a visual display of how close the routine is to...
	t When complete, resume normal operation.

	r If the Automatic Startup function is not enabled:
	t At the Menu bar, select Cycles�tt Mini Prime.
	t Cycle in progress�:�Mini Prime status bar provides a visual display of how close the routine is...
	t When complete, resume normal operation.



	ICON QUICK REFERENCE
	Print

	TUBE HOLDERS QUICK REFERENCE
	This is a simplified overview of tube holders and the approved collection devices and control via...
	Position B
	c Most 13�mm x 75�mm evacuated specimen tubes containing either K3EDTA or K2EDTA for collecting w...
	c COULTER® AC•T™ 5diff Control Plus control tubes
	Position C
	c COULTER® AC•T™ 5diff Cal Calibrator vial
	Position D
	c Sarstedt Monovette® 11.5�mm x 66�mm specimen tube collecting 2.7�mL of whole-blood
	Position E
	c Becton-Dickinson Microtainer for collection of 0.25�to�0.50�mL of whole-blood
	Position B
	c Becton-Dickinson Microtainer for collection of 0.25�to�0.50�mL of whole-blood
	Position C
	c Becton-Dickinson 10.25�mm�x�64�mm Vacutainer® for collecting 3�mL of whole-blood
	Position D
	c RAM Scientific microcollection device for collecting 125�µL of whole-blood
	Position E
	c 13�mm x 75�mm specimen tube with mulitiple labels
	c COULTER® AC•T™ 5diff Control Plus control tubes


	ONLINE HELP SYSTEM QUICK REFERENCE
	Accessing Online Help
	ATTENTION: In the event that you cannot access the AC•T 5diff Cap Pierce Online Help System, cont...
	Using the COULTER® AC•T™ 5diff CP Workstation
	r Click to display the Help screen

	Using Your COULTER AC•T 5diff CP Hematology Analyzer Operator Manuals CD-ROM
	ATTENTION: Do not use this CD-ROM on your AC•T 5diff CP Workstation.
	1 Turn on your personal or office desktop PC and allow it to boot up. Refer to the PC manual for ...
	2 Insert the CD-ROM into the CD-ROM drive.
	r If Autorun is enabled on your PC, the PC automatically launches the program.
	r If Autorun is disabled on your PC, do steps 3 through 4.

	3 Locate the Start.HTM file (CD-ROM�drive letter:\Start.HTM):
	r Click the Windows Start button.
	r Click Run.
	r Click Browse and locate the CD-ROM drive.
	r Double-click the CD-ROM drive letter (usually D or E).

	4 Double-click Start.HTM to launch the program.
	5 Click For Viewing (or For Printing) as desired.


	Moving or Resizing the Help Screen
	1 Access online Help.
	2 To move the Help window:
	r Click the title bar and hold down the left mouse button.
	r Move the mouse to drag the window to a new location.
	r Release the mouse button when the window is located as desired.

	3 To resize the Help window:
	r Move the cursor over the window border until the arrows appear.
	r Click the left mouse button and drag the border to resize the window.
	r Release the mouse button when the window is the desired size.


	Opening / Closing the Topics Pane
	1 Access online Help.
	2 Click the arrows to close the topics pane.
	3 Click Contents, Index, Illustrations, Tables, or Search to re-open the topics pane.

	Viewing Help Topics
	1 Access online Help.
	2 Navigate through Help as needed:
	r Click Contents to browse through topics by heading.
	r Click Index to see a list of index entries.
	r Click Tables to see a list of tables.
	r Click Illustrations to see a list of illustrations.
	r Click Search to search for words or phrases.
	r Click Home to return to main Help screen.

	3 Move through topics as needed:
	r Click to display the previous topic in the sequence.
	r Click to display the next topic in the sequence.
	r Click to display the previous link.

	4 View referenced or related topics:
	r Click the highlighted words in a topic body to link directly to the referenced topic.
	r Click a word in the highlighted hierarchy – at the top of the topic�– to change topic levels. T...

	5 To view information not visible in the Help window, scroll through the window by using the scro...

	Using the Contents Option
	1 Access online Help.
	2 Click Contents to browse through topics by heading.
	3 Select a top-level heading to expand and view its sub-topic headings.
	4 Select a sub-heading to display information about that topic in the Content pane.
	5 Use the scroll bar to scroll through the information.

	Using the Index Option
	1 Access online Help.
	2 Click Index.
	3 Click the letter corresponding with the list of index entries you want to see.
	4 Scroll through the topics as needed.
	5 Click a number after the index entry to display information about that topic.

	Using the Tables Option
	1 Access online Help.
	2 Click Tables to display the list of tables.
	3 Scroll through the tables to locate the table you want to view.
	4 Click the table to display it on the screen.

	Using the Illustrations Option
	1 Access online Help.
	2 Click Illustrations to display the list of illustrations.
	3 Scroll through the illustrations to locate the table you want to view.
	4 Click the illustration to display it on the screen.

	Using the Search Option
	1 Access online Help.
	2 Click Search to display the search field.
	3 Type the word you want to locate.
	4 Click Search. If the word you typed appears in the document, each instance where it appears wil...
	T

	Printing Operator Manuals
	To Print the Instructions For Use Manual from the Workstation
	Note: Prints with the same page breaks and document structure as the printed document that is ava...
	1 At the Menu bar, click Help�tt Contents�tt Print Manual.
	2 Click Print.
	3 Define what pages you want to print. You can print all or part of the document.
	4 Follow the instructions on the screen.

	To Print Operator Manuals from the CD-ROM
	Note: Prints with the same page breaks and document structure as the printed document that is ava...
	ATTENTION: Do not use this CD-ROM on your AC•T 5diff CP Workstation.

	1 Turn on your personal or office desktop PC and allow it to boot up. Refer to the PC manual for ...
	2 Insert the CD-ROM into the CD-ROM drive.
	r If Autorun is enabled on your PC, the PC automatically launches the program. (The contents of t...
	r If Autorun is disabled on your PC, do steps 3 through 4.

	3 Locate the Start.HTM file (CD-ROM�drive letter:\Start.HTM):
	r Click the Windows Start button.
	r Click Run.
	r Click Browse and locate the CD-ROM drive.
	r Double-click the CD-ROM drive letter (usually D or E).

	4 Double-click Start.HTM to launch the Home page.
	5 Select a language.
	6 Under the name of the manual you wish to print, click For Printing.
	7 Define what pages you want to print. You can print all or part of the document.
	8 Follow the instructions on the screen.



	TRAINING CHECKLIST
	OFFICIAL TRAINING DOCUMENTATION
	(for COULTER® AC•T™ 5diff CP Hematology Analyzer Training)
	Laboratory
	Address
	Phone
	AC•T 5diff CP Serial Number _
	Key Operator
	Training Dates

	Instructions
	The overall objectives for COULTER AC•T 5diff CP Hematology Analyzer Key Operator training are li...

	Checklist
	Your signature at the end of this checklist indicates agreement that the Trainee is able to�.�.�.
	_______
	Locate important procedures in the Instructions For Use manual including:
	_______ Startup and Shutdown procedures
	_______ Quality Assurance and Calibration procedures
	_______ Sample Analysis procedures
	_______ Reagent replacement procedures
	_______ Troubleshooting procedures
	_______
	Identify basic instrument components and describe their functions
	_______
	Correctly perform Startup and Shutdown procedures
	_______
	Explain the importance of the Startup and Shutdown procedures and the frequency with which they s...
	_______
	Perform appropriate Quality Assurance checks
	_______
	Review, delete, and set up control files
	_______
	Prepare IQAP data for submission, if applicable
	_______
	Perform all preliminary procedures required for calibration
	_______
	Perform calibration with COULTER® AC•T™ 5diff Cal Calibrator and document the results according t...
	_______
	Perform Sample Analysis using their preferred workflow pattern (with or without Worklist)
	_______
	Look up samples in the current, active archive
	_______
	Explain how to open a closed archive
	_______
	Understand the basics principles of parameter derivation and state if a parameter result is direc...

	_______
	Review data and recognize if a DiffPlot is normal or abnormal
	_______
	Review data and recognize if an RBC and/or Plt histogram is typical or atypical
	_______
	Explain what a particular flag indicates when provided with an example
	_______
	Recognize an instrument problem based on abnormal sample results, abnormal Startup, abnormal cont...

	Comments
	All other trademarks, service marks, products, or services are trademarks or registered trademark...



	TRADEMARKS
	AC•T, Beckman Coulter, the BECKMAN COULTER logo, and COULTER are trademarks of Beckman Coulter, Inc.
	Documentation
	COULTER® AC• T™ 5diff CP Hematology Analyzer Documentation
	s Instructions For Use PN 624021
	s Host Transmission Specification PN 4277065
	s Training Guide PN 4277205
	s Daily Operations Quick Reference PN 4277315

	Printed on Recycled Paper
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